
 

 

 
 
 

А. Н. Осипов, С. В. Кракасевич, В. М. Бондарик 
 

 

 

 

 

ЭЛЕКТРОННАЯ ЛЕЧЕБНАЯ АППАРАТУРА 
КУРСОВОЕ ПРОЕКТИРОВАНИЕ 

 
Допущено Министерством образования Республики Беларусь 

в качестве учебного пособия  
для студентов учреждений,  

обеспечивающих получение высшего образования  
по специальности «Медицинская электроника» 

 

 
 

 

 

 

 

 

 

 

 
 

Минск БГУИР 2008 

Би
бл
ио
те
ка

 БГ
УИ
Р



 2 

УДК 615.47 (075.8) 
ББК 34.7 я 73 
О–74 

 
 
 
 

Р е ц е н з е н т ы : 
кафедра конструирования и производства приборов Белорусского 

национального технического университета,  
(заведующий кафедрой, доктор технических наук, профессор М. Г. Киселев); 

 
доктор технических наук В. Н. Ильин 

 
 
 
 
 
 
 
 

 
О–74 

Осипов, А. Н. 
Электронная лечебная аппаратура. Курсовое проектирование : 

учеб. пособие / А. Н. Осипов, С. В. Кракасевич, В. М. Бондарик. – Минск : 
БГУИР, 2008. – 211 с. : ил. 

 ISBN 978-985-488-257-4 
Содержит общие требования к курсовому проекту, методику и особенности проекти-

рования электронной лечебной аппаратуры. Приведены требования к расчетной части кур-
сового проекта с примерами электрических и конструкторских расчетов, а также рекомен-
дации по автоматизированному проектированию и оформлению курсовых проектов. 

Имеет целью научить студентов самостоятельно проектировать электронные лечеб-
ные аппараты различной конфигурации. 

Предназначено для студентов специальности «Медицинская электроника» и руково-
дителей курсовых проектов. Может быть полезно студентам специальностей «Проектиро-
вание и производство РЭС», «Электронно-оптические системы и технологии», а также дру-
гих родственных специальностей высших технических учебных заведений. 

 
УДК 615.47 (075.8) 
ББК 34.7 я 73 

 
 
 
 
 
 
ISBN 978-985-488-257-4 © Осипов А. Н., Кракасевич С. В.,  
 Бондарик В. М., 2008 

© УО «Белорусский государственный 
университет информатики 
и радиоэлектроники», 2008 

Би
бл
ио
те
ка

 БГ
УИ
Р



 3 

СОДЕРЖАНИЕ 
 
1 Задачи и тематика курсового проектирования................................................5 
 

2 Общие требования к курсовому проекту.........................................................7 
 

3 Обеспечение требований электробезопасности при проектировании 
средств медицинской электроники ................................................................... 11 

3.1 Особенности эксплуатации средств медицинской электроники ....... 11 
3.2 Защита от прикосновения к частям,  
находящимся под напряжением ................................................................ 12 
3.3 Защита от недопустимо большого напряжения  
прикосновения............................................................................................ 13 
3.4 Особенности обеспечения электробезопасности  
различных видов электромедицинской аппаратуры ................................ 19 

 

4 Анализ исходных данных. Выбор структурной схемы................................. 23 
4.1 Классификация электротерапевтической аппаратуры ....................... 23 
4.2 Разработка структурной схемы терапевтического аппарата ............. 27 

 

5 Разработка функциональной (принципиальной) схемы аппарата ............... 33 
 

6 Разработка алгоритма и программы управления электронного  
лечебного аппарата с микропроцессорным управлением ............................... 45 
 

7 Разработка конструкции устройства.............................................................. 50 
7.1 Особенности проектирования электронной лечебной  
аппаратуры ................................................................................................. 50 
7.2 Компоновочный расчет........................................................................ 51 
7.3 Расчет надежности ............................................................................... 52 
7.4 Автоматизированный расчет надежности модулей  
электронной лечебной аппаратуры ........................................................... 58 
7.5 Конструирование и расчет печатных плат.......................................... 65 

 

8 Автоматизированное проектирование  
электронной лечебной аппаратуры................................................................... 77 

8.1 Моделирование электрических схем .................................................. 77 
8.2 Проектирование печатных узлов в P-CAD ......................................... 83 
8.3 Оформление чертежей электронной аппаратуры в AutoCAD..........119 

 

9 Оформление комплекта конструкторских документов ...............................127 
9.1 Комплектность и обозначение конструкторских документов..........127 
9.2 Правила оформления схем..................................................................130 
9.3 Правила оформления спецификаций .................................................141 
9.4 Требования к чертежам деталей .........................................................145 
9.5 Оформление сборочных чертежей .....................................................159 
9.6 Оформление текстовых документов ..................................................168 

Би
бл
ио
те
ка

 БГ
УИ
Р



 4 

Список рекомендуемой литературы ................................................................176 
 

Приложение А. Пример исходных данных, содержания пояснительной 
 записки и перечня графического материала курсовых проектов..................181 
 

Приложение Б. Пример оформления титульного листа  
курсового проекта .............................................................................................184 
 

Приложение В. Максимальные значения интенсивностей отказов  
элементов электронной аппаратуры ................................................................185 
 

Приложение Г. Данные к расчету поправочного коэффициента α1,2 ............188 
 

Приложение Д. Значения поправочных коэффициентов ...............................192 
 

Приложение Е. Средние значения случайного времени восстановления  τj  
элементов и функциональных частей электронной аппаратуры ...................193 
 

Приложение Ж. Пример расчета надежности электронного блока  
с помощью программы АСРН..........................................................................194 
 

Приложение И. Примеры некоторых классов классификатора ЕСКД ..........195 
 

Приложение К. Буквенный код наиболее распространённых  
видов элементов ................................................................................................197 
 

Приложение Л. Пример выполнения перечня элементов к схеме  
электрической принципиальной ......................................................................200 
 

Приложение М. Пример выполнения спецификации .....................................202 
 

Приложение Н. Материалы, наиболее часто применяемые  
при разработке ЭЛА .........................................................................................204 
 

Приложение П. Материалы, используемые для изделий  
с электромонтажом ...........................................................................................207 
 

Приложение Р. Пример оформления чертежа печатной платы .....................208 
 

Приложение С. Пример оформления сборочного чертежа  
печатного узла...................................................................................................210 
 

 Би
бл
ио
те
ка

 БГ
УИ
Р



 5 

1 ЗАДАЧИ И ТЕМАТИКА КУРСОВОГО ПРОЕКТИРОВАНИЯ 
 
 

Курсовой проект по дисциплине «Электронная лечебная аппаратура» 
(ЭЛА) выполняется после изучения основных дисциплин по проектированию 
средств медицинской электроники (СМЭ). В результате выполнения проекта 
студент должен расширить, систематизировать и закрепить знания основных 
принципов проектирования СМЭ, методик их оптимального расчета с исполь-
зованием систем автоматизированного проектирования (САПР), методов воз-
действия физическими факторами на организм человека с целью получения ле-
чебного эффекта, знания структуры и основ проектирования современных ап-
паратов, включая устройства с микропроцессорными блоками управления, ре-
гистрации и обработки биомедицинских сигналов. 

Основными задачами курсового проектирования являются: 
− систематизация и закрепление теоретических знаний по основным раз-

делам дисциплины;  
− развитие навыков самостоятельного применения теоретических и прак-

тических знаний для решения инженерно-технических задач при проектирова-
нии наиболее эффективных терапевтических аппаратов; 

− расширение профессионального кругозора и развитие навыков само-
стоятельной работы с научной, патентной, технической и справочной литерату-
рой, действующей нормативно-технической документацией; 

− развитие творческого отношения к выбранной специальности, умения 
оперативно использовать новейшие достижения отечественной и зарубежной 
науки при проектировании СМЭ, чувства ответственности за принятые решения; 

− широкое использование вычислительной техники, пакетов прикладных 
программ для решения проектных задач любой степени сложности. 

Темы заданий на курсовое проектирование должны соответствовать тре-
бованиям квалификационной характеристики инженеров специальности «Ме-
дицинская электроника», современному развитию науки и техники и могут 
быть различного профиля. Наиболее распространены проекты инженерного и 
научно-исследовательского типа. 

Тематика курсовых проектов инженерного профиля должна быть посвя-
щена проектированию основных блоков и узлов медицинских аппаратов и са-
мих медицинских аппаратов, разработке программного обеспечения при реали-
зации аппаратов на микроконтроллерах и включать:  

− разработку (электрический расчет, синтез) функциональных электриче-
ских схем блоков, узлов, аппаратов; 

− моделирование работы электронных схем; 
− разработку программ управления блоками устройства; 
− конструкторские расчеты отдельных блоков и всего устройства в целом 

(расчет надежности, компоновочный расчет, расчет печатной платы, техноло-
гичности конструкции); 

− разработку конструкции отдельных блоков и всего устройства. 
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В курсовых проектах данного вида решаются задачи по разработке (усо-
вершенствованию) СМЭ или функциональных частей (блоков, субблоков  
и т.п.), входящих в их состав, а также разработке устройств обеспечения произ-
водства, ремонта и обслуживания СМЭ. Разработка или модернизация конст-
рукций выполняется на уровне эскизного или технического проекта с дальней-
шим отображением принятых решений в конструкторской документации (чер-
тежах). Объектами курсовых проектов инженерного профиля могут быть: 

1 Аппарат для электропунктуры с заданной формой электрического им-
пульса. 

2 СВЧ-излучатель с задаваемой диаграммой направленности для аппарата 
СМВ-терапии. 

3 Импульсный дефибрилятор. 
4 Магнитотерапевтический аппарат для терапии переменным магнитным 

полем. 
5 Аппарат гальванизации и электрофореза. 
6 Инструмент для электрохирургического аппарата. 
7 Аппарат франклинизации. 
8 Противоболевой электронейростимулятор. 
9 Аппарат дарсонвализации. 
10 Ультразвуковое стоматологическое устройство. 
11 Акустоэлектронное терапевтическое устройство. 
12 Аппарат электростимуляции групп мышц с биологической обратной 

связью. 
Научно-исследовательские проекты должны содержать аналитический 

материал по решаемой проблеме, теоретический и экспериментальный разделы 
и должны быть связанны с данной тематикой в рамках госбюджетных и хоздо-
говорных НИР и заказов предприятий и организаций.  Темами курсовых проек-
тов научно-исследовательского профиля могут быть: 

− исследование физико-химических процессов, протекающих в организме 
при проведении физиотерапевтических процедур, и применение полученных 
результатов для разработки терапевтических аппаратов; 

− моделирование и оптимизация воздействия физическими факторами на 
биоткани человека. 

Рекомендуется выполнение курсового проекта научно-исследовательско- 
го профиля как продолжение темы НИРС или индивидуального задания по те-
матике НИР кафедры. Отдельные оригинальные технические решения и разра-
ботки, выполненные студентами в рамках курсового проекта, могут «перерас-
ти» в дипломный проект. Допускается выполнение курсовых проектов по раз-
работке и изготовлению устройств и приборов для научных исследований или 
макетов лабораторных работ. 
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2 ОБЩИЕ ТРЕБОВАНИЯ К КУРСОВОМУ ПРОЕКТУ 
 
 

Техническое задание на проектирование содержит: тему проекта, исход-
ные данные, перечень подлежащих разработке вопросов, перечень графическо-
го материала, указание сроков выдачи задания и защиты проекта, подписанное 
руководителем и студентом (приложение А). Задание выдается в течение пер-
вых двух недель семестра и утверждается заведующим кафедрой. 

Исходными данными проекта могут быть: 
− назначение и объект установки разрабатываемого изделия, его связь  

с другими частями устройства, внешней средой и человеком-оператором; 
− электрические параметры с указанием наиболее характерных данных 

для проектируемого изделия; 
− вид источника электрического питания (сеть, генератор, аккумулятор  

и т.п.), его напряжение и стабильность; 
− эксплуатационные характеристики: режим и характер работы изделия 

(непрерывный, циклический и т.д.), требования устойчивости проектируемого 
изделия к различным видам воздействий (диапазон рабочих температур, отно-
сительная влажность, частотный диапазон и уровень вибраций и т.д.); 

− основные конструктивные характеристики (форма, габариты, масса); 
− требования к основным качественным показателям проектируемого из-

делия (точности и стабильности выходных параметров, надежности, стоимости 
и др.); 

− планируемая программа выпуска проектируемого изделия в год или ука-
зание о типе производства (массовое, крупносерийное и т.д.); 

− ограничения на применяемые материалы, комплектующие элементы, 
технологические процессы и т.п., накладываемые условиями производства на 
конкретном предприятии; 

− специальные требования, специфичные для проектируемого изделия и 
не оговоренные выше. 

Курсовой проект состоит из пояснительной записки (ПЗ), содержащей  
40–50 страниц технического текста формата А4, необходимых приложений и 
графической части на 4–5 листах формата А1. Общими требованиями к поясни-
тельной записке являются: четкость и логическая последовательность изложе-
ния материала, убедительность аргументации, краткость и ясность формулиро-
вок, исключающих неоднозначность толкования, конкретность изложения ре-
зультатов, доказательств и выводов.  

Пояснительная записка к курсовому проекту комплектуется в следующем 
порядке: титульный лист (приложение Б), аннотация, задание, содержание, вве-
дение, основная часть, заключение, список используемых источников, прило-
жения. 

Основную часть ПЗ составляют разделы, в которых даются: обзор литера-
туры по теме и выбор направления проектирования или исследований, изложе-
ние общей концепции и основных методов проектирования или исследований, 
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описание экспериментальной части, применяемого оборудования и техники 
эксперимента, основные конструкторские и иные расчеты, выполненные в ра-
боте теоретические и (или) экспериментальные исследования, анализ и обоб-
щение результатов проектирования и исследований. 

При описании общей концепции и основных методов исследований дается 
теоретическое обоснование предлагаемых методов, алгоритмов решения задач, 
излагается их суть, дается обоснование выбора принятого направления иссле-
дования. Излагаются принципы действия и характеристики разработанной ап-
паратуры, оценки погрешностей измерений. 

В разделах ПЗ полно и аргументированно излагается собственная разра-
ботка или исследование студента с выявлением того нового, что он вносит  
в развитие проблемы (задачи). Автор проекта должен давать оценку достиже-
ния цели и полноты решения поставленных задач, оценку достоверности полу-
ченных результатов, их сравнение с аналогичными результатами отечествен-
ных и зарубежных работ, обоснование необходимости проведения дополни-
тельных исследований, отрицательные результаты и т.д. По каждому разделу 
пояснительной записки следует делать выводы. 

Весь порядок изложения в ПЗ должен быть подчинен цели проектирова-
ния, сформулированной автором. Логичность построения изложения основного 
содержания достигается только тогда, когда каждый раздел имеет определенное 
целевое назначение и является базой для последующих. 

Структура и содержание материала ПЗ определяются профилем проекта, 
который, напомним, может быть инженерным, научно-исследовательским и др. 

При инженерном профиле проекта ПЗ включает: 
Введение. В этом разделе необходимо отразить актуальность темы, оце-

нить современное состояние решаемой технической задачи, показать перспек-
тивные пути ее решения. 

Обзор современных методов и аппаратов лечения заболеваний. Здесь сле-
дует по литературным и патентным источникам рассмотреть современные ме-
дицинские методы, методики и аппараты, реализованные на их основе, для ле-
чения заболеваний посредством воздействия тех или иных физических факто-
ров на пациента. Отразить достоинства и недостатки уже имеющихся инженер-
ных решений, перспективы применения новых процессов и оборудования. 

В обзоре литературы следует дать краткое изложение основных этапов  
в развитии научной мысли по рассматриваемой проблеме. Сжато, критически 
осветив литературу, студент должен назвать те вопросы, которые остались не-
разрешенными, и, таким образом, определить свое место в решении проблемы. 
Желательно закончить обзор кратким резюме о необходимости проведения ис-
следований в данной области или проектирования устройства, определить пред-
мет своего исследования или проектирования. 

Выбор структурной схемы. При проектировании структурной схемы сис-
темы или устройства необходимо руководствоваться рядом стандартных тех-
нических решений, определяющих порядок организации и взаимодействия бло-
ков и узлов между собой и с внешними устройствами. Основой для разработки 
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структурной схемы системы (устройства) являются формализованное описание 
работы устройства или алгоритм работы устройства, протоколы передачи дан-
ных, алгоритм обработки сигналов и т.д. На основании этого и с учетом прин-
ципов реализации и применения различных классов устройств следует выби-
рать реализацию блоков (генераторы, регистры, источники тока и др.) и взаи-
мосвязь между ними. 

Большинство современных СМЭ построено по магистрально-модульному 
принципу организации, при котором отдельные блоки формируются в закон-
ченные модули с конкретными функциями, которые объединяются в необходи-
мые конфигурации с помощью линий связи. В основе магистрально-модульной 
организации системы лежит максимально высокий уровень стандартизации 
элементной базы внутренних блоков модулей, компонентов внутримодульных 
и межмодульных связей, направленный на достижение предельных характери-
стик, а также системы информационных шин. 

Разработка функциональной электрической схемы аппарата. Разработка 
функциональной (принципиальной) схемы СМЭ предполагает электрические 
расчёты аналоговых схем, датчиков-измерителей и исполнительных устройств, 
синтез цифровых устройств, расчет элементов БИС, системотехнический син-
тез устройств управления, синтез микропроцессорных систем управления и об-
работки биомедицинской информации. 

Разработка алгоритма и программы управления аппаратом. Данный раз-
дел выполняется, если медицинский аппарат реализуется на основе контролле-
ров или других вычислительных средств. Необходимо формализовать постав-
ленную задачу и разработать алгоритм работы проектируемого аппарата. Раз-
работать программное обеспечение аппарата с анализом заданных форматов 
данных, выбором языка программирования, разработкой программного интер-
фейса, удобного интерфейса пользователя и т.п. Описать работу разработанно-
го программного обеспечения: его установку, алгоритм работы, примеры ис-
пользования. 

Разработка конструкции устройств. В данном разделе производится вы-
бор и обоснование комплектующих элементов и материалов конструкции уст-
ройства. Рассчитываются основные компоновочные характеристики устройства 
(коэффициента заполнения по объему), показатели надежности и восстанавли-
ваемости устройства с учетом электрического режима и условий работы эле-
ментов. Разрабатываются печатная плата и электронный блок на ее основе с 
конструкторскими расчетами платы (в САПР), а также конструкция всего уст-
ройства в целом с описанием особенностей и условий соблюдения электробезо-
пасности, эргономичности и т.п. 

В заключении необходимо сделать выводы по результатам работ, оценить 
характеристики разработанного аппарата, привести сопоставление полученных 
результатов с заданием и с известными решениями. 

Список использованных источников должен содержать материалы патент-
ного поиска, научно-техническую и методическую литературу, нормативно-
технические документы. 
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В зависимости от темы курсового проекта подразделы ПЗ и их содержание 
могут уточняться руководителем проекта. 

При выполнении курсового проекта научно-исследовательского профиля 
ПЗ содержит: введение, анализ перспектив различных направлений исследова-
ния, разработку схемы и методики проведения исследований, оценку их точно-
сти, расчет точности выходных параметров изделия с учетом погрешностей па-
раметров изделий и обоснование метода достижения требуемой точности, со-
ставление аналитической модели и моделирующего алгоритма исследуемых 
процессов с применением ПЭВМ, результаты оптимизации на ПЭВМ матема-
тических моделей исследуемых процессов. 

Графическая часть курсового проекта инженерного профиля включает: 
1) электрическую структурную схему устройства; 2) электрическую принципи-
альную схему устройства; 3) сборочный чертеж устройства и электронного 
блока; 4) чертеж печатной платы (возможна деталировка). 

Графическая часть проекта научно-исследовательского профиля включа-
ет: 1) структурную схему исследований; 2) сборочный чертеж приспособления 
для проведения исследований; 3) графики полученных экспериментальных за-
висимостей; 4) схему алгоритма обработки экспериментальных данных на 
ЭВМ; 5) графики, модели, таблицы, диаграммы. 
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3 ОБЕСПЕЧЕНИЕ ТРЕБОВАНИЙ ЭЛЕКТРОБЕЗОПАСНОСТИ  
ПРИ ПРОЕКТИРОВАНИИ СРЕДСТВ МЕДИЦИНСКОЙ ЭЛЕКТРОНИКИ 

 
 

3.1 Особенности эксплуатации средств медицинской электроники 
Электронная лечебная аппаратура (ЭЛА) является разновидностью элек-

трических установок и подпадает под действие соответствующих правил и по-
ложений, в частности «Правил устройства электроустановок» и «Правил техни-
ки безопасности при эксплуатации электроустановок потребителей». Однако 
специфика условий эксплуатации ЭЛА вызывает необходимость установления 
дополнительных, специальных требований электробезопасности. Эти требова-
ния так же, как и соответствующие методы испытаний, содержатся в 
ГОСТ 30324.0-95 (МЭК 601-1-88) «Изделия медицинские электрические. Часть 1. 
Общие требования безопасности». 

Электробезопасность медицинской аппаратуры определяется следующими 
особенностями ее эксплуатации. 

1 Пациенты, которым проводят лечебные процедуры и диагностические 
исследования, могут иметь ослабленное здоровье, нарушения в деятельности 
отдельных органов и систем и, как следствие этого, повышенную чувствитель-
ность к действию электрического тока. Величины тока, практически безопасные 
для здорового человека, могут оказаться опасными для больного. 

2 Электронные медицинские приборы и аппараты имеют так называемую ра-
бочую часть, представляющую собой совокупность деталей, находящихся в то-
копроводящем соединении или соприкасающихся с телом пациента (электроды, 
излучатели, датчики). С помощью рабочей части при применении терапевтиче-
ских, хирургических электромедицинских аппаратов электрическая энергия в ка-
кой-либо форме передается тканям тела пациента; при использовании диагностиче-
ских электромедицинских приборов с помощью рабочей части воспринимаются 
биопотенциалы либо измеряются механические, химические и другие параметры 
органов и тканей, что приводит к непосредственной связи пациента с аппаратурой 
и, как следствие, к повышенной опасности поражения электрическим током. 

3 В ряде лечебных аппаратов электрическая энергия в различной форме, в част-
ности, в виде электрического тока используется для лечебного воздействия на 
организм. Неправильная эксплуатация таких аппаратов связана с возможностью 
передозировок, непредвиденными путями прохождения тока и другими опасно-
стями для пациента. 

4 Пациент во многих случаях не может реагировать на действие электрическо-
го тока так, как это сделал бы здоровый человек, т.к. может быть парализован, 
находиться под наркозом и т.п. Кроме того, кожный покров пациента обрабатывает-
ся дезинфицирующим и другими растворами и теряет свои защитные свойства. 

5 Условия проведения диагностических и лечебных процедур могут быть 
самыми различными – от кабинета лечебного учреждения  до жилых помещений  
и открытой местности (при оказании скорой помощи). Различные условия экс-
плуатации, в частности, наличие в непосредственной близости от пациента за-
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земленных предметов, накладывают дополнительные требования к электробезо-
пасности аппаратуры. 

С учетом указанной специфики далее излагаются основные требования к 
электробезопасности ЭЛА. 

 
 

3.2 Защита от прикосновения к частям,  
находящимся под напряжением 

Одно из основных требований электробезопасности – исключить возмож-
ность случайного прикосновения к находящимся под напряжением частям. 

Особенностью ЭЛА является то, что требования защиты от прикосновения 
не распространяются на рабочую часть, например находящиеся под напряжени-
ем электроды. Это ограничение, естественно, вытекает из задачи воздействия 
на пациента электрическим током при лечебных процедурах. 

Части ЭЛА, находящиеся под напряжением, не должны оголяться после 
снятия без помощи инструмента кожухов, крышек, задвижек, а также сменных 
частей. Исключение делается для предохранителей. Кожухи, крышки, которые 
закрывают части, находящиеся под напряжением менее 24 В переменного тока 
или 50 В постоянного тока, могут открываться без применения инструмента, 
если рабочие части изолированы двойной изоляцией от сетевой цепи. 

Значительную опасность может представлять электрическая энергия нахо-
дящегося в аппарате заряженного конденсатора. В связи с этим должен быть 
обеспечен  автоматический разряд конденсатора после отключения аппарата от 
сети. Постоянная времени разряда должна быть такой, чтобы за время, необхо-
димое для снятия крышки, корпуса или другой детали, дающей доступ к кон-
денсатору, напряжение на нем упало до величины, не превышающей 50 В. 

Особый случай представляет аппарат с сетевым помехоподавляющим 
фильтром, имеющим конденсатор, который блокирует симметричную состав-
ляющую радиопомех. Такой конденсатор, имеющий обычно значительную ем-
кость, подключен параллельно сетевым проводам. Сразу после вынимания вил-
ки сетевого шнура из штепсельной розетки конденсатор может оказаться заря-
женным  до амплитуды сетевого напряжения. Одновременное касание обоих 
штифтов вилки представляет в таком случае значительную опасность. Посто-
янная времени разряда этого конденсатора должна быть такой, чтобы через 1 с 
после того, как вилка вынута из розетки, напряжение на ней не превышало 
50 В. Обеспечение достаточной скорости разряда конденсаторов производится 
параллельным подключением разрядных резисторов. 

При наличии в аппарате частей, находящихся под напряжением, превы-
шающим 1000 В переменного или 1500 В постоянного тока, на этих частях или 
рядом с ними должен быть знак высокого напряжения – красная стрела молнии. 
Рекомендуется на кожухе (крышке) таких аппаратов помещать предупредитель-
ную надпись: «Перед снятием кожуха отсоединить аппарат от сети». 

При наличии в аппарате высоких напряжений в ряде случаев находят приме-
нение блокировки, автоматически отключающие аппарат от сети после снятия 

Би
бл
ио
те
ка

 БГ
УИ
Р



 13 

кожуха или крышки, закрывающих электроопасные части, даже с помощью инст-
румента. Следует отметить, что подобным блокировочным устройствам присущ 
ряд недостатков с точки зрения надежности. Кроме того, при ремонте аппарата для 
его включения без кожуха блокировку приходится закорачивать, и поскольку это на 
работе аппарата никак не сказывается, они зачастую так и остаются закороченны-
ми. Учитывая это, такие блокировочные устройства применяются крайне редко. 

Существенно, что при рассмотрении требований к защите от прикосновения 
к частям, находящимся под напряжением, речь идет о случайном касании, т.е.  
о касании без посредства какого-либо предмета. Если же в отверстие в кожухе ап-
парата вставляется какой-нибудь металлический предмет, то это уже не случай-
ное, а намеренное действие, так же, как и отвинчивание винтов, крепящих крышку 
прибора или аппарата с помощью отвертки. В этом случае, как уже указывалось, 
не предъявляются требования к защите от случайного прикосновения. 

 
 

3.3 Защита от недопустимо большого напряжения прикосновения 
Для обеспечения электробезопасности недостаточно просто закрыть нахо-

дящиеся под напряжением части аппаратуры. Необходимо рассмотреть, какова 
надежность их изоляции от доступных для прикосновения частей. Обычно час-
ти под напряжением изолируются с помощью так называемой основной изоля-
ции, которая может также обеспечивать нормальное функционирование элек-
трических цепей изделия. 

Надежность основной изоляции достаточна для обеспечения работоспо-
собности изделия, но недостаточна для обеспечения его электробезопасности. 
Необходимо учитывать возможность нарушения основной изоляции вследствие  
старения, механических поломок и т.п. 

Рассмотрим, какие же опасности могут возникнуть при нарушении основ-
ной изоляции. Если нарушится изоляция цепей, не относящихся к питающей се-
ти, то это может вызвать нарушение работоспособности аппаратуры, но, как пра-
вило, не будет опасным для обслуживающего персонала. Это объясняется тем, 
что корпус изделия может принять при пробое такой изоляции потенциал одной 
точки вторичной цепи, но при этом не изменится его потенциал относительно 
земли (при вторичной цепи, соединенной с корпусом, такой пробой приведет к 
короткому замыканию цепи). Если же происходит пробой изоляции сетевой цепи 
от корпуса, то на нем появляется напряжение относительно земли  
и, как следствие, напряжение прикосновения. 

Для дополнительной защиты от напряжения прикосновения применяют 
различные способы. В зависимости от способа защиты электромедицинские 
приборы и аппараты с внешним питанием делятся на четыре класса. 

Классы 0I и I предусматривают защитное заземление или зануление, класс II – 
защитную изоляцию, класс III – питание от цепи низкого напряжения. Класс 0, 
при котором нет каких-либо дополнительных мер защиты от напряжения при 
прикосновении, кроме основной изоляции, в изделиях медицинской техники 
недопустим. 
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Сущность защиты по классам 0I и I заключается в максимальном умень-
шении напряжения прикосновения, возникающего при нарушении основной 
изоляции сетевой цепи от корпуса – это защитное заземление в цепях с изоли-
рованной нейтралью, либо в обеспечении срабатывания при этом предохрани-
телей или автоматических выключателей, отключающих  аппарат от сети, – это 
зануление в сетях с заземленной нейтралью. 

Защитное заземление осуществляется с помощью заземляющего устройст-
ва, состоящего из заземлителей и заземляющих проводников. Соответственно 
общее сопротивление заземляющего устройства слагается из сопротивления 
растеканию заземлителя (сопротивление, оказываемое землей току, растекаю-
щемуся с заземлителя) и сопротивления заземляющих проводников. Заземлите-
ли подразделяются на естественные и искусственные. В качестве естественных 
заземлителей могут быть использованы металлические конструкции и арматура 
железобетонных конструкций зданий, проложенные в земле металлические во-
допроводные трубы и другие металлические сооружения, имеющие надежное 
соединение с землей. Не допускается использование для этой цели сетей цен-
трального отопления и канализации, трубопроводов горючих жидкостей, а так-
же горючих или взрывчатых газов, заземлителей молниеотводов. Если естест-
венные заземлители отсутствуют или если их сопротивление растеканию пре-
вышает 4 Ом, то необходимо устройство искусственных заземлителей. 

В качестве искусственных заземлителей следует применять горизонтально 
или вертикально погруженные в грунт стальные трубы, полосы, стержни. Дли-
на каждого заземлителя обычно равна 2–3 м, глубина заложения не менее 0,5 м. 
Стальные трубы, полосы должны быть предварительно очищены от краски, 
масла и, если грунт может вызвать усиленную коррозию, оцинкованы или 
омеднены. Для снижения сопротивления заземления в плохо проводящие грун-
ты (песчаные, скалистые) добавляют поваренную соль, графит и т.п. К заземли-
телю с помощью сварки внахлестку присоединяется не менее чем двумя про-
водниками магистраль заземления. Каждый заземляемый прибор или аппарат 
должен быть присоединен к магистрали заземления отдельным заземляющим 
проводником. Не допускается последовательное включение в заземляющий 
проводник нескольких изделий. Заземляющие проводники должны быть предо-
хранены от механических и химических воздействий. Открыто проложенные 
голые проводники, включая магистраль заземления, должны быть окрашены в 
черный цвет либо иметь в местах присоединений не менее двух полос черного 
цвета на расстоянии 150 мм друг от друга. 

Запрещается использовать в качестве заземляющих проводников проходя-
щие в здании водопроводные трубы, сети центрального отопления, канализа-
ции. В заземляющих проводах не должны устанавливаться выключатели, пре-
дохранители, разъемы. 

Наименьшие сечения стальных заземлителей и заземляющих проводников 
зависят от места заземления и типа сечения (круглое, прямоугольное, уголок) и 
лежат в пределах от 24 до 48 мм2. Медные заземляющие одножильные провод-
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ники без изоляции должны иметь сечение не менее 4 мм2, а медные изолиро-
ванные многожильные проводники не менее 1,5 мм2. 

Все сказанное выше о требованиях к защитному заземлению относится и к 
зануляющим проводникам и повторному заземляющему устройству. 

Все изделия с защитным заземлением (занулением), имеющие постоянное 
присоединение к питающей сети (т. е. отключаемые только с помощью инстру-
мента), относятся к классу I. Присоединение к таким изделиям провода защит-
ного заземления производится с помощью инструмента к установленному на 
корпусе резьбовому зажиму. Такое присоединение производится при монтаже 
прибора или аппарата. 

У переносных изделий присоединение сети производится с помощью 
штепсельного соединения. В зависимости от конструкции штепсельного соеди-
нения переносные приборы и аппараты с защитным заземлением (занулением) 
могут быть выполнены по классу 0I или I. 

У изделий класса 0I имеется наружный зажим защитного заземления, к ко-
торому до включения вилки в сетевую розетку может быть присоединен от-
дельный провод, другой конец которого соединяется с заземляющим или зану-
ляющим устройством. В отдельных случаях в качестве защитного провода мо-
жет использоваться третья жила несъемного сетевого шнура, присоединенная к 
внутреннему зажиму защитного заземления изделия. На конце шнура эта жила 
ответвляется от шнура и заканчивается кабельным наконечником, подключае-
мым к зажиму заземления (зануления) на щите, от которого питается аппарат. 

Вилки у изделий класса 0I имеют два штыря и могут включаться в обыч-
ную сетевую розетку без заземляющих контактов. 

Переносные изделия класса I присоединяются к сети с помощью трехжиль-
ного сетевого шнура, имеющего вилку с заземляющими контактами. Шнур треть-
ей жилой соединяется с зажимом защитного заземления внутри аппарата. Со-
ответственно сетевая розетка имеет заземляющие контакты, соединенные с 
заземляющим (зануляющим) устройством. 

Приборы и аппараты класса I имеют автоматическую защиту, независимо 
от внимательности и добросовестности обслуживающего персонала, и в этом 
их преимущество перед аппаратами класса 0I. В ряде стран применение в ме-
дицине изделий класса 0I не допускается. 

Основное преимущество классов защиты 0I и I – это простота и дешевизна 
их выполнения. Дополнительно к основной изоляции аппарата требуется пре-
дусмотреть только возможность присоединения защитного провода. 

Однако защита по классу I и особенно 0I имеет ряд недостатков. При при-
менении аппаратуры класса 0I обслуживающий персонал должен обеспечить 
во всех случаях защитное заземление. В условиях специализированного каби-
нета медицинского учреждения, имеющего заземляющее или зануляющее уст-
ройство, это обычно не представляет затруднений, но при проведении лечеб-
ных процедур или исследования в больничной палате или на дому у больного – 
зачастую невыполнимо. Отдельный провод мешает, всегда может быть задет и 
порван. 
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При применении приборов и аппаратов класса I велика опасность перепу-
тывания мест присоединения фазного и заземляющего (зануляющего) проводов 
при установке и особенно ремонте сетевых розеток. Опасен также обрыв за-
щитной жилы сетевого шнура, что усугубляется тем, что эта неисправность без 
специальной проверки не может быть обнаружена. 

При нарушении защитного заземления или зануления даже при исправной 
изоляции возникает опасность поражения током утечки, протекающим в конту-
ре «сетевая цепь–корпус–человек–земля». Величина тока утечки на корпус оп-
ределяется сопротивлением изоляции и распределений емкостью между сете-
вой цепью и корпусом, а также емкостью помехоподавляющих конденсаторов 
сетевого фильтра. Обеспечение допустимой величины тока утечки связано,  
в основном, с уменьшением емкостей сетевых фильтров. При напряжении 
220 В емкость помехоподавляющих конденсаторов, установленных между каж-
дой фазой и корпусом, не должна превышать 5000 пФ. Такое ограничение ем-
кости фильтра связано в ряде случаев со значительными трудностями защиты 
от излучения радиопомех, распространяющихся по сети. 

Помимо перечисленных недостатков весьма существенно, что при небла-
гоприятных обстоятельствах применение аппаратуры класса 0I или I может 
создать новые опасности. При эксплуатации аппаратуры на дому у пациента 
может оказаться поблизости поврежденный бытовой электроприбор, например, 
настольная лампа, сетевые провода которой замкнулись на доступные металли-
ческие части. Такое повреждение может не обнаруживаться из-за хорошо изо-
лированного от земли пола. При установке же заземленного прибора или аппа-
рата резко возрастает опасность поражения медицинского персонала из-за воз-
можности одновременного касания поврежденной лампы и заземленного кор-
пуса (еще более велика опасность касания лампы для больного, на которого на-
ложен заземленный электрод электрокардиографа). 

Несмотря на указанные выше и некоторые другие недостатки, защита 
классов 0I и I в связи с ее дешевизной и простотой широко применяется при 
производстве медицинской аппаратуры. 

Одним из важных путей по повышению электробезопасности медицинской 
аппаратуры является комплекс мероприятий по созданию аппаратов класса II. 

Сущность защиты по классу II заключается в повышении надежности изо-
ляции частей, доступных для прикосновения, от частей, находящихся под на-
пряжением (в первую очередь сетевой цепи), т.е. в применении защитной изо-
ляции (рисунок 3.1). 

Защитная изоляция обеспечивает электробезопасность дополнительно 
к основной изоляции при ее нарушении. Конструктивно защитная изоляция, 
как правило, выполняется таким образом, чтобы имелась возможность ее от-
дельного от основной изоляции испытания. В совокупности образуется так на-
зываемая двойная изоляция. Иногда невозможно раздельное выполнение ос-
новной и защитной изоляции, например, для колодок, выключателей и т.п.  
В этом случае допускается применение усиленной изоляции, эквивалентной по 
своим электрическим и механическим свойствам двойной изоляции. 
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1 – сетевая вилка; 2 – шнур питания; 3 – основная изоляция; 4 – дополнительная  

изоляция; 5 – корпус; 6 – зажим рабочего заземления; 7 – сетевая часть; 8 – рабочая часть;  
9 – усиленная изоляция; 10 – электродвигатель с доступным ротором 
Рисунок 3.1 – Пример изделия класса II с металлическим корпусом 

 
Двойная изоляция может быть выполнена различными способами. Первый, 

наиболее надежный, это применение изолирующей оболочки, которая делает 
невозможным прикосновение не только к частям, находящимся под напряже-
нием, но и к металлическим нетоковедущим частям прибора или аппарата, 
имеющим только основную изоляцию. Пример: аппарат с корпусом из изоля-
ционного материала. Шасси хотя и находятся под напряжением, но недоступны 
для прикосновения. 

Второй способ – это применение промежуточной изоляции, представляю-
щей собой изолирующие вставки, прокладки и т.п., которые отделяют доступ-
ные для прикосновения металлические части от металлических нетоковедущих 
частей, имеющих только основную изоляцию. Пример: аппарат имеет металли-
ческий незаземленный корпус; шасси и другие металлические части, имеющие 
с ним токопроводящие соединения, изолированы от сетевой цепи основной изо-
ляцией, а от корпуса аппарата – промежуточной изоляцией. 

Выполнение аппаратуры по классу II обеспечивает наибольшие надеж-
ность и удобство в эксплуатации, особенно для переносных изделий. В этом 
случае о заземлении заботиться не надо, включать прибор или аппарат можно 
в любую сетевую розетку, для чего он снабжается сетевым шнуром с вилкой, 
входящей как в обычную розетку, так и в розетку с защитными контактами. 

Ограниченное применение изделий класса II объясняется рядом трудно-
стей конструктивного характера. Применение пластмассового корпуса ограни-
чено аппаратами небольших габаритов, а защитная изоляция сетевой цепи при-
водит к увеличению веса и габаритов трансформатора, усложнению технологии 
его производства. 
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Защита от излучения радиопомех аппаратов класса II усложнена. Это от-
носится как к изделиям с пластмассовым корпусом, так и с металлическим из-за 
недопустимости подключения помехоподавляющих конденсаторов между сете-
выми проводами и металлическим корпусом. Пластмассовые корпуса должны 
иметь металлизированное покрытие с внутренней стороны.  

Весьма существенно отсутствие типовых деталей, имеющих двойную или 
усиленную изоляцию, в связи с чем силовой трансформатор, узел переключе-
ния напряжения сети и ряд других узлов и деталей приходится разрабатывать и 
изготавливать как оригинальные. 

Несмотря на перечисленные недостатки и трудности изготовления аппара-
туры класса II, защита от напряжения прикосновения с помощью защитной 
изоляции в большинстве случаев является более прогрессивным методом. В 
первую очередь это относится к переносным и портативным изделиям с рабо-
чей частью, находящейся в токопроводящем соединении с телом больного 
(приборы для измерения биопотенциалов, низкочастотная физиотерапевтиче-
ская аппаратура и др.), которые должны быть рассчитаны на самые разнообраз-
ные условия эксплуатации. 

Сущность защиты по классу III заключается в питании аппаратуры от цепи 
низкого напряжения не более 24 В переменного или 50 В постоянного тока. 
Даже при пробое сетевой цепи на корпус аппарата класса III напряжение при-
косновения не превысит практически безопасной величины. Надо подчеркнуть, 
что смысл понятия «цепь низкого напряжения» не ограничивается величиной 
напряжения. Если с помощью автотрансформатора, подключенного к сети, по-
лучить 24 В, то это не будет цепью низкого напряжения с точки зрения техники 
безопасности. Обязательное требование к цепи низкого напряжения – отделе-
ние ее от обычной сети и всех других цепей, имеющих более высокое напряже-
ние. Поэтому изделия, выполненные по классу III, питаются от так называемого 
защитного понижающего трансформатора, к конструкции которого представ-
ляются весьма высокие требования. Поскольку нарушение изоляции между об-
мотками этого трансформатора ведет к попаданию сетевого напряжения на не-
защищенный прибор или аппарат, то прочность этой изоляции испытывается 
напряжением 4 кВ. Конструкция трансформатора должна предусматривать про-
странственное разделение обмоток, т.е. либо размещение их на двух каркасах, 
либо на общем каркасе с перегородкой. Перегородка должна быть не вставлен-
ная, а монолитная. Возможно также применение общего каркаса без перегород-
ки, но при этом должны быть приняты меры, исключающие возможность запа-
дания витков вторичной обмотки к виткам сетевой обмотки (межслойная изо-
ляция с загибами по краям), и трансформатор должен быть подвергнут вакуум-
ной пропитке, желательно эпоксидными компаундами. Защитный трансформа-
тор должен иметь защиту от короткого замыкания. Защита может быть обеспе-
чена либо с помощью предохранителя, либо за счет большого внутреннего со-
противления трансформатора. 

Защита по классу III применяется в медицинском приборостроении крайне 
редко. Малое распространение изделий класса III объясняется рядом недостат-
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ков этого метода защиты: необходим отдельный защитный трансформатор, что 
неудобно при переносной аппаратуре; из-за низкого напряжения приходится 
иметь дело с большими токами. 

Более подробно общие требования электробезопасности медицинской тех-
ники с рисунками и схемами аппаратов приведены в ГОСТ 30324.0-95. 

 
 

3.4 Особенности обеспечения электробезопасности  
различных видов электромедицинской аппаратуры 

Различия в требованиях к электробезопасности отдельных видов изделий 
медицинской техники и к методам ее обеспечения связаны, в основном, с раз-
личной степенью связи изделий с пациентом и, как следствие этого, с различ-
ной опасностью для него. 

ГОСТ 30324.0-95 предусматривает деление всех изделий на 4 типа. Изде-
лия типа Н имеют нормальную степень защиты, типа В – повышенную степень 
защиты, типа BF – повышенную степень защиты и изолированную рабочую 
часть, типа CF – наивысшую степень защиты и изолированную рабочую часть. 
К типу Н относятся изделия без рабочей части (лабораторные приборы, стери-
лизаторы и т.п.).  

К типу В относятся приборы и аппараты с рабочей частью, которая может 
иметь электрический контакт с телом пациента, за исключением непосредст-
венного контакта с сердцем (электрокардиографы, ультразвуковые приборы  
и аппараты и др.). K типу BF относятся  приборы и аппараты, отличающиеся от 
типа В наличием изолированной от корпуса рабочей части (низкочастотная 
электролечебная аппаратура, стимуляторы и др.). Наконец, к типу CF относятся 
приборы и аппараты, рабочая часть которых имеет непосредственный контакт 
с сердцем (внешние электрокардиостимуляторы, измерители давления в полос-
ти сердца и др.). 

При обеспечении электробезопасности изделий типа Н, как правило, не 
возникает каких-либо дополнительных трудностей, помимо обеспечения ос-
новной изоляции сетевой цепи от корпуса и дополнительной защиты в соответ-
ствии с классом защиты изделия. 

При наличии рабочей части возникает задача отделения рабочей части от 
сетевой цепи и от других частей, не относящихся к ней и находящихся под на-
пряжением. 

Поскольку, несмотря на указания в правилах проведения процедур, паци-
ент может коснуться как корпуса аппарата, так и другого заземленного предме-
та, – наибольшую опасность представляет его поражение низкочастотным на-
пряжением питающей сети. В связи с этим необходимо надежное разделение 
сетевой цепи от цепей с рабочей частью (пациентом). Это разделение должно 
обеспечиваться и при таких аварийных ситуациях, как пробой транзисторов, 
обрыв проводов и т.п. Способом, гарантирующим надежное разделение этих 
цепей, является использование сетевого трансформатора с электрически, а же-
лательно и пространственно разделенными обмотками. Если рабочая часть 
имеет токопроводящее соединение с телом пациента и изолирована от корпуса, 
как это имеет место в низкочастотных физиотерапевтических аппаратах (изде-
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лия типа BF), то между сетевой цепью и рабочей частью должна иметься двой-
ная или усиленная изоляция. Грубейшая, абсолютно недопустимая ошибка – 
связь источника выходного напряжения с питающей сетью через автотранс-
форматор или потенциометр. 

Особое значение имеет оптоэлектронная развязка рабочего инструмента 
и силовой части электронной аппаратуры в медицине (рисунок 3.2). Так как 
инструменты обычно прикрепляются к телу человека, то необходима защита 
их от высокого напряжения, имеющегося в ЭЛА. 

 
Рисунок 3.2 – Схема связи рабочего инструмента с силовой частью аппарата 

 
Изоляция выходной цепи от корпуса – важное требование электробезопас-

ности, которое предъявляется к физиотерапевтической аппаратуре, воздейст-
вующей на пациента низкочастотным током. При отсутствии такой изоляции 
касание пациентом корпуса аппарата непосредственно либо через лицо, прово-
дящее процедуру, приведет к появлению непредвиденных опасных для пациен-
та путей тока. 

Поскольку в указанных выше аппаратах пациент включается, как правило, 
в виде нагрузки в коллекторную или эмиттерную цепь выходного транзистора, 
то необходимо  полностью исключить возможность соединения с корпусом 
аппарата цепей источника питания этого транзистора, так как такое соедине-
ние приведет к появлению напряжения между электродами и корпусом (а так-
же и землей, при применении аппарата класса 0I или I). 

Наилучшим решением в этом случае является корпус из изоляционного 
материала. Если корпус металлический, то должна быть очень тщательно вы-
полнена изоляция от него всех деталей схемы, и в первую очередь, деталей 
управления. 

В терапевтических аппаратах для воздействия высокочастотными электри-
ческими, магнитными полями (УВЧ-терапия, индуктотермия), рабочие части 
которых (электроды, индукторы) не заземлены, должна быть исключена воз-
можность попадания в выходной контур напряжения источника питания гене-
раторной лампы, один полюс которого соединен с корпусом аппарата. Такое 
соединение представляет большую опасность, так как металлические детали 
рабочей части оказываются при этом под высоким напряжением относительно 
корпуса, а изоляция их на такое напряжение, как правило, не рассчитана. Не-
смотря на то, что выходной контур не имеет гальванической связи с контуром 
генератора, принципиальная возможность замыкания между собой этих цепей 
при каких-либо поломках и смещениях деталей имеется. Наилучшим решением 
является соединение выходной цепи через высокочастотный дроссель с корпу-
сом аппарата. Если это невозможно, то необходимо разделение выходной цепи 

  VU 

к инструменту 
Сеть 
~220 В 
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от контура генератора промежуточными цепями, соединенными с корпусом, 
например экранированным витком связи. 

В приборах для наблюдения и регистрации биопотенциалов сердца, мышц 
одна из важных задач – надежное ограничение тока, протекающего в цепи между 
электродами, наложенными на пациента. Это ограничение должно быть эффек-
тивным не только в нормальных условиях, но и при возможных нарушениях в 
приборе. Наиболее вероятно протекание непредвиденных токов в цепях между 
каждым из незаземленных и заземленным электродами. Ток в цепи электродов 
ограничивается транзистором входного каскада, резисторами в цепи выпрямите-
ля, питающего этот каскад, а также резисторами во входной цепи. Поскольку 
транзисторы могут оказаться пробитыми, а резисторы в цепи выпрямителя не 
могут иметь достаточно большого сопротивления, то защита обеспечивается 
практически только резисторами во входной цепи. Эти резисторы должны огра-
ничивать ток через электроды при аварийной ситуации до величины, не превы-
шающей 100 мкА. Резисторы должны монтироваться как можно ближе к входу 
прибора, чтобы исключить возможность непосредственного соединения проводов 
пациента с находящимися под напряжением частями. 

Особенно высокие требования предъявляются к отделению от находящих-
ся под напряжением частей и от корпуса рабочей части приборов и аппаратов 
типа СF. Как уже указывалось, эти приборы и аппараты предназначены для не-
посредственного контактирования с сердцем. Поскольку при таком контакти-
ровании пороговый ток, вызывающий фибриляцию, составляет 50–100 мкА, ток 
утечки через рабочую часть изделия типа CF не должен превышать 10 мкА. 
Следует учитывать возможность одновременного применения нескольких при-
боров и аппаратов. Если, например, при внешней электростимуляции сердца 
производится снятие электрокардиограммы, то ток утечки электрокардиографа 
может пройти через введенный в сердце электрод электрокардиостимулятора. 
Чтобы этого не произошло, должна быть обеспечена надежная изоляция рабочей 
части стимулятора от земли. Для этого недостаточно изолировать рабочую часть 
от корпуса. Необходимо также защитить изоляцией наружные детали рабочей 
части, чтобы при случайном прикосновении к ним лица, проводящего процеду-
ру, не возникло токопроводящего пути на землю. 

При рассмотрении выходных схем различного рода низкочастотных сти-
муляторов следует иметь в виду возможность одновременного применения 
двух и более аппаратов. Наиболее часто вторым аппаратом является электро-
кардиограф, у которого один электрод заземлен для уменьшения наводок. За-
земляющее устройство для совместно работающих аппаратов должно быть од-
но и то же, и питаться эти аппараты должны от одной фазы сети. Особое вни-
мание следует уделить изоляции выходной цепи низкочастотных терапевтиче-
ских аппаратов от сетевой цепи, корпуса аппарата и земли. 

Кроме опасностей, связанных с нарушениями в аппаратуре, существуют 
опасности, связанные с неправильной ее эксплуатацией. Всю ответственность за 
выполнение правил эксплуатации при проведении лечебной процедуры или диаг-
ностического исследования несет обслуживающий медперсонал. Однако при про-
ектировании аппаратуры должны быть приняты все меры, чтобы рациональной 
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схемой и конструкцией, применением средств автоматики свести эти опасности к 
минимуму. 

Одним из важных факторов, определяющих безопасность пациента при 
возможных нарушениях со стороны медперсонала, является соотношение меж-
ду максимальной мощностью (током, напряжением) терапевтического аппарата 
и ее величиной, используемой при проведении процедуры. Это соотношение 
должно быть минимальным. Так, например, неправильно проводить процедуру 
гальванизации слизистой рта при токе не более нескольких миллиампер с по-
мощью аппарата, рассчитанного на максимальный ток 50 мА. При случайных 
поворотах ручки регулятора тока или обрыве выходного потенциометра ток па-
циента может значительно превысить заданную величину. В связи с этим соз-
даются специализированные аппараты, предназначенные для более узкого кру-
га лечебных процедур, а также вводится переключение на режимы работы, от-
личающиеся максимальной выходной мощностью. Обязательной является бло-
кировка, исключающая возможность переключения режима работы при вве-
денном регуляторе интенсивности. 

Для исключения передозировок по времени в физиотерапевтических аппа-
ратах применяются процедурные часы со звуковым или световым сигналом, 
встроенные таймеры.  

В аппаратах с широкими пределами регулирования выходной мощности 
(тока, напряжения) должны быть приняты меры, чтобы независимо от желания 
обслуживающего персонала при начале процедуры выходная мощность была 
минимальной. Наиболее просто эта задача решается совмещением ручек вы-
ключателя сети и регулятора интенсивности, так чтобы при включении и вы-
ключении аппарата интенсивность была минимальной.  

В аппаратах для электрохирургии весьма важно правильное наложение 
пассивного электрода на пациента и надежное соединение его с аппаратом. Для 
контроля за соединением электрода в аппаратах с выходной мощностью более 
50 Вт для этой цели используется двухжильный провод, по которому протекает 
ток низкого напряжения, управляющий исполнительным реле. При обрыве од-
ного из проводов или нарушении контакта проводов с аппаратом реле срабаты-
вает и выключает генератор высокой частоты. 

Важную роль в обеспечении правильности проведения процедуры играют 
элементы сигнализации, указывающие на включение той или иной цепи аппа-
рата. Световая сигнализация о включении аппарата в сеть является обязатель-
ной. Исключение делается для аппаратов, включение которых в сеть легко об-
наруживается по шуму вентилятора или другого узла. 

Как следует из вышеприведенных примеров, использование средств авто-
матики позволяет значительно снизить опасность для пациента, которая может 
быть вызвана как нарушениями в аппарате, так и небрежными или неправиль-
ными действиями обслуживающего медперсонала. 
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4 АНАЛИЗ ИСХОДНЫХ ДАННЫХ. ВЫБОР СТРУКТУРНОЙ СХЕМЫ 
 
 

4.1 Классификация электротерапевтической аппаратуры 
Чтобы оценить место ЭЛА в общей системе технических средств, исполь-

зуемых при диагностике, терапии и обслуживании пациента, необходимо рас-
смотреть классификацию таких средств, объединенных под общим названием 
«Медицинская техника» (рисунок 4.1). 

Медицинское оборудование

Медицинская техника

Медицинская аппаратура Медицинские инструменты

Электро-медицинская
аппаратура

Механическая
медицинская аппаратура

По виду используемой энергии

Терапевтичес-
кие аппараты

Диагностичес-
кие приборы

Воспринима-
ющие электри-
ческую энергию

Воздействующие аппараты и приборы Воспринимающие приборы

По направлению потока энергии

По назначению По виду воспринимаемой энергии

Воспринима-
ющие механи-
ческую энергию

Воспринима-
ющие хими-
ческую энергию

Воспринима-
ющие тепловую

энергию
По виду воздействующей энергии

Воздействую-
щие электри-
ческой энергией

Воздействующие
механической
энергией

По агрегатному состоянию рабочего тела

Электромедицинские
механические

приборы и аппараты

Электромедицинские
гидравлические

приборы и аппараты

Электромедицинские
газовые приборы и

аппараты

Низкочастотные
приборы и
аппараты

Высокочастотные
приборы и
аппараты

Светооптические
приборы и
аппараты

Рентгеновские
приборы и
аппараты

Радиологические
приборы и
аппараты

По положению в спектре электромагнитных колебаний

 
Рисунок 4.1 – Общая классификация медицинской техники 

 

С точки зрения задачи, решаемой в медицинском технологическом процес-
се, всю медицинскую технику можно разбить на три большие группы: аппара-
туру, инструменты и оборудование. 

Аппаратура в той или иной степени обеспечивает самостоятельный, авто-
матизированный процесс взаимодействия с пациентом; инструмент действует 
на пациента в сочетании с рукой человека, являясь как бы ее продолжением; 
оборудование – вспомогательные устройства для обслуживания пациента 
и обеспечения медицинского технологического процесса. 

Медицинская аппаратура – наиболее сложная, интенсивно развивающаяся 
область медицинской техники. Большую часть медицинской аппаратуры со-
ставляют электромедицинские приборы и аппараты, представляющие собой 
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электротехнические или электронные устройства, которые основаны на исполь-
зовании электрической энергии. 

Имеется также аппаратура, использующая механическую энергию: твердо-
го тела (обычно ее называют просто механической) – это аппараты для вытяже-
ния костей, для механотерапии и др.; жидкости (гидравлическая) – это водоле-
чебные установки; газа (газовая) – наркозные аппараты, аппараты для искусст-
венной вентиляции легких и др. 

В процессе функционирования аппаратура оказывается определенным об-
разом связанной с пациентом. При этом в системе аппаратура – пациент уста-
навливается движение энергии от аппаратуры к пациенту или наоборот. В зави-
симости от направления потока энергии всю электромедицинскую аппаратуру 
можно разделить на две группы: аппаратуру воздействующую и аппаратуру 
воспринимающую. 

В то же время электромедицинская аппаратура по функциональному при-
знаку, т.е. в зависимости от целей, для которых она используется, может быть 
разделена на терапевтическую и диагностическую. Изделия терапевтической 
аппаратуры принято называть аппаратами, изделия диагностической аппарату-
ры – приборами. 

Терапевтические аппараты воздействуют на пациента с целью вызвать же-
лаемые сдвиги в его организме – перестройку патологического процесса в сто-
рону нормализации. Хирургические аппараты, являющиеся частью терапевти-
ческих, предназначены для осуществления радикальных изменений в структуре 
органов и биотканях. Таким образом, терапевтические аппараты являются воз-
действующими. 

Диагностические приборы предназначены для исследования характеристик 
живого организма с тем, чтобы установить возможные отклонения от нормы и 
вызвавшие их причины. Диагностические приборы могут быть как воздейст-
вующими, так и воспринимающими. 

Воздействующие диагностические приборы дают необходимую информа-
цию по реакции пациента на определенное воздействие (например диагностиче-
ские электростимуляторы) либо по внесенному телом пациента возмущению в 
поток энергии (рентгеновское просвечивание, ультразвуковая эхография и т.п.). 
При диагностике воздействующими приборами стремятся, как правило, снизить 
до минимально возможного уровня энергию воздействия, чтобы исключить по-
бочные вредные для организма эффекты. Предел такому снижению кладет чув-
ствительность организма к воздействию либо чувствительность метода регист-
рации внесенных возмущений. 

Воспринимающие диагностические приборы дают информацию о различ-
ных процессах в организме, генерируемых тканями и органами биопотенциа-
лах, звуковых тонах сердца, температуре тела и др. Воспринимающие диагно-
стические приборы аналогично любым другим измерительным приборам 
должны оказывать минимальное влияние на исследуемый процесс и передавать 
информацию с наименьшими искажениями. 
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Воздействующие терапевтические аппараты и диагностические приборы в 
зависимости от вида энергии, направленной на пациента, делятся на воздейст-
вующие электрической энергией и воздействующие механической энергией (по 
сложившейся терминологии многие диагностические воздействующие приборы 
принято называть аппаратами, например, рентгеновские, для электродиагно-
стики и др.). 

Аппаратуру, использующую для воздействия механическую энергию, мож-
но разделить по агрегатному состоянию рабочего тела, т. е. тела, непосредствен-
но соприкасающегося с пациентом. Рабочее тело может быть твердым, жидким 
или газообразным. Соответственно можно выделить электромедицинские меха-
нические, гидравлические и газовые аппараты и приборы. К первым относятся 
ультразвуковые терапевтические аппараты и диагностические приборы, аудио-
метры, вибромассажные аппараты и др., ко вторым – аэрозольные аппараты с 
центробежными и ультразвуковыми распылителями, к третьим – аппараты для 
искусственной вентиляции легких с электроприводом. 

Аппаратура, воздействующая электрической энергией соответственно ис-
пользуемой части спектра электромагнитных колебаний, включает в себя аппа-
раты и приборы низкочастотные, высокочастотные, светооптические, рентге-
новские и радиологические. 

При проектировании терапевтических аппаратов фактором, определяю-
щим конструктивное и схемотехническое исполнение, является вид физическо-
го воздействия. В зависимости от видов используемой энергии лечебные физи-
ческие факторы и соответствующие им методы можно разделить на следующие 
группы. 

Первая группа – постоянный электрический ток низкого напряжения 
(гальванизация, лекарственный электрофорез). 

Вторая группа – импульсные токи низкого напряжения (электросон, диа-
динамотерапия, амплипульстерапия, интерференцтерапия, флюктуоризация, 
электродиагностика, электростимуляция). 

Третья группа – электрические токи высокого напряжения (диатермия, 
ультратонотерапия, местная дарсонвализация) . 

Четвертая группа – электрические, магнитные и электромагнитные поля 
различных характеристик (франклинизация, магнитотерапия, индуктотермия, 
ультравысокочастотная терапия, микроволновая терапия). 

Пятая группа – электромагнитные колебания оптического (светового) 
диапазона (терапия инфракрасным, видимым и ультрафиолетовым излучением, 
лазерная терапия). 

Шестая группа – механические колебания среды (массаж, ультразвуковая 
терапия, лекарственный фонофорез, вибротерапия). 

Седьмая группа – измененная или особая воздушная среда (ингаляционная 
или аэрозольтерапия, электроаэрозольтерапия, баротерапия, аэроионотерапия 
и др.). 

Восьмая группа – пресная вода, природные минеральные воды и их искус-
ственные аналоги.  
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Девятая группа – тепло (теплолечение) и холод (криотерапия, гипотер-
мия). 

Особую группу составляют сочетанные методы, позволяющие использо-
вать два физических фактора и более. С каждым годом они получают все боль-
шее распространение в медицине. 

Наиболее широкое распространение получили терапевтические низкочас-
тотные и высокочастотные аппараты. Низкочастотные терапевтические аппараты 
(рисунок 4.2) делятся на две группы в зависимости от формы воздействующей 
электрической энергии (ток, поле). Среди аппаратов, воздействующих током, 
можно выделить три группы в зависимости от вида тока (постоянный, перемен-
ный или импульсный). Дальнейшее деление этих аппаратов производится по 
функциональному признаку и включает в себя названия медицинских методик. 
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Рисунок 4.2 – Классификация низкочастотной электротерапевтической аппаратуры 
 

Аппараты, воздействующие низкочастотным полем, делятся в зависимости 
от рода поля, т.е. используемой составляющей поля индукции (электрическое, 
магнитное). Следующая ступень классификации определяется видом поля (по-
стоянное, переменное, импульсное). Дальнейшее деление – по медицинским 
методикам. 

Высокочастотные терапевтические аппараты (рисунок 4.3) составляют две 
группы в соответствии с формой используемой энергии (ток, поле). Аппараты, 
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воздействующие полем, делятся на три группы в зависимости от используемой 
составляющей электромагнитного поля (электрическое, магнитное, электро-
магнитное). Дальнейшее деление аппаратов, воздействующих как током, так и 
полем, – в зависимости от режима колебаний (непрерывный, импульсный). За-
канчивается классификация высокочастотных терапевтических аппаратов кон-
кретными медицинскими методиками.  
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Рисунок 4.3 – Классификация высокочастотной электротерапевтической аппаратуры 

 
 

4.2 Разработка структурной схемы терапевтического аппарата 
Выбор структурной схемы основывается на анализе исходных данных,  

разработке технического задания на проектирование изделия, результатах лите-
ратурного и патентного обзора по теме проекта. В качестве структурной схемы 
допускается использование схем лучших образцов зарубежных или отечествен-
ных аппаратов, позволяющих достичь требуемых технических характеристик, 
либо применение оригинальных компоновок блоков, разработанных автором 
самостоятельно. 

Структурная схема терапевтического аппарата должна содержать наиболее 
крупные функциональные блоки и узлы. Необходимо привести функциональное 
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назначение каждого блока и описать их взаимодействие во времени. При опи-
сании целесообразно пользоваться временными диаграммами работы блоков  
и устройств, описанием сигналов на входах/выходах блоков и т.д. Особенностью 
данных схем является детализация блоков, взаимодействующих с пациентом. 
Возможны различные подходы при проектировании аппарата. Аппарат может 
быть реализован на основе дискретных элементов, полузаказных и заказных 
микросхем, на основе микроконтроллеров и различных компьютерных техноло-
гий. Независимо от того, какая часть аппарата реализуется программно, а какая 
аппаратно, необходимо привести структурную схему, позволяющую понять, ка-
кие функции реализуются в устройстве. 

Например, на рисунке 4.4 приведена структурная схема аппарата акусто-
электронной терапии и временные диаграммы, поясняющие принцип работы 
и синтеза сигнала. 

 
а – структурная схема аппарата;  
б – временные диаграммы работы 

Рисунок 4.4 – Аппарат акустоэлектронной терапии 
 

Развитие технологии электронной техники позволяет использовать микро-
процессоры и микроконтроллеры для построения терапевтической аппаратуры 
(рисунок 4.5). Обычно имеется возможность управлять следующими парамет-
рами выходных сигналов: длительностью и скважностью, амплитудой и выход-
ной мощностью и т.д. При помощи микропроцессорных средств управления 
можно задавать форму и тип импульсов (однополярный/биполярный), а также 
задавать длительность положительных и отрицательных импульсов. Для зада-
ния длительности сигналов в микропроцессорных системах используется блок 
таймеров, в то время как ЦАП (встроенный или внешний) задает огибающую. 
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Далее сигнал поступает на выходной каскад для усиления. Выходной каскад 
также обеспечивает гальваническую развязку для защиты пациента в случае 
выхода прибора из строя. 

 
Рисунок 4.5 – Типовая схема терапевтического прибора 

  

При построении терапевтической техники возможны два подхода: одно-
процессорная и многопроцессорная реализация блока управления. Для кор-
ректного выбора необходимо учесть следующие аспекты: 

1 Необходимость в независимых каналах терапевтического воздействия. 
2 Диапазон изменения параметров (как правило, частота) сигнала для каж-

дого канала. 
3 Потребность в дополнительных средствах контроля и индикации. 
4 Возможности для дальнейшей модернизации и изменений прибора. 
Если нет необходимости в независимых каналах терапевтического воз-

действия, то можно сэкономить средства на разработку и производство изде-
лия, а также существенно уменьшить его размеры. С помощью обычного 
мультиплексора одноканальный аппарат можно превратить в многоканальный 
(рисунок 4.6). Проблемы начинаются при обеспечении независимого воздей-
ствия по нескольким терапевтическим каналам, а также при обеспечении био-
технической обратной связи. Все независимые каналы должны работать одно-
временно и независимо друг от друга. В следующий период времени необхо-
димо регистрировать ответную реакцию организма на терапевтическое воз-
действие. Перекрестные помехи активных каналов могут сделать регистрацию 
ответной реакции невозможной. 

Для обеспечения независимой установки частоты для каждого канала не-
обходимо обеспечить независимые блоки генерации сигналов. Это возможно 
при использовании мультипроцессорных систем либо однопроцессорных сис-
тем с установкой таймеров для каждого из каналов. Если принять ограничение, 
что линейка допустимых частот в каналах создается путем умножения базовой 
частоты, разработка однопроцессорной системы упростится. 

Необходимо разработать интерфейс пользователя, т.е. обеспечить возмож-
ность ввода параметров процедуры и получения информации о работе устрой-
ства. При этом используется широкий спектр приборов, начиная от кнопок и 
заканчивая сенсорными экранами, от светодиодов до ЖК-мониторов. Кроме то-
го, необходимо обеспечить связь с персональным компьютером (протоколы 
RS232, USB, TCP/IP). Это позволяет быстро задавать параметры терапевтиче-

Би
бл
ио
те
ка

 БГ
УИ
Р



 30 

ских процедур, делает возможным применение терапевтического аппарата  
в комплексе с другими устройствами, позволяет легко анализировать диагно-
стические данные. 

 
Рисунок 4.6 – Многоканальное устройство с мультиплексором 

 

На практике возможны две концепции построения медицинской аппарату-
ры: однопроцессорное и мультипроцессорное решение. При сравнении этих ва-
риантов необходимо учитывать: наличие независимых каналов терапевтическо-
го воздействия, интерфейс пользователя, связь устройства с персональным 
компьютером (ПК), внутреннюю память устройства. 

При разработке однопроцессорной системы (рисунок 4.7) необходимо кор-
ректно выбрать процессор. Высокопроизводительные процессоры являются до-
рогостоящими. Системы со слабыми процессорами сложно модифицировать. 
Кроме того, есть риск, что эти процессоры снимут с производства. Выбранный 
интерфейс связи с персональным компьютером должен быть аппаратно реализо-
ван в процессоре. Это экономит процессорное время для решения более важных 
задач. Определив требования к системе, необходимо продумать структуру про-
граммного обеспечения. Разработчик сталкивается с проблемой задержек в рабо-
те процессора (при отсчете временных интервалов и обработке прерываний, при 
одновременной работе двух таймеров для одного независимого канала – один 
для отсчета длительности импульса и второй для отсчета полуволны). Кроме то-
го, при реализации связи с ПК необходимо исключить возможность переполне-
ния буфера. Дополнительные проблемы возникают при необходимости расшире-
ния возможностей системы (например вместо трех необходимо четыре канала). 

 
Рисунок 4.7 – Однопроцессорная терапевтическая система 
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При увеличении количества задач возникает необходимость в многозадач-
ной операционной системе. Программа может быть разбита на более понятные 
независимые задачи и легко расширена дополнительными заданиями. Однако 
при этом требования к производительности процессора возрастают на два по-
рядка. Кроме того, такая система не может работать в режиме реального време-
ни, что необходимо для генерации терапевтических сигналов. Для устранения 
этих проблем необходимо использовать операционную систему реального вре-
мени, а также подходящий процессор. 

Идея мультипроцессорной системы (рисунок 4.8) заключается в распреде-
лении задач между несколькими микропроцессорами или микроконтроллерами. 
Небольшие (низкопроизводительные и дешевые) процессоры выполняют зада-
чи реального времени, такие как генерация терапевтических сигналов, прием  
и обработка диагностической информации. Центральный процессор использу-
ется для реализации интерфейса пользователя и связи с ПК, для задания на-
чальных условий работы и обработки поступающих данных.  

 

 
Рисунок 4.8 – Многопроцессорная терапевтическая система 

 
Так как задачи реального времени решаются другими устройствами, цен-

тральный процессор может быть гораздо менее мощным по сравнению с одно-
процессорными решениями и не требует операционной системы реального 
времени. Важным этапом при создании мультипроцессорных систем является 
разработка шины данных. Необходимо разработать структуру, подобную ши-
нам SPI или I2C, с возможностью передачи данных от ведущего к ведомому  
и наоборот. Обычно центральный процессор контролирует процесс передачи 
данных. Иногда возникает необходимость в дополнительном контроллере пе-
редачи данных. В таком случае необходимо использовать шины с возможно-
стью работы нескольких ведущих (подобно I2C). Аппаратная поддержка шины 
может сэкономить время на разработку программы и процессорное время. 

Таким образом, при создании систем обоих типов могут возникнуть труд-
ности. При однопроцессорном варианте необходимо разработать операцион-
ную систему, работающую в режиме реального времени. Системы являются 
более надежными, однако расширение такой системы может быть ограничено 
аппаратными мощностями процессора. Для мультипроцессорной системы  
в свою очередь возникают проблемы с взаимодействием центрального и пери-
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ферических процессоров, необходимо устранять ошибки передачи данных, раз-
работать шину передачи, выбрать и реализовать протокол обмена. Однако раз-
работать мультипроцессорную систему обычно проще. Дополнительный тера-
певтический или диагностический канал может быть реализован простым до-
бавлением к шине еще одного процессора. Если рассматривать безопасность 
пациента, можно отметить, что в случае сбоя в однопроцессорной системе сти-
муляция прекращается по всем каналам. Это хорошо, например,  для систем 
электростимуляции периферической мускулатуры, однако в случае кардиости-
муляции или электростимуляции дыхания это может привести к смерти паци-
ента. В случае сбоя одного из процессоров многопроцессорной системы выхо-
дит из строя только один канал. 
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5 РАЗРАБОТКА ФУНКЦИОНАЛЬНОЙ (ПРИНЦИПИАЛЬНОЙ)  
СХЕМЫ АППАРАТА 

 
 

В зависимости от сложности аппарата разрабатывается функциональная 
или принципиальная электрическая схема аппарата.  

При разработке схемы устройства необходимо уделить внимание: 
− выбору, обоснованию и оптимизации пассивных и активных комплек-

тующих элементов; 
− выбору и обоснованию схемотехнической реализации отдельных блоков 

и каскадов; 
− разработке электрической схемы изделия с расчетом и синтезом отдель-

ных блоков; 
− электрическому расчету (синтезу) отдельных блоков, каскадов, излуча-

телей, направляющих систем; 
− исследованию электрических и (или) иных характеристик разрабатывае-

мого изделия. 
В общем случае могут быть выполнены следующие расчеты: 
− электрические расчеты схемы и отдельных ее блоков с целью определе-

ния электрических и динамических параметров и характеристик элементов, 
мощности тепловых потерь, коэффициентов нагрузки, частотных и переходных 
характеристик устройства, устойчивости системы и других параметров, необ-
ходимых для оценки работы СМЭ в различных режимах и проведения конст-
рукторских расчетов; 

− синтез цифровых и расчет аналоговых схем с целью определения быст-
родействия, нагрузочной способности элементов, разрядности устройств, про-
токола передачи информации, метода кодирования данных, способа хранения 
информации; 

− точности и стабильности выходных параметров функционально закон-
ченных частей изделия с учетом технологического разброса и эксплуатацион-
ного ухода первичных параметров; 

Пример функциональной электрической схемы простейшего электроней-
ростимулятора, реализованного на интегральных схемах средней интеграции, 
приведен на рисунке 5.1. 

Уделить внимание всем указанным электрическим расчетам даже в случае 
несложной функциональной части не всегда представляется возможным. В та-
ких случаях необходимо уделить внимание трем–пяти расчетам, важнейшим 
для проектируемого изделия, с обязательным включением в этот перечень не 
менее двух электрических расчетов схемы и отдельных ее частей. Конкретное 
содержание и объем расчетного материала зависят от темы проекта или функ-
циональной части устройства, выбранных для детального рассмотрения,  
а также от исходных данных.  
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Рисунок 5.1 – Функциональная  схема электростимулятора на основе источника тока 

 

Аппараты электронной терапии имеют специфические узлы. К таким узлам 
относятся: выходные каскады аппаратов, различные схемы защиты (по излучае-
мой мощности, по току), обеспечивающие безопасность проведения процедур 
терапии, схемы измерения выходной мощности (амплитуды) сигнала и т.д. При 
проектировании ЭЛА на них необходимо обратить особое внимание. 

С целью проверки правильности теоретических расчетов, исследования 
частотных и переходных характеристик электронных блоков и спектральных 
характеристик сигналов, выполнения расчетов по постоянному и переменному 
току выполняется моделирование работы принципиальной электрической схе-
мы всего аппарата или отдельных его блоков. В качестве средства моделирова-
ния могут быть использованы пакеты прикладных программ Micro-Cap, Work 
Bench, SIMetrix и др. 

Рассмотрим примеры расчета электронных блоков. 
Пример 1 – Расчет «мостовой» схемы выходного каскада электромиости-

мулятора со стимуляцией током (рисунок 5.2). 
Расчёт мостовой схемы произведем для одного из плеч схемы. Расчет для 

второй половины аналогичен. Схема работает таким образом, что когда ток ге-
нерируется источником тока на транзисторе VT4, то открыт электронный ключ 
на транзисторах  VT1 и VT2, и наоборот. 

Исходные данные для расчёта: напряжение питания Uп=200 В, амплитуда 
входного сигнала Uc=1 В, амплитуда тока в нагрузке Iн =20 мА, частота стиму-
лирующего сигнала fc=5 кГц. 

По требованиям электробезопасности ток частотой более 1 кГц в нагрузке 
Rн=500 Ом должен быть не более 80 мА. 

Ток в нагрузке задаётся источником тока, выполненном на транзисторе 
VT5, и определяется по формуле 

 
5

( )c бэU UIн R
−

= . (5.1) 
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а 

 
б 

Рисунок 5.2 – Электрическая принципиальная схема выходного каскада  
электростимулятора (а) и диаграммы работы выходного каскада (б) 

 

Зная, что Uбэ=0,6 В и подставив в формулу (5.1) исходные данные для рас-
чёта, находим R5: 

( ) 1 0,6 20 Ом.5 20
c бэU U В ВR

I мАн

− −
= = =  

Для предотвращения возможного перехода транзистора VT5 в режим на-
сыщения необходимо, чтобы напряжение на его переходе коллектор–эмиттер 
составляло 2...3 В. 

Транзисторы VT1,VT2 во включенном состоянии работают в режиме на-
сыщения. Соответственно данному режиму работы падение на переходах кол-
лектор–эмиттер этих транзисторов составляет 0,02…3,0 В. Максимальный ток 
коллектора транзисторов VT2,VT5 должен быть не менее тока нагрузки: 

max 1,5...3к нI I= ⋅ ≈ 2·20 = 40 мА. 
Максимальное напряжение коллектор–эмиттер транзисторов VT2,VT5 

должно быть не менее напряжения питания: 
max 1, 2...3кэ пU U= ⋅ ≈ 1,2·200 = 240 В. 

Iн 
Uс 
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Максимальная мощность, рассеиваемая на коллекторе VT5, должна быть 
не менее максимальной мощности, которая может быть передана от источника 
в нагрузку: 
 max max1,2...2к исP P= ⋅ , (5.2) 

max maxис пит нP U I= ⋅ = 200 В·20 мА = 4 Вт. 

Вт. 4,8  Вт 42,1max =⋅=кP  
По выше рассчитанным характеристикам выберем транзисторы VT2,VT5 

и сведём их параметры в таблицу 5.1. 
Таблица 5.1 – Параметры транзисторов VT2,VT5 

Обозначение Марка Поляр- 
ность 

Рк 
max, 
Вт 

Uкб 
max, 
В 

Uкэ 
max, 
В 

Uэб 
max, 
В 

Iк 
max, 
мА 

h21е 
Uкэ 
нас, 
В 

Iкбо, 
мкА 

fгр, 
МГц 

Корпус и 
диапазон 
раб.темпер. 

VT2 КТ521А PNP 0,625 300 300 5 500 >40 0,5 100 50 КТ-26* 
–60...85°С 

VT5 KT969A NPN 6,0 300 250 5,0 100 50–250 1,0 0,05 60 КТ-27 
–45...85°С 

 

Для повышения помехоустойчивости ключа на транзисторе VT2 ток базы 
должен быть: 

 
221

max
2 5,1..2,1

ЭVT

к
бVT h

II ⋅= , (5.3) 

2,1
40
402,12 =⋅=бVTI  мА. 

Напряжение на R4 не должно превышать напряжение Uб max транзистора 
VT2: 
 224 4 бVTбVTR URIU <⋅= . (5.4) 

Отсюда выразим R4: 

 
2

2max4
bVT

VTb

I
U

R < , (5.5) 

4170
2,1

54 ≈<R  Ом. 

Зададимся ближайшим из ряда стандартных значений Е24 R4=4,1 Ом. 
R2 определим из соотношения: 

 2412 2 бэVTRкVTR UURIU +=⋅= . (5.6) 
Для повышения помехоустойчивости ключа на транзисторе VT2 зададимся 

током IкVT1=10·IбVT2=12 мА: 

 
2

242
кVT

бэVTR

I
UUR +

= , (5.7) 

460
12

6,02,11,42 =
+⋅

=R  Ом. 

Из стандартного ряда Е24 выберем ближайшее значение R2 = 470 Ом. 
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Выберем транзистор VT1 по тем же соображениям, что и VT2 (таблица 5.2). 
Таблица 5.2 – Параметры транзисторов VT1 

Обозначение Марка Поляр- 
ность 

Рк 
max, 
Вт 

Uкб 
max, 
В 

Uкэ 
max, 
В 

Uэб 
max, 
В 

Iк 
max, 
мА 

h21е 
Uкэ 
нас, 
В 

Iкбо, 
мкА 

fгр, 
МГц 

Корпус и 
диапазон 
раб.темпер. 

VT1 КТ520А NPN 0,625 300 300 6 500 >40 0,5 100 50 КТ-26* 
-60...85°С 

 

Номинал R3 определим из следующего соотношения: 
 3 2 1пR R кэ насVTU U U U= − − , (5.8) 

 2 1

1
3 п R кэ насVT

кVT

U U U
R

I
− −

= , (5.9) 

Ом  16165
12

5,052,52003 =
−−

=R . 

Из стандартного ряда выберем ближайшее значение R3=16 кОм. 

 
1

1
(1,5...2)

упр бэ

бVT

U U
R

I
−

=
⋅

, (5.10) 

где Uупр напряжение управляющего сигнала Uупр=4,5 В. 

 1
21 1

1
бVT

ЭVT

кVTII
h

= , (5.11) 

3,0
40
12

1 ==бVTI мА. 

Ом 6500
3,0)2...5,1(

6,05,41 =
⋅

−
=R . 

Выбираем ближайшее из стандартного ряда значений R1=6,4 кОм.  
Номиналы мощностей резисторов определяются по формуле 

 RIP RR ⋅= 2 , (5.12) 
где IR – ток, протекающий через резистор, R – номинал резистора.  
Соответственно для каждого из резисторов получаем: 

2 2
24 4 1,2 4,1 0,0059бVTRP I R= ⋅ = ⋅ =  Вт, 

2 2
12 2 12 4,1 0,59кVTRP I R= ⋅ = ⋅ =  Вт, 

2 2
13 3 12 16 2,3кVTRP I R= ⋅ = ⋅ =  Вт, 

2 2
11 1 0,3 6,4 0,00058бVTRP I R= ⋅ = ⋅ =  Вт, 

2 2
5 5 20 4,1 1,64нRP I R= ⋅ = ⋅ =  Вт. 

Мощность, рассеиваемая на резисторах R2, R3, является импульсной, а не 
долговременной. Поэтому представляется возможным выбрать резистор не-
сколько меньшей долговременной мощности, но с малыми габаритными раз-
мерами. Номиналы мощностей резисторов выбираем ближайшие из ряда 
мощностей. Результаты расчетов номиналов резисторов сведем в таблицу 5.3. 
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Таблица 5.3 – Выбор резисторов схемы  
Поз. Тип Расчетный пара-

метр, Ррасчёт, Вт 
Выбранный пара-
метр, Рном, Вт 

Коэффициент  
нагрузки, Кн 

R1 С2-23 0,00058 0,125 <0,1 
R2 С2-23 0,59 0,5 1,18 
R3 С2-23 2,3 2 1,15 
R4 С2-23 0,0059 0,125 <0,1 
R5 С2-23 1,64 2 <0.82 
 
Номиналы емкостей С1 и С2 определяются из условия 

 3 ( )и вх иR R C t⋅ + ⋅ ≤ , (5.13) 
где  Rи – сопротивление источника сигнала, 

Rвх – входное сопротивление ключа по отношению к емкости C, 
tи – длительность импульса управления (переключения ключа). 

 

 
1

2и
c

t
f

=
⋅ , (5.14) 

1 0,1
2 5иt = =

⋅
мс. 

Значения емкостей можно рассчитать следующим образом. Для емкости 
С2 сопротивление Rи является R3||R2, а Rвх=R4+RвхVT2, где RвхVT2 – входное со-
противление транзистора VT2. В схеме с общим эмиттером оно мало и им 
можно пренебречь. Определим номинал С2: 

 2
3 ( 3 || 2 4)

иtC
R R R

=
⋅ +

, (5.15) 

0,12 7,216 000 4603 ( 4,1 1000)
16 000 460

C = =
⋅

⋅ + ⋅
+

 нФ. 

Для емкости C1 Rи является сопротивлением выходных цепей схемы 
управления. Как правило, значение его мало и им можно пренебречь. 
Rвх = R1 + RвхVT1, где RвхVT1 – входное сопротивление транзистора VT1. Как и  
в случае расчёта ёмкости С2, им также можно пренебречь. Таким образом, для 
C1 получаем: 

 
13

1
R

t
C и

⋅
= , (5.16) 

2,5
10004,63
1,01 =
⋅⋅

=C нФ. 

Выбираем ближайшие к полученным при расчёте значениям номиналы ём-
костей С1 и С2 из стандартного ряда значений. С1=7,5 нФ, С2=5,6 нФ. 

Номинальное предельно допустимое напряжение конденсаторов определя-
ется максимальными напряжениями, которые будут прикладываться к их об-
кладкам. Для конденсатора C1 это напряжение не превысит напряжения вход-
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ного сигнала, для C2 – падения на R2. По результатам проведенных вычисле-
ний выберем конденсаторы типа К10-17 (таблица 5.4). 
Таблица 5.4 – Выбор конденсаторов схемы  
Поз. Тип Расчетный пара-

метр, Uрасчёт, В 
Выбранный пара-
метр, Uном, В 

Коэффициент  
нагрузки, Кн 

C1 К10-17 4,5 40 0,11 
C2 К10-17 5,52 40 0,138 

 

Пример 2 – Расчет задающего генератора аппарата дарсонвализации.  
Рассмотрим базовую схему мультивибратора на таймере 555 для генера-

ции прямоугольных импульсов (рисунок 5.3). 

 
Рисунок 5.3 – Базовая схема включения таймера 555 

 

Форма выходного сигнала изображена на рисунке 5.4, а. На рисунке 5.4, б 
приведена форма напряжения на конденсаторе С1.  

 
Рисунок 5.4 – Форма выходного сигнала и напряжения на конденсаторе 

 

После включения питания этот конденсатор заряжается от 0 до 2Un/3 (при 
этом напряжении переключается первый компаратор) за время t3, равное 
 1)21(1,13 СRRt ⋅+⋅= . (5.17) 

Это является причиной того, что первый положительный импульс полу-
чается длиннее следующих за ним импульсов. Далее конденсатор заряжается 
от напряжения Uп/3 (срабатывает второй компаратор) до напряжения 2Un/3. 
Это быстрее, и время заряда составляет 
 1)21(693,01 СRRt ⋅+⋅= . (5.18) 

а 

б 
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Разряжается конденсатор от 2Un/3 до Un/3 за время 
 2 0,693 1 1t R С= ⋅ ⋅ . (5.19) 

Длительность рабочего цикла установившихся колебаний получается 
 21 ttT += , (5.20) 

а частота, соответственно: 

 
1,443

(2 1 2) 1
f

R R С
=

⋅ + ⋅
. (5.21) 

Генератор формирует меандр с высокой точностью.  
Для случая, когда частота следования прямоугольных импульсов должна 

быть f = 20 Гц, период соответственно равен T = 0,05 c, а скважность – близка к 
50 %, получаем:  

 05,01)212(693,021 =⋅+⋅=+= СRRttT  с. (5.22) 
Зададимся емкостью конденсатора С1 = 1 мкФ, сопротивлением 

R2 = 1 кОм. Тогда из формулы (5.22) получаем R2 = 36 кОм и  t1≈t2≈0,025 с. 
Таким образом, получаем на выходе микросхемы прямоугольные импуль-

сы с частотой следования 20 Гц и скважностью примерно равной 50 %. При 
этом R1 = 1 кОм, R2 = 36 кОм, С1 = 1 мкФ, С2 = 10 нФ. 

Конденсатор С2 нужен для стабильной работы генератора. 
Пример 3 – Расчет генератора управляемого напряжением (ГУН) схемы 

фазовой автоподстройки частоты (ФАПЧ). 
Задающий генератор должен обеспечить генерацию и поддержание частот 

от 22 до 880 кГц. Для реализации этих параметров целесообразно применение 
микросхемы CD4046AB, сочетающей в себе генератор, управляемый напряже-
нием, и схему ФАПЧ. Микромощная цифровая микросхема CD4046AB содержит 
следующие внутренние узлы (рисунок 5.5): генератор, управляемый напряжени-
ем (ГУН), два фазовых компаратора (ФК1 – исключающее ИЛИ или ФК2 – триг-
герная схема), формирователь-усилитель УФ входного сигнала, выходной исто-
ковый повторитель ИП. Для удобства применения на кристалле микросхемы из-
готовлен источник опорного напряжения – стабилитрон с напряжением 5,2 В. 

Узел ГУН – основа фазовой автоматической подстройки (ФАП). Он обес-
печивает линейность преобразования напряжение–частота лучше 1 %. Для ус-
тановки свободной частоты ГУН и диапазона девиации этой частоты требуются 
три внешних элемента: конденсатор С1 и резисторы R1, R2. Элементы R1 и С1 
фиксируют свободную частоту генерации с помощью R2 этой частоты. Частота 
выходных импульсов ГУН (на выходе 4) называется свободной, если на входе 
управления частотой ГУН (на выводе 9) напряжение отсутствует. 

В петле ФАП на вход ГУН подается напряжение ошибки. В устройстве оно 
снимается с внешнего фильтра низкой частоты (R3, C2), где сглаживается им-
пульсный сигнал, генерируемый одним из фазовых компараторов ФК1 или 
ФК2. Выбрать выход компаратора позволяет переключатель S1. Управляющий 
сигнал ГУН имеется и на выводе 10 – исток повторителя. Для правильной рабо-
ты повторителя требуется подключать внешний резистор нагрузки Rи > 10 кОм. 
Если этот выход не нужен, вывод 10 оставляется свободным. 
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Рисунок 5.5 – Структурная схема ФАП CD4046AB 

Петля ФАП в схеме состоит из трех узлов: ГУН, ФК1 (или ФК2) и фильтра 
низкой частоты (ФНЧ). Фильтр НЧ образуют резистор R3 и конденсатор C2. 
Как известно, особо опасна для работы системы ФАП вторая гармоника часто-
ты ГУН. Поскольку входное сопротивление ГУН велико (до 1012 Ом), номи-
нальная емкость конденсатора C2 в результате может быть небольшой. 

Входной цифровой сигнал Uc вводится в петлю ФАП от входа 14 через 
усилитель УФ и поступает на сигнальные входы обоих компараторов ФК1 и 
ФК2. На вторые входы компараторов подается выходной меандр свободной 
частоты от выхода ГУН. Отфильтрованное (сглаженное) напряжение с конден-
сатора С2 поступает на вход ГУН (вывод 9) в такой фазе, чтобы частота ГУН 
стала приближаться к частоте сигнала Uc. Некоторое время, таким образом, бу-
дет идти переходной процесс автоподстройки частоты. В конце этого процесса 
установится режим автоподстройки фазы, поскольку частоты будут равны. За-
тем петля ФАП с большой точностью уравняет фазы сигнала и выходного на-
пряжения ГУН. Полезными выходными сигналами петли ФАП могут быть как 
напряжение с выхода ФНЧ (выход повторителя, вывод 10), так и выходная час-
тота fГУН (вывод 4).  

Если требуется уменьшить мощность потребления в режиме ожидания, на 
вход разрешения Е следует подать напряжение высокого уровня. Номиналы 
внешних элементов следует выбирать в следующих пределах: R1, R2 ≥ 10 кОм, 
Rи ≤ 1 МОм, С1 > 100 пФ (при Uи.п = 5 В) и С1 > 50 пФ (при Uи.п  > 10 В). 
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Центральную частоту ГУН f0 (свободная частота ФАП, работающей с компа-
ратором ФК1) можно выбрать по рисунку 5.6, а. Выбранную частоту следует сме-
стить на величину ∆fСДВ, если вывод 12 микросхемы и нулевой провод соединить че-
рез резистор R2. Значение частоты сдвига ∆fСДВ можно определить по рисунку 5.6, б. 

На рисунке 5.6, в  показана зависимость максимальной fmax и минимальной 
fmin частот от отношения номиналов R1/R2. Здесь fmax определяется, когда 
UвхГУН = Uи.п, а fmin, если UвхГУН = 0. 
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а – зависимость центральной частоты f0 от R1 и C1; 

б – то же для частоты сдвига ∆fСДВ;  
в – зависимость пределов частот от отношения R2/R1 
Рисунок 5.6 – Частотные характеристики ФАП 

Фазовые компараторы ФК1 и ФК2 имеют общие входы (вывод 3). На внеш-
ний вывод 3 следует подавать сигнал только логики КМОП (уровень логического 
нуля ниже 0,3 Uи.п, логической единицы – выше 0,7 Uи.п). Сигналы с меньшей ам-
плитудой можно подавать через емкость и дополнительный усилительный каскад. 
Схема ФК2 представляет собой четырехтриггерное ЗУ с логикой управления. ФК2 
запускается положительными перепадами входных импульсов, поэтому скваж-
ность приходящих прямоугольных импульсов сигнала UС не имеет значения. На 
рисунке 5.7 показаны диаграммы сигналов в петле ФАП, работающей с ФК2. Если 
частота входного сигнала больше (или меньше), чем частота ГУН, выходной кас-
кад ФК2 находится в разомкнутом Z-состоянии. Когда частоты равны, но сигнал 
отстает по фазе от напряжения ГУН, выходное напряжение ФК2 будет находиться 
на низком уровне. Если отстает по фазе напряжение ГУН от напряжения сигнала 
UC, на выходе ФК2 появится напряжение высокого уровня. 
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Рисунок 5.7 – Диаграммы сигналов в петле ФАП 

Высокий (или низкий) уровень на выходе ФК2 будет удерживаться до тех 
пор, пока существует разность фаз. На выходе ФНЧ напряжение UС2 скачком из-
меняться не может, поэтому уравнивание фазы UвыхГУН с фазой сигнала UC по-
требует некоторого времени. После уравнивания фаз оба p-n-канальные выход-
ных транзистора ФК2 размыкаются, выход переходит в Z-состояние, следова-
тельно, на конденсаторе С2 будет храниться потенциал, соответствующий ра-
венству фаз. Соответственно управляющему напряжению UС2 будет зафиксиро-
вана частота ГУН. Таким образом, при работе ФК2 разность фаз между UС и 
UГУН в режиме слежения петли равна нулю. В эти моменты ФК2 потребляет ми-
нимум тока, поскольку его выходной каскад разомкнут. Полосы слежения и за-
хвата ФАП с ФК2 одинаковы и не определяются свойствами ФНЧ. 

Произведем синтез схемы задающего генератора  на основе микросхемы 
К564ГГ1. Подключением элементов R1-R3, C1 задаем центральную частоту и 
диапазон ее девиации. Для настройки генератора в режиме наладки целесообразна 
установка подстроечного резистора R2. Резистор R4 и конденсаторы C3, С4 обра-
зуют ФНЧ для схемы ФАП. Для реализации синтеза частот 22 кГц и 880 кГц вы-
ход ГУН присоединяется ко входам ФК2 (вывод 3) через внешний цифровой де-
литель частоты в N раз. Для этого используем переключение ключом S1 выходов 
3 К561ИЕ5, делящих основную частоту генерации на 2. Перестройку генератора  
в диапазоне от 22 до 880 кГц осуществить технически сложно, и точность на-
стройки будет грубой. Поэтому, чтобы обеспечить перестройку, диапазон будет 
разбит на 2 поддиапазона и должен иметь одинаковый коэффициент: 

 k = max

min

f
f

. (5.23) 

Выбираем 2 поддиапазона: 22–140 кГц и 140–880 кГц. Для них: 
k1 =140/22=6,3 ;  k2 =880/140=6,2. 

Находим центральную частоту ГУН f0: 

 max min
O min2

f ff f−
= + . (5.24) 

Для первого поддиапазона: f01 =(140 – 22)/2+22=81 кГц;  
для второго поддиапазона: f02 =(880 – 140)/2+140=510 кГц. 
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Используя рисунок 5.6, выбираем следующие номиналы частотозадающих 
элементов: R1= 100 кОм, R2= 6000 кОм, R3= 110 кОм, С1= 50 нФ. 

Элементы ФНЧ рассчитываются исходя из необходимости получить по-
стоянную времени фильтра, равную периоду колебаний. Таким образом, полу-
чаем два значения постоянной времени 
 

f
1

=τ : (5.25) 

6
321 1045

1022
1 −⋅=
⋅

=τ  с, 

6
322 101

10880
1 −⋅=
⋅

=τ  с, 

где τ21, τ22 – постоянные времени при частоте 22 и 880 кГц соответственно. 
Приняв значение R3 равным 11 кОм, получим номиналы С3 и С4: 

7,8
3

3 ==
R

C
τ

 нФ. 

Таким образом, произведен расчет задающего генератора на частотах  
22–880 кГц и обеспечена его работоспособность в качестве элемента ФАПЧ. 

Пример 4 – Расчет режекторного фильтра для удаления сетевой помехи. 
Для выборочного подавления составляющих определенных частот необхо-

дим фильтр, коэффициент передачи которого на резонансной частоте равен ну-
лю, а для нижних и верхних частот имеет постоянное значение. Такой фильтр 
называется заграждающим (режекторным) (рисунок 5.8). 

 
Рисунок 5.8 – Схема режекторного фильтра для удаления сетевой помехи 

 
Если при расчете фильтра принять R1=R2=R3=R4=R5=R и С1=C2=C, то 

расчет резонансной частоты (частоты подавления) будет проходить по формуле: 

 CR
Fрез ⋅⋅

=
π2

1
.  (5.26) 

Частота сетевой помехи равна 50 Гц. Выбираем емкость С=3,3мкФ и рас-
считываем номинал сопротивления 

 6

1 1 965 Ом.
2 2 50 3.3 10−= = =

⋅ ⋅ ⋅ ⋅ ⋅рез
R

F Cπ π  

Выбираем значение сопротивления, ближайшее из ряда сопротивлений 
R = 1 кОм. 
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6 РАЗРАБОТКА АЛГОРИТМА И ПРОГРАММЫ УПРАВЛЕНИЯ 
ЭЛЕКТРОННОГО ЛЕЧЕБНОГО АППАРАТА 
С МИКРОПРОЦЕССОРНЫМ УПРАВЛЕНИЕМ 

 
 

Для аппаратов, реализованных на основе микропроцессоров, контролле-
ров, компьютерных технологий, необходимо разработать алгоритм и програм-
му работы устройства. Студенту, выполняющему проект, необходимо уделить 
внимание: 

− формализации поставленной задачи; 
− разработке алгоритмов работы проектируемой системы; 
− разработке программного обеспечения к системе с анализом заданных 

форматов данных, выбором языка программирования, разработкой программ-
ного интерфейса, удобного интерфейса пользователя и т.п.; 

− описанию работы разработанного программного обеспечения: его уста-
новке, алгоритму работы, примеру использования. 

Любая программируемая система выполняет 3 основные функции: приём 
данных; логические и арифметические преобразования; выработку управляю-
щих воздействий. Первым шагом разработки аппарата на вычислительной 
платформе  является уточнение целей и задач, которые система должна ре-
шать. Затем необходимо как можно подробнее и, по возможности, математи-
чески строго уточнить все логические связи между причинами и следствиями. 
Желательно алгоритм иметь примерно в таком виде: если кнопка A нажата и 
контакты электрического реле B замкнуты, то должна включиться сигнальная 
лампочка H и заработать насос, подающий анестезию пациенту. При этом не-
обходимо учитывать возможности микропроцессорной системы управления. 
Этапы разработки ЭЛА на основе вычислительных программируемых средств 
следующие: 

1 Выработка базовой концепции, т.е. общих представлений, первичной 
идеи, определяющей принцип действия и метод реализации системы. 

2 Разработка алгоритма, т.е. набора процедур, четкой последовательности 
действий, выполнение которых дает требуемый результат. 

3 Проектирование аппаратных средств. 
4 Разработка рабочих программ. 
На этапе выбора базовой концепции необходимо сделать предварительное 

распределение логических действий между аппаратными и программными 
средствами и решить, как практически будут использоваться выходные данные 
системы. Следующим шагом является определение того, как все необходимые 
действия реализовать последовательным методом. В результате должна быть 
разработана диаграмма потока информации и установлены основные требова-
ния к микропроцессору. После этого можно разрабатывать алгоритм. Даже для 
относительно простой системы управления трудно разработать алгоритм, охва-
тывающий сразу все детали. Поэтому рекомендуется использовать три последо-
вательных уровня детализации алгоритма: концептуальная схема, функциональ-

Би
бл
ио
те
ка

 БГ
УИ
Р



 46 

ная схема, структурная схема машинных команд. Концептуальная блок-схема ал-
горитма показывает, что должно быть сделано. На этой стадии требуется иметь 
не очень много функциональных блоков. В качестве примера на рисунке 6.1 по-
казана схема работы электротерапевтического аппарата с обратной связью. 

 
Рисунок 6.1 – Концептуальная блок-схема алгоритма работы  

электротерапевтического аппарата с программным опросом датчиков 
 

На функциональном уровне разработки алгоритма каждый блок концепту-
альной блок-схемы расширяется до такой степени, чтобы показать отдельные 
шаги, которые требуется совершить для достижения желаемого результата. 
Различные алгоритмы могут устанавливать различные пути решения одной  
и той же задачи. При выборе той или иной формы записи для решения кон-
кретной проблемы могут использоваться различные критерии: заданный набор 
операций (машинных команд), удобство адресации, возникающие временные 
задержки. После завершения разработки функциональной схемы алгоритма тре-

? 

?

? 
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буется выяснить специфику характеристик микроконтроллера (или другого вы-
числительного средства) для того чтобы определить его конструктивные осо-
бенности и выбрать микропроцессорный комплект. Набор команд выбранного 
контроллера является основой для разработки структурной схемы машинных 
команд. За этой схемой следует только кодирование команд. Таким образом, 
ключом для успешного применения контроллеров является разработка функ-
циональной схемы алгоритма. 

Выбор микроконтроллера производится на этапе структурно-логического 
проектирования управляющей микропроцессорной системы. До этого на этапе 
системного проектирования уже должны быть разработаны функциональная 
схема алгоритма работы блока на базе микроконтроллера и функциональная 
схема аппаратной части. Из этой  документации могут быть взяты данные, не-
обходимые для обоснования выбора контроллера. Выбор контроллера основы-
вается на следующих данных: 

1 Функциональные  возможности  БИС, которые  могут  быть  использова-
ны для построения законченного управляюще-вычислительного устройства. 

2 Разрядность данных в контроллере.  
3 Объем адресуемой памяти, который складывается из объема ОЗУ и ПЗУ. 
4 Количество обслуживаемых внешних устройств и методы обмена дан-

ными. 
5 Производительность, определяющая время  выполнения  необходимых 

вычислительных и обменных операций. 
6 Конструктивно-технологические и энергетические характеристики (тип 

корпуса, напряжение источников питания, потребляемая мощность, климатиче-
ские требования). 

 
Пример разработки программы генерации сигналов синусоидально-

модулированных токов (СМТ) в среде MathCad 
Синусоидально модулированные токи – это переменные электрические 

токи, используемые для электростимуляции нервно-мышечного аппарата, час-
тотой 2–10 КГц, модулированные по амплитуде. Синусоидально-модули- 
рованное колебание может быть записано в виде:  
 х = А0 (1 + m sin Ω t) sin (ωt + j), (6.1) 

где A0 и ω=1/T – амплитуда и частота исходного колебания, 
Ω  = 1/τ  –  частота модуляции, а величина m называется глубиной мо-

дуляции и характеризует степень изменения амплитуды:  
 m = (Аmax – Аmin) / (Аmax + Аmin). (6.2) 

Программная генерация заключается в создании массива данных, который 
при выводе его через цифроаналоговый преобразователь (ЦАП) будет пред-
ставлять собой сигнал с заданными параметрами. Ниже приводится расчет мас-
сива данных синусоидального сигнала со следующими параметрами: 

частота  f – 2000 Гц,  длительность сигнала (Т1) – 2 с,  
частота дискретизации fd – 48 000 Гц, разрядность ЦАП – 16 бит. 
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Рассчитаем длину массива: L = T1 fd = 96 000 элементов. 
Формула расчета элементов массива для синусоидальных колебаний вы-

глядит следующим образом: 
 Xi = sin (i (2πf / fd)), (6.3) 

где Xi – значение i-го элемента массива, 
i – порядковый номер элемента массива, 
f – частота колебаний, 

fd – частота дискретизации. 
Так как разрядность выходного ЦАП будет составлять 16 бит, то макси-

мально возможные числа на выходе ЦАП будут: 2(16-1) – 1 = 32 767 (положи-
тельное) и –32 768 (отрицательное). 

Максимальная амплитуда рассчитанного по формуле (6.3) синусоидально-
го сигнала изменяется от –1 до 1. Следовательно, для того чтобы уровень сиг-
нала соответствовал выходному уровню ЦАП, необходимо увеличить амплиту-
ду до максимального значения: 
 X: = X (2(16-1) – 1). (6.4) 

Далее следует округлить полученные числа до целых значений, сделать 
экспорт полученных данных в нужный формат. 

В среде MathCad расчет выглядит следующим образом (рисунок 6.2): 
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Рисунок 6.2 – Программа генерации сигналов СМТ в среде MathCad 
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Часто при синтезе сложных сигналов (например при сложении нескольких 
гармоник) заранее неизвестна максимальная амплитуда сигнала. Тогда посту-
пают следующим образом: из всего массива данных находят максимальный 
(минимальный) элемент. Затем рассчитывают коэффициент масштабирования 
по следующей формуле: 
 К = (MAXцап – 1) / Xmax, (6.5) 

где MAXцап – максимально возможное число, преобразовываемое цифро-
аналоговым преобразователем, 

Xmax – абсолютное значение (модуль) максимального (минимального) 
элемента массива полученных данных. 

Значение каждого элемента массива умножается на полученный коэффи-
циент и затем округляется. 
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7 РАЗРАБОТКА КОНСТРУКЦИИ УСТРОЙСТВА 
 
 

7.1 Особенности проектирования 
электронной лечебной аппаратуры 

Процесс проектирования в общем виде можно описать как осознанную 
мыслительную и творческую деятельность разработчика, базирующуюся на 
синтезе и анализе принимаемых решений и направленную на получение за-
конченного изделия в виде конструкторской документации, макета или образ-
ца, изготовленных с помощью современных информационных, программных 
и  технологических средств. 

При разработке электронной лечебной аппаратуры необходимо учитывать 
ее специфику: подключение непосредственно к человеку, в том числе и инва-
зивно. Поэтому к ЭЛА предъявляют особые требования по электробезопасно-
сти, применяемым материалам, надежности  и т.п.  

При проектировании ЭЛА необходимо дополнительно предусматривать 
элементы сигнализации, указывающие на включение той или иной цепи аппа-
рата, использовать средства автоматики, позволяющие исключить опасное воз-
действие на пациента из-за неисправности или неграмотной эксплуатации ап-
паратуры. 

Для обеспечения повышенных требований к электробезопасности ЭЛА 
держатели предохранителей и вывод шнура питания необходимо размещать на 
диэлектрических панелях, при напряжении питания свыше 42 В должны при-
меняться сетевые выключатели, обеспечивающие изоляцию пользователя аппа-
ратуры от металлических или других токопроводящих конструкций. 

В ЭЛА желательно применение элементной базы с повышенными эксплуа-
тационными характеристиками.  

Отдельные функциональные узлы (преобразователи напряжения, источни-
ки питания, операционные усилители с гальванической развязкой и т.п.) выпус-
каются в специальном исполнении для изделий медицинского назначения. 

Для ЭЛА особые требования предъявляются и к эргономике: алгоритмы 
работы, обозначения на передних панелях аппаратов, вид и содержание меню 
управления и т.п. должны быть максимально понятными и простыми, т.к. с ме-
дицинской техникой в основном работает персонал, не имеющий технического 
образования. Необходимо также учитывать и то, что эксплуатация ЭЛА воз-
можна в особых условиях: в состоянии стресса обслуживающего персонала,  
в неприспособленных помещениях и т.п.  
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7.2 Компоновочный расчет 
Под компоновкой электронной лечебной аппаратуры понимается процесс 

размещения комплектующих модулей, изделий электронной техники (ИЭТ) и 
деталей ЭЛА на плоскости или в пространстве с определением основных гео-
метрических форм и размеров, а также ориентировочное определение массы 
изделия. На практике задача компоновки чаще всего решается путем размеще-
ния готовых элементов с заданными формами, размером и весом на плоскости с 
учетом электрических, магнитных, механических, тепловых и других видов 
связи. При компоновке нужно стремиться к тому, чтобы: 

− отсутствовали заметные паразитные электрические магнитные взаимо-
связи, влияющие на технические характеристики изделия; 

− взаимное расположение элементов обеспечивало технологичность сбор-
ки и монтажа, легкий доступ для контроля, ремонта и обслуживания; 

− изделие удовлетворяло требованиям технической эстетики; 
− габариты и масса изделия были минимальными. 
Существуют много способов компоновки элементов РЭС, среди них мож-

но выделить два: аналитический и модельный. В основе аналитического спосо-
ба лежит представление геометрических параметров РЭС в виде чисел. Основу 
модельного способа составляет создание физических моделей элементов, на-
пример, в виде геометрически подобного тела. В том и ином способе произво-
дится анализ общих аналитических зависимостей.  

Исходными данными для компоновочного расчета являются: перечень 
элементов, габаритные и установочные размеры ИЭТ. Ниже приведена методи-
ка расчета. 

1 Определяется суммарная площадь, занимаемая всеми ИЭТ: 

 ∑
=

=
n

i
yiC SS

1
, (7.1) 

где n – количество элементов, 
Sуi – значение установочной площади i-го элемента.  

2 Рассчитывается приблизительная площадь печатной платы с учетом спо-
соба монтажа (односторонний, двусторонний): 

 ( )mk
SS

З

C
ПЛ ⋅= , (7.2) 

где kЗ – коэффициент заполнения платы печатной (0,3–0,8),  
m – количество сторон монтажа (1, 2). 

Исходя из рассчитанной площади платы и высоты ИЭТ определяют ее 
приблизительные габаритные размеры. 

При оценке приблизительных габаритных размеров всего устройства два 
размера из трех определяют по рассчитанным размерам платы печатной с учетом 
допусков на зазоры между платой и корпусом, толщины корпуса, особенностей 
дизайна устройства и т.п. Третий размер определяется с учетом максимально вы-
соких элементов, размещаемых на плате, и размеров, обусловленных особенно-
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стью разрабатываемой конструкции (способ крепления платы в корпусе, толщина 
корпуса, наличие дополнительных деталей на корпусе и т.п.). 

Допускается предварительный расчет габаритных размеров электронной 
лечебной аппаратуры выполнять по следующей методике. 

1 Определяется суммарный объем, занимаемый всеми ИЭТ и деталями: 

 ∑ ∑
= =

+=
n

i

m

j
jiC VVV

1 1
21 , (7.3) 

где V1i – значение объема i-го ИЭТ,  
V2j – значение объема j-й детали, 
n – количество ИЭТ, 
m – количество деталей. 

2 Оценивается приблизительный объем всего устройства: 

 
ЗУ

C
У K

VV = , (7.4) 

где КЗУ – коэффициент заполнения устройства по объему (0,2–0,6). 
3 По вычисленному объему всего устройства определяются его приблизи-

тельные габаритные размеры. 
После расчета габаритных размеров платы и устройства полученные дан-

ные сравнивают с заданием на курсовое проектирование. При необходимости 
производят корректировку либо исходных данных на проектирование, либо 
конструктивных ограничений (количество сторон монтажа платы, тип элемент-
ной базы, компоновку отдельных блоков и т.п.) с целью изменения общих габа-
ритных размеров устройства. 

 
 

7.3 Расчет надежности 
Надежность является одним из свойств, которые определяют качество элек-

тронной аппаратуры (ЭА), в том числе и электронной лечебной аппаратуры. 
Выделяют два этапа оценки надежности блоков ЭЛА: 
1) ориентировочный расчет показателей безотказности (выполняют на 

ранней стадии проектирования); 
2) уточненный расчет показателей надежности (выполняют на заключи-

тельных стадиях проектирования). 
Расчеты выполняются при следующих допущениях: 
а) отказы элементов случайны и независимы; 
б) для элементов справедлив экспоненциальный закон надежности; 
в) принимаются во внимание только внезапные отказы, т.е. вероятность  

с точки зрения отсутствия постепенных отказов равна единице; 
г) учитываются только элементы электрической схемы, а также монтажные 

соединения, если вид соединений заранее определен; 
д) при уточненном расчете электрический режим и условия эксплуатации 

элементов учитываются более точно, чем при ориентировочном расчете, и, кроме 
того, принимаются во внимание конструктивные элементы устройства (шасси, 
корпус провода и т.п.). 
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В настоящее время для высоконадежных элементов для оценки интенсивно-
сти отказов используют расчет и прогнозирование, принимая во внимание струк-
турную сложность таких элементов и опыт эксплуатации аналогичных элемен-
тов. Интенсивность отказов (λ) современных элементов находится в диапазоне 
10–10…10–5 1/ч. Для зарубежных компонентов в качестве размерности величины λ 
используют процент на 1000 ч работы, что равносильно введению множителя 
105. Интенсивность отказов на каждый конкретный элемент обычно указывается 
в технической документации предприятия-изготовителя. Для учебных целей мож-
но воспользоваться таблицей приложения В или учебной литературой, например 
[10]. Необходимо учитывать, что для элементов коммутации интенсивность отка-
зов задается на один контакт кнопки, реле и т.п., штырь разъема, контактную 
группу переключателя и на метр длины монтажного или соединительного провода 
при номинальном токе (плотности тока). 

При расчетах надежности необходимо учитывать то, что для поверхностно-
монтируемых (SMD) компонентов интенсивность отказов обычно ниже в не-
сколько раз. Надежность ИМС слабо зависит от степени интеграции, т.к. макси-
мальный вклад в ее ненадежность вносят корпус и соединения внутри него. 

Надежность элементов зависит также от коэффициентов электрической на-
грузки: 

 КН = FРАБ/FНОМ , (7.5) 
где FРАБ – электрическая нагрузка элемента в рабочем режиме, т.е. нагруз-

ка, которая имеет место на рассматриваемом схемном элементе; 
FНОМ – номинальная или предельная по ТУ электрическая нагрузка эле-

мента, выполняющего в конструкции функцию схемного эле-
мента. 

В качестве электрической нагрузки FНОМ необходимо использовать номи-
нальные или предельные по ТУ электрические характеристики элементов, вы-
бранные для проектируемой ЭЛА. Электрические характеристики FРАБ следует 
брать из результатов электрического расчета принципиальной электрической 
схемы ЭЛА или получать путем экспресс-анализа (ориентировочной оценки) 
электрических нагрузок схемных элементов. 

На практике при определении коэффициента электрической нагрузки кон-
кретного элемента выбирают такую электрическую характеристику (одну или 
несколько), которая в наибольшей степени влияет на надежность этого элемен-
та. Например, для резисторов это мощность рассеяния, для конденсаторов – на-
пряжение, для низковольтных (до 300 В) элементов коммутации – ток через 
контакт, для цифровых ИМС – выходной ток, для транзисторов – мощность, 
рассеиваемая на коллекторе (стоке), ток коллектора или напряжение на коллек-
торе и т.п.  

Для транзисторов, диодов и аналоговых ИМС в качестве определяющего па-
раметра выбирается тот, для которого КН ≥ 0,05…0,1. 

Справочные значения интенсивностей отказов элементов соответствуют 
КН = 1 и нормальным (лабораторным) условиям эксплуатации. На практике выби-
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рают режимы работы ЭЛА с КН < 1 для ее элементов, а условия эксплуатации – 
более жесткие. Поэтому необходимо производить перерасчет справочных зна-
чений интенсивностей отказов с учетом реального коэффициента нагрузки и 
условий эксплуатации. Для перерасчета интенсивностей отказов пользуются 
выражением 
 ( ) ( )nxx ,,10 Kϕλνλ ⋅= , (7.6) 

где λ(ν) – значение интенсивности отказов с учетом электрического режи-
ма и условий эксплуатации, 

λ0 – справочное значение интенсивности отказов, 
φ (х1, …, хn) – перерасчетная функция, 
х1, …, хn – факторы, принимаемые во внимание (коэффициент нагруз-

ки, температура, давление, характер электрического режи-
ма и т.п.); 

 ( ) ( )∏
=

=
n

i
in xxx

1
1 ,, αϕ K , (7.7) 

где α(хi) – поправочный коэффициент, учитывающий влияние фактора хi,  
n – количество факторов. 

При расчетах надежности изделий наиболее часто учитывают влияние 
двух факторов – коэффициента электрической нагрузки и температуры. В этом 
случае для определения перерасчетной функции можно пользоваться номо-
граммами, построенными для различных видов элементов по результатам экс-
периментальных исследований (приложение Г). 

На практике оценка показателей надежности проектируемой ЭЛА выпол-
няется в предположении, что элементы в ней с точки зрения надежности соеди-
нены последовательно, их отказы случайны и независимы, используется экспо-
ненциальный закон надежности элементов.  

При курсовом проектировании необходимо выполнить расчет надежности 
всего устройства. В данном пособии в качестве примеров приведены расчеты 
отдельных блоков. 

 
7.3.1 Ориентировочный расчет показателей безотказности выходного 

каскада, работающего в составе электромиостимулятора 
(рисунок 5.2) 

Данный расчет надежности выполняется на ранней стадии проектирования. 
В качестве исходных данных выступают условия эксплуатации (наземные ста-
ционарные) и заданное время работы блока (tз =1000 ч). Предполагается, что 
электромиостимулятор будет изготовлен с использованием печатного монтажа. 

Решение 
1 Сформируем группы однотипных элементов и для каждой группы по 

справочникам (см. приложение В) определим значение интенсивностей отказов, 
соответствующее в среднем элементам каждой группы. Для резисторов выби-
раем значение интенсивности отказов, соответствующее мощности рассеивания 
менее 0,5 Вт при переменном токе. Аналогично выбираются значения интен-
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сивностей отказов для керамических конденсаторов и остальных элементов 
(таблица 7.1). Число паек можно определить как суммарное число выводов эле-
ментов и внешних выводов блока ЭЛА с учетом того, что монтаж будет выпол-
няться в металлизированные отверстия печатной платы. 
Таблица 7.1 – Ориентировочный расчет надежности 

Группа элементов (j) 
Количество эле-
ментов в j-й 
группе ( nj ) 

Интенсивность отказов 
для элементов j-й     

группы 
λOj × 10-6 1/ч 

Произведение 
λOj × nj × 10-6 1/ч 

Транзистор средней мощности 4 0,45 1,8 
Транзистор высокой мощности 2 0,50 1,0 

Резистор 9 0,10 0,9 
Конденсатор 4 0,05 0,2 
Вилка выходная 2 0,70 1,4 
Плата печатная  1 0,20 0,2 

Пайка 50 0,04 2,0 
Σ - - 7,5 

 
2 С помощью обобщенного эксплуатационного коэффициента, найденного 

по справочным таблицам (таблица 7.2) для наземных стационарных условий, 
скорректируем величину λΣ, учтя тем самым приближенно электрический ре-
жим и условия работы элементов каскада. 

Таблица 7.2 – Значение обобщенного эксплуатационного коэффициента Кэ 

Вид ЭЛА,  
условия эксплуатации 

Значение Кэ 

Лабораторные условия 1,0 
Помещения с регулируемой  
температурой и влажностью 

 
1,1 

Наземные стационарные условия  2…4,7 (2,5) 
Наземные возимые ЭЛА 4…7 (5,0) 
Наземные переносимые ЭЛА 7…15 (7,0) 
Морские защищенные условия 7…12 (7,6) 

 

λΣ (ν) = λΣ × Кэ = 7,5× 10-6 × 2,5 = 18,75×10-6 1/ч. 
 
3 По формулам для экспоненциального закона надежности [10] подсчиты-

ваем другие показатели надежности: 
а) наработка блока ЭЛА на отказ 

( ) 33353
1075,18

11
60 ≈

×
== −

Σ νλ
T  ч. 

Заметим, что данное значение наработки на отказ носит расчетный харак-
тер, ибо ресурс такого элемента, например, как транзистор, заметно меньше 
рассчитанного значения Т0; 
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б) вероятность безотказной работы за время tЗ = 1000 ч: 

( ) ( ) 61000 18,75 10 0,981;tз
зP t e eλ ν −− ⋅ − × ×Σ= = ≈  

в) гамма-процентная наработка до отказа (при γ = 99 %) 

540
1075,18
99,0ln

)(
100

ln

6 ≈
×

−=








−= −
Σ v

T
λ

γ

γ  ч. 

В отличие от Т0 показатели P(t) и Тγ имеют физический смысл. 
 
7.3.2 Уточненный расчет показателей безотказности и ремонтопри-

годности каскада ЭЛА, рассмотренного в 7.3.1. Параметры элементов: 
R1, R9 = 6,4 кОм±10 %; R2, R7 = 470 Ом±10 %; R3, R8 = 16 кОм±10 %;  
R4, R6 = 4,1 Ом±10 %, R5 = 20 Ом±10 %; С1, C4 = 7500 пФ±20 %, 
С2, C3 = 5600 пФ±20 %. 

Для сборки каскада использован печатный монтаж в металлизированные 
отверстия. Тип выбранных резисторов: С2-23 с номинальной мощностью рас-
сеивания Рном = 0,125 Вт и допуском на сопротивление ±10 %. Тип выбранного 
конденсатора: К10-17 с напряжением Uном = 40 В. Тип транзисторов: VT1, VT6 –
КТ520А; VT2, VT3 – КТ521А; VT3, VT5 – КТ969А. В качестве выходной вилки 
Х1 используется оригинальное изделие с двумя контактными группами. На-
пряжение источника питания Uпит = 200 В±10 %. Каскад используется в составе 
ЭЛА, для которого характерны следующие условия эксплуатации: 

− диапазон рабочих температур –10 ... +45°С;  
− относительная влажность воздуха до 80 % при температуре +25 °С; 
− атмосферное давление 930±13 кПа. 
Предварительный расчет теплового режима электромиостимулятора, в кото-

ром используется выходной каскад, показал, что перегрев в нагретой зоне состав-
ляет не более 23 °С, а средний перегрев воздуха в устройстве – примерно 12 °С. 

Решение 
1 Определяется коэффициент электрической нагрузки и рабочая температура 

всех элементов выходного каскада электромиостимулятора (см. таблицы 5.1–5.4). 
При расчете схемы электрической принципиальной и выборе элементной 

базы, определение значений коэффициентов электрической нагрузки и рабочей 
температуры для выбранных элементов выходного каскада в учебных целях 
допускается проводить методом экспертных оценок.  

Значения коэффициентов электрической нагрузки и температура элемен-
тов внесены в таблицу 7.3. 

2 Формируем группы однотипных элементов. 
При формировании групп однотипных элементов необходимо учитывать, 

что рассматриваемый каскад ЭЛА состоит из двух однотипных звеньев. 
Резисторы R1, R3…R6, R8, R9 включаем в одну группу, так как для них 

КН < 0,1. Самостоятельные группы составляют точки паек, а также плата пе-
чатная. 
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3 Определяем суммарную интенсивность отказов элементов выходного 
каскада электромиостимулятора и результаты расчетов заносим в таблицу 7.3. 
При этом справочные значения интенсивностей отказов элементов каждой 
группы находим по таблице максимальных значений интенсивностей отказов 
элементов (см. приложение В), а поправочные коэффициенты αΣ, учитывающие 
влияние коэффициентов электрической нагрузки и температуры, определяем по 
номограммам (см. приложение Г). 
Таблица 7.3 – Уточненный расчет надежности 

Группа 
элементов  

Количе-
ство эле-
ментов 
в группе 

(nj) 

Справоч-
ное зна-
чение 

λOj × 10-6 
1/ч 

Коэффици-
ент элек-
трической 
нагрузки 

(Кн) 

Расчётная 
рабочая 
темпера-
тура эле-
мента, °С 

Произведе-
ние попра-
вочных ко-
эффициен-
тов (αΣ) 

Значение 
λо(ν) × 

× 10-6 1/ч 

Значение 
λо(ν) × nj × 
× 10-6 1/ч 

VT1, VT6 2 0,60* 0,67 58 1,3 0,78 1,56 
VT2, VT4 2 0,60* 0,67 58 1,3 0,78 0,78 
VT3 VT5 2 0,50 0,80 69 2,5 1,25 2,5 

R2, R7 2 0,10 0,54 69 1,1 0,11 0,22 
R1, R3…R6, 

R8, R9 7 0,10 <0,1 58 0,15 0,015 0,11 

С1, С4 2 0,05 0,10 58 0,07 0,004 0,008 
С2, С3 2 0,05 0,13 58 0,07 0,004 0,008 

X1 1 0,70** 0,50 58 1,6 1,12 1,12 
Плата пе-
чатная  1 0,2 – 58 1,0 0,2 0,2 

Пайка 46 0,04*** – 58 3,0 0,12 5,52 
Σ — ≈12,1 
* – с учетом того, что транзисторы работают в ключевом режиме; 
* – с учетом того, что в вилке используются два штыря; 
*** – с учетом того, что постоянный ток в схеме значительно превышает пульсирующий 
 

Возможно вычисление поправочных коэффициентов αΣ по формуле (7.7) с 
учетом данных приложения Д. 

Расчетное значение величины λΣ(ν) для выходного каскада электромиости-
мулятора составляет λΣ(ν) ≈ 12,1 × 10-6 1/ч. 

4 Определяем наработку блока на отказ: 

0 6

1 1 82 650  ч .
( ) 12,1 10

T
vλ −

Σ

= = ≈
×

 

5 Рассчитываем вероятность безотказной работы выходного каскада элек-
тромиостимулятора за время tЗ = 1000 ч. Получим 

61000 12,1 10( ) 0,987;зP t e
−− × ×= ≈  

6 Определяем гамма-процентную наработку блока ЭЛА до отказа для зна-
чения γ = 99 %: 

830
101,12

100
99ln

6 ≈
×









−= −γT ч. 
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7 Подсчитываем среднее время восстановления ТВ.  Расчет величины ТВ  
с использованием справочных значений интенсивностей отказов элементов 
и таблицы 7.3 сведен в таблице 7.4. 
Таблица 7.4 – Расчет показателей ремонтопригодности 

Группа эле-
ментов (j) 

Количество эле-
ментов в группе 

(nj) 

Значение 
λj(v)×10 -6 

1/ч 

Значение τj, ч; 
табличное  

[приложение Е] 

Произведение 
njτjλj(ν) ×10-6 

 
VT1, VT6 2 0,78 0,8 1,248 
VT2, VT4 2 0,78 0,8 1,248 
VT3 VT5 2 1,25 0,7 1,75 

R2, R7 2 0,11 0,5 0,11 
R1, R3…R6, 

R8, R9 7 0,015 0,5 0,053 

С1, С4 2 0,004 1,1 0,009 
С2, С3 2 0,004 1,1 0,009 

X1 1 1,12 0,8 0,896 
Плата  
печатная  1 0,2 3,0 0,6 

Пайка 46 0,12 0,5 2,76 
Σ – ≈ 8,68 

 

С учетом того, что 6

1
1081,12)( −

=

×=∑
k

j
jjn νλ  1/ч, получим 

7,0
101,12
1068,8

6

6

≈
×
×≈ −

−

ВT  ч. 

8 Подсчитываем значение вероятности восстановления блока за заданное 
время, например τз = 1,0 ч: 

76,011)( 7,01/ ≈−=−= −− eev ВЗ Т
З

ττ . 
Полученные результаты расчета далее необходимо сравнить с требования-

ми, предъявляемыми к показателям надежности проектируемого ЭЛА. 
Более подробно с методикой расчета надежности и восстанавливаемости 

блоков ЭЛА можно ознакомиться в [10, 11] и ГОСТ 27.301-95. 
 
 

7.4 Автоматизированный расчет надежности модулей  
электронной лечебной аппаратуры 

В настоящее время существует множество различных пакетов для автома-
тизированного расчета надежности электронной аппаратуры. Для расчета на-
дежности ЭЛА наиболее подходящей является программа «Автоматизирован-
ная система расчета надежности» (АСРН), разработанная российскими спе-
циалистами на основании руководящих методических документов для техники 
военного назначения. Она позволяет рассчитывать суммарную интенсивность 
отказов модулей 1-го и 2-го уровней без резервирования, укомплектованных 
отечественными и импортными электрорадиоизделиями (ЭРИ) в режиме экс-
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плуатации и хранения (только для отечественных ЭРИ) в составе подвижных и 
неподвижных объектов. 

На рисунке 7.1 представлено главное окно программы, появляющееся при 
загрузке системы. 

 
Рисунок 7.1 – Главное окно программы 

 

Конструктивно главное окно состоит из главного меню, панели инстру-
ментов, дерева модулей 1-го и 2-го уровней и сеток отображения данных по 
выбранному модулю или ЭРИ. 

Главное меню (рисунок 7.2) состоит из 3-х пунктов: Расчет, Сервис  
и Справка: 

 
 

 

а б в 
а – Расчет; б – Сервис; с – Справка 
Рисунок 7.2 – Главное меню программы 

 

Расчет надежности... – вызов на экран окна ввода общих исходных дан-
ных для расчета и установки режима отчета. Пункт активен только при выборе 
конкретного модуля; 

Выход – выход из АСРН; 
Справочник «Надежность ЭРИ» – вызов справочника «Надежность 

ЭРИ» в окне программы просмотра PDF-документов Acrobat Reader; 
Справочник «Надежность импортных ЭРИ» – вызов справочника о по-

рядке расчета надежности импортных ЭРИ (на базе методики MIL-HDBK-217F) 
в окне программы просмотра PDF-документов Acrobat Reader; 

База данных импортных ЭРИ – вызов окна для заполнения корпоратив-
ной базы импортных ЭРИ; 

Содержание... – визуализация справочной информации по правилам рабо-
ты с системой. 

Панель инструментов (рисунок 7.3) состоит из набора кнопок, большая 
часть которых (кроме кнопки Модуль) повторяют основные пункты главного 
меню. 
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Рисунок 7.3 – Панель инструментов 

 

При нажатии на кнопку Модуль появляется всплывающее меню, пункты 
которого зависят от того, модуль какого уровня или ЭРИ выбран в дереве мо-
дулей или сетке отображения данных. Полный перечень пунктов меню приве-
ден ниже (рисунок 7.4). 

 
Рисунок 7.4 – Меню Модуль 

 

Первая группа пунктов меню предназначена для создания, редактирова-
ния и удаления модуля 2-го уровня. 

Вторая группа предназначена для создания удаления и редактирования 
модуля 1-го уровня в составе модуля 2-го уровня. 

Третья группа предназначена для добавления, редактирования и удаления 
ЭРИ в модуле 2-го уровня. 

Четвертая группа предназначена для перехода к модулю 1-го уровня при 
нахождении его в модуле 2-го уровня. 

 
7.4.1 Пример расчета надежности модуля 2-го уровня 
Необходимо рассчитать суммарную интенсивность отказов микропроцес-

сорного блока управления (рисунок 7.5). 
Блок управления с децимальным номером БГУИ.943010.001 можно отне-

сти к модулю 2-го уровня, состоящего из модуля 1-го уровня (Плата1 
БГУИ.943011.001, схемная позиция в составе блока – A1), соединитель типа 
РБН1 (XS1) для электрической связи платы с клавиатурой и пяти кнопок типа 
SKHHAN (SA1..SA5). 

Модуль первого уровня Плата1 содержит следующие ЭРИ: 
− два конденсатора К10-17-2а-М1500-18пФ±10 % (С1-С2); 
− интегральную микросхему PIC16F872/72A (DD1); 
− диод Д522В (VD1); 
− реле электромагнитное FRT5S-DC5V (К1); 
− резистор Р1-8-0,25-100 Ом±10 % (R1); 
− пять резисторов Р1-12-0,125-10 кОм±10 % (R2..R6); 
− транзистор КТ815Г (VT1); 
− резонатор HC-49SM (ZQ1). 
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Общие исходные данные: расчет провести в режиме эксплуатации, группа 
аппаратуры – 3.3, температура – 25 °С. 
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Рисунок 7.5 – Микропроцессорный блок управления 

 

Решение  
1 Создаем модуль 1-го уровня Плата1. Для этого в дереве модулей выбира-

ем узел Модули 1-го уровня, нажимаем на кнопку Модуль и выбираем пункт 
Создать модуль 1-го уровня. В появившемся окне вводим шифр Плата1 и де-
цимальный номер БГУИ.943011.001 платы, нажимаем на кнопку ОК. Модуль 
создан. 

В дереве модулей выбираем узел Модули 1-го уровня и раскрываем его 
двойным нажатием на левую кнопку мыши. В раскрытом узле находим модуль 
Плата1 и выделяем его (рисунок 7.6). 

 
Рисунок 7.6 – Выбор модуля Плата1 для редактирования 

 

Добавляем в созданный модуль Плата1 поочередно все ЭРИ.  
Во-первых, добавляем два конденсатора К10-17-2а. Для чего при выделен-

ном модуле Плата1 нажимаем на кнопку Модуль и выбираем пункт Добавить 
ЭРИ в модуль 1-го уровня. В появившемся окне в дереве класс-группа-тип рас-
крываем иерархию: отечественная элементная база –> конденсаторы –> кера-
мические на номинальное напряжение менее 1600 В –> К10-17а или ищем 
ЭРИ, нажав на кнопку Поиск. Вводим все параметры ЭРИ (напряжение пита-
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ния и вид приемки), схемную позицию (С1-С2) и количество (2) (рисунок 7.7). 
Нажимаем ОК – два конденсатора добавлены в модуль Плата1. 

 
Рисунок 7.7 – Диалоговое окно Редактировать ЭРИ в модуле 1-го уровня:  

вставка отечественных ЭРИ  
 

Во-вторых, вносим интегральную микросхему PIC16F872/72A (DD1) в мо-
дуль Плата1. Для чего при выделенном модуле Плата1 нажимаем на кнопку 
Модуль и выбираем пункт Добавить ЭРИ в модуль 1-го уровня. В появив-
шемся окне в дереве класс-группа-тип раскрываем иерархию: импортная эле-
ментная база –> интегральные микросхемы –> микропроцессоры МОП-
технологии –> тип не существенен. Далее указываем параметры требуемой микро-
схемы (коэффициент нагрузки, функциональный режим работы, нагрузку по на-
пряжению, вид приемки), схемную позицию (DD1) и количество (1) (рисунок 7.8). 
Аналогично добавляем в модуль 1-го уровня Плата1 остальные элементы. 

2 Создаем модуль 2-го уровня Блок управления. Для этого в дереве моду-
лей выбираем узел Модули 2-го уровня, нажимаем на кнопку «Модуль»  
и выбираем пункт Создать модуль 2-го уровня. В появившемся окне вводим 
шифр Блок 1 и децимальный номер БГУИ.943010.001 блока. Нажимаем на 
кнопку ОК – модуль Блок 1 создан. 

Далее необходимо внести в модуль Блок 1 его составляющие. В дереве мо-
дулей выбираем узел Модули 2-го уровня и раскрываем его двойным нажати-
ем на левую кнопку мыши. В раскрытом узле находим модуль Блок управления 
и выделяем его. Затем добавляем в Блок управления модуль Плата 1. Для этого 
при выделенном модуле Блок управления нажимаем на кнопку Модуль и вы-
бираем пункт Добавить модуль 1-го уровня в модуль 2-го уровня, в появив-
шемся окне выбираем модуль 1-го уровня Плата1, указываем схемную позицию 
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(A1) и количество модулей (1) (рисунок 7.9), нажимаем на кнопку ОК. Модуль 
Плата1 добавлен в модуль Блок управления. 

 
Рисунок 7.8 – Диалоговое окно Редактировать ЭРИ в модуле 1-го уровня:  

вставка импортных ЭРИ  
 

 
Рисунок 7.9 – Диалоговое окно Редактировать  
модуль 1-го уровня в модуле 2-го уровня 

 

Добавляем в Блок управления соединитель РБН1. Для чего при выделен-
ном модуле Блок управления нажимаем на кнопку Модуль и выбираем пункт 
Добавить ЭРИ в модуль 2-го уровня, в появившемся окне в дереве класс-
группа-тип раскрываем иерархию: отечественная элементная база –> соеди-
нители низкочастотные и радиочастотные –> соединители низкочастотные 
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цилиндрические для объемного монтажа нормальных габаритов –> РБН1 или 
ищем ЭРИ, нажав на кнопку Поиск. Вводим все параметры ЭРИ (коэффициент 
нагрузки по току, количество задействованных контактов, количество сочлене-
ний-расчленений, вид приемки), схемную позицию (XP1) и количество (1), на-
жимаем ОК. 

Добавляем в Блок управления пять кнопок. Для чего при выделенном мо-
дуле Блок управления нажимаем на кнопку Модуль и выбираем пункт Доба-
вить ЭРИ в модуль 2-го уровня. В появившемся окне в дереве класс-группа-
тип раскрываем иерархию: отечественная элементная база –> соединители 
низкочастотные и радиочастотные –> коммутационные изделия –> кнопки  
и кнопочные переключатели –> тип не существенен. Далее устанавливаем па-
раметры кнопок (коэффициент нагрузки по току, количество задействованных 
контактов, количество сочленений-расчленений, вид приемки), схемную пози-
цию (SA1-SA5) и количество (5) и нажимаем ОК. Все ЭРИ модуля второго 
уровня внесены.  

Выбираем Блок1 и нажимаем на кнопку Расчет  на панели инструмен-
тов или выбираем пункт меню Расчет надежности... .  

Выбираем основные исходные данные: 
− режим – эксплуатации; 
− группу аппаратуры – 3.3–3.4; 
− температуру окружающей среды – 25 °С. 
Отмечаем состав отчета (данные о надежности ЭРИ и (или) коэффициенты 

моделей) (рисунок 7.10) и нажимаем на кнопку Просмотр.  
Результат расчета отображается на экране (приложение Ж) и может быть 

распечатан на принтере при нажатии кнопки Print. 

 
Рисунок 7.10 – Диалоговое окно Выберите общие данные для расчета 

 

Полученные результаты необходимо проанализировать, сравнить с исход-
ными данными в задании на курсовое проектирование и, при необходимости, 
откорректировать схему и (или) конструкцию устройства с целью повышения 
ее надежности. 
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7.5 Конструирование и расчет печатных плат 
Для межконтактных соединений в конструкциях ЭЛА на первом иерар-

хическом уровне (ячеистый монтаж) применяется в основном печатный мон-
таж (с помощью печатных плат). Применение печатных плат создает предпо-
сылки для механизации и автоматизации процессов сборки ЭЛА, повышает их 
надежность, обеспечивает повторяемость параметров монтажа (емкость, индук-
тивность) от образца к образцу. 

Печатные платы – это элементы конструкции, которые состоят из плоских 
проводников, контактных площадок и металлизированных отверстий, разме-
щенных на диэлектрическом основании и обеспечивающих соединение элемен-
тов электрической цепи. Они получили широкое распространение в производ-
стве ЭЛА. 

По конструктивному исполнению различают: односторонние (ОПП), дву-
сторонние (ДПП), многослойные (МПП) и гибкие (ГПП) печатные платы.  

Печатные платы имеют основные технические требования в соответствии 
с ГОСТ 23752-79. Элементами печатных плат являются диэлектрическое осно-
вание, металлическое покрытие в виде рисунка печатных проводников и кон-
тактных площадок, монтажные и фиксирующие отверстия. ГОСТ 23752-79 оп-
ределяет требования к конструкции и внешнему виду ПП, к устойчивости при 
климатических и механических воздействиях и т.д. 

Основные технические требования к печатным платам: 
1 Габаритные размеры печатной платы не превышают установленных зна-

чений для следующих типов: особо малогабаритных − 60×90 мм; малогабарит-
ных − 120×180 мм; крупногабаритных − 240×360 мм. Толщина печатной платы 
выбирается из следующего ряда значений: 0,8; 1,0; 1,5; 2,0; 2,5; 3,0 мм. Допус-
тимые отклонения по толщине не должны превышать: при толщине до 1 мм − 
±0,15 мм; до 2 мм – ±0,20 мм; до 3 мм − ±0,30 мм. 

2 Плотность монтажа определяется шириной проводников и расстоянием 
между ними. В соответствии с ГОСТ 23751-86 для печатных плат установлено 
пять классов точности монтажа. 

3 Трассировку рисунка схемы проводят по координатной сетке с шагом 2,5; 
1,25; 0,625 мм, а также 0,5 мм по ГОСТ 10317-79. Минимальные диаметры от-
верстий, располагаемых в узлах координатной сетки, зависят от максимального 
диаметра вывода навесного элемента, наличия металлизации и толщины платы. 

4 Плотность тока в печатных проводниках наружных слоев плат не должна 
превышать 20 А/мм². 

5 Сопротивление изоляции зависит от материала диэлектрического осно-
вания и характера электрических цепей, для стеклотекстолита оно должно быть 
не менее 104 МОм. 

6 Плотность сцепления печатных проводников с основанием не менее 
15 МПа. 

7 Допустимый уровень рабочего напряжения зависит от расстояния между 
проводниками: для 2–4 классов Uраб − до 50 В, для 1 класса Uраб − до 100 В. 

Би
бл
ио
те
ка

 БГ
УИ
Р



 66 

8 Контактные площадки должны смачиваться припоем за 3–5 с и выдер-
живать не менее трех перепаек. 

В соответствии с ГОСТ 10317-79 рекомендуется использовать платы пря-
моугольной формы, размеры каждой стороны печатной платы должны быть 
кратными: 2,5; 5 или 10 при длине соответственно до 100, до 350 и свыше 
350 мм. Максимальный размер любой из сторон не должен превышать 470 мм, 
соотношение сторон – не более 3 : 1. Данные ограничения обусловлены в ос-
новном возможностями технологического оборудования по изготовлению пе-
чатных плат (ПП). При необходимости возможно отклонение габаритов, соот-
ношения сторон и формы ПП от рекомендуемых. 

ГОСТ 23751-86 устанавливает основные конструктивные параметры ПП 
(размеры печатных проводников, зазоров, контактных площадок, отверстий  
и т.п.), электрические параметры и т.д. 

При выборе толщины печатных плат учитывают метод изготовления  
и предъявляемые к ним механические требования. 

При проектировании ПП применяют следующие способы конструирования: 
ручной, полуавтоматический, автоматический. Автоматический метод конструи-
рования ПП с использованием специализированных пакетов автоматизированного 
проектирования (P-CAD, OrCAD и т.п.) в настоящее время является основным. 

 
7.5.1 Последовательность разработки и расчета конструкции ПП 
1 Анализ ТЗ и выбор группы жесткости. 
2 Выбор типа ПП. 
3 Выбор класса точности ПП. 
4 Выбор размеров и конфигурации ПП. Компоновочный расчет. 
5 Выбор материалов ПП. 
6 Расчет элементов печатного рисунка. 
7 Выбор и размещение элементов печатного рисунка. 
8 Трассировка печатных проводников. 
9 Маркировка и контроль. 
10 Оформление КД. 
 
7.5.2 Анализ ТЗ и выбор группы жесткости 
На данном этапе определяют условия эксплуатации, хранения и транспор-

тировки РЭС, условия сборки узлов, требования по ремонтопригодности, тех-
нологичности, стоимости и т.д. 

Затем определяют группу жесткости по климатическим факторам. В соот-
ветствии с ГОСТ 23752-79 выделяют 4 группы жесткости (таблица 7.5). 
Таблица 7.5 – Группы жесткости печатных плат 

Группа жесткости Воздействующий фактор 1 2 3 4 
Температура окр. среды, ОС –25..+55 –40..+85 –60..+100 –60..+120 
Относ. влажность, % 75 93 98 98 
Давление, кПа, (мм. рт. ст.) 101 (760) 53,6(400) 53,6(400) 0,67(5) 
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7.5.3 Выбор типа ПП 
В зависимости от сложности схемы, реализуемой на ПП, а также руково-

дствуясь возможностями технологического оборудования и экономическими 
критериями, выбирают тип ПП: ОПП, ДПП или МПП. При выборе типа ПП 
следует учитывать, что трудоемкость изготовления ПП приблизительно оцени-
вается пропорцией ОПП:ДПП:МПП = 1:4:20. ОПП наиболее простые и деше-
вые, но имеют малые коммутационные способности. В современных РЭС наи-
более часто используют ДПП и МПП. 

 
7.5.4 Выбор класса точности ПП 
Класс точности определяет наименьшие минимальные значения основных 

размеров конструктивных элементов (ширина проводника, расстояния между 
центрами 2-х проводников (контактных площадок), ширина гарантийного поя-
ска металлизации контактной площадки и др.). ГОСТ 23751-86 определяет 5 
классов точности. Минимальные размеры конструктивных элементов умень-
шаются с 1-го по 5-й класс точности (таблица 7.6).  
Таблица 7.6 – Классы точности печатных плат 

Класс точности* Параметр 2 3 4 5 
Мин. ширина проводника, t, мм 0,45 0,25 0,15 0,10 
Мин. расстояние между центрами провод-
ников, S, мм 0,45 0,25 0,15 0,10 

Мин. ширина гарантийного пояска, B, мм 0,20 0,10 0,05 0,025 
Отношение диаметра мин. отв. к толщине 
ПП (γ) 1:2,5 1:3 1:4 1:5 

* – 1-й класс в настоящее время практически не используется. 
 

При использовании технологии поверхностного монтажа, а также ИМС 
высокой степени интеграции необходимо разрабатывать ПП 3-го и 4-го классов 
точности. 

 
7.5.5 Выбор размеров и конфигурации ПП 
Предварительный выбор размеров и конфигурации ПП выполняется на 

стадии компоновочного расчета (см. подраздел 7.2). 
Размеры и конфигурация ПП определяются конструктивными параметра-

ми блоков ЭЛА более высокой иерархии. При выборе размеров ПП необходимо 
придерживаться следующего принципа: максимальное количество связей вы-
полнять с помощью печатного монтажа, а также внутри корпусов ИМС и т.п.  

Быстродействие, установочные размеры, эксплуатационные характеристи-
ки, технологические особенности, автоматизация и т.п. также влияют на выбор 
размеров и конфигурации ПП. Необходимо выбирать размеры и конфигурацию 
ПП по ГОСТ 10317-79. 

Толщину ПП определяют в зависимости от механических нагрузок на ПП 
и диаметра отверстий. 
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Обычно соблюдается правило: 
     H > (2,5–5) ∙ d0, (7.8) 
где H – толщина ПП; 

d0 – минимальный диаметр отверстий. 
Для ОПП и ДПП толщина определяется 
 фM hnHH ⋅+= , (7.9) 
где HM – толщина материала основания; 

n – количество слоев ПП; 
hф – толщина фольги. 

Для МПП: 

 ( ) П

n

j
прj

n

i
Ci hHHH 29,06,0

1

11
+++= ∑∑

−

==
, (7.10) 

где HCi, Hпрj – номинальная толщина материала слоя и прокладки, причем 
последняя должна быть не менее двух толщин печатных 
проводников; 

hП – толщина нанесенных на плату покрытий. 
 
7.5.6 Выбор материалов ПП 
Физико-механические свойства материалов должны удовлетворять уста-

новленным ТУ и обеспечивать качественное изготовление ПП в соответствии  
с типовыми ТП. Для изготовления плат применяют слоистые пластики, в том 
числе фольгированные диэлектрики, плакированные электролитической мед-
ной фольгой толщиной 5, 20, 35, 50, 70 и 105 мкм с чистотой меди не менее 
99,5 %, шероховатостью поверхности не менее 0,4–0,5 мкм, которые поставля-
ются в виде листов размерами 500×700 мм и толщиной 0,06–3 мм.  

В качестве основы в слоистых пластиках используют стеклотекстолиты – 
спрессованные слои стеклоткани,  пропитанные эпоксифенольной смолой, и дру-
гие материалы (таблица 7.7). Они отличаются широким диапазоном рабочих тем-
ператур, низким (0,2–0,8 %) водопоглощением, высокими значениями объемного 
и поверхностного сопротивлений, стойкостью к короблению. Смолы определяют 
практически все электрические и механические характеристики материала (пре-
дел прочности, влагопоглощение, сопротивление изоляции, электрическую проч-
ность, диэлектрическую проницаемость, потери и т.п.). Выбор материала ПП 
также зависит от технологии изготовления ПП. 

Характеристики некоторых диэлектриков приведены ниже. 
Общие характеристики ламинатов FR4: 
− класс огнестойкости – 94V-0; 
− весь материал поставляется с ультрафиолетовой блокировкой; 
− возможная толщина фольги – от 18 до 105 мкм; 
− стандартный размер листа 1041х1245 мм. По заказу могут поставляться 

листы других размеров.  
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CEM-1 – ламинат на основе композиции целлюлозной бумаги и стеклотка-
ни с эпоксидной смолой. Применяется при производстве плат, в которых не 
требуются высокие свойства стеклотекстолита FR4.  

KB 2150 GC (FR-2) – фольгированный гетинакс (основа из целлюлозной 
бумаги, пропитанной фенольной смолой), широко применяется при изготовле-
нии печатных плат для бытовой электроники, аудио-, видеотехники, в автомо-
билестроении. Обладая всеми свойствами FR2, данный материал обладает по-
вышенными показателями жаро- и влагоустойчивости. Не содержит галогенов 
и сурьмы. 
Таблица 7.7 – Основные материалы для изготовления плат 

Толщина Материал Марка фольги, мкм материала, мм 
Область 
применения 

Стеклотекстолит:     
травящийся ФТС-1(2) 18;35 0,08–0,5 МПП, ДПП 
с адгезионным слоем СТЭК  1,0–1,5 ДПП 

Фольгированный  
диэлектрик (ламинаты и 
препреги): 

    

ламинат GFN PND 39 18;35 0,8–3 ДПП 
ламинат CEM-1, CEM-3 18;35 0,8–3 ДПП 
ламинат FR-1, FR-2 18;35 0,8–3 ДПП 
ламинат FR-4 LamPlex 18;35 0,8–3 ДПП 
ламинат FR-5 18;35 0,8–3 ДПП 
Тонкий диэлектрик ФДТ-1 50 0,5 МПП 
для МПП ФДМ-1(2) 35 0,2–0,35 МПП 

СП-1-0,0025  0,0025 МПП Стеклоткань  
прокладочная СП-2-0,1  0,1 МПП 

 
Для защиты контактных площадок и концевых ламелей  ПП от внешних 

воздействий в настоящее время используют различные конструктивные покры-
тия (таблица 7.8). 

Таблица 7.8 – Толщина различных финишных покрытий 
Тип покрытия Толщина (мкм) 

ПОС-61 оплавлением  
(маска по ПОС) 10–15 допускаются наплывы 

ПОС-63 методом HAL  
(hot air leveling – выравнивание 

горячим воздухом) 
(маска по меди) 

12–18 не допускаются наплывы 

Hard Gold 2,5-5 – Ni / 0,025-0,4 – Au 
Immersion Gold 2,5-5 – Ni / 0,076-0,25 – Au 

Gold Fingers 2,5-5 – Ni / 0,127-0,76 – Au 
Ni 2,54-7,6 

 
В технических требованиях к плате печатной указываются обозначения 

только конструктивных покрытий, например Хим.М.М24 О-С(61) 10-15 опл, 
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ПОС 63 12-18 опл (HAL). При использовании в качестве покрытия драг-
металлов необходимо указывать массу покрытия. 

Сверху на ПП для защиты проводников от замыканий при пайке и т.п. на-
носят слой диэлектрической защиты (лак, эмаль, пленочные резисты и т.п.) 
(таблица 7.9). 
Таблица 7.9 – Защитные паяльные маски 

Тип покрытия, производитель Характеристики, область применения 

TAMURA FINEDEL DSR-2200TT 19G 
(Япония) 

Жидкая двухкомпонентная фоточувствительная за-
щитная паяльная маска зеленого цвета. Устойчива к 
растворителям и очистителям  

FSR 8000-8G 
UNION SOLTEK GROUP (Тайвань) 

Маска обладает высокими адгезионными свойствами, 
слабым запахом, технологична, устойчива к процес-
сам электролитической металлизации (никелирова-
ние, золочение), горячего лужения (HAL). Покрытие 
глянцевое 

FSR 8000-11G 
UNION SOLTEK GROUP (Тайвань) 

Маски данной серии образуют матовое покрытие с 
ярко выраженными антибликовыми свойствами. 
Маска устойчива к процессам электролитической ме-
таллизации (никелирование, золочение), горячего 
лужения (HAL) 

FSR 8000-10W 
UNION SOLTEK GROUP (Тайвань) 

Маска белого цвета. Пригодна как в качестве защит-
ного паяльного резиста, так и для нанесения марки-
ровки при производстве единичных и мелкосерий-
ных партий печатных плат. Устойчива к процес-
сам никелирования, золочения, горячего лужения 
(HAL) 

Полиуретановый лак URETHAN clear 
(аналог лака УР-231) 

Специально разработан для печатных плат, электрон-
ных компонентов и электротехники. Используется 
как прочное защитное покрытие. Лак однокомпо-
нентный, полностью готовый к употреблению 

 
7.5.7 Расчет элементов печатного рисунка 
Расчет печатного монтажа состоит из трех этапов: расчет по постоянному 

и переменному току и конструктивно-технологический расчет. Ниже приводит-
ся рекомендуемый порядок расчета. 

1 Исходя из технологических возможностей производства выбирается ме-
тод изготовления и класс точности ПП. 

2 Определяем минимальную ширину печатного проводника по постоянно-
му току для цепей питания и заземления, мм: 

 max
min

доп
,Ib

j t
=

⋅
 (7.11) 

где maxI – максимальный постоянный ток через проводник, А (определя-
ется из анализа электрической схемы); 

допj – допустимая плотность тока, выбирается в зависимости от ме-
тода изготовления ПП (таблица 7.10); 

t –толщина проводника, мм. 
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3 Определяем минимальную ширину проводника, мм, исходя из допусти-
мого падения напряжения на нем: 

 max
min2

доп
,I p lb

U t
⋅ ⋅

=
⋅

 (7.12) 

где p – удельное объемное сопротивление материала (см. таблицу 7.10); 
l – максимальная длина проводника, м; 
допU  – допустимое падение напряжения, В (определяется из анализа 

электрической схемы). 
Таблица 7.10 – Допустимая плотность тока в зависимости от метода изготовления 
Метод изготовления Толщина фольги, t, 

мм 
Допустимая плотность 
тока, допj , А/мм2 

Удельное сопро-
тивление, ρ, 
Ом·мм2/м 

Химический: 
внутренние слои 

МПП 
наружные слои 
ОПП, ДПП 

 
20, 35, 50 

 
20, 35, 50 

 
15 
 

20 
0,050 

Комбинированный  
позитивный 

18 
35 
50 

75 
48 
38 

0,0175 

Электрохимический - 25 0,050 
 

Допустимое падение напряжения на проводниках не должно превышать 5 % 
от питающего напряжения для микросхем и запас помехоустойчивости. 

4 Определяем  номинальное значение диаметров монтажных отверстий d: 
 .= + + ,Э Н Оd d d r∆  (7.13) 

где Эd  – максимальный диаметр вывода устанавливаемого ИЭТ, мм; 
ОНd .∆  – нижнее предельное отклонение от номинального диаметра монтаж-
ного отверстия (определяется классом точности ПП и диаметром 
отверстия) (таблица 7.11), мм; 

r – разница между минимальным диаметром отверстия и максимальным 
диаметром вывода ИЭТ, ее выбирают в пределах 0,1…0,4 мм.  

Рассчитанные значения d сводят к предпочтительному ряду отверстий: 0,7; 
0,9; 1,1; 1,3; 1,5 мм и т.д.  

5 Рассчитываем диаметр контактных площадок. Минимальный диаметр кон-
тактных площадок для ОПП и внутренних слоев МПП, изготовленных химиче-
ским методом: 

 03,05,1min1min +⋅+= ФhDD , (7.14) 
где hФ – толщина фольги; 

D1min – минимальный эффективный диаметр площадки: 

 max
1min 2 ,2M

dD b d pδ δ = ⋅ + + + 
 

 (7.15) 
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где bМ – расстояние от края просверленного отверстия до края контактной 
площадки;  

δd и δр – допуски на расположение отверстий и контактных площадок 
(см. таблицу 7.11); 

dmax – максимальный диаметр просверленного отверстия, мм: 
 ( )15,01,0max K+∆+= ddd , (7.16) 
где d – допуск на отверстие (см. таблицу 7.11). 

Таблица 7.11 – Допуски  на расположение отверстий  и контактных площадок 
Класс точности ПП Параметры 2 3 4 5 

Допуск на отверстие Δd, мм, без металлизации: 
d<1 мм 

 
±0,10 

 
±0,05 

 
±0,05 

 
±0,025 

d>1 мм ±0,15 ±0,10 ±0,10 ±0,10 
Допуск на отверстие Δd, мм, с металлизацией и оплавлением: 

d<1 мм  
 

+0,05 
-0,18 

 
+0,00 
-0,13 

 
+0,00 
-0,13 

 
+0,00 
-0,13 

d>1 мм +0,10 
-0,23 

+0,05 
-0,18 

+0,05 
-0,18 

+0,05 
-0,18 

Допуск на ширину проводника Δb, мм: 
без покрытия 

 
±0,10 

 
±0,05 

 
±0,03 

+ 0 
-0,03 

с покрытием +0,15 
-0,10 ±0,10 ±0,05 ±0,03 

Допуск на расположение отверстий δd, мм,  
при размере платы: 

менее 180 мм 

 
 

0,15 

 
 

0,08 

 
 

0,05 

 
 

0,05 
от 180 до 360 мм 0,20 0,10 0,08 0,08 
более 360 мм 0,25 0,15 0,10 0,10 

Допуск на расположение контактных площадок δp, мм, 
на ОПП и ДПП при размере платы: 

менее 180 мм 

 
 

0,25 

 
 

0,15 

 
 

0,10 

 
 

0,05 
от  180 до 360 мм 0,30 0,20 0,15 0,08 
более 360 мм 0,35 0,25 0,20 0,15 

Допуск на подтравливание диэлектрика МПП Δdтp, мм 0,03 0,03 0,03 0,03 
Допуск на расположение контактных площадок δр, мм, на 
МПП (внутренний слой) при размере платы:  

менее 180 мм 

 
 

0,30 

 
 

0,20 

 
 

0,15 

 
 

0,10 
от 180 до 360 мм 0,35 0,25 0,15 0,10 
более 360 мм 0,40 0,30 0,25 0,20 

Допуск на расположение проводников, мм: 
на ОПП и ДПП δl, 

 
0,10 

 
0,05 

 
0,03 

 
0,02 

на МПП (внутренний слой) 0,15 0,10 0,08 0,05 
Расстояние от края просверленного отверстия до края  
контактной площадки, bм, мм 

 
0,045 

 
0,035 

 
0,025 

 
0,015 

 

Минимальный диаметр контактных площадок для ДПП и наружных слоев 
МПП, изготовляемых комбинированным позитивным методом: 

при фотохимическом способе получения рисунка 
 min 1min 1,5 0,03ФD D h= + ⋅ + ; (7.17) 
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при сеточнографическом способе получения рисунка 
 min 1min 1,5 0,08ФD D h= + ⋅ + . (7.18) 
Для ДПП и наружных слоев МПП, изготовляемых электрохимическим ме-

тодом: 
при фотохимическом способе получения рисунка 
 min 1min 0,03D D= + ; (7.19) 
при сеточнографическом способе получения рисунка 
 08,0min1min += DD . (7.20) 
Максимальный диаметр контактной площадки 
 ( )06,002,0minmax K+= DD . (7.21) 
Для каждого типоразмера ИЭТ проводится расчет диаметров отвер-

стий и контактных площадок. 
6 Определяем ширину проводников. Минимальная ширина проводников 

для ОПП и внутренних слоев МПП, изготовляемых химическим методом: 
 min 1min 1,5 фb b h= + , (7.22) 
где b1min – минимальная эффективная ширина проводника (b1min = 0,15 мм 

для плат 1- и 2-го классов точности, b1min = 0,10 мм для плат 3- и 
4-го классов точности). 

Минимальная ширина проводников для ДПП и наружных слоев МПП, из-
готовляемых комбинированным позитивным методом: 

при фотохимическом способе получения рисунка 
 03,05,1min1min ++= фhbb ; (7.23) 
при сеточнографическом способе получения рисунка 
 08,05,1min1min ++= фhbb . (7.24) 
Для ДПП и наружных слоев МПП, изготовляемых электрохимическим ме-

тодом: 
при фотохимическом способе получения рисунка 
 03,0min1min += bb ; (7.25) 
при сеточнографическом способе получения рисунка 
 08,0min1min += bb . (7.26) 
Максимальная ширина проводников 
 )06,0...02,0(min1min += bb . (7.27) 
7 Определяем минимальное расстояние между элементами проводящего 

рисунка. 
Минимальное расстояние между проводником и контактной площадкой 
 ( ) ( )[ ]lbpDLs δδ +++−= 2/2/ maxmax0min1 , (7.28) 
где L0 – расстояние между центрами рассматриваемых элементов; 

lδ – допуск на расположение проводников (см. таблицу 7.11). 
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Минимальное расстояние между двумя контактными площадками 

 ( )[ ]pDLs δ+−= max0min1 . (7.29) 
Минимальное расстояние между двумя проводниками 
 ( )[ ]lDLs δ+−= max0min1 . (7.30) 
8 Величина паразитной емкости между двумя проводниками, пФ: 

 ,2ln

12,0

n

n
пар

th
S

lС

+
⋅

⋅⋅
=

ε
 (7.33)  

где ε  – диэлектрическая проницаемость материала основания печатной 
платы; 

nl – длина взаимного перекрытия проводников, мм; 
S – ширина зазора между краями печатных проводников, мм; 
h – ширина печатного проводника, мм. 

9 Индуктивность печатных проводников рассчитываем по формуле, мкГн: 

 22 2,3 0, 2235 0,5 10n n
n

n n

l h tL l
h t l

− +
= ⋅ ⋅ ⋅ + ⋅ + ⋅ + 

. (7.34) 

10 Вычисляем сопротивление изоляции печатных цепей, расположенных 
на поверхности платы: 

 ,
l
SpR SS ⋅=  (7.35) 

где SR  – сопротивление изоляции разобщенных печатных цепей, Ом; 
ps – удельное поверхностное сопротивление изоляционного основа 

ния, Ом/; 
S – изоляционный зазор разобщенных цепей, мм; 
l  – длина изоляционного зазора, м. 

Основными параметрами, обусловливающими стабильность работы печат-
ных плат, являются тангенс угла потерь δtg , диэлектрическая проницаемость 
ε , которые больше всего подвержены изменению в процессе старения органи-
ческого основания платы. Изменение диэлектрических свойств печатной плат 
(от воздействия температуры и влаги) приводит к существенным потерям, ко-
торые могут достигать 70 % от расчетной мощности схемы. Поэтому необхо-
димо произвести расчет мощности потерь печатной платы PП, Вт: 

 ,2 2 δπ tgUCfPП ⋅⋅⋅⋅⋅=  (7.36) 
где f – частота питающего напряжения схемы, мГц; 
С – емкость печатной платы, мкФ; 
U – напряжение питания, В; 

δtg – тангенс угла диэлектрических потерь материала основания платы. 
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Емкость печатной платы вычисляют по формуле, пФ: 

 ,009,0
H

FС ⋅⋅
=

ε
 (7.37) 

где F – суммарная площадь печатных проводников, мм 2 ; 
H – толщина платы, мм. 

После проведения расчетов делают вывод о том, отвечают ли параметры 
печатного монтажа требованиям, предъявляемым к платам заданного класса 
точности. 

 

7.5.8 Выбор и размещение элементов печатного рисунка 
Размещение отверстий и других элементов печатного рисунка производят 

относительно базы координат координатной сетки в соответствии с принятым 
при разработке печатного узла расположением навесных элементов и их выво-
дов. Основной шаг линий, используемый в координатной сетке, равен 2,5 мм; 
допускаются вспомогательные шаги –1,25; 0,625 и 0,5 мм (зависят от исполь-
зуемой элементной базы). 

Центры отверстий и контактных площадок располагают в узлах сетки. 
Центры монтажных отверстий под неформуемые выводы многовыводных ИЭТ, 
межцентровые расстояния которых не кратны шагу координатной сетки, следу-
ет располагать таким образом, чтобы в узле координатной сетки находился по 
крайней мере центр одного из монтажных отверстий. 

Количество типоразмеров любых отверстий на печатной плате из соображе-
ний технологичности и стоимости ПП обычно ограничивают тремя–четырьмя. 

Контактные площадки выполняют прямоугольной, круглой или близкой  
к ним формы (круглые предпочтительнее). 

Печатные проводники следует выполнять постоянной, возможно большей 
ширины и располагать равномерно, на возможно большем расстоянии от со-
седних элементов. Проводники обычно располагают параллельно линиям ко-
ординатной сетки или под углом 45° к ним. На соседних проводящих слоях 
платы проводники располагаются во взаимно перпендикулярных направлени-
ях для уменьшения перекрестных помех. Печатные проводники  шириной бо-
лее 3 мм выполняют с вырезами,  по правилам выполнения экранов. 

Концевые печатные контакты (ламели) разъемного соединителя прямого 
сочленения располагают на краю ПП.  На торце печатной платы со стороны пе-
чатных контактов снимают фаску 0,3×45°. Все печатные контакты на плате 
должны иметь износоустойчивое покрытие. 

 

7.5.9 Трассировка печатных проводников 
При создании печатных плат для электронных узлов РЭС обычно исполь-

зуется координатный способ разводки печатных проводников, предусматри-
вающий ортогональные направления проводников на разных сторонах (смеж-
ных слоях) платы. 

Для выполнения диагональных соединений и предотвращения нежелательно-
го пересечения проводника с ранее проведенными проводниками в конструкцию 

Би
бл
ио
те
ка

 БГ
УИ
Р



 76 

ПП вводятся специальные переходные отверстия, переводящие проводники на 
противоположную сторону ПП, на которой трасса продолжается (может быть ис-
пользовано и монтажное отверстие). 

Ортогональное направление трасс позволяет свести к  минимуму взаимное  
влияние и упрощает процесс разводки проводников, расположенных на разных 
слоях. Возможно также изменение направления трассы под  углом 45° или 90°  
к первоначальному направлению, а также первоначальные  сдвиги относитель-
но выбранного направления. Желательно, однако, чтобы трассы не имели фор-
му лесенки, а по возможности приближались к прямой. 

В настоящее время для трассировки ПП используют САПР с различными 
пакетами прикладных программ (P-CAD, OrCAD и т.п.). 

 
7.5.10 Маркировка и контроль 
Маркировка состоит в нанесении основной (наносимой обязательно) и до-

полнительной надписей на печатные платы (основная и дополнительная мар-
кировки).  

Маркировка выполняется краской, устойчивой к воздействию нейтральных 
растворителей, или способом, которым выполняется проводящий рисунок.  

Основная маркировка должна содержать: 
− обозначение печатной платы или ее условный шифр; 
− дату изготовления; 
− буквенно-цифровое обозначение слоя МПП. 
Дополнительной маркировкой по необходимости могут быть нанесены на 

ПП: позиционное обозначение навесных ИЭТ; изображение контуров навесных 
ИЭТ; цифровое обозначение первого вывода ИЭТ, контрольных точек; обозна-
чение положительного вывода полярного ИЭТ (знак «+») и др.  

Место расположения и данные по маркировке должны быть указаны на чер-
теже ПП в соответствии с ГОСТ 2.314-68. 

В учебных чертежах необходимо указывать как основную, так и дополни-
тельную маркировку. 

 
7.5.11 Оформление КД 
Оформление КД на печатные платы должно производиться в соответствии 

с ГОСТ 2.109-73 и ГОСТ 2.417-78.  Чертеж ОПП иди ДПП должен содержать 
основные проекции платы с печатными проводниками и другими элементами 
(отверстиями, контактными площадками и т.п.).  

Сборочный чертеж МПП должен содержать данные по сборке и контро-
лю МПП, причем чертежи слоев МПП рекомендуется изображать на отдельных 
листах. На чертеже слоя проставляют габаритные размеры. Допускается на 
слои МПП чертежи не выпускать, при этом в зависимости от характера произ-
водства слои МПП могут учитываться как детали или как материал. 
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8 АВТОМАТИЗИРОВАННОЕ ПРОЕКТИРОВАНИЕ  
ЭЛЕКТРОННОЙ ЛЕЧЕБНОЙ АППАРАТУРЫ 

 
 

8.1 Моделирование электрических схем 
Для моделирования работы радиоэлектронных устройств, в частности 

электронной лечебной аппаратуры, могут использоваться такие пакеты про-
грамм, как Simulink – расширение математического пакета MatLab, MicroCap, 
Electronics Workbench и др. 

В данном подразделе рассмотрена работа программного комплекса 
Electronics Workbench (рисунок 8.1). 

 
Рисунок 8.1 – Внешний вид экрана программы Electronics Workbench 

 
8.1.1 Подготовка к работе Electronics Workbench 
Для работы с программным комплексом Electronics Workbench V.5.0 C не-

обходим  IBM-совместимый персональный компьютер с процессором I 486 (ре-
комендуется Pentium) и операционной системой Windows (рекомендуется 
Windows 98 и выше). 

Для начала работы с программным пакетом необходимо загрузить опера-
ционную систему, установить Electronics Workbench, если это не было сделано 
ранее. Затем запустить исполняемый файл WEWB32.EXE. Произвести настрой-
ки интерфейса пользователя, если это необходимо. 
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8.1.2 Интерфейс пользователя Electronics Workbench 
Приложение Electronics Workbench представляет собой средство про-

граммной разработки и имитации электрических цепей. Интерфейс пользовате-
ля состоит из полоски меню, панели инструментов и рабочей области. 

Полоса меню состоит из следующих компонент: меню работы с файлами 
(File), меню редактирования (Edit), меню работы с цепями (Circut), меню ана-
лиза схем (Analysis), меню работы с окнами (Window), меню работы с файлами 
справок (Help) (см. рисунок 8.1). 

Панель инструментов состоит из «быстрых кнопок», имеющих аналоги в ме-
ню, кнопок запуска и приостановки схем, набора радиоэлектронных аналоговых и 
цифровых деталей, индикаторов, элементов управления и инструментов. 

 
8.1.3 Пример моделирования интегрирующей RC-цепи 
Для начала разработки необходимо загрузить файл-схему в среду 

Electronics Workbench, если этот файл уже создан и находится на одном из на-
копителей компьютера. Это делается посредством выполнения команды меню 
File/Open либо нажатием соответствующей «горячей кнопки» на панели инст-
рументов и дальнейшим выбором накопителя, каталога и имени файла. Если 
же файл еще не создан, необходимо создать его посредством выполнения ко-
манды File/New и команды File/Save as. При выполнении первой команды бу-
дет создан новый файл-схема. Вторая команда предназначена для записи фай-
ла на накопитель и установки каталога и имени, под которым будет храниться 
данная схема. 

Нанести на рабочую область Electronics Workbench модели деталей, необ-
ходимые для моделирования данной схемы. Это делается посредством нажатия 
левой кнопкой мыши на нужном наборе деталей, после чего будет выведено 
дополнительное окно, включающее в себя детали набора. Выбором соответст-
вующей детали элемент переносится на рабочую область (кнопку мыши необ-
ходимо держать нажатой до выбора места расположения элемента). Для вы-
бранного примера необходимы: источник импульсов (Function Generator), ре-
зистор (Resistor), конденсатор (Capacitor), осциллограф (Oscilloscope) и зазем-
ление (Ground). Резистор и конденсатор находятся в наборе Basics, заземление – 
в наборе Sources, осциллограф и генератор импульсов – в наборе Instruments. 

Каждый элемент имеет точки соединения, которые необходимо соединить 
для получения нужной схемы. Это делается выбором контакта левой кнопкой 
мыши и переносом ее к другому контакту, при этом создается провод, соеди-
няющий их. При необходимости на провод можно нанести узел (Connector в 
наборе Basics). Для наглядности можно перенести элементы в необходимые 
места рабочей области. Это действие осуществляется нажатием на элементе ле-
вой кнопкой мыши и переносом при удержанной в нажатом состоянии кнопке. 
При этом соединительные провода будут перемещены автоматически. При не-
обходимости можно также перемещать провода. На рисунке 8.2 представлен 
вид интерфейса Electronics Workbench после сборки RC-цепи. 
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Когда схема создана и готова к работе, для начала имитации процесса ра-
боты необходимо выполнить команду включения питания на панели инстру-
ментов. Данное действие приведет в рабочее состояние схему, и в одном из 
окон строки состояния будет показываться время работы схемы, которое не со-
ответствует реальному и зависит от скорости процессора и системы персональ-
ного компьютера. Поэтому для разработки сложных схем рекомендуется ис-
пользовать компьютеры не хуже Pentium II с тактовой частотой процессора не 
ниже 266 MГц. 

 
Рисунок 8.2 – RC-цепь в Electronics Workbench 

 

Прервать имитацию можно двумя способами. Во-первых, закончить рабо-
ту и просмотр результатов имитации можно повторным нажатием на кнопку 
включения питания. Если же нужно временно прервать работу схемы, напри-
мер, для детального исследования осциллограммы, а затем продолжить работу, 
можно воспользоваться кнопкой Pause, которая также расположена на панели 
инструментов. 

Для анализа результатов моделирования желательно изменять номиналы эле-
ментов, выводить и настраивать экраны приборов. В данном случае можно про-
смотреть осциллограмму на выходе RC-цепи. Для этого нужно вывести окно экра-
на осциллографа двойным нажатием на компоненте Oscilloscope (рисунок 8.3). 

При использовании осциллографа в Electronics Workbench имеется воз-
можность просмотра сигнала на протяжении всего времени имитации. Для это-
го можно воспользоваться кнопкой Expand и полосами прокрутки изображе-
ния. Для перевода панели в нормальный режим используется кнопка Reduce. 
Вид расширенной панели осциллографа показан на рисунке 8.4. 

Для изучения свойств RC-цепи можно изменить сигнал на ее входе. Для 
этого нужно вывести при помощи двойного нажатия кнопкой мыши на компо-
ненте на экран панель генератора импульсов (рисунок 8.5). 

При помощи генератора импульсов формируются три вида сигналов: сину-
соидальный, пилообразный и прямоугольный. В данном случае для анализа 
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нужен прямоугольный импульс. Для перевода генератора в нужный режим сле-
дует нажать соответствующую кнопку на панели. Аналогично изменяются дру-
гие параметры – частота и амплитуда сигнала.  

 
 

Рисунок 8.3 – Вид нормальной панели осциллографа Electronics Workbench 
 

 
Рисунок 8.4 – Расширенная панель осциллографа 

 

 
Рисунок 8.5 – Панель генератора импульсов 

 
Перед изменением каких-либо параметров следует отключить источники 

питания схемы, иначе возможно получение неверных результатов. 
Выходной сигнал интегрирующей цепи показан на рисунке 8.6. 
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Для изменения параметров элементов схемы требуется дважды щелкнуть 
левой кнопкой мыши на нужном элементе. При этом будет выведено окно 
свойств элемента (рисунок 8.7).  

 

 
 

Рисунок 8.6 – Сигнал на выходе интегрирующей RC-цепи 
 

 
Рисунок 8.7 – Окно параметров резистора 

 
Кроме анализа посредством прямого наблюдения за экранами инструмен-

тов Electronics Workbench позволяет выполнить дополнительные виды анализа. 
В качестве примера для данной схемы можно привести получение АЧХ- и ФЧХ-
схемы как четырехполюсника. Т.е. при расчете на вход схемы подается сигнал 
различной частоты и производится анализ зависимости вида выходного сигнала 
от входного. При этом нужно задать начальную и конечную частоты анализа. 

Для проведения этого анализа следует остановить работу цепи, т.е. восполь-
зоваться переключателем питания или кнопкой Pause и выполнить команду меню 
Analysis / AC Frequency. Перед расчетом появляется окно параметров анализа 
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(рисунок 8.8). При необходимости можно изменить некоторые из параметров: 
Start frequency (начальную частоту), End frequency (конечную частоту), Sweep 
type (тип горизонтальной оси на конечном графике), Number of points (количест-
во точек анализа). В данном случае удобно установить количество исследуемых 
точек равным 1000 для получения более гладкого графика, тип горизонтальной 
оси – логарифмическим и диапазон частот от 1 Гц до 100 кГц. 

 
Рисунок 8.8 – Параметры анализа AC Frequency 

 
Для получения графиков АЧХ и ФЧХ нужно нажать кнопку Simulate в окне 

параметров анализа, после чего будет выведено окно результатов (рисунок 8.9). 

 
 

Рисунок 8.9 – АЧХ и ФЧХ интегрирующей RC-цепи 
 
8.1.4 Моделирование режекторного фильтра для удаления помехи 
Чтобы смоделировать режекторный фильтр для удаления сетевой помехи, 

необходимо собрать схему, представленную на рисунке 8.10. Для этого следует 
нанести все компоненты схемы на рабочую область Electronics Workbench и со-
единить все контакты проводниками. 
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К входу фильтра подключены два генератора синусоидального напряже-
ния. Первый выдает сигнал (параметры сигнала: частота 5 Гц, амплитуда 
120 мВ). Второй генератор моделирует помеху в канале передачи (частота 
50 Гц, амплитуда 15 мВ). К входу и выходу схемы подключаются анализатор 
АЧХ и ФЧХ, а также осциллограф.  

 
Рисунок 8.10 – Моделирование режекторного фильтра для удаления сетевой помехи 

 

За сигналом на выходе фильтра удобно наблюдать, используя расширен-
ное окно терминала осциллографа (рисунок 8.11, а). В результате моделирова-
ния схемы получаем АЧХ прибора (рисунок 8.11, б). 

Для получения более точной модели следует заменить идеальные компо-
ненты реальными моделями существующих элементов. Electronics Workbench 
включает в себя достаточно большое количество реальных моделей деталей 
широко известных производителей. 

После завершения работы с программным комплексом нужно закрыть про-
грамму, предварительно сохранив файл со схемой, если это необходимо. 

По результатам моделирования необходимо произвести корректировку 
схемы электрической принципиальной и перечня элементов разрабатываемого 
аппарата ЭЛА. 

 
 

8.2 Проектирование печатных узлов в P-CAD 
 
Система автоматизированного проектирования (САПР) электронной аппа-

ратуры P-CAD на сегодняшний день является одной из самых мощных, полных 
и последовательных систем автоматизированного проектирования для персо-
нальных компьютеров. 

САПР P-CAD представляет собой пакет специализированных модулей, 
тесно связанных друг с другом и охватывающих все этапы разработки и изго-
товления однослойных и многослойных печатных плат. 

Программные средства системы позволяют автоматизировать весь процесс 
проектирования электронных средств, начиная с ввода принципиальной схемы, 
ее моделирования, упаковки схемы на печатную плату, интерактивного разме-
щения радиоэлектронных компонентов  на плате и автотрассировки соедине-
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ний, вплоть до получения конструкторской документации и подготовки ин-
формации для производства плат на технологическом оборудовании. 

 

 
а 

 
б 

Рисунок 8.11 – Осциллограммы входного и выходного сигналов (а) и АЧХ (б)  
режекторного фильтра для удаления сетевой помехи 

 

Поставляемые с системой P-CAD библиотеки не соответствуют белорус-
ским стандартам, поэтому для успешного проектирования печатных плат важно 
уметь создавать новые библиотечные компоненты и редактировать старые. 

Интегрированные библиотеки P-CAD 2001/02 содержат компоненты 
(components), корпуса (pattern) и символы (symbol). На схеме компонент пред-
ставлен символом, а на печатной плате – корпусом. Кроме графики символа и 
корпуса в библиотеке содержится информация об упаковке в корпус (подвод 
питания, подключение выводов и т.д.). Единство символа, графики корпуса и 
упаковочной информации и составляет понятие компонента. Преимущество 
интегрированных библиотек заключается в том, что упаковочная информация 
для каждого компонента хранится в одном месте и должна вводиться всего 
один раз. 
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Поэтому при создании библиотеки компонентов в PCAD 2001/05 необхо-
димо: 

1) создать новую библиотеку; 
2) в редакторе Symbol Editor создать символ компонента и сохранить его в 

библиотеку под своим именем; 
3) в редакторе Pattern Editor создать корпус компонента и сохранить его в 

библиотеку под своим именем; 
4) в блоке Library Executive произвести объединение (упаковку) корпуса и 

символа в один компонент. 
 
8.2.1 Создание библиотеки компонентов 
Все необходимые действия с библиотеками выполняются с помощью ме-

неджера библиотек Library Executive. 
Новая библиотека создается командой меню Library/New. В открывшемся 

диалоговом окне (рисунок 8.12) с помощью команды  Create New Folder  
создаем новую папку проекта (например папку MyProject) и записываем новую 
библиотеку MyLibrary (кнопка Save). 

 
Рисунок 8.12 – Диалоговое окно Library New 

 
8.2.2 Создавать символы компонентов можно тремя различными спосо-

бами: 
1) в редакторе  P-CAD  Schematic; 
2) в редакторе P-CAD  Symbol Editor; 
3) путем редактирования существующего символа компонента. 
Наиболее удобно создавать символы компонентов в редакторе P-CAD  

Symbol Editor. 
Редактор P-CAD  Symbol Editor имеет аналогичный с основным редактором 

P-CAD Schematic экран (рисунок 8.13). В P-CAD Symbol Editor работают с файла-
ми библиотек (*.LIB) и отдельных символов (*.SYM). Система единиц, набор 
толщин линий и ряд других глобальных параметров P-CAD Symbol Editor сохра-
няются в файле конфигурации SymEd.INI: например, система единиц устанавли-
вается с помощью ключевого слова Units, принимающего значения 0 – mil, 1 – 
inch, 2 – мм. По умолчанию устанавливается сетка 100 mil или 2,54 мм, поэтому 
необходимо предварительно настраивать параметры редактора в меню Options. 
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Рисунок 8.13 – Диалоговое окно Symbol Editor 

При создании символов компонентов с большим количеством выводов 
удобен «Мастер символов», вызываемый по команде Symbol Wizard меню 
Symbol или кнопкой . В его диалоговом окне (рисунок 8.14) указывается сле-
дующая информация: Symbol Width – ширина символа; Pin Spacing – расстоя-
ние между смежными выводами; Length – длина вывода (Short, Normal, Long, 
User); Number Pin Left (Right) – количество выводов на левой (правой) сторо-
не символа; Symbol Outline – необходимость изображать контур символа; Line 
Width – ширина линии контура символа; Display Pin Name (Pin Des) – необхо-
димость указывать на чертеже символа имена (номера) выводов; Default Pin 
Name – имя первого вывода, принимаемое по умолчанию (не более 20 симво-
лов); Default Pin Designator – номер первого вывода, принимаемый по умолча-
нию; Current Pin Number – порядковый номер текущего вывода. 

Нажатие на клавишу Finish завершает создание символа, и его изображе-
ние заносится в библиотеку по команде Symbol>Save или Symbol>Save As.  
В связи с тем, что «Мастер символов» всегда создает прямоугольный символ 
без разбиения на зоны, графику символа обычно требуется редактировать.  

При ручном рисовании символа полезна команда Place>Pin, диалоговое 
окно которой (рисунок 8.15) в удобной форме содержит всю информацию, не-
обходимую для настройки режима размещения выводов символов, и окно для 
просмотра их графики. 
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Рисунок 8.14 – Диалоговое окно Symbol Wizard 

 
 

 
Рисунок 8.15 – Диалоговое окно Place Pin 

 

Проверка корректности создания символа компонента осуществляется  
с помощью команды Utils/Validate или кнопки . Если обнаружена ошибка, 
откроется окно с описанием ошибки (рисунок 8.16, а). В данном случае воз-
никла ошибка Found duplicate pin number (найдены выводы с одинаковыми но-
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мерами). Если ошибок не обнаружено, появится окно (рисунок 8.16, б) со стро-
кой No errors found! – ошибок не обнаружено и такой символ разрешается зано-
сить в библиотеку. 

 

 

 

 
а  б 

Рисунок 8.16 – Проверка символа компонента на ошибки 
 
С помощью P-CAD Symbol Editor вводятся атрибуты символов, сохраняе-

мые в библиотеках. Эти атрибуты вводятся и редактируются по команде 
Symbol>Attributes  или по команде Place>Attribute . Удобнее вводить ат-
рибуты с помощью P-CAD  Symbol Editor, а не с помощью P-CAD Schematic, 
так как при создании библиотеки компонентов с однотипными атрибутами 
проще их ввести один раз, копировать вместе с символом и затем редактиро-
вать. 

8.2.3 Создавать корпуса компонентов можно тремя различными спосо-
бами: 

1) в редакторе  P-CAD  РСВ; 
2) в редакторе P-CAD  Pattern Editor; 
3) путем редактирования существующего корпуса компонента. 
Наиболее удобно создавать символы компонентов в редакторе P-CAD   

Pattern Editor.  
При создании корпуса компонента необходимо помнить, что создается 

проекция корпуса на плату с отформованными выводами. В общем случае вид 
проекции корпуса может значительно отличаться от внешнего вида кор-
пуса компонента. 

Экран редактора корпусов компонентов P-CAD Pattern Editor (рису-
нок 8.17) в основном такой же, как экран основного редактора P-CAD PCB.  
В нем работают с файлами библиотек (*.LIB) и отдельных корпусов (*.РАТ). 

В P-CAD Pattern Editor параметры конфигурации сохраняются в файлах 
отдельных символов «*.РАТ». Поэтому можно установить необходимый набор 
сеток и сохранить «пустой» файл шаблона корпуса по команде 
File>Copy To File As. Система единиц и ряд других глобальных параметров со-
храняются в файле конфигурации PatEd.INI. Перед вызовом программы  
P-CAD Pattern Editor устанавливается нужный файл конфигурации и по коман-
де File>Open загружается шаблон корпуса. 

По команде Options/Pad Style осуществляется просмотр и изменение сте-
ков контактных площадок. Размеры контактных площадок и диаметры отвер-
стий для печатных плат определяются в соответствии с выбранным классом 
точности. 
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Рисунок 8.17 – Экран P-CAD Pattern Editor 

 

При начальной загрузке программы в окне Options Pad Style (рисунок 8.18, а) 
в разделе Current Style показан только один стиль [Default] (по умолчанию). 
Он используется как прототип для разработки остальных стилей для стеков 
контактных площадок. Для примера создадим новый стиль для монтажного от-
верстия с круглой и прямоугольной контактными площадками с внутренним 
диаметром d=1,0 мм и внешним D=1,4 мм. Для этого в окне Options Pad Style 
щёлкаем по кнопке Copy, в открывшемся окне Copy Pad Style вводим имя для 
круглой контактной площадки (например КР1,0/1,4) и затем щёлкаем по кнопке 
OK (рисунок 8.18, б). 

 

  
а б 
Рисунок 8.18 – Диалоговое окно Options Pad Style 
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Для редактирования простого стека контактных площадок (форма и раз-
мер контактных площадок одинаковы на всех слоях платы) необходимо вы-
брать кнопку  Modify (Simple). В открывшемся окне Modify Pad Style устанав-
ливаем следующие параметры. В разделе типа отверстия Type указываем 
сквозное Thru (используются компоненты со штыревыми выводами). В разделе 
формы контактной площадки Shape указываем значение Ellipse (эллиптиче-
ская), а в полях ширины Width и длины Height контактной площадки указыва-
ем значение 1.4. В разделе Hole в поле Diameter указываем диаметр отверстия 
1.0 и устанавливаем флажок Plate (металлизация) (рисунок 8.19). 

 

 
Рисунок 8.19 – Диалоговое окно Modify Pad Style 

 

Аналогично создается и редактируется стиль для прямоугольной контакт-
ной площадки, используемой для компонентов поверхностного монтажа, но в 
разделе типа отверстия Type указываем Top (сверху платы). В разделе формы 
контактной площадки Shape указываем значение Rectangle (прямоугольная), а 
в полях ширины Width и длины Height контактной площадки указываем зна-
чения, соответствующие справочным или рассчитанным данным о контактной 
площадке конкретного компонента. Раздел Hole при этом будет недоступным. 

Затем по команде Pattern Wizard  вызывается «Мастер создания корпу-
сов компонентов». В его диалоговом окне (рисунок 8.20) указывается следую-
щая информация: Pattern Type – тип корпуса (посадочного места) компонента; 
Number of Pads Down – число строк выводов; Number of Pads Across – число 
столбцов в массиве выводов; Pad to Pad Spacing (On Center) – расстояние ме-
жду центрами выводов; Pattern Width – расстояние между крайними столбца-
ми выводов (для корпусов DIP, QUAD); Pattern Heigh – расстояние между 
крайними строками выводов (для корпуса QUAD); Pad 1 Position – расположе-
ние первого вывода (для корпусов DIP, QUAD); Pad Style – тип стека контакт-
ной площадки (КП) (отдельно для первого и остальных выводов); Silk Screen – 
необходимость изображения контура корпуса; Silk Line Width – ширина линий 
контура корпуса; Silk Rectangle Pattern Width – ширина корпуса компонента; 
Silk Rectangle Pattern Height – высота корпуса компонента; Rotate – признак 
поворота контактных площадок на 90°; Notch Type – тип скоса графики корпу-
са компонента (в верхнем левом углу, в нижнем левом углу и т.п.). 

 

Би
бл
ио
те
ка

 БГ
УИ
Р



 91 

 
Рисунок 8.20 – Диалоговое окно P-CAD Pattern Wizard 

 

Нажатие на клавишу Finish завершает создание корпуса компонента, после 
чего его изображение переносится на основной экран редактора Pattern Editor. 
Здесь его графику можно обычным способом отредактировать и затем занести  
в библиотеку по команде Pattern>Save или Pattern>Save As. 

Одному символу компонента может соответствовать несколько корпусов 
(DIP, SMT, flat-pack и т.п.). По команде Pattern>Add Pattern Graphics  к ос-
новному изображению графики корпуса компонента (оно по умолчанию носит 
название Primary) добавляется альтернативное. Назначение альтернативных 
корпусов выполняется в программе Library Executive по команде Li-
brary>Pattern Graphics. 

При редактировании существующего корпуса в рабочее окно редактора 
помещают изображение корпуса, хранящееся в библиотеке как единый объект. 
Затем его преобразуют в набор графических примитивов, что дает возможность 
внесения изменений и дополнений. После модификации корпус заносится  
в библиотеку под новым именем и сохраняется как единое целое. Последова-
тельность действий такова. 

1 Нажатием пиктограммы  включают режим выбора объектов и указы-
вают редактируемый корпус щелчком левой кнопки мыши. 

2 По команде Edit>Explode Component выбранный корпус преобразуется 
в набор графических примитивов. Если добавлены или удалены выводы компо-
нента, то нужно заново их пронумеровать по команде Utils>Renumber. Для 
этого перед выполнением команды включают режим выбора объектов, а в меню 
команды указывают режим перенумерации выводов Pad Number. После закры-
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тия меню команды все выводы, подлежащие перенумерации, по очереди поме-
чают щелчком мыши в порядке возрастания их номеров, начиная с первого (пе-
ренумерованные выводы окрашиваются). 

3 После внесения всех изменений корпус заносят в библиотеку. Сначала 
выполняют операцию блочного выбора всех принадлежащих ему графических 
объектов, заключая их в прямоугольную рамку. Далее по команде 
Library>Pattern Save As заносят корпус в библиотеку. В списке Library выби-
рают имя одной из открытых библиотек и в графе Pattern вводят имя нового 
корпуса. Если компонент будет создаваться в дальнейшем с помощью Library 
Executive или Library Manager, не нужно включать опцию Create Component. 

 
8.2.4 Менеджер библиотек компонентов 
В системе P-CAD поддерживаются два типа библиотек:  
1) интегрированные библиотеки компонентов; 
2) отдельные библиотеки символов и корпусов компонентов.  
В интегрированную библиотеку заносятся данные трех типов:  
1) текстовая информация о компонентах;  
2) графика корпусов; 
3) графика символов компонентов.  
Способы создания графики корпусов и символов указаны выше. Менеджер 

библиотек Library Manager или Library Executive заносит эти данные в интегриро-
ванную библиотеку и добавляет текстовую информацию о компонентах. 

Использование интегрированных библиотек при проектировании печатных 
плат в P-CAD  предпочтительнее, так как это позволяет осуществлять: 

− «горячую связь» между графическими редакторами; 
− прямую и обратную корректировку проекта; 
− перестановку логически эквивалентных выводов и секций компонентов. 
Содержание загруженных библиотек просматривают в графических редак-

торах по команде Place>Part или Place>Component, а также в менеджере биб-
лиотек по команде Component>Open. 

Library Executive имеет ряд дополнительных средств по сравнению с  
Library Manage: 

− добавлена команда Query для поиска компонентов в библиотеках по за-
данному набору атрибутов; 

− при использовании Library Executive стало возможно применение редак-
тора символов Symbol Editor и редактора корпусов Pattern Editor.  

Упаковка компонентов в Library Executive – самый трудоемкий и ответст-
венный этап в создании библиотечного компонента. Неправильное заполнение 
таблицы упаковки ведет к ошибочной трассировке печатной платы и даже к не-
возможности ее проектирования. 

После загрузки программы Library Executive на строке инструментов дос-
тупны только пиктограммы Component>New, Component>Open и 
View>Source Browser  (недоступные пиктограммы и строки меню окрашены 
в серый цвет, при вызове Source Browser щелчком правой кнопки мыши от-
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крывается (раскрывающееся меню, содержание которого зависит от типа объ-
екта, выбранного в окне). После загрузки существующего компонента или от-
крытия нового по командам Component>Open, Component>New на экране по-
является диалоговое окно Component Information, показанное в левом верхнем 
углу (рисунок 8.21). 

 

 
Рисунок 8.21 – Подробная информация о компоненте на экране Library Manager 

 
На трех остальных окнах этого рисунка представлена детальная информация 

о компоненте, позволяющая установить связь между выводами символа и корпуса 
компонента. Всего меню Library Executive имеет четыре основных окна. 

Окно Component Information. В этом окне представлена общая информа-
ция о компоненте: 

− в строке Select Pattern выбирается тип корпуса компонента, например 
SO 14; 

− в строке Number of Gates задается число секций в компоненте; 
− в строке Number of Pads указывается общее число выводов; 
− в строке Refdes Prefix задается префикс позиционного обозначения ком-

понента; 
− в разделе Component Type выбирают тип компонента (который прини-

мается во внимание при составлении списков соединений и заполнении граф 
отчетов о проекте): 

Би
бл
ио
те
ка

 БГ
УИ
Р



 94 

Normal – обычный компонент; Power – источник питания (компоненты та-
кого типа, в частности, не включаются в списки соединений для «упаковки» 
схемы на ПП, но включаются в списки соединений для выполнения моделиро-
вания); Sheet Connector – соединитель листов схемы; Module – символ (модуль) 
иерархической структуры; Link – связь символа модуля иерархической струк-
туры с его схемой;  

− в разделе Component Style выбирают: 
Homogeneous – однородный компонент (все секции однотипны); 
Heterogeneous – неоднородный компонент (секции разных типов); 
− в разделе Gate Numbering задают способ нумерации секций: 
Alphabetic – буквенный; Numeric – числовой (рекомендуется); 
− в разделе Alternate Views указывают альтернативные изображения сим-

волов. 
В нижней части окна располагается таблица, где для каждого типа секций 

указаны: 
Gate # – номер секции; 
Gate Eq – код логической эквивалентности секции (секции, имеющие оди-

наковый отличный от нуля код эквивалентности, могут переставляться при оп-
тимизации цепей на печатной плате); 

Normal – имя символа в нормальном изображении. 
Альтернативные обозначения символов можно использовать для введения 

их изображений по ЕСКД. 
Вверху располагаются кнопки Pins View, Pattern View и Symbol View для 

открытия окон редактирования параметров выводов компонентов. 
Окно Symbol View. В нем приведено изображение символа текущего ком-

понента и таблица с информацией о его выводах. Каждому выводу компонента 
отведена одна строка. В столбцах указана следующая информация: 

Pad # – номер вывода компонента; 
Pin Des – физический номер вывода компонента в корпусе; 
Gate # – номер секции компонента; 
Sym Pin # – порядковый номер вывода символа компонента в пределах 

секции; 
Pin Name – имя вывода символа секции компонента; 
Gate Eq – код логической эквивалентности секции компонента; 
Pin Eq – код логической эквивалентности вывода секции; 
Elec. Type – электрический тип вывода, необходимый для проверки прин-

ципиальной схемы: 
Unknown – неизвестный; Passive – вывод пассивного компонента; Input – 

вход; Output – выход; Bidirectional – двунаправленный вывод; Ореп-Н – вывод 
секции с открытым эмиттером; Open-L – вывод секции с открытым коллекто-
ром; Passive-H – вывод пассивного компонента, подключенный к источнику 
высокого потенциала; Passive-L – вывод пассивного компонента, подключен-
ный к источнику низкого потенциала; 3-State – 3-стабильный вывод; Power – 
вывод цепи питания. 
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Нажатие на кнопку Select Symbol позволяет изменить символ, назначен-
ный текущему компоненту. 

Окно Pattern View. В нем приводится изображение корпуса текущего 
компонента и таблица с информацией о его выводах. Нажатие на кнопку Se-
lect Pattern позволяет изменить корпус, назначенный текущему компоненту. 

Окно Pins View. В нем приведена таблица с информацией о всех выводах 
компонента. После выбора курсором какой-либо ячейки выше таблицы появля-
ется строка с информацией о занесенных в нее данных и панель для их редак-
тирования. 

Каждый компонент библиотеки состоит из одной или нескольких логиче-
ских секций (gates), которые упаковываются в корпус. Несколько разных ком-
понентов могут упаковываться в один и тот же типовой корпус 

Редактор P-CAD РСВ не может использовать информацию только о ком-
поненте (так как это только текстовая информация) или только о корпусе (так 
как это только графическая информация), для него необходимы совместные 
данные компонент/корпус. Аналогично для редактора P-CAD  Schematic необ-
ходимы совместные данные компонент/символ. Когда компонент размещается 
на ПП или на схеме, используется графика корпусов или символов, на которые 
сделаны ссылки в описании компонента. Разные компоненты могут ссылаться 
на одну и ту же графику корпусов или символов. Корпуса и символы, на кото-
рые имеются ссылки в компонентах, должны находиться в одной и той же биб-
лиотеке. 

Ссылки в разных компонентах на одни и те же корпуса и символы значи-
тельно экономят память, занимаемую библиотекой. Кроме того, редактирова-
ние типовых корпусов и символов сразу вносит изменения в графику всех род-
ственных компонентов.  

При работе с библиотекой компонентов важно различать следующие ос-
новные понятия (рисунок 8.22): 

Pad Number – порядковый номер вывода компонента (обычно совпадает с 
физическим номером вывода, но это необязательно); 

Pin Designator – физический номер вывода в корпусе; 
(Symbol) Pin Number – номер вывода в пределах секции компонента; 
Pin Name – имя вывода (в секции компонента). 
Работа с библиотеками значительно облегчается с помощью окна просмотра 

Source Browser (рисунок 8.23). В нем отображается дерево библиотек, откры-
тых по команде Library>Setup. Каждая библиотека состоит из разделов Com-
ponents, Patterns и Symbols. Двойной щелчок курсора мыши по символу или 
компоненту открывает окно просмотра их изображения. Щелчок правой кноп-
кой мыши по компоненту открывает всплывающее меню, содержащее две стро-
ки: Open и Place. Выбор варианта Open открывает окно Component Information  
с предоставлением возможностей редактирования параметров компонента. Вы-
бор варианта Place позволяет по дополнительному выбору (РСВ, Schematic) раз-
местить символ компонента на схеме или его корпус на ПП (для этого предвари-
тельно должна быть открыта программа P-CAD РСВ или Schematic). 
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 а б 
 

Рисунок 8.22 – Изображение компонента на схеме (а) и на ПП (б) ИС  K155ЛАЗ 
 

 
 

 
Рисунок 8.23 – Окно просмотра Source Browser 

 
Изображение иконки компонента в окне просмотра свидетельствует о на-

личии у него присоединенного корпуса и/или символа. 
Для создания библиотечного компонента (например К1533ЛА3) необхо-

димо выполнить следующие этапы. 
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1 Подключение символа. 
Для подключения символа необходимо выбрать в таблице любую строку в 

графе Normal, нажать на кнопку Select Symbol и в открывшемся окне Library 
Browse из списка символов, помещенных в открытую библиотеку, выбрать 
нужный. 

2 Подключение корпуса. 
Для подключения корпуса нажимают кнопку Select Pattern для подключе-

ния графики корпуса компонента. В открывшемся окне Library Browse из спи-
ска корпусов, помещенных в открытую библиотеку, выбирают нужный.  

3 Заполнение таблицы выводов. 
Заполнение таблицы выводов, которая выводится на экран нажатием кноп-

ки Pins View (рисунок 8.24). 
 

 
Рисунок 8.24 – Таблица выводов компонента  

 
При заполнении таблицы для выводов питания необходимо выбирать тип 

Power. При этом в столбец Gate# автоматически будет поставлено PWR. При ре-
дактировании таблицы это значение надо будет устанавливать вручную. Имена 
выводов питания должны совпадать с именами цепей питания и земли. 

4 Сохранение компонента в библиотеке. Перед сохранением в библиоте-
ке компонента необходимо выполнить команду проверки Component>Validate 

. При обнаружении ошибок выводятся соответствующие информационные 
сообщения, например:  

Missing Pin Des in row 1. Only ‘unused’ pads are allowed to have a blank 
Pin Des (Пропущен номер вывода в строке 1. Только неиспользуемые выводы 
могут не иметь информации в графе Pin Des). 

Если же ошибок не обнаружено, программа сообщает: No errors found! 
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После исправления всех ошибок выполняется команда сохранения компо-
нента в текущей библиотеке Component>Save или Component>Save As. Одна-
ко перед выполнением этих команд обязательно проверяется наличие ошибок, 
и пока ошибки не исправлены, компонент сохранить нельзя. Имя нового ком-
понента указывают по дополнительному запросу. 

 
8.2.5 Создание модели схемы электрической принципиальной в редак-

торе P-CAD Shematic 
Редактор P-CAD Shematic предназначен для построения схем электриче-

ских из библиотечных компонентов с последующей передачей информации об 
электрических связях между компонентами в P-CAD PCB для проектирования 
печатной платы. P-CAD Shematic можно использовать также для оформления 
конструкторской документации (схем электрических принципиальных, переч-
ней документов и т.п.). 

После запуска редактора схем P-CAD Schematic рекомендуется настроить 
его конфигурацию: определить размер листа схемы и настроить другие пара-
метры в меню команд Options > Configure.  

В графе Units выбирают систему единиц – миллиметры. Изменить систему 
единиц можно на любой фазе работы со схемой без потери точности. О теку-
щей системе единиц можно судить по размерности ширины линий, указывае-
мой на строке состояний. 

Режим ввода цепей и линий устанавливают в графе Orthogonal Modes: 
90/90 Line-Line – ввод ортогональных линий, 45/90 Line-Line – ввод диагональ-
ных линий. При включении режима 90/90 Line-Line линии проводятся по осям 
координат или под произвольным углом, при включении режима 45/90 Line-
Line – по диагоналям или под произвольным углом. Рекомендуется включить 
оба режима, тогда линии проводятся по осям координат, по диагоналям или под 
произвольным углом, что определяется дополнительным нажатием клавиши О. 

Переключатель DDE Hotlinks устанавливает режим взаимного выделения 
цепей между графическими редакторами P-CAD Schematic и P-CAD РСВ (так 
называемую горячую связь). 

Шаг сетки устанавливают в меню Option>Grids. Текущее значение шага 
сетки выбирают курсором в списке Grids или, что более удобно, непосредст-
венно строке состояний. 

В меню Options>Display задают цвета различных объектов, стиль изобра-
жения шин и ряд других параметров. 

В окне Bus Connection Mode указывают один из трех стилей изображения 
подсоединения цепей к шине. 

В окне Junction Size выбирают размер точки электрического соединения 
цепей (точки «пайки»). 

На закладке Miscellaneous на поле ERC Errors выбираются параметры: 
Show – разрешение вывода на схему маркеров ошибок ERC; Hide – запрет 

вывода на схему маркеров ошибок ERC; No Change – запрет изменения на схе-
ме маркеров ошибок ERC. 

Би
бл
ио
те
ка

 БГ
УИ
Р



 99 

На панели Cursor Style выбирают тип курсора: 
Arrow – стрелка; Small Cross – маленькое перекрестье; Large Cross – боль-

шое перекрестье. 
На панели Sheet Connector Cross Referencing устанавливаются параметры 

соединителей страниц. 
На панели Miscellaneous задают разнообразные параметры: 
Draft Mode – изображение контуров линий и полигонов; 
Display Default PinDes – отображение на экране номеров выводов символов 

компонентов, заданных по умолчанию; 
Display Open Ends – отображение неподсоединенных выводов или цепей; 
Display Overridden Errors – отображение на экране перекрывающихся мар-

керов ошибок; 
Display Part Gate Number – отображение на экране номеров секций компо-

нентов; 
Scroll Bars – размещение на экране линий прокрутки; 
Show Data Tips – вывод подсказок на рабочем поле (они не выводятся при 

использовании курсора большого размера и при выполнении команды 
View>Snap to Grid); 

Thin Stroke Text – установка тонких линий векторных шрифтов; 
Drag by Outline – изображение символов компонентов линиями контура при 

их перемещении или копировании (для ускорения перечерчивания экрана). 
Нажатие клавиши Defaults назначает всем параметрам значения по умол-

чанию. 
В P-CAD Schematic нет понятия слоев изображения, которые можно сде-

лать видимыми или невидимыми. Вся информация располагается на одном 
слое, и с помощью меню Options > Display можно любую информацию, на-
пример атрибуты компонентов (Part Attr), сделать невидимой – для этого ее 
нужно окрасить в цвет фона (Background). 

По командам Options > Current Wire и Options > Current Line определя-
ют ширину цепей Wire (осуществляют электрические соединения) и Line (гра-
фические линии не обеспечивают электрического соединения). 

В меню Options > Text Style выбирают стиль текста, устанавливаемый по 
умолчанию, и при необходимости редактируют стили выполнения отдельных 
надписей. Все стили надписей сохраняются в файле схемы. 

Параметры настройки конфигурации программы P-CAD Schematic зано-
сятся в файл SCH.INI и сохраняются при последующей работе с ней. Кроме то-
го, параметры проекта (стили линий, стили шрифта и др.) заносятся в файл 
схемы. Поэтому целесообразно создать «шаблоны» пустых схем, например, в 
файлах template1.sch, template2.sch..., занося в них только параметры конфигу-
рации (включая список шагов сетки, список стилей линии и т. п.), и загружать 
их перед началом создания новых схем. 

В P-CAD имеется команда File>Design Technology Parameters для про-
смотра и загрузки набора технологических требований к ПП. Технологические 
правила, относящиеся к определению классов цепей и правил их трассировки и 
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трассировки отдельных цепей, вводятся по команде Option>Design Rules как в 
редакторе P-CAD Schematic, так и в редакторе P-CAD РСВ. Данные об аперту-
рах, о наборе слоев ПП и стилях контактных площадок (КП) и переходных от-
верстий (ПО) можно модифицировать и ввести заново только в P-CAD РСВ. 

После настройки конфигурации P-CAD Schematic приступают к созданию 
принципиальной схемы по следующему алгоритму. 

Загрузка библиотек. Перед нанесением на схему символов компонентов 
по команде Library>Setup обеспечивается доступ к необходимым библиотекам 
(рисунок 8.25, а). Нажав клавишу Add, добавляют имена библиотек в список 
открытых библиотек (Open Libraries).  

Размещение компонентов на схеме. В режим размещения символов компо-
нентов на схеме переходят по команде Place>Part . После этого щелчок курсо-
ром в любой точке схемы открывает меню выбора компонента (рисунок 8.25, б). 

На панели Library указывается имя одной из открытых библиотек, список 
ее компонентов выводится в окне Component Name. 

Имя нужного компонента выбирают из этого списка или вводят в верхней 
строке. Нажатие клавиши Browse позволяет просмотреть графическое изобра-
жение символа компонента (справа на рисунке 8.25, б).  

В графе Num Parts указывается общее число секций компонента (изменять 
их на этом этапе нельзя). В окне Part Num по умолчанию указывается номер 
секции 1, но при необходимости его можно изменить перед размещением сим-
вола компонента на схеме. 

Позиционные обозначения компонентов на схеме проставляются автома-
тически. Для изменения назначенного в библиотеке префикса позиционного 
обозначения его надо указать в поле RefDes в явном виде (см. рисунок 8.25, б). 
Для компонентов, состоящих из одной секции, имя секции не проставляется. 

При изображении многосекционных компонентов совмещенным способом 
(изображения смежных секций примыкают друг к другу) позиционные обозна-
чения отдельных секций обычно не указываются, для этого необходимо пара-
метры RefDes всех секций, кроме первой, сделать невидимыми (выключить 
кнопку Visibility), тогда будет видно позиционное обозначение только первой 
секции.  

На строке Value проставляют номинал компонента, например сопротивле-
ние резистора. 

После выбора в меню Place>Part нужного компонента и введения всех не-
обходимых параметров нажимают OK – курсор примет форму перекрестья  
с разрывом в центре для точного позиционирования в узлах сетки. Непосредст-
венное размещение символа компонента на схеме выполняется после щелчка 
курсором в любой точке рабочего окна. До тех пор, пока не отпущена левая 
кнопка мыши, символ перемещается по экрану. Он поворачивается на 90° в на-
правлении против часовой стрелки и зеркально отображается нажатием клавиш 
R и F соответственно. Повторным щелчком курсора на схеме размещается оче-
редная копия символа выбранного компонента с присвоением ему следующего 
позиционного обозначения, которое одновременно выводится в строке инфор-
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мации. Для увеличения на единицу номера секции компонента перед размеще-
нием символа нажимают клавишу Р, а для увеличения позиционного обозначе-
ния – клавишу D. Уменьшить эти значения можно одновременным нажатием 
клавиш Shift+P или Shift+D. Нажатие правой кнопки мыши или Esc прекраща-
ет ввод символов. 

 

 
а 

 
б 

Рисунок 8.25 – Загрузка библиотек (а) и выбор символа компонента (б) 
 
В режиме Edit>Select щелчок курсора в любой точке внутри контура сим-

вола компонента производит его выбор с возможностью перемещения, поворо-
та и удаления символа вместе с принадлежащими ему атрибутами. Нажатие 
клавиши Shift и удерживание ее до щелчка курсора позволяет выбрать отдель-
ный элемент символа: вывод, элемент графики, позиционное обозначение и др. 

Размещение электрических цепей. После выбора команды Place>Wire 
 курсор принимает форму перекрестья. Щелчком мыши отмечается началь-
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ная точка цепи. Каждое нажатие левой кнопки мыши фиксирует точку излома. 
Нажатие клавиши О до отпускания левой кнопки мыши изменяет угол ввода 
линии из числа разрешенных (задаваемых в меню Options>Configure), нажатие 
клавиши F изменяет ее ориентацию. В связи с тем, что на схеме обычно преоб-
ладают горизонтальные или вертикальные цепи, в меню Options>Configure 
достаточно включить только режим ввода ортогональных цепей 90/90 Line-
Line. Завершается ввод цепи нажатием правой кнопки мыши (или Esc). 

Ширина прокладываемой цепи (рекомендуется 0,25 мм) устанавливается 
по команде Options>Current Wire. 

Неподсоединенные выводы компонентов и открытые концы цепей, не под-
соединенных к другим цепям или к выводам компонентов, помечаются квадра-
тиками, которые гаснут после выполнения электрического соединения. 

Если при перемещении цепи, имеющей присвоенное ей ранее имя (не сис-
темное имя типа NETxxxxx), она соприкоснулась с другой такой же цепью, от-
крывается диалоговое окно для выбора имени объединенной цепи или отказа от 
выполнения операции. При одновременном соединении нескольких цепей (это 
возможно при их перемещении в окне) выводится сообщение об отказе от  их 
объединения, что позволяет продолжить перемещение этих цепей или вернуть-
ся к исходному состоянию по команде Undo. 

Включение в цепь дополнительной точки излома для последующего редак-
тирования выполняется по команде Rewire>Manual . 

В строке информации выводится присваиваемое автоматически имя раз-
мещаемой цепи, например Net: NET00003. Следующая цепь получит имя 
NET00004. 

Присвоить цепи другое имя можно двумя способами: 
а) индивидуально выбрать каждую цепь, щелчком правой кнопки мыши 

открыть в меню редактирования пункт Properties и изменить имя цепи, заме-
нив на строке Net Name назначенное системой имя другим, например заменить 
NET00001 на А1. Это имя будет видимым, если включить на закладке Wire пе-
реключатель Display.  

б) с помощью команды Utils>Rename Nets в открывшемся меню на строке 
Net Name ввести префикс имени и выбрать параметр Increment Name (режим 
приращения имени). После закрытия этого меню щелчком курсора по первой 
цепи ей присваивается имя Pref 0, по второй – Pref 1 и т. д. Чтобы начать нуме-
рацию цепей не с нуля, нужно начальное имя ввести в явном виде, например 
A5. Тогда первая цепь получит A5, вторая – A6 и т.д. 

Если к цепи подсоединить компонент заземления GND, то она автоматиче-
ски получит имя GND, так как выводу компонента заземления присвоен тип 
Power, что обеспечивает автоматическую замену имени цепи, к которому он 
подключен, на имя этого компонента. 

Электрическое соединение пересекающихся цепей обозначается точкой 
«пайки» (Junction), которая автоматически проставляется на Т-образных со-
единениях. Чтобы проставить точку соединения пересекающихся цепей, нужно 
при вводе второй цепи щелкнуть курсором в точке пересечения и затем про-
должить ее построение. 
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Размещение шин. Выбор команды Place>Bus  активизирует режим 
ввода шин. Щелчком курсора отмечают начало шины и точки ее излома. По-
строение шины завершается нажатием правой кнопки мыши или Esc. 

После этого по команде Place>Wire размещают цепи. При рисовании це-
пи, входящей в состав шины, ее начало или конец должны располагаться в лю-
бой точке шины. При этом при подключении к шине автоматически изобража-
ется излом цепи под углом 45° (стиль этого изображения устанавливают в меню 
команды Options>Display). Шина изображается на схеме линией шириной 
0,76 мм, и изменить ее ширину нельзя. При необходимости можно поверх нее 
нарисовать линию нужной ширины по команде Place>Line. 

Имена цепей, образующих шину, задаются подключением к цепям по коман-
де Place>Port  специальных портов. После выбора команды Place>Port щелч-
ком мыши на любой точке схемы открывается изображенное на рисунке 8.26,  
а меню выбора порта. На расположенной вверху строке Net Name указывают имя 
первой цепи, например D1. Если включить переключатель Increment Port Name, то 
при размещении портов они автоматически получат имена D1, D2, D3 и т.п.  

 

 

 

а б 
Рисунок  8.26 – Диалоговые окна команд Place>Port (а) и Bus Properties (б) 

 
Для обозначения цепей в шине в соответствии с ЕСКД необходимо вы-

брать тип порта без рамки (None) с одним выводом (One pin) и располагать его 
вертикально (Vertical). В результате имя цепи (порта) будет расположено над 
ней. После закрытия меню нажатием ОК порты подключаются последова-
тельными щелчками мыши по именуемым цепям (текущее имя цепи отобра-
жается в строке информации). Именованные таким образом цепи являются 
глобальными (Global), их можно переименовывать по командам Edit>Nets  
и Utils>Rename Nets. Видимость имени шины устанавливается с помощью пе-
реключателя Display меню Bus Properties (рисунок 8.26, б). 
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Добавление атрибутов цепей и компонентов. Для добавления атрибута 
цепи (или компонента) выбирается цепь (или компонент) и после открытия 
щелчком правой кнопки мыши меню редактирования указывают в нем пункт 
Properties. Затем по команде Add добавляют атрибуты, как показано на ри-
сунке 8.27, где введен атрибут ширины проводника Width, который будет при-
нят во внимание автотрассировщиком. С помощью выключателя Visible каж-
дый атрибут может быть сделан видимым или невидимым на схеме. Для 
управления видимостью на экране всех однотипных атрибутов по команде 
Option>Display атрибуту можно назначить индивидуальный цвет или цвет 
фона (чтобы он был не виден). Аналогично при выводе схемы на печать по 
команде File>Print>Print Options указывают цвета атрибутов и других объек-
тов. Таким образом назначают цепям или компонентам индивидуальные атри-
буты. Атрибуты общего характера вводят по команде Place>Attribute. 

 

 
Рисунок 8.27 – Редактирование атрибутов цепей 

 
Редактирование схемы. Для перемещения компонента или цепи необхо-

димо выбрать их щелчком курсора и затем перемещать движением мыши. Если 
после перемещения сегментов цепей часть из них будет расположена неакку-
ратно, щелчком курсора выбирают отдельный сегмент и перемещают его вер-
шину. Выбор для редактирования элемента сложного объекта (например пози-
ционного обозначения компонента) производится щелчком левой клавиши 
мыши при одновременном нажатии кнопки Shift. 

Изменение позиционных обозначений. Перед завершением создания 
схемы целесообразно переименовать позиционные обозначения компонентов 
согласно ЕСКД вручную или с помощью специальной утилиты DBX. При пе-
ренумерации позиционных обозначений по команде Utils>Renumber невоз-
можно соблюдать требования ЕСКД.  
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Сохранение проекта. По команде File>Save отредактированный проект 
сохраняется в исходном файле, по команде File>Save As проект сохраняется  
в другом файле, причем предварительно можно выбрать его формат: 

Binary Files – бинарный формат (расширение имени *.SCH); 
ASCII Files – текстовый формат (расширение имени *.SCH).  
Файлы обоих форматов имеют одно и то же расширение имени *.SCH. Би-

нарный формат более компактен и является основным, текстовый формат ис-
пользуют для обмена данными с другими программами. 

В файле схемы хранятся следующие параметры: система единиц; набор 
шагов сетки; стили текста; шаблоны отчетов. 

 
8.2.6 Проверка схем с помощью утилиты ERC 
После создания принципиальной электрической схемы целесообразно вы-

явить синтаксические ошибки, исправить их и только после этого перейти к 
разработке ПП. Проверку схемы выполняют по команде Utils>ERC (Electrical 
Rules Check). В основном меню этой команды задают перечень проверок, ре-
зультаты которых приводятся в текстовом отчете. 

Степень серьезности отдельных ошибок (Error, Warning или Ignored) на-
значается в диалоговом окне, открываемом после нажатия на панель Severity 
Level. Там же необходимо включить опции View Report (Просмотр отчета со-
общений об ошибках) и Annotate Errors (Индикация ошибок на схеме). 

Сообщения об ошибках заносятся в файл <имя схемы>.ЕRС, изменение 
этого имени производят после выбора панели Filename. 

Поиск ошибок в соответствии с заданной конфигурацией начинается после 
нажатия панели ОК. Информация об ошибках помечается на схеме индикато-
рами и выводится в текстовый отчет. 

 
8.2.7 Вывод данных 
Результаты проектирования выводятся в P-CAD Schematic в виде: 
− схемы, напечатанной на принтере или плоттере; 
− списка соединений схемы (в частности, для упаковки схемы на ПП или 

выполнения моделирования);  
− текстовых отчетов. 
Вывод схемы на печать. Для подготовки к печати электрической схемы 

на принтере или плоттере выполняют команду File>Print Setup и в развернув-
шемся меню выбирают тип устройства вывода, предварительно установленного 
средствами Windows. Нажатием панели Setup открывают меню выбора размера 
и ориентации бумаги, характера передачи полутонов, разрешающей способно-
сти, качества печати (высокое, черновое). На строке Minimum Line Width for 
printing (pixels) устанавливают минимальную ширину прямых линий в пиксе-
лях (на дуги это не распространяется). При подготовке к печати указывается 
также масштабный фактор и поворот чертежа на 90 0, если необходимо.  

Непосредственный вывод на печать выбранных листов начинается после 
нажатия клавиши Generate Printouts, предварительный просмотр – после на-
жатия клавиши Print Preview. 
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Создание списка соединений. Список соединений включает в себя список 
компонентов и цепей с указанием номеров выводов компонентов, к которым 
они подключены. Он используется для так называемой процедуры «упаковки 
схемы на печатную плату» – размещения на поле ПП корпусов компонентов  
с указанием их электрических связей согласно принципиальной схеме. Для соз-
дания списка соединений необходимо по команде Utils>Generate Netlist от-
крыть меню настройки параметров и в пункте меню Netlist Format выбирать 
формат списка соединений. Для разработки ПП с помощью графического ре-
дактора P-CAD PCB рекомендуется выбирать формат Tango или PCAD ASCII 
(последний передает атрибуты схем на ПП). Имя файла списка соединений за-
дают после нажатия клавиши Netlist Filename. 

Нажатием кнопки Include Library Information включают в файл списка 
соединений (только для формата PCAD ASCII) информацию, необходимую 
для составления с помощью Library Manager библиотеки символов компонен-
тов, находящихся в данной схеме (по команде Library>Translate).  

Составление отчетов. По команде File>Reports создают текстовые отче-
ты о схеме. Дополнительно выбирается содержание и форма отчета, а также 
устройство вывода: консоль, принтер или файл. С помощью отчета удобно ана-
лизировать спроектированную схему и контролировать ошибки, внесенные 
оператором при создании библиотечных компонентов и вводе информации. 

 
8.2.8 Проектирование печатной платы в P-CAD РСВ 
Редактор РСВ используется для размещения компонентов на печатной 

плате и ручной трассировки соединений. 
Построен редактор печатных плат так же, как и редактор схем – отличие 

лишь в объектах, с которыми он работает. Поэтому на инструментальных пане-
лях редактора имеются новые кнопки, а в меню – новые команды, необходимые 
для создания печатных плат. P-CAD PCB в отличие от P-CAD Shematic под-
держивает многослойную организацию проекта. 

Перед началом работы в P-CAD PCB необходимо настроить его конфигура-
цию по команде Options>Configure. Настройки P-CAD PCB в основном совпада-
ют с настройками редактора P-CAD Shematic. Дополнительно в графе Workspace 
Size указывают размеры рабочей области, немного превышающие габаритные 
размеры ПП (по умолчанию устанавливается 254х254 мм). 

На закладке Route отмечают опцию T-Route by Default для разрешения 
образования Т-образных соединений проводников, в графе Orthogonal Modes 
включают все режимы (остальные параметры принимают значения по умолча-
нию, их настраивают позже по мере надобности). 

На закладке Manufacturing  задают значения глобальных технологических 
параметров: отступы масок пайки, зазоры между областью металлизации, на-
правление пайки волной припоя и т.п. 

При создании новой ПП по умолчанию устанавливаются 11 стандартных 
слоев (рисунок 8.28): Тор – верхняя сторона ПП; Bottom – нижняя сторона ПП; 
Board – контур ПП; Top Mask – маска пайки на верхней стороне ПП; Bot Mask – 

Би
бл
ио
те
ка

 БГ
УИ
Р



 107 

маска пайки на нижней стороне ПП; Top Silk – шелкография на верхней сторо-
не ПП (маркировка и контуры компонентов и т.п.); Bot Silk – шелкография на 
нижней стороне ПП; Top Paste – маска для паяльной пасты на верхней стороне 
ПП; Bot Paste – маска для паяльной пасты на нижней стороне ПП; Top Assy – 
вспомогательные данные на верхней стороне ПП; Bot Assy – вспомогательные 
данные на нижней стороне ПП. 

 
Рисунок 8.28 – Определение структуры и атрибутов слоев печатной платы  

Слои Тор и Bottom, Top Silk и Bot Silk и т.п. являются парными. Понятие 
парности слоев используется при переносе компонента на другую сторону ПП 
нажатием на клавишу F (Flip – зеркальное отображение), при этом вся графи-
ческая и текстовая информация переносится на ответствующие парные слои 
(при зеркальном отображении простых графических объектов – линий, полиго-
нов и т.п. – они остаются на первоначальном слое). 

Всего в P-CAD PCB может быть до 99 слоев. Слои создают и удаляют по 
команде Options Layers. Выделяют три типа слоев: Signal – слои разводки про-
водников сигналов, помечают символом S; Plane – слой металлизации для под-
ключения цепей «земли» и «питания», помечают символом Р; Non Signal – 
вспомогательные слои, помечают символом N. 

Каждый слой может быть включен (Enable, символ Е) или выключен (Dis-
able, символ D). 

В графе Routing Bias указывают приоритетную ориентацию проводников 
на каждом слое при автоматической трассировке: Auto – выбирается автомати-
чески, символ А; Horizontal – горизонтальная, символ Н; Vertical – вертикаль-
ная, символ V. 
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Удалять можно только слои, введенные пользователем, не являющиеся те-
кущими и на которых не содержится информация; стандартные слои удалять 
нельзя. 

Список значений ширины трасс проводников и геометрических линий со-
ставляется по команде Options>Current Line. 

По команде Options>Pad Style открывают список стеков КП, по команде 
Options>Vie Style – список стеков ПО. Выбранные курсором в этих списках 
стеки являются текущими и помещаются на ПП при выполнении команд 
Place>Pad, Place>Vie.  

Перед размещением на ПП компонентов вручную или с помощью проце-
дуры упаковки принципиальной схемы необходимо обеспечить доступ к биб-
лиотекам, в которых находятся эти компоненты. Библиотеки подключают по 
команде Library>Setup.  

Разработку новой ПП начинают с выполнения команды File>New и на-
стройки конфигурации или загрузки шаблона. Затем на слое Board по команде 
Place>Line наносится контур ПП в виде замкнутой линейно-ломаной линии 
(дуги не разрешаются). 

Упаковка схемы на печатную плату. При отсутствии принципиальной 
схемы проекта компоненты расставляют на ПП по команде Place>Component и 
по команде Place>Connection вводят электрические связи между их выводами. 
При наличии принципиальной схемы для переноса (упаковки) ее на ПП по ко-
манде Utils>Load Netlist загружают файл списка соединений (который создает-
ся в редакторе P-CAD Schematic в форматах Tango или P-CAD ASCII). 

Обычно схема упаковывается на ПП, на которой предварительно разме-
щены: вилки, розетки; крепежные отверстия; другие компоненты, имеющие 
фиксированное положение (в диалоговом окне Properties этих компонентов 
необходимо отметить опцию Fixed), и проложен ряд трасс. В этом случае по-
сле загрузки команды Utils>Load Netlist выводится сообщение, информирую-
щее о необходимости соблюдения следующих ограничений: 

– компоненты с совпадающими на ПП и на схеме позиционными обозна-
чениями (RefDes) должны иметь одинаковые типы корпуса (Type). При обнару-
жении конфликтов упаковка не производится; 

– все присутствующие на ПП компоненты, не входящие в список соедине-
ний, будут сохранены; 

– на ПП переносятся все компоненты из списка соединений, которые не 
установлены на ней предварительно; 

– электрические связи, проложенные предварительно на ПП и отсутст-
вующие в списке соединений, удаляются (обновляется вся информация об 
электрических связях), однако все проложенные ранее проводники сохраняют-
ся, даже если они отсутствуют в списке соединений; 

– после выполнения команды нельзя восстановить первоначальный вид ПП 
с предварительно размещенными компонентами, поэтому ее рекомендуется со-
хранить в отдельном файле. 
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Размещение компонентов на плате. После загрузки списка соединений 
(упаковки схемы) на ПП приступают к размещению компонентов внутри кон-
тура ПП (если он есть). Размещение компонентов на ПП обычно производят 
вручную. Линии электрических связей, перемещаемые вместе с компонентами, 
помогают правильно их разместить. 

Нажатием клавиши R поворачиваем выбранный объект против часовой 
стрелки на 90°, одновременным нажатием Shift+R поворачиваем его на угол, 
заданный в меню Options>Configure на закладке General (параметр Rotation 
Increment), нажатием клавиши F зеркально отображаем объекты относительно 
оси Y и переносим компоненты на противоположную сторону ПП. 

При размещении однотипных компонентов удобно их автоматически вы-
равнивать. Для этого выравниваемые компоненты по очереди выбираются 
щелчком курсора (при выборе второго и последующих компонентов нажима-
ют и удерживают клавишу Ctrl). Затем выбирают опцию Align (Выравнива-
ние) и в открывшемся меню отмечают способ выравнивания. 

После завершения размещения компонентов полезно выполнить миними-
зацию длин соединений путем перестановки логически эквивалентных секций 
компонентов и их выводов по команде Utils>Optimize Nets (перестановка воз-
можна, если в ней не участвуют уже проложенные проводники). 

Задание правил проектирования. Перед началом трассировки в меню 
Options>Grids задают необходимый шаг сетки.  

Затем по команде Options>Design Rules на закладке Layers устанавливают 
допустимые зазоры для каждого слоя трассировки (рисунок 8.29). 

Перед началом ручной трассировки целесообразно включить режим теку-
щей проверки допустимых зазоров, пометив на закладке Online DRC команды 
Options>Configure строку Enable Online DRC. 

Для управления размещением компонентов и трассировки соединений в 
автоматическом или интерактивном режиме и проверки DRC цепям и компо-
нентам присваивают атрибуты по команде Edit>Nets. 

 
Рисунок 8.29 – Пример задания правил и ограничений трассировки 

 

Барьеры трассировки. Графический редактор P-CAD РСВ имеет возмож-
ность создавать на ПП барьеры трассировки. Расположение на ПП по команде 
Р1асе>Keepout сегмента линии или замкнутой области в виде полигона запре-
щает Quick Route пересекать их трассами проводников на одном выбранном 
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или на всех доступных слоях (места размещения крепежных отверстий, облас-
ти, запрещенные для трассировки по конструкционным соображениям, и т.п.). 
Предварительно по команде Options>Current Keepout устанавливают пара-
метры барьеров трассировки: линия (Line) или полигон (Polygon), располагае-
мые на текущем (Current) или на всех доступных слоях (All). 

Контур ПП, рисуемый на слое Board по команде Place>Line, воспринима-
ется Quick Route как барьер, который нельзя пересекать проводниками на всех 
слоях. Поэтому трассы будут проведены как внутри этого контура, так и вне его 
(но не пересекая). 

Ручная трассировка соединений. Перед началом трассировки какого-
нибудь проводника задают его ширину и выбирают нужный слой. Трассу про-
водника можно начать только от тех КП, которые имеют электрические связи. 
При необходимости электрические связи устанавливают вручную по команде 
Рlаce>Connection. 

Ручную трассировку проводников выполняют по команде Route>Manual. 
Для облегчения создания Т-образного соединения трасс выполняют его 

при нажатой клавише Shift или заранее на закладке Route диалогового окна ко-
манды Options>Configure включают опцию T-Route by Default. 

При смене в процессе прокладки трассы текущего слоя нажатием клавиш 
L, Shift+L или с помощью строки состояний трасса продолжается на другом 
слое, при этом автоматически вставляется ПО текущего типа (заданного зара-
нее по команде Options>Via Style). 

Не прерывая прокладку трассы, можно изменить ширину проводника по 
команде Options>Current Line или с помощью строки состояний. 

Нарушение зазора между трассой проводника и выводом компонента, ПО 
или трассой другой цепи отмечается индикаторами ошибок в виде круга с пере-
крестьем, если включен режим Online DRC. 

Нажатие правой кнопки мыши или выбор любой команды завершает трас-
сировку проводника по кратчайшему расстоянию до контактной площадки вы-
вода компонента. Нажатием косой черты «/» или «\» прекращают прокладку 
трассы без ее завершения. 

Завершение трассы точно на контактной площадке пункта назначения обо-
значается ромбом с перекрестьем. 

Интерактивная трассировка соединений. Трассу прокладывают по ко-
манде Route>Interactive движением курсора при нажатой левой кнопке, при 
этом автоматически огибаются препятствия (проводники, КП, ПО и области 
металлизации), соблюдаются допустимые зазоры. Нажатием правой кнопки 
мыши в процессе прокладки трассы открывают следующее меню: 

Complete – завершение прокладки трассы (если это возможно) с соблюде-
нием установленного ранее режима ввода проводников (ортогонально или по 
диагонали) и допустимых зазоров; 

Push Traces  – включение режима отталкивания мешающих проводников; 
Suspend – прекращение прокладки трассы с сохранением проложенного 

участка; 
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Cansel – прекращение прокладки трассы с отменой ввода последнего сег-
мента (аналог нажатия клавиши Esc); 

Options – изменение параметров конфигурации проекта по команде  
Options>Configure; 

Layers – открытие окна команды Options>Layers для изменения структуры 
слоев платы; 

Via Style – открытие окна Options>Via Style для выбора типа ПО или его 
редактирования; 

Unwind – отмена прокладки последнего сегмента проводника (аналог на-
жатия клавиши Backspace). 

Клавиши О, F, «/», «\» и стрелки имеют такие же назначения, как и при 
ручной прокладке трасс. Единственное отличие – не производится скругление 
трасс по дуге.  

Когда в процессе прокладки трассы левую кнопку мыши отпускают в точ-
ке окончания линии электрической связи, прокладка трассы завершается и 
можно переходить к прокладке следующей. 

Сглаживание прямоугольных изгибов проводников. Прямоугольные из-
гибы проводников скашиваются под углом 45° или сглаживаются дугами по ко-
манде Route>Miter. Режим сглаживания устанавливают на панели Miter Mode 
закладки Route команды Options>Configure. Сглаживание начинают щелчком 
курсора в точке излома трассы, не отпуская левую клавишу мыши, перемещают 
курсор и устанавливают необходимые размеры изгиба трассы. 

По завершении ручной трассировки проводников полезно выполнить ко-
манду Utils>Trace Clean-up для удаления наложенных друг на друга сегментов 
трасс и лишних точек излома. 

Области металлизации. На сигнальных слоях могут располагаться области 
металлизации, электрически подсоединяемые к одной из цепей и автоматически 
отделяемые зазорами от других цепей и КП. Эти области создают в два этапа: 

1) по команде Place>Copper Pour рисуют внешний контур области метал-
лизации в виде полигона (пересечения сторон полигона не допускаются); 

2) область выбирают щелчком курсора, в раскрывающемся меню выбира-
ют строку Properties и затем на закладке Connectivity открывшегося меню Cop-
per Pour Properties указывают имя цепи, к которой она должна быть подклю-
чена. Здесь же выбирают необходимость использования КП с тепловыми барь-
ерами (Thermals) или непосредственного соединения (Direct Connection) и за-
дают ширину теплового барьера. После этого на закладке Style указывают осо-
бенности выполнения металлизации. 

При прокладке проводников через область металлизации зазоры образуют-
ся автоматически, если на закладке General команды Options>Configure вклю-
чена опция Auto Plow Copper Pours. 

Сохранение проекта. По команде File>Save либо File>Save As отредакти-
рованный проект сохраняется в файле, причем предварительно можно выбрать 
его формат. 
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Проверка печатной платы с помощью утилиты DRC. Перед заверше-
нием разработки ПП и выпуском фотошаблонов необходимо по команде 
Utils>DRC (Design Rule Checking) проверить ПП на соответствие принципиаль-
ной схеме и проверить соблюдение технологических ограничений. В меню этой 
команды выбирают различные правила проверок. 

После выполнения проверок перечень ошибок заносится в файл с расши-
рением имени *.DRC. Включение опции Annotate Errors помечает на ПП мес-
та ошибок специальными индикаторами. После исправления ошибки ее инди-
катор автоматически удаляется. 

Результаты разработки ПП выводят на принтеры и плоттеры различных 
типов, используя средства Windows. В меню команды FiIe>Print в поле  
Minimum Line Width (pixels) устанавливают минимальную ширину линий, за-
тем нажимают кнопку Setup Print Jobs и переходят в меню составления зада-
ний. В этом меню сначала каждому заданию в графе Print Name присваивают 
имя. Затем в списке слоев Layers указывают нужные (второй и последующие 
слои выбирают щелчком курсора при нажатой кнопке Ctrl). 

В заключение устанавливают опции печати: 
Scale – масштаб изображения; 
Х и Y offset – смещение изображения по горизонтали и вертикали от края 

бумаги; 
Drill Symbols Size – размер символов отверстий; 
Rotate – поворот изображения на 90° по часовой стрелке; 
Mirror – зеркальное отображение; 
Draft – вывод контуров линий; 
Thin Striked Text – изображение векторных шрифтов тонкими линиями; 
RefDes, Type, Value, Pads, Vias и т.п. – печать соответствующих объектов. 
Нажатие на кнопку Print Preview позволяет просмотреть изображение, пе-

чать производится после нажатия на кнопку Generate Printouts. 
Создание и просмотр Gerber-файлов. P-CAD РСВ обеспечивает создание 

управляющих файлов в стандартном формате фотоплоттера Gerber по команде 
File>Export>Gerber и загрузку изображения фотошаблона для контроля оши-
бок по команде File>Import>Gerber. 

Вывод информации для сверления отверстий. По команде 
File>Export>N/C Drill из базы данных спроектированной ПП извлекается ин-
формация о координатах отверстий и создается текстовый управляющий файл 
в формате станка с ЧПУ типа Excellon (аббревиатура N/C означает Numerically 
Controlled – числовое программное управление (ЧПУ)). 

Составление списков соединений. Список соединений включает в себя 
список компонентов и цепей с указанием номеров выводов компонентов, к ко-
торым они подключены. Изолированные области металлизации, а также непод-
соединенные выводы компонентов в этот список не заносятся. 

По команде Utils>Generate Netlist открывается меню настройки парамет-
ров. В пункте меню Netlist Format выбирают формат списка соединений:  
P-CAD ASCII или Tango. Нажатием кнопки Include Library Information вклю-
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чают в файл списка соединений (только для формата Р-CAD ASCII) информа-
цию, необходимую для составления с помощью Library библиотеки корпусов 
компонентов, находящихся в данном проекте (по команде Library>Translate). 

По команде FiIe>Reports создают текстовые отчеты о ПП. 
 
8.2.9 Автоматическая трассировка печатной платы в P-CAD 
8.2.9.1 Программа автоматической трассировки Quick Route  поставляет-

ся совместно с P-CAD РСВ. Вызывают Quick Route из управляющей оболочки 
P-CAD РСВ по команде Route>Autorouters (рисунок 8.30).  

 
Рисунок 8.30 – Выбор автотрассировщика Quick Route 

 
Подготовка к трассировке. Quick Route трассирует текущую ПП, загру-

женную в P-CAD РСВ. На ней должны быть размещены все компоненты и ука-
заны электрические связи между выводами. Предварительно на ПП можно раз-
местить барьеры трассировки Keepout и некоторые проводники. Quick Route не 
изменяет предварительно размещенные проводники и не прокладывает трассы 
заново по более короткому пути. 

В меню Quick Route (рисунок 8.30) в нижней части экрана расположены 
следующие кнопки: 

Layers – конфигурация слоев. Quick Route поддерживает до четырех слоев 
металлизации; 

Net Attrs – редактирование атрибутов цепей; 
Passes – выбор проходов трассировки; 
Via Style – выбор типа ПО. 
На строке Line Width выбирают ширину проводника от 0,1 mil (0,01 мм) до 

некоторого значения, зависящего от выбранного шага сетки. Например, для шага 
сетки 25 mil оно составляет 12 mil в английской системе или 0,305 мм в метриче-
ской системе, не более. Ширину индивидуального проводника назначают с по-
мощью атрибута WIDTH, который может принимать любое значение. 
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В меню редактирования стратегии трассировки Pass Selection выбирают 
типы проходов трассировки, выполняемых в порядке их размещения на одно-
именной закладке. Трассировка начинается после нажатия на клавишу Start в 
меню Quick Route. При этом одновременно изменяется вид экрана, как показа-
но на рисунке 8.31.  

 
Рисунок 8.31 – Экран трассировщика Quick Route 

 
По команде Route>Info выводится текущая информация о результатах 

трассировки. По команде Route>Cancel трассировка прекращается. 
В рабочем окне на экране приводится изображение ПП. После прокладки 

проводника его изображение сразу же появляется на экране. Сообщение Route 
completed указывает о завершении трассировки. Одновременно выводятся дан-
ные о проценте разведенных цепей. Кроме того, в скобках приведено число 
разведенных цепей и общее число цепей, отделенное косой чертой. 

Информация о стратегии трассировки, результатах выполнения отдельных 
фаз трассировки и итоговые данные помещаются в файл протокола, имеющий 
расширение имени .LOG.  

Ограничения Quick Route:  
- разрешены только простые КП и ПО (имеют одну и ту же форму на всех 

слоях), глухие межслойные ПО не допускаются; 
- для цепей, не имеющих атрибута AUTOROUTEWIDE, допускается толь-

ко один стиль ПО; 
- диаметр ПО не может более чем в два раза превышать текущий шаг сетки 

трассировки; 
- разрешенные размеры сетки трассировки: 12,5 mil, 16,7–16,6–16,7 mil, 

20 mil и 25 mil. Метрическая сетка не разрешается; 
- ширина проводника не может быть больше половины шага сетки; 
- для ПО нельзя создать специальную сетку; 
- выводы компонентов можно повернуть только на 90°; 
- допускается не более четырех слоев металлизации. 
Расположение объектов вне сетки трассировки. Если вывод компонента 

не совпадает с узлом выбранной сетки, то трасса проводника подводится к 
ближайшему пути и от него будет проложен короткий сегмент до центра КП. 
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Поэтому не совпадающие с узлами сетки выводы компонентов способствуют 
блокированию каналов трассировки. Рекомендуется так располагать компонен-
ты, чтобы все их выводы совпадали с узлами сетки. 

Особенности трассировки компонентов с планарными выводами. 
Quick Route позволяет выбрать предпочтительную ориентацию проводников на 
каждом слое трассировки. Для двусторонних ПП обычно выбирается горизон-
тальная ориентация проводников на верхнем слое (Тор) и вертикальная на 
нижнем (Bottom). Однако это соглашение препятствует трассировке компонен-
тов с планарными выводами. Например, если на верхней стороне ПП размещен 
планарный разъем, ориентированный параллельно нижнему краю ПП, к его 
средним выводам будет очень трудно подвести проводники. Для облегчения 
автоматической разводки компонентов с планарными выводами Quick Route 
генерирует рядом с каждым планарным выводом сквозное ПО (стрингер) и со-
единяет их коротким проводником. После завершения разводки неиспользо-
ванные ПО автоматически удаляются. 

Выбор сетки трассировки. В Quick Route можно выбрать одну из четырех 
сеток трассировки: регулярные сетки с шагом 25, 20, 12,5 mil и нерегулярная 
сетка 16,7-16,6–16,7 mil. Перед выбором шага сетки и ширины проводников не-
обходимо выяснить на предприятии, где будет изготавливаться ПП, принятые 
технологические нормы. 

Выполнение предварительных расчетов по выбору сетки и расположение 
компонентов абсолютно необходимо. Наименьший шаг сетки размещения, при 
которой возможно применение всех имеющихся в Quick Route сеток разводки, 
составляет 100 mil. При несогласованном выборе сеток размещения и разводки 
многие выводы компонентов не будут попадать в узлы сетки разводки, что не 
позволит достичь наиболее высокой степени разводки. 

8.2.9.2 Бессеточный трассировщик Shape-Based Router 
В программе Shape-Based Router используются принципы оптимизации 

нейронных сетей, и она в основном предназначена для трассировки многослой-
ных ПП с высокой плотностью размещения компонентов в автоматическом, 
интерактивном и ручном режимах. Особые преимущества трассировщик имеет 
при наличии планарных компонентов, выполненных в разных системах единиц 
(метрической и английской). 

Кроме того, эта программа основана на так называемой Shape-Based, или 
бессеточной технологии. Согласно ей все объекты ПП моделируются в виде 
совокупности геометрических фигур (прямоугольник, круг, дуга, трасса, поли-
гон). В отличие от привязанных к сеткам технологиям (Grid-Based), используе-
мым, в частности, в P-CAD Quick Route, при бессеточной технологии каждый 
объект моделируется не набором узлов сетки, а геометрически точно, за счет 
чего достигается более плотный монтаж.  

Программа Shape-Based Router нацелена на решение глобальных проблем 
(100 %-ная трассировка, минимизация количества ПО и др.) и не позволяет вы-
полнить тонкую настройку стратегии трассировки (например, определенную 
цепь заключить в экран, провести дифференциальную пару проводников, про-
ложить индивидуальную цепь заданной длины и т.п.).  
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Shape-Based Router обрабатывает ПП, имеющие до 30 слоев, до 4000 ком-
понентов, до 5000 выводов в одном компоненте, до 10 000 цепей и до 16 000 
электрических соединений. 

Программа Shape-Based Router может быть вызвана автономно из среды 
Windows (файл SR.EXE) или из меню Route P-CAD PCB (команда 
Autorouters). В диалоговом окне вызова этой программы можно только указать 
имена файлов: исходной ПП в формате P-CAD Route File (*.PRF), выходной 
(оттрассированной) ПП в формате P-CAD PCB (*.pcb), протокол команд 
(*.LOG). По умолчанию эти файлы получают те же имена, что и файл исходно-
го проекта, но в начале имени выходных файлов добавляется префикс R. 

В Shape-Based Router передаются из P-CAD PCB значения ширины трасс, 
присвоенные цепям с помощью атрибутов Width, и тип ПО, установленный по 
умолчанию. В качестве глобального зазора Primary Clearance принимается зазор 
Line to Line, заданный для слоя Bottom (его можно в дальнейшем изменить). Трас-
сы, проложенные вручную, защищаются от изменений по команде Edit>Fix.  

Настройка стратегии трассировки. По команде Options>Auto-Router 
открывается диалоговое окно настройки стратегии трассировки (рисунок 8.32), 
имеющее 3 закладки.  

  
а б 

 
в 

a – закладка Routing Passes, б – закладка Parameters, в – закладка Testpoints 
Рисунок 8.32 – Диалоговое окно Autorouter Setup  
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На закладке Routing Passes в полях Router Passes и Manufacturing Passes 
выбирается тип трассировки: 

Memory – трассировка типа «память»; 
Fan Out User SMD Pins – генерация веерообразно расположенных стрин-

геров для выводов планарных компонентов; 
Pattern – трассировка фрагментов ПП с использованием типовых образцов, 

имеющихся в программе (рекомендуется включать всегда); 
Shape Router – Push And Shove – раздвигание и отталкивание ранее про-

ложенных мешающих трасс; 
Shape Router – Rip Up – разрыв и повторная трассировка трасс, проложен-

ных на предыдущих проходах с нарушениями (превышение допустимых зазо-
ров или пересечение на одном слое); 

Clean During Routing – уменьшение количества изгибов трасс и удаление 
лишних ПО в процессе трассировки; 

Clean After Routing – уменьшение количества изгибов трасс и удаление 
лишних ПО после трассировки; 

Evenly Space Traces – равномерное распределение трасс; 
Add Testpoints – вставка контрольных точек. 
В поле Options выбирается тип изгибов трасс Routed Corners: под углом 90 

или 45°. 
На закладке Parameters в поле Router Direction для каждого слоя ПП выби-

рают предпочтительную ориентацию трасс из следующего перечня: 
Auto – предоставление выбора программе; 
Disable – запрет для трассировки; 
Fan Out – генерация веерообразно расположенных ПО, соединенных с вы-

водами планарных компонентов короткими отрезками трасс (стрингерами); 
Plane – резервирование слоя для использования в качестве слоя металли-

зации; 
Vertical – вертикальная; 
Horizontal – горизонтальная; 
1 o'clock, 2 o'clock, 4 o'clock, 5 o'clock, 45/, 45\\ – выбор одной из ориента-

ций (разрешается для многослойных ПП); 
Any Direction – отказ от прокладки трасс определенной ориентации (раз-

решается для многослойных ПП). 
Нажатие на панель Analyze Directions выбирает предпочтительное направ-

ление трассировки слоев, имеющих признак Auto. Кроме того, назначаются 
следующие параметры (рисунок 8.32, б): 

Units – система единиц величин, отображаемых на экране дисплея (Mils, 
Inches, Centimeters, Millimeters, Microns; на точность трассировки не влияет); 

Via Type – запрет (No Vias), разрешение (Thruhole Only) использования ПО; 
Via under SMD – запрет (No), разрешение (Yes) размещения ПО под КП 

планарных компонентов; 
Channel Size – размер канала трассировки, равный сумме ширины трассы 

Primary Trace Width и допустимого зазора Primary Clearance. Это значение мо-
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жет быть изменено; для выполнения бессеточной трассировки назначается 
1 mil и менее. 

Primary Pad Size – диаметр большинства КП выводов штыревых компонен-
тов. Если штыревых компонентов нет, то этот параметр равен наибольшему раз-
меру КП планарных компонентов (используется при расчете Channel Size); 

Primary Via Width – диаметр ПО, выбранного в P-CAD РСВ в качестве ПО 
по умолчанию; 

Primary Trace Width – ширина большинства трасс ПП (устанавливается 
программой на основе анализа таблицы цепей меню команды Edit>Net; исполь-
зуется при расчете Channel Size и прокладке трасс, которым в P-CAD РСВ не 
был назначен атрибут Width); 

Primary Clearance – минимально допустимый зазор между любыми объ-
ектами, т.е. Track to Track, Track to Pad, Track to Via, Via to Pad (устанавлива-
ется в PCAD PCВ, но может быть изменен). 

Для облегчения доработки ПП после ее трассировки рекомендуется не из-
менять значение Channel Size, рассчитанное программой. Бессеточная трасси-
ровка (с шагом сетки 1 mil и менее) целесообразна в проектах, имеющих боль-
шое разнообразие значений ширины трасс и зазоров. При использовании значе-
ния Channel Size, установленного программой, нет разницы между качеством 
сеточной и бессеточной трассировки.  

На закладке Testpoints (рисунок 8.32, в) устанавливается приоритет разме-
щения контрольных точек (КТ), размещаемых на ПП, если на закладке Routing 
Passes отмечена опция Add Testspoints. 

По команде Edit>Net Attributes открывается диалоговое окно (рисунок 8.33) 
задания атрибутов всем цепям проекта. 

 
Рисунок 8.33 – Диалоговое окно Net Attributes 
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Перед выполнением трассировки полезно ознакомиться со статистически-
ми данными о ПП по команде Reports>Pre-Route Synopsis для внесения при 
необходимости коррекции в исходную ПП или стратегию трассировки. Полез-
ная информация о плотности связей ПП может быть получена также по коман-
де View>Density. 

Автотрассировка всей ПП начинается по команде Tools>Start Autorouter 
. Интерактивная трассировка выполняется по другим командам меню Tools: 

AutoRoute Connection , AutoRoute Net , AutoRoute Component , 
AutoRoute Area . Ручная прокладка трассы выполняется по команде Manual 
Route . С помощью команды Tools>Sketch Route курсором рисуется при-
мерное расположение трассы выбранной цепи, которая прокладывается затем 
автоматически. 

По завершении трассировки по командам Reports>Routing Statistics,  
Reports>Reports можно просмотреть итоговые отчеты. 

Возвращение в P-CAD РСВ после трассировки производится по команде 
File>Save and Return. 

 
8.2.10 Доработка печатной платы  
В ряде случаев после автоматической трассировки печатная плата требует 

дополнительной доработки. Элементы печатного монтажа редактируются с по-
мощью команд Edit/Delete (удалить), Edit/Properties (редактировать свойства) 
и др. При необходимости используют команды размещения новых элементов 
Place Connection (разместить соединение), Place Via (разместить переходное 
отверстие) и др. После добавления новых элементов удобно использовать руч-
ную трассировку – команда  Route/Manual . Ввод дополнительных тексто-
вых надписей (позиционные обозначения элементов, маркировка печатной пла-
ты и т.п.) выполняется по команде Place text . Доработанная плата сохраня-
ется командой Save. 

 
 

8.3 Оформление чертежей электронной аппаратуры в AutoCAD 
8.3.1 Назначение и возможности пакета AutoCAD 
AutoCAD – универсальная система автоматизированного проектирования  

фирмы Autodesk (США), завоевавшая наибольшую популярность во всем ми-
ре – 76 % пользователей работают в AutoCAD. Многие предприятия в разных 
странах обмениваются между собой чертежами в формате AutoCAD *.dwg. Ос-
новным достоинством AutoCAD является доступность для создания на его базе 
мощных специализированных расчетно-графических пакетов. 

Система AutoCAD позволяет разрабатывать двухмерные (плоские) черте-
жи и рисунки, а также разрабатывать и моделировать каркасные, полигональ-
ные (поверхностные) и объемные (твердотельные) конструкции в различных 
областях человеческой деятельности (техника, строительство и архитектура, 
швейное производство и т.п.). 
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Требования к компьютеру различны в зависимости от версии программно-
го обеспечения. Для каждой более поздней версии AutoCAD требования к ком-
пьютеру ужесточаются. Так, для AutoCAD 2000 необходим процессор не хуже 
Р 133, рекомендуемый объем памяти – 64 Мб (минимальный – 32 Мб), жесткий 
диск – не менее 130 Мб свободного пространства, 50 Мб свободного дискового 
пространства в системном каталоге, не менее 64 Мб в файле подкачки. Для 
AutoCAD 2004 необходим компьютер не ниже Pentium III с процессором 
500 МГц, оперативной памятью 256 Мб, винчестером 2 Гб; на винчестере надо 
иметь свободными 350 Мб под программное обеспечение и не менее 250 Мб 
для временных файлов, которые система образует во время сеансов работы. Для 
установки версии AutoCAD 2004 рекомендуется одна из следующих операци-
онных систем: Windows 2000; Windows XP; Windows NT 4.0 (с обновлением 
Service Pack 6a или более поздним).  

Начиная с версии 2000 (релиз 15) и выше, в AutoCAD был введен новый 
механизм оформления чертежей. Этот механизм использует такие понятия, как 
пространство модели (или модель), пространство листа, видовой экран, ассо-
циативные размеры. 

Процесс проектирования и оформления КД можно разделить на следую-
щие этапы:  

− проектирование (вычерчивание) в пространстве модели конструкции 
в масштабе 1:1. На данном этапе проектируется конструкция и строится необ-
ходимое число видов без нанесения на  них пояснительной информации и раз-
меров. Чертежные виды могут располагаться в пространстве модели произ-
вольно; 

− из шаблона создается необходимое число новых листов необходимого 
формата со штампом и основной надписью; 

− на каждом из листов создаются видовые экраны, представляющие собой 
чертежные виды. Для каждого видового экрана настраивается масштаб отобра-
жения и другие параметры; 

− видовые экраны размещаются на листе и закрепляются; 
− в пространстве листа на виды наносятся ассоциативные размеры, а так-

же наносятся все остальные элементы оформления.  
К достоинствам данного способа оформления стоит отнести:  
− удобство проектирования (нет необходимости чертить в масштабе; нет 

необходимости точно размещать чертежные виды);  
− легкость размещения чертежных видов на листе;  
− более «аккуратное» представление многостраничных документов (один 

лист – одна закладка);  
− возможность сохранения для каждого листа уникальных настроек выво-

да на печать. 
Пространство модели и пространство листа. Пространством модели на-

зывается чертежная область, предназначенная для проектирования изделия. Ее 
размеры во всех направлениях не ограничены. Рекомендуется в пространстве 
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модели чертить конструкцию в масштабе 1:1 независимо от ее габаритов. При 
этом все дополнительные (местные) виды чертятся также в масштабе 1:1, причем 
их взаимное расположение может быть произвольным. 

Пространством листа называется чертежная область, предназначенная 
для вывода изображения на печать. Ее особенностью является то, что 
1 мм пространства листа теоретически должен быть равен 1 мм на бумаге печа-
тающего устройства. На практике получается, что почти все малоформатные 
принтеры имеют поля печати. Поэтому при выводе на печать имеется некото-
рая погрешность (уменьшение). Обычно она не превышает 5–8 %. 

Видовые экраны. Видовой экран (ВЭ) представляет собой фрагмент мо-
дели, находящийся на листе. При этом для каждого видового экрана отдельно 
можно настроить масштаб отображения. В сущности, ВЭ является границей 
чертежного вида на листе. Видовые экраны бывают двух типов: прямоугольные 
и произвольной формы. Создание и управление ВЭ производится при помощи 
инструментов, представленных на панели Viewports. На этой панели есть также 
поле, отображающее масштаб для выделенного ВЭ. 

Видовые экраны могут накладываться друг на друга полностью или час-
тично. Для того чтобы границы ВЭ не выводились на печать, их следует поме-
щать на непечатаемый слой. 

 
8.3.2 Примерный алгоритм оформления чертежа детали в AutoCAD  
Очень часто перед построением чертежей для получения опорных точек 

чертежа целесообразно выполнить дополнительные построения. Для этого сле-
дует использовать специально выделенный слой. Кроме того, различные эле-
менты чертежа целесообразно выполнять в различных слоях различными цве-
тами. Исходя из этих соображений, можно рекомендовать следующую после-
довательность (этапы) оформления чертежа детали электронной аппаратуры: 

Подготовительные операции 
1 Задать формат чертежа (поля, в котором будет создаваться изображение). 

Для этого необходимо выполнить команду limits (меню Format > Orawing 
Limits) По этой команде ввести координаты левого нижнего угла чертежа и 
правого верхнего. Например, для формата А3 необходимо ввести соответствен-
но 0, 0 и 420, 297. 

2 Установить командой grid требуемую координатную сетку и режим вы-
вода на экран координатной сетки (включить кнопку GRID в строке состоя-
ния). Установить привязку к узлам сетки (включить кнопку SNAP в строке со-
стояния). При необходимости включить режим ортогональности (кнопка 
ORТНО в строке состояния). 

3 Командой zoom (меню View > Zoom) установить требуемый масштаб 
изображения. 

4 Установить слои с помощью команды layer (пункт меню Format > Layer) 
Целесообразно ввести следующие слои: 

MAIN – слой для основных линий чертежа; 
FINE – слой тонких линий (штриховка, резьба и т.п.); 
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DIM – слой для простановки размеров; 
AXIS – слой осевых линий (тип линии DASH DOT – штрихпунктир); 
BUILD – слой для дополнительных построений; 
ATTR – слой для атрибутов. 
Создание чертежа 
1 Загрузить форматку листа с использованием команды вставки блока или 

загрузить шаблон *.dwt. 
2 В слое AXIS построить осевые линии. 
3 В слое BUILD выполнить необходимые дополнительные построения для 

получения опорных точек чертежа. 
4 Сделать обводку детали в слое MAIN с помощью команды PLINE тол-

щиной линии ~0,8 мм. При формировании основных линий обратить внимание 
на формирование замкнутых контуров штриховки. После завершения формиро-
вания основных линий слой BUILD можно выключить. 

5 В слое FINE обозначить резьбу, нанести штриховку. 
6 В слое DIM нанести размеры. 
7 Выполнить ввод текста технических требований, обозначений видов  

и т.п. в соответствии с нормативно-технической документацией на проектиро-
вание деталей машиностроения. 

8 Заполнить основную надпись чертежа.  
9 Сохранить чертеж (File > Save). 
 
8.3.3 Экспорт платы печатной из P-CAD в AutoCAD. Особенности 

оформления чертежа платы печатной с использованием  пакета 
AutoCAD 

Рекомендуется оформлять чертеж платы печатной в следующей последо-
вательности: 

Подготовительные операции 
1 Выполнить настройку рабочей среды AutoCAD или загрузить сохранен-

ный шаблон из файла *.dwt.  
2 Загрузить в PCAD PCB файл *.pcb с информацией о спроектированной 

плате печатной. 
3 Выполнить экспортирование файла в формате *.dxf, для чего: 
− выделить в рабочей области P-CAD PCB зону с экспортируемой инфор-

мацией; 
− выполнить команду FILE>EXPORT>DXF. 
4 В открывшемся диалоговом окне экспорта данных из P-CAD PCB (рису-

нок 8.34): 
− убрать галочку в пункте Output Drill Symbols (информация о стеках кон-

тактных площадок); 
− выбрать единицы измерения (mm); 
− выбрать для экспорта все созданные в P-CAD PCB слои (кнопка Set All). 
5 Указать имя и расположение экспортируемого файла (кнопка DXF File-

name…). 
6 Нажать кнопку ОК. 

Би
бл
ио
те
ка

 БГ
УИ
Р



 123 

Создание базового блока чертежа 
1 Открыть в AutoCAD сохраненный файл формата *.dxf. 

 
Рисунок 8.34 – Диалоговое окно экспорта данных  

 

Если проводники необходимо распечатать реальной толщины (что бывает 
редко), то замораживаются слои топологии (TOP, BOTTOM и т.д.). 

При импорте в AutoCAD файла платы из P-CAD в формате *.dxf автомати-
чески создаются все выделенные слои. Информация для дальнейшего оформле-
ния платы печатной содержится на слоях: TOP, BOTTOM – трассировка платы, 
BOARD – контур платы печатной; TOP_SILK, BOT SILK – информация о марки-
ровке элементов). Остальные слои можно «заморозить», сделать невидимыми 
или удалить. 

2 При необходимости – произвести корректировку трассировки. Для этого 
с помощью многократного применения команды EXPLODE разгруппировать 
компоненты файла, затем произвести редактирование трасс.  

3 Удалить мелкие объекты (круги, дуги и т.п.), созданные в P-CAD PCB  
и экспортированные в файл *.dxf, для чего: 

− открыть диалоговое окно Properties (рисунок 8.35); 
− нажать кнопку Quick Select; 
− выбрать параметры: Object type – Arc, Properties – Radius, Operator – 

Less then, Value – 0.03; 
− нажать кнопку OK.  
− нажать кнопку Delete. 
4 Выделить все в рабочем поле и создать блок по команде BLOCK. 
5 Созданный блок перенести в настроенный шаблон (толщины линий луч-

ше задавать по слоям, но можно и по цветам – тогда необходимо позаботиться 
о придании разным цветам различных значений толщины линий). Если едини-
цы шаблона – мм, плата автоматически примет размеры в миллиметрах. В шаб-
лоне также должна быть рамка чертежа. 
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Рисунок 8.35 – Диалоговое окно команды Properties 

 

6 Масштабировать созданный блок (при необходимости) по команде 
SCALE, для чего: 

− проверить размеры заранее известного объекта по команде 
DIMLINEAR. Например, известно расстояние между двумя выводами инте-
гральной микросхемы в DIP-корпусе – 2,5 мм; 

− выделить блок и применить команду SCALE (масштабный фактор (scale 
factor) выбирается больше 1,0, если необходимо увеличить размеры блока). 

Создание чертежа платы печатной 
1 Созданный базовый блок зеркально отразить по команде MIRROR при 

включенном режиме ORTHO.  
2 Разбить полученные блоки на примитивы по команде EXPLODE. 
3 «Заморозить» слои BOARD, TOP, TOP_SILK и удалить примитивы базо-

вого блока.  
4 «Разморозить» слои TOP, TOP_SILK. 
5 «Заморозить» слои BOTTOM, BOT_SILK, удалить примитивы зеркально 

отраженного блока. 
6 Включить слои BOARD, BOTTOM, BOT_SILK.  
7 Создать вид сбоку платы печатной, для чего необходимо по команде 

RECTANG в месте расположения линии зеркального отображения блоков 
вставить прямоугольник с шириной, равной толщине платы (с учетом масштаба 
чертежа) (рисунок 8.36). 

8 Нанести линии координатной сетки на основной вид печатной платы: 
− создать новый слой (например KS); 
− нанести линию координатной сетки по команде LINE в созданном слое 

поверх одной из сторон платы печатной; 
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− клонировать по команде ARRAY созданную линию на поверхность те-
кущего вида платы печатной с заданным заранее шагом (например 2,5 мм). 

 
Рисунок 8.36 – Экран AutoCAD со сформированными видами платы печатной 

 

9 Нанести вертикальные и горизонтальные линии координатной сетки на 
все сигнальные виды платы печатной по аналогии. 

10 Подписать значения координат, технические требования, добавить раз-
меры и шероховатость. 

11 Заполнить основную надпись чертежа. 
 
8.3.4 Особенности оформления сборочного чертежа электронного блока с 

использованием  пакета AutoCAD 
Рекомендуется оформлять сборочный чертеж электронного блока в сле-

дующей последовательности: 
Подготовительные операции 
1 Выполнить настройку рабочей среды AutoCAD или загрузить сохранен-

ный шаблон из файла *.dwt.  
2 Экспортировать из P-CAD необходимые слои: TOP SILK, BOT SILK 

(маркировка и корпуса элементов с двух сторон платы, если используется двух-
сторонний монтаж); TOP ASSY, BOT_ASSY (дополнительная информация о кор-
пусах элементов) и BOARD (контур платы). Последовательность действий опи-
сана в пункте 8.3.3. 

Создание сборочного чертежа 
1 Открыть в AutoCAD сохраненный файл формата *.dxf.  
2 При необходимости – произвести корректировку изображения.  
3 Выделить все в рабочем поле и создать блок по команде BLOCK. 
4 Созданный блок перенести в настроенный шаблон. 
5 Масштабировать созданный блок (при необходимости) по команде 

SCALE, для чего: 
− проверить размеры заранее известного объекта по команде 

DIMLINEAR; 
− выделить блок и применить команду SCALE (масштабный фактор (scale 

factor) выбирается больше 1,0, если необходимо увеличить размеры блока). 
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6 Добавить к созданному изображению вид сбоку и дополнительные виды 
(при необходимости). 

7 Нанести на чертеже размеры, позиционные обозначения деталей и сбо-
рочных единиц согласно спецификации (рисунок 8.37). 

 

 

Рисунок 8.37 – Экран AutoCAD с дополнительными построениями 
 
8 Нанести на чертеже технические требования и заполнить основную над-

пись. Сборочный чертеж электронного блока оформлен. 
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9 ОФОРМЛЕНИЕ КОМПЛЕКТА КОНСТРУКТОРСКИХ 
ДОКУМЕНТОВ 

 
 

9.1 Комплектность и обозначение конструкторских документов 
 

В ходе курсового проектирования разрабатываются графические (черте-
жи, схемы, графики) и текстовые (спецификации, перечни элементов, эксплуа-
тационные инструкции, пояснительная записка и т.д.) документы. Комплект 
КД определяет состав и устройство проектируемого изделия и содержит дан-
ные, необходимые для его изготовления, контроля, приемки, эксплуатации и 
ремонта. В соответствии с ГОСТ 2.102-68 КД подразделяют на определенные 
виды (таблица 9.1). 

Таблица 9.1 – Номенклатура конструкторских документов (по ГОСТ 2.102-68) 
Шифр КД Вид документа 

– Чертеж детали 
СБ Сборочный чертеж 
ВО Чертеж общего вида 
ТЧ Теоретический чертеж 
ГЧ Габаритный чертеж 
МЭ Электромонтажный чертеж 
МЧ Монтажный чертеж 
УЧ Упаковочный чертеж 
– Схемы 
– Спецификация 
ВС Ведомость спецификаций 
ВД Ведомость ссылочных документов 
ВП Ведомость покупных изделий 
ВИ Ведомость согласования применения покупных изделий 
ДП Ведомость держателей подлинников 
ПТ Ведомость технического предложения 
ЭП Ведомость эскизного проекта 
ТП Ведомость технического проекта 
ПЗ Пояснительная записка 
ТУ Технические условия 
ТО Технические описания 
ПМ Программа и методика испытаний 
ТБ Таблицы 
РР Расчеты 
Д Документы прочие 
ПФ Патентный формуляр  
– Документы эксплуатационные 
– Документы ремонтные 
КУ Карта технического уровня и качества  
И Инструкция 

 

В объеме одного или даже нескольких курсовых проектов невозможно 
представить полный комплект КД на изделие. Поэтому состав и объем КД не-
обходимо согласовывать с руководителем для каждого конкретного случая. 
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Для оценки способности самостоятельно проектировать изделия наиболь-
ший интерес представляет рабочая КД, которая включает принципиальные 
схемы и сборочные чертежи с перечнем элементов и спецификациями, чертежи 
деталей. В учебных целях при разработке КД в курсовых проектах документа-
ции рекомендуется присваивать литеру «О», «Т» или «И».  

Большое значение имеет система обозначения. Быстро разыскать чертеж, 
правильно распределить документы по исполнителям изделия, внести измене-
ние в чертеж или заменить его и многое другое – все это требует хорошо про-
думанной системы обозначений. Единая обезличенная классификационная сис-
тема обозначения изделий и их конструкторских документов устанавливается 
ГОСТ 2.201-80. 

Обозначения изделиям и конструкторским документам могут быть при-
своены централизованно или децентрализованно. Централизованное присвое-
ние обозначений должны осуществлять организации, которым это поручено 
министерством, ведомством, в пределах объединения, отрасли. Децентрализо-
ванное присвоение обозначений должны осуществлять организации-
разработчики. 

Конструкторские документы сохраняют присвоенное им обозначение не-
зависимо от того, в каких изделиях они применяются, причем эти обозначения 
записывают без сокращений и изменений, за исключением случаев, предусмот-
ренных ГОСТ 2.113-75. Если КД выполнен на нескольких листах, его обозначе-
ние должно быть указано на каждом листе. 

Деталям, на которые не выпущены чертежи, согласно ГОСТ 2.109-73 при-
сваиваются самостоятельные обозначения по общим правилам. 

Согласно ГОСТ 2.201-80 структура обозначения изделия и основного кон-
структорского документа должна быть следующей: 

Код организации-разработчика
Код классификационной характеристики
Порядковый регистрационный номер

Х Х Х Х.  Х Х Х Х Х Х.   Х Х Х               

 
Четырехзначный буквенный код организации-разработчика назначается по 

кодификатору организаций-разработчиков. В БГУИР на факультете компью-
терного проектирования приняты следующие коды: КПКП, БГУИ – для курсо-
вых проектов. 

Код классификационной характеристики присваивают изделию и конст-
рукторскому документу в соответствии с классификатором ЕСКД.  

Классификатор ЕСКД введен в действие с 1 января 1984 г. Всего в класси-
фикаторе 100 классов. Все изделия размещены в 50 функционально однород-
ных классах. 50 классов являются резервными. Занятыми классами являются 
следующие: 04, 05, 06, 10, 16, 20, 27, 28, 29, 30, 31, 32, 33, 36, 37, 38, 40, 41, 42, 
43, 44, 45, 46, 47, 48, 49, 50, 51, 52, 56, 61, 62, 63, 64, 65, 66, 67, 68, 69, 70, 71, 72, 
73, 74, 75, 76, 77, 79, 80, 94. 
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Структура кода классификационной характеристики: 

Класс
П одкласс
Группа
П одгруппа
Вид

ХХ     Х     Х     Х     Х

 
При классификации изделий в классах использованы в основном следую-

щие признаки: 
– функциональный (основная эксплуатационная функция, выполняемая 

изделием); 
– конструктивный (конструктивные особенности изделия); 
– принцип действия (физический, физико-химический процесс, на основе 

которого действует изделие); 
– параметрический (величины и степени точности рабочих параметров из-

делий: основные размеры, мощность, напряжение, сила тока и пр.); 
– геометрические формы. 
Наиболее общие признаки используются на верхних уровнях классифика-

ции (класс, подкласс) и конкретизируются на последующих уровнях. 
Каждый класс классификатора делится на 10 подклассов (от 0 до 9), каж-

дый подкласс – на 10 групп, каждая группа – на 10 подгрупп и каждая подгруп-
па – на 10 видов. 

Для классификации общих документов используется подкласс «0» во всех 
классах. К подклассу «0» относятся документы, регламентирующие общие для 
изделий всего класса, его подклассов, групп и т.д., нормы, правила, требования, 
методы и т.п. в области свойств изделий, их маркировки, упаковки, контроля, 
приемки, эксплуатации, ремонта, технологии производства и др. Например, 
технические условия, техническое описание, инструкции по ремонту, эксплуа-
тации и т.п. 

Практически во всех классах не все подклассы заняты, часть оставлена для 
вновь разрабатываемых типов изделий. По такому же принципу разбиты и под-
классы, группы, виды. 

Некоторые классы и подклассы изделий, наиболее часто используемые при 
кодировке изделий медицинской электроники, приведены в приложении И, ко-
торое составлено на основе введения к классификатору ЕСКД. Более детальное 
описание кода изделия необходимо уточнять в томах «Классы классификатора 
ЕСКД» (50 классов). 

Порядковый регистрационный номер присваивают по классификационной 
характеристике от 001 до 999 в пределах кода организации-разработчика или 
организации, осуществляющей централизованное присвоение.  

Например, электронный измеритель температуры можно закодировать 
следующим образом: БГУИ.941123.001 – класс 94 (Медицинская техника), под-
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класс 1 (Комплексы медицинской техники. Приборы медицинские. Аппараты 
медицинские). Группа, подгруппа и вид описывают более подробно принцип 
измерения температуры, вид прибора и т.п.  

При обозначении неосновных конструкторских документов (кроме черте-
жей деталей и спецификаций) к обозначению основного документа добавляют 
соответствующий код, установленный ГОСТ 2.102-68 (см. таблицу 9.1). Струк-
тура обозначения неосновного КД следующая: 

Х  Х  Х  Х .  Х  Х  Х  Х  Х  Х .  Х  Х  Х    Х  Х  Х
Обозначение изделия
Код документа

 
В коде документа должно быть не более четырех знаков, включая номер 

части документа, например: КПКП.943341.021 СБ – сборочный чертеж; 
КПКП.943341.021 ТУ – технические условия. 

При групповом или базовом выполнении КД обозначение документа со-
стоит из базового обозначения, как в рассмотренных выше случаях, и порядко-
вого номера исполнения. Каждому исполнению изделия следует присваивать 
самостоятельное обозначение: 

Х Х Х Х.  Х Х Х Х Х Х.  Х Х Х -Х Х
Базовое обозначение
Порядковый номер исполнения

 
В курсовых проектах некоторые чертежи представляют собой графики, 

диаграммы, эпюры напряжений и т.п. Их следует относить к документам про-
чим, устанавливать классификационную характеристику изделия и добавлять 
к обозначению основного конструкторского документа (спецификации проек-
тируемого изделия, оборудования и т.п.) Д, Д1 и т.д. в зависимости от количе-
ства документов. Пример: БГУИ.941123.001 Д – Измеритель температуры 
электронный. Графики исследований. 

Особенности заполнения основной надписи и дополнительных граф к ним 
устанавливает ГОСТ 2.104-68. Если технический документ выполнен на не-
скольких листах, то обозначение должно быть указано на каждом листе доку-
мента. Деталям, на которые не выпущены чертежи, должны быть по общим 
правилам присвоены самостоятельные обозначения. 

 
 

9.2 Правила оформления схем 
Для курсового проектирования по дисциплине «Электронная лечебная ап-

паратура» основными чертежами являются схемы структурные, функциональ-
ные и принципиальные устройства. 

Схемы – конструкторские документы, на которых составные части изде-
лия, их взаимное расположение и связи между ними изображены условно, – по-
зволяют значительно быстрее (чем по чертежам) разобраться в принципе и по-
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следовательности действия элементов того или иного устройства. Виды, типы  
и общие требования к выполнению схем установлены ГОСТ 2.701-84. 

В зависимости от элементов, входящих в состав изделия, связей между 
ними схемы разделяют на различные виды (таблица 9.2).  
Таблица 9.2 – Виды схем 

Виды схем Обозначение 
Электрические Э 
Гидравлические Г 
Пневматические П 

Газовые (кроме пневматических) Х 
Кинематические  К 
Оптические  Л 
Вакуумные В 

Автоматизации А 
Энергетические  Р 
Комбинированные С 

Деления Е 
 
Если в состав изделия входят элементы и связи различных видов, разраба-

тывается комбинированная схема, обозначаемая буквой С. Ее наименование 
определяется видами и типом, например, С3 – схема электропневматическая 
принципиальная. 

По основному назначению схемы делят на определенные типы, обозначае-
мые соответствующей цифрой (таблица 9.3). 
Таблица 9.3 – Типы схем 

Типы схем Обозначение  Назначение 

Структурные 1 
Служат для общего ознакомления с изде-
лием и определяют состав и взаимосвязь 
основных элементов изделия и их назна-
чение 

Функциональные 2 Поясняют процессы, протекающие в из-
делии и его составных частях 

Принципиальные 3 Определяют полный состав элементов из-
делия и связи между ними 

Монтажные 4 
Показывают соединения составных час-
тей изделия и элементы этих соединений 
(провода, кабели, трубопроводы и т.п.) 

Подключения 5 Показывают внешнее подключение изде-
лия 

Общие 6 
Определяют составные части комплекса и 
соединения их между собой на месте экс-
плуатации 

Расположения 7 Определяют относительное расположение 
составных частей изделия 

 
Наименование схемы определяется ее видом и типом, например: схема 

электрическая монтажная (Э4).  
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9.2.1 Построение схемы 
Схемы выполняют без соблюдения масштаба на листах стандартного фор-

мата. При этом действительное пространственное расположение составных час-
тей изделия можно не учитывать. Элементы изделия изображают в виде услов-
ных графических обозначений, устанавливаемых соответствующими стандар-
тами ЕСКД. Связь между ними показывают линиями связи, условно представ-
ляющими собой валы, кабели и т.п. 

Схемы следует выполнять компактно, но не за счет ухудшения ясности и 
удобства их чтения. Линии связи изображают в виде горизонтальных и верти-
кальных отрезков, образующих минимальное количество изломов и взаимных 
пересечений. Расстояния между отдельными связями должны быть не менее 3 
мм, между отдельными условными графическими обозначениями – не менее 2 
мм. Элементы, составляющие отдельное устройство, на схеме выделяют 
штрихпунктирными линиями с указанием наименований этого устройства. 

Допускается выполнять схемы в пределах условного контура, упрощенно 
отображающего конструкцию изделия (например платы). Условные контуры при 
этом выполняются сплошными линиями, равными по толщине линиям связи. 

Устройства, имеющие самостоятельную принципиальную схему, выпол-
няют на схемах в виде фигуры сплошной линией, равной по толщине линии 
связи. 

Функциональную группу или устройство, не имеющее самостоятельной 
принципиальной схемы, выполняют на схемах в виде фигуры сплошной лини-
ей, равной по толщине линиям связи. Фигура, как правило, должна иметь пря-
моугольную форму. Допускается выделять части схемы фигурами непрямо-
угольной формы. 

Если изделие содержит одинаковые устройства, имеющие самостоятель-
ные принципиальные схемы, то каждое из них рассматривают как элемент схе-
мы и изображают на схеме в виде прямоугольника или условного графического 
обозначения, присваивают ему позиционное обозначение и записывают в пере-
чень элементов одной позицией. 

На схеме одного вида допускается изображать элементы схем других ви-
дов, непосредственно влияющих на работу изделия. Эти элементы и их связи 
изображают штриховыми линиями. 

Схемам присваивают обозначения соответствующих им изделий. После 
обозначения следует записывать шифр схемы. Наименование схемы указывают 
в основной надписи после наименования изделия. 

9.2.2 Кинематические схемы 
Выполняются в соответствии с правилами, установленными ГОСТ 2.701-84, 

ГОСТ 2.703-68 и ГОСТ 2.770-68, ГОСТ 2.721-74. В соответствии с ГОСТ 2.703-68 
на кинематической схеме необходимо изображать всю совокупность кинемати-
ческих элементов и их соединений, все кинематические связи между парами, 
цепями и т.п., а также связи с источниками движения. Кинематическую схему 
изделия следует вычерчивать, как правило, в виде развертки. Допускается изо-
бражать схемы в аксонометрических проекциях и, не нарушая ясности схемы, 
переносить элементы вверх или вниз от их истинного положения, а также пово-
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рачивать их в положения, наиболее удобные для изображения. Сопряженные 
звенья пары, вычерченные раздельно, следует соединять штриховой линией.  

Все элементы схемы должны быть изображены условными графическими 
обозначениями по ГОСТ 2.770-68 или упрощенно внешними очертаниями. 
Элементы схемы следует изображать: 

− валы, оси и т.п. – сплошными основными линиями толщиной s; 
− элементы, изображенные упрощенно внешними очертаниями (зубчатые 

колеса, червяки, шкивы, звездочки и т.п.), – сплошными тонкими линиями тол-
щиной s/2; 

− контур изделия, в который вписана схема, – сплошными линиями тол-
щиной s/3; 

− кинематические связи между сопряженными звеньями пары, вычерчен-
ными раздельно, – штриховыми линиями толщиной s/2; 

− крайние положения элемента, меняющего свое положение при работе 
изделия, – тонкими штрихпунктирными линиями с двумя точками; 

− валы и оси, закрытые другими элементами (невидимые), – штриховыми 
линиями. 

Пересекающиеся валы и оси в местах пересечения изображают без разрыва. 
Каждому кинематическому элементу, начиная от источника движения, 

присваивается порядковый номер. Валы нумеруют римскими цифрами, осталь-
ные элементы – арабскими. Элементы покупных или заимствованных механиз-
мов не нумеруют, порядковый номер присваивают всему механизму. Номер 
проставляют на полке линии-выноски. Под полкой необходимо указывать ос-
новные характеристики и параметры кинематического элемента: 

− мощность электродвигателя, Вт, и частоту вращения его вала, мин -1 (угло-
вую скорость, рад/с) или мощность и частоту вращения входного вала агрегата; 

− вращающий момент, Н⋅м, и частоту вращения, мин-1, выходного вала; 
− число и угол наклона зубьев и модуль зубчатых и червячных колес, а для 

червяка – число заходов, модуль и коэффициент диаметра; 
− диаметры шкивов ременной передачи; 
− число зубьев звездочек и шаг цепи и т.п. 
Наименование каждой кинематической группы элементов (например при-

вод подачи) нужно наносить на полке линии-выноски, проведенной от этой 
группы. Сменные кинематические элементы следует обозначать на схеме строч-
ными буквами латинского алфавита и указывать в таблице характеристики для 
всего набора сменных элементов. Таблицу допускается выполнять на отдельных 
листах. Сменным элементам порядковый номер не присваивается. 

9.2.3 Электрические схемы 
Выполняются в соответствии с правилами, установленными ГОСТ 2.701-84, 

ГОСТ 2.702-75 и ГОСТ 2.708-81. В схемах следует применять условные графи-
ческие обозначения элементов, предусмотренные стандартами седьмой класси-
фикационной группы (ГОСТ 2.747-68 и др.). Изделие на схеме следует изобра-
жать в отключенном состоянии. 
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На структурной схеме (Э1) изображают все основные функциональные 
части изделия (элементы, устройства и функциональные группы) и основные 
взаимосвязи между ними. Функциональные части на схеме изображают в виде 
прямоугольника или условных графических обозначений. 

Графическое построение схемы должно давать наиболее наглядное пред-
ставление о последовательности взаимодействия функциональных частей в из-
делии. На линиях взаимосвязей рекомендуется стрелками обозначать направле-
ние хода процессов, происходящих в изделии. 

При большом количестве функциональных частей допускается взамен на-
именований, типов и обозначений проставлять порядковые номера справа от 
изображения или над ним, как правило, сверху вниз в направлении слева напра-
во. В этом случае наименования, типы и обозначения указывают в таблице, по-
мещаемой на поле схемы. 

Допускается помещать на схеме поясняющие надписи, диаграммы или таб-
лицы, определяющие последовательность процессов во времени, а также ука-
зывать параметры в характерных точках (величины токов, напряжений, формы 
и величины импульсов, математические зависимости и т. п.). 

На функциональной схеме (Э2) изображают функциональные части изде-
лия (элементы, устройства и функциональные группы), участвующие в процессе, 
иллюстрируемой схемой, и связи между этими частями. 

Функциональные части и связи между ними на схеме изображают в виде 
условных графических обозначений, установленных в стандартах Единой систе-
мы конструкторской документации. Отдельные функциональные части допуска-
ется изображать в виде прямоугольников. 

На схеме рекомендуется указывать технические характеристики функцио-
нальных частей (рядом с графическими обозначениями или на свободном поле 
схемы), поясняющие надписи, диаграммы или таблицы, определяющие последо-
вательность процессов во времени, а также указывают параметры в характерных 
точках (величины токов, напряжений, формы и величины импульсов, математи-
ческие зависимости и т.д.). 

Схема электрическая принципиальная (ЭЗ) является наиболее полной 
электрической схемой изделия, на которой изображают все электрические эле-
менты и устройства, необходимые для функционирования и контроля в изделии 
данных электрических процессов, все электрические связи между ними, а также 
электрические элементы, которыми заканчиваются входные и выходные цепи. 

Электрические элементы на схеме изображают в виде условных графиче-
ских обозначений, установленных стандартами ЕСКД. Элементы, используе-
мые в изделии частично, допускается изображать не полностью, а только ис-
пользуемые части. 

Условные графические обозначения элементов и устройств выполняют со-
вмещенным или разнесенным способом. При совмещенном способе составные 
части элементов или устройств изображают на схеме в непосредственной бли-
зости друг к другу (рисунок 9.1). При разнесенном способе составные части 
элементов и устройств или отдельные элементы устройств изображают на схе-
ме в разных местах таким образом, чтобы отдельные цепи изделия были изо-
бражены наиболее наглядно. 
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 А1 

 

 А 1.1 А 1.2 

 
а б 

а – совмещенное изображение; б – разнесенное изображение  
Рисунок 9.1 – Фрагмент построения схемы электрической 

 

При изображении элементов разнесенным способом допускается на свобод-
ном поле схемы помещать условные графические обозначения элементов, выпол-
ненные совмещенным способом. При этом элементы, используемые в изделии 
частично, изображают полностью с указанием использованных и неиспользован-
ных частей (например все секции ИМС или все контакты реле). Выводы неис-
пользованных частей изображают короче, чем выводы использованных. 

Схемы выполняют в многолинейном или однолинейном изображении. При 
многолинейном изображении каждую цепь изображают отдельной линией,  
а элементы, содержащиеся в этих цепях, – отдельными условными графически-
ми обозначениями. При однолинейном изображении цепи, выполняющие иден-
тичные функции, изображают одной линией, а одинаковые элементы этих це-
пей – одним условным графическим изображением (рисунок 9.2). 

 S1 

 

 
 S1 

3 3 

 
а б 

а – многолинейное изображение; б – однолинейное изображение 
Рисунок 9.2 – Фрагмент схемы электрической принципиальной 

При изображении на одной схеме нескольких функциональных цепей до-
пускается различать их толщиной линии. На одной схеме рекомендуется при-
менять не более трех размеров линий по толщине. 

Элементы на схеме рекомендуется группировать в соответствии с функ-
циональным назначением в горизонтальные и вертикальные цепи. 

Элементы должны быть соединены линиями электрической связи. При 
этом расстояние между параллельными линиями должно быть не менее 3 мм. 
При большом числе линий связи и их большой протяженности можно группи-
ровать электрически не связанные линии – шины, увеличивая расстояние меж-
ду группами. Вход единичной линии в групповую и выход из нее должны обо-
значаться буквами или цифрами.  

В состав схемы кроме изображений входят надписи, характеризующие 
входные и выходные цепи, позиционные обозначения элементов и перечень 
элементов. 

Каждый элемент схемы должен иметь буквенно-цифровое позиционное 
обозначение, наносимое рядом с его условным графическим обозначением 
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(сверху или справа). Позиционное обозначение должно состоять в общем слу-
чае из трех частей: 

- буквенный код элемента, определяющий его вид, – одна или несколько 
букв латинского алфавита (например VT – транзистор) (приложение К); 

- порядковый номер элемента в пределах группы элементов одного вида – 
одна или несколько арабских цифр; 

- буквенный код функционального назначения данного элемента – одна 
или несколько букв латинского алфавита. 

Нумерацию элементов выполняют по порядку, начиная с единицы, в соответ-
ствии с расположением элементов, считая сверху вниз и слева направо. Буквы и 
цифры обозначения следует выполнять чертежным шрифтом одного размера. 

На принципиальной схеме должны быть однозначно определены все эле-
менты, входящие в состав изделия и изображенные на схеме.  

Расположение условных обозначений элементов определяется последова-
тельностью процесса и удобством чтения схемы, возможностью нанесения по-
зиционных обозначений и, при необходимости, номинальных параметров эле-
ментов. 

На схеме изделия разрешается изображать отдельные элементы, не входя-
щие в данное изделие, но необходимые для разъяснения принципа его работы. 
Графические обозначения этих элементов отделяют от основной схемы тонкой 
штрихпунктирной линией с двумя точками. 

На схемах рекомендуется приводить характеристики входных и выходных 
цепей (ток, напряжение, частоту и т.п.) и адреса внешних соединений, записывая 
их в таблицы, помещаемые взамен условных графических обозначений (плат, 
разъемов и т.п.). Таблицы должны иметь позиционное обозначение записывае-
мого элемента. Адрес должен обеспечивать однозначность присоединения. 

Порядок расположения контактов в таблице определяется удобством по-
строения схемы. При наличии на схеме нескольких таблиц допускается головку 
таблицы приводить только в одной из них. При необходимости допускается 
вводить в таблицу дополнительные графы. Допускается проставлять в графе 
«Конт.» несколько последовательных номеров контактов, в случае если они со-
единены между собой. Номера контактов отделяют друг от друга запятой. 

Сведения о контактах в соединителях указывают одним из следующих 
способов: 

1 Около изображения соединителя на свободном поле схемы или на после-
дующих листах схемы помещают таблицы, в которых указывают адрес соеди-
нения (обозначение цепи (рисунок 9.3) и (или) позиционное обозначение эле-
ментов, присоединяемых к данному контакту). При необходимости в таблице 
приводятся характеристики цепей и адреса внешних соединений. 

В графах таблиц указывают следующие данные: 
в графе «Конт.» – номер контакта, соединителя. Номера контактов записы-

вают в порядке возрастания; 
в графе «Цепь» – характеристику цепи; 
в графе «Адрес» – обозначение цепи и (или) позиционного обозначения 

элементов, соединяемых с контактами. 
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Конт. Цепь Адрес 
1 +5 В Х2:3 
2 Сигнал Х2:5 
3 Корпус Х2:7 

Рисунок 9.3 – Таблица адресов 

2 Соединения с контактами соединителя изображают разнесенным спосо-
бом (рисунок 9.4). 

 Х2 

А1 А2 

Х1 

Х1 Х2 Х3 

1 

2 

3 
1 
2 
4 

3 
5 4 

7 
+5 В 
+12 В 
Общий 
Сигнал 

Х1 

 
Рисунок 9.4 – Разнесенный способ указания таблицы адресов 

При изображении устройств в виде прямоугольников допускается взамен 
условных графических обозначений входных и выходных элементов поме-
щать таблицы с характеристиками входных и выходных цепей, а вне прямо-
угольника – таблицы с указанием адресов внешних соединений. 

В таблице разрешается взамен слова «Конт.» помещать условное графиче-
ское обозначение контакта соединителя. 

В прямоугольниках, изображающих устройства, имеющие самостоятель-
ные электрические принципиальные схемы, допускается помещать их струк-
турные или функциональные схемы или повторять принципиальные схемы. 
Элементы этих устройств в перечень не записывают. 

Если в изделие входит несколько одинаковых устройств, то схему устрой-
ства помещают не в прямоугольник, а на свободном поле с надписью по типу 
«Схема блока А1-А3».  

На поле схемы допускается помещать указания о марках, сечениях и рас-
цветках соединительных проводов и кабелей, а также специальные указания к 
электрическому монтажу изделия. 

При выполнении принципиальной схемы на нескольких листах должны 
соблюдаться следующие требования: 

1) нумерация позиционных обозначений элементов должна быть сквозной 
в пределах изделия (устройства); 

2) перечень элементов должен быть общим; 
3) при повторном изображении отдельных элементов на других листах 

схемы следует сохранять позиционные обозначения, присвоенные им на одном 
из листов схемы. 
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Рисунок 9.5 – Схема электрическая принципиальная устройства 
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Элементы с регулируемыми параметрами на схеме обозначаются звездоч-
кой, и на свободном поле схемы (в технических требованиях) помещается сно-
ска: «Подбирается при регулировании», а в графе «Примечание» перечня эле-
ментов указываются предельные допустимые значения параметров. 

Пример выполнения электрической схемы приведен на рисунке 9.5. 
 
9.2.4 Оптические схемы 
Выполняются по ГОСТ 2.412-81. На оптической схеме должны быть изо-

бражены: 
– выполняющие определенную функцию оптические элементы изделия; 
– источники излучения (упрощенно или условными обозначениями); 
– приемники лучистой энергии, например, фотоэлементы, фотоумножите-

ли (условными графическими обозначениями). 
Элементы, поворачивающиеся или перемещающиеся вдоль или перпенди-

кулярно оси, следует показывать в основном рабочем положении. Кроме него 
могут быть показаны и другие положения, например крайние. При необходимо-
сти допускается обозначать оси прописными буквами русского алфавита. 

Кроме того, на оптической схеме следует указывать: 
− положение диафрагм; 
− положение зрачков (при необходимости); 
− положение фокальных плоскостей, плоскостей изображения и предмета 

(при необходимости, например для фотографических объективов и объективов 
микроскопов); положение экранов, светорассеивающих полостей и поверхно-
стей (при необходимости). 

Номера позиций элементам схемы следует присваивать по ходу луча. При 
разветвлении схемы в несколько направлений номера позиций указываются по 
одному из направлений до конца, затем последующие номера позиций по дру-
гим направлениям. 

Если в схему изделия входит элемент, имеющий самостоятельную прин-
ципиальную схему (расчет оптических величин), то его следует изобразить уп-
рощенно, обвести тонкой штрихпунктирной линией и указать размеры, опреде-
ляющие его положение. 

Повторяющимся элементам необходимо присваивать один и тот же номер 
позиции, после которого в скобках допускается ставить порядковый номер. 

На принципиальной оптической схеме следует помещать основные опти-
ческие характеристики изделия в виде записей на поле схемы или таблицы про-
извольной формы, например: 

– для телескопических систем: видимое увеличение, угловое поле оптиче-
ской системы в пространстве предметов, диаметр выходного зрачка, удаление 
выходного зрачка от последней поверхности, предел разрешения, коэффициент 
пропускания (при необходимости); 

– для фотографических объектов: фокусное расстояние, относительное 
отверстие, угловое поле оптической системы в пространстве предметов или 
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размер кадра, разрешающую способность и коэффициент пропускания (при не-
обходимости); 

– для фотоэлектрических  систем: размеры фотокатодов или типы фото-
приемников, размеры светового пятна на фотокатодах (при необходимости). 

На оптической схеме в зависимости от типа следует указывать:  
– диаметры диафрагм, размеры зрачков, размеры тела накала или других 

светящихся элементов источников излучения (при необходимости); 
– воздушные промежутки и другие размеры по оси, определяющие взаим-

ное расположение оптических элементов, диафрагм, зрачков, фокальных плоско-
стей, плоскостей изображения и плоскостей предмета (для систем, работающих 
на конечном расстоянии), источников излучения и приемников энергии; 

– размеры, определяющие пределы рабочего перемещения или предель-
ные углы поворота оптических деталей; 

– размеры, определяющие положение оптической системы относительно ме-
ханических частей прибора, например, размер,  определяющий положение объек-
тива микроскопа относительно нижнего среза тубуса (при необходимости); 

– габаритные или установочные размеры, например, длину базы, высоту 
выноса (при необходимости). 
 

9.2.5 Перечень элементов 
При составлении схем данные об элементах схемы должны быть записаны 

в таблицу перечня элементов, помещаемую на первом листе схемы или на от-
дельных листах формата А4 в виде самостоятельного текстового документа  
и заполняемую сверху вниз. Перечень элементов, помещенный на листе схемы, 
должен располагаться над основной надписью на расстоянии не менее 12 мм. 
Его продолжение можно помещать слева от основной надписи, повторяя голов-
ку таблицы. При выполнении перечня отдельным текстовым документом в гра-
фе 1 основной надписи следует записывать наименование изделия, для которо-
го составлен перечень, а под ним делать запись «Перечень элементов» шриф-
том, на один или два пункта меньшим того, каким записано наименование из-
делия. Во второй графе – децимальный номер схемы и шифр «П», присвоенный 
документу, а вслед за ним – шифр схемы, например, ПЭ3 – перечень элементов 
схемы электрической принципиальной. 

В графах перечня необходимо приводить следующие данные: 
в графе «Поз. обозначение» – позиционное обозначение элемента; 
в графе «Наименование» – наименование элемента схемы в соответствии  

с документом, на основании которого он применен; 
в графе «Кол.» – количество одинаковых элементов; 
в графе «Примечание» – технические данные элемента, не содержащиеся  

в его наименовании. 
Элементы в перечень следует вносить по группам в алфавитном порядке 

(латинский алфавит) буквенных позиционных обозначений, а в пределах каж-
дой группы – в порядке возрастания номеров. В графе «Наименование» указы-
вают наименование элемента таким образом, как указано в документации на 
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данное изделие с указанием конкретного нормативно-технического документа 
(ТУ, СТБ, ГОСТ и т.п.). 

Ниже наименования функциональной группы (устройства) оставляют одну 
свободную строку, выше – не менее одной свободной строки. 

Между отдельными группами элементов или между элементами в большой 
группе рекомендуется оставлять незаполненные строки для внесения изменений. 
Первую и последнюю строки на каждом листе перечня элементов не заполняют. 

Если в перечень вносят элементы одной группы с одинаковым буквенным 
обозначением, то в графе «Наименование» общее наименование записывают в 
виде заголовка (без повторения наименования элемента в каждой строке) и 
подчеркивают сплошной тонкой линией. Не следует повторять и обозначение 
документа, на основании которого применены элементы данной группы с раз-
личными параметрами.  

Элементы одного вида с одинаковыми параметрами, имеющие на схеме по-
следовательные порядковые номера, рекомендуется записывать одной строкой  
с указанием в графе «Поз. обозначение» обозначения с наименьшим и наиболь-
шим порядковыми номерами, а в графе «Кол.»  общего числа этих элементов. 

При разбивке поля схемы на зоны перечень элементов слева дополняют 
графой «Зона», указывая в ней обозначение зоны, в которой расположен эле-
мент или устройство. 

Перечень элементов записывается в спецификацию после схемы, к которой 
он выпущен.  

Пример заполнения перечня элементов приводится в приложении Л. 
 
 

9.3 Правила оформления спецификаций 
Спецификация – основной конструкторский документ, определяющий со-

став изделия и всей конструкторской документации, относящейся к этому изде-
лию. Ее следует составлять на отдельных листах формата А4 на каждую сбо-
рочную единицу, комплекс и комплект. Заглавный лист оформляют по форме 1 
с основной надписью по форме 2, а последующие листы – по форме 1а с основ-
ной надписью по форме 2а (ГОСТ 2.104-68). 

В зависимости от состава специфицируемого изделия спецификация может 
состоять из разделов, которые следует располагать сверху вниз в такой после-
довательности:  

− документация;  
− комплексы;  
− сборочные единицы;  
− детали;  
− стандартные изделия; 
− прочие изделия;  
− материалы;  
− комплекты. 

 

Би
бл
ио
те
ка

 БГ
УИ
Р



 142 

Комплекс – это два и более специфицированных изделия, не соединенных 
на предприятии-изготовителе сборочными операциями, но предназначенных 
для выполнения взаимосвязанных эксплуатационных функций. Каждое из вхо-
дящих в комплекс специфицированных изделий предназначено для выполнения 
одной или нескольких основных функций, установленных для всего комплекса 
(например, автоматическая линия станков; автоматическая телефонная станция; 
система, состоящая из метеорологической ракеты, пусковой установки и 
средств управления). 

Сборочная единица – это изделие, составные части которого подлежат со-
единению между собой на предприятии-изготовителе сборочными операциями 
(свинчиванием, клепкой, сваркой, пайкой, опрессовкой, развальцовкой, склеива-
нием и пр.), например, осциллограф, блок питания, микромодуль, сварной корпус. 

Деталь – это изделие, изготовленное из однородного по наименованию и 
марке материала без применения сборочных операций (например, стойка из од-
ного куска металла; литой корпус; пластина из биметаллического листа). К де-
талям относятся также указанные выше изделия с покрытием (защитным или 
декоративным) независимо от его вида, толщины и назначения (например пе-
редняя панель со сложным покрытием), а также изделия, изготовленные с при-
менением местной сварки, пайки, склейки и т.п. (например, трубка, спаянная из 
одного куска листового материала). 

Стандартное изделие – это изделие, примененное по государственному, 
отраслевому или республиканскому стандарту, полностью и однозначно опре-
деляющему его конструкцию, показатели качества, методы контроля, правил 
приемки и поставки. 

Комплект – это два и более изделия, не соединенных на предприятии-
изготовителе сборочными операциями и представляющих собой набор изделий, 
имеющих общее эксплуатационное значение вспомогательного характера, на-
пример, комплект запасных частей, комплект инструмента и принадлежностей, 
комплект измерительной аппаратуры. 

Специфицированное изделие – это изделие, состоящее из нескольких со-
ставных частей. 

Неспецифицированное изделие – это изделие, не имеющее составных час-
тей. 

Комплектующее изделие – это изделие (составная часть изделия), полу-
чаемое предприятием в готовом виде и изготовленное по конструкторской до-
кументации предприятия-поставщика. 

Покупное изделие – это изделие (составная часть изделия), получаемое 
предприятием в готовом виде. 

Кооперированное изделие – это изделие (составная часть изделия), полу-
чаемое предприятием в готовом виде и изготовленное по его конструкторской 
документации на другом предприятии. 

Оригинальное изделие – это изделие, примененное в конструкторской до-
кументации только данного изделия. 

Унифицированное изделие – это изделие, примененное в конструкторской 
документации нескольких (разных) изделий. 
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Типовое изделие (изделие однотипного исполнения) – это изделие, при-
надлежащее к группе изделий близких конструкций и обладающее наибольшим 
числом конструктивных и технологических признаков этой группы. 

Наименование разделов записывают в виде заголовков в графе «Наимено-
вание» строчными буквами (кроме первой прописной) и подчеркивают. Ниже 
заголовка должна быть оставлена одна свободная строка, выше – не менее од-
ной свободной строки. 

В раздел «Документация» вносят все документы специфицируемого изде-
лия, кроме его спецификации, а также документы записываемых в специфика-
цию неспецифицируемых составных частей (деталей) (если таковые использу-
ются), кроме их рабочих чертежей. 

В разделы «Комплексы», «Сборочные единицы» и «Детали» вносят ком-
плексы, сборочные единицы и детали специфицируемого изделия. 

В разделе «Стандартные изделия» записывают изделия, примененные по го-
сударственным стандартам, отраслевым стандартам, стандартам предприятий. 

В пределах каждой категории стандартов изделия записывают по группам 
в зависимости от функционального назначения (например, подшипники, кре-
пежные детали, контакты и т.п.), в пределах каждой группы – в алфавитном по-
рядке по наименованиям изделий, в пределах каждого наименования – в поряд-
ке возрастания обозначений стандартов, а в пределах каждого обозначения стан-
дартов – в порядке возрастания основных параметров или размеров изделия. 

В раздел «Прочие изделиия» записывают изделия, взятые из каталогов, 
прейскурантов и других источников, за исключением стандартных изделий. 
Порядок записи подобен порядку раздела «Стандартные изделия». 

В раздел «Материалы» вносят все материалы специфицируемого изделия в 
такой последовательности: металлы черные; металлы магнитоэлектрические и 
ферромагнитные; металлы цветные; кабели, провода и шнуры; пластмассы и 
пресс-материалы; бумажные, текстильные и лесные материалы; резиновые, ми-
неральные, керамические и стеклянные материалы; лаки, краски, нефтепродук-
ты и химикаты; прочие материалы. 

В пределах вида материалов их записывают в алфавитном порядке по на-
именованиям, в пределах наименования – по возрастанию размеров или других 
параметров. 

Графы спецификации заполняют следующим образом. 
В графе «Формат» указывают форматы документов, имеющих обозначение 

в графе «Обозначение». Если документ выполнен на нескольких листах раз-
личного формата, то в графе ставят «звездочку», а в графе «Примечание» пере-
числяют все форматы с простановкой знака звездочки, например: *А3, А4, 
А4х3. Для деталей, на которые нет чертежей, в данной графе указывают БЧ. 
Для документов, записанных в разделы «Стандартные изделия», «Прочие изде-
лия» и «Материалы» графу «Формат» не заполняют. 

В графе «Зона» указывают обозначение зоны, где находится номер пози-
ции записываемой части изделия (если поле чертежа разбито на зоны по 
ГОСТ 2.104-68). 
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В графе «Поз.» указывают порядковые номера составных частей в после-
довательности записи их в спецификации. Порядковые номера должны записы-
ваться в порядке возрастания, но рекомендуется пропускать некоторые номера 
для возможности последующей корректировки документации, например, 1, 3, 7. 
Графу не заполняют для разделов «Документация» и «Комплекты». 

В графе «Обозначение» указывают: для раздела «Документация» – обозначе-
ние записываемых документов, для разделов «Комплексы», «Сборочные едини-
цы», «Детали» и «Комплекты» – обозначение основных конструкторских доку-
ментов на записываемые изделия; для деталей, выпущенных без чертежей, – при-
своенное им обозначение (если таковое имеется). Графу не заполняют для разде-
лов «Стандартные изделия», «Прочие изделия» и «Материалы». 

В графе «Наименование» указывают: 
− в разделе «Документация» для документов специфицируемого изделия – 

только их наименование; например Сборочный чертеж, Габаритный чертеж, 
Технические условия, Пояснительная записка; для документов на неспецифици-
руемые части – наименования изделия и документа; 

− в разделах «Комплексы», «Сборочные единицы», «Детали» и «Комплек-
ты» – наименования изделий в соответствии с их основной надписью на основ-
ных конструкторских документах; для деталей без чертежа указывают наиме-
нования и материалы, а также размеры, необходимые для их изготовления; 

− в разделе «Стандартные изделия» – наименования и обозначения изде-
лий в соответствии с нормативно-технической документацией; 

− в разделе «Прочие изделия» – наименования и условные обозначения изде-
лий по документам на их поставку с указанием обозначений этих документов; 

− в разделе «Материалы» – обозначение материала с указанием норматив-
но-технической документации (ГОСТ, СТБ, ТУ …). 

Допускается для изделий и материалов, различающихся размерами и дру-
гими данными и примененных по одному документу, общую часть наименова-
ния с обозначением документа записывать на каждом листе спецификации 
один раз в виде заголовка. Под общим наименованием следует записывать для 
каждого изделия и материала только их параметры и размеры. В этом случае 
записывают следующим образом: 

Гайки ГОСТ 5927-70 
М2-6Н.5.019; 
М3-6Н.5.016 и т.д. 
Если основные параметры или размеры изделия обозначаются одним чис-

лом или буквой, то не допускается пользоваться указанным допущением. 
В графе «Кол.» указывают количество составных частей на одно специфи-

цируемое изделие, а для раздела «Материалы» – общее количество материала 
на одно изделие с указанием единицы величины, которая указана в нормативно-
технической документации на материал. Последние допускается записывать  
и в графе «Примечание». Количество таких материалов, как припой, клей, 
флюс, электроды для сварки и т.п., в спецификации не указывают. Эти сведения 
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дают на поле чертежа в технических требованиях. В разделе «Документация» 
данную графу не заполняют. 

После каждого раздела спецификации необходимо оставлять несколько 
свободных строк для дополнительных записей. Первую и последнюю строки 
на каждом листе спецификации не заполняют. Состав разделов специфика-
ции зависит от специфицируемого изделия. 

Допускается совмещение спецификации со сборочным чертежом при ус-
ловии его размещения на листе формата А4. При этом основную надпись вы-
полняют по ГОСТ 2.104-68 (форма 1) с указанием обозначения основного кон-
структорского документа (спецификации).  

Пример выполнения спецификации на сборочный чертеж платы приведен 
в приложении М. 

 
 

9.4 Требования к чертежам деталей 
При выполнении чертежей деталей следует ограничиться минимальным 

количеством изображений (видов, разрезов, сечений). Вопрос о количестве изо-
бражений, их содержании, взаимном расположении, масштабе и т.д. решают 
комплексно, исходя из удобства пользования чертежом при изготовлении и 
контроле изделия, а также исходя из особенностей детали (пружина, корпус, 
печатная плата и т.д.). Для деталей типа тел вращения достаточно дать одно 
изображение, добавляя к нему при необходимости частичные виды, разрезы, 
сечения и выносные элементы.  

Деталь должна быть изображена, как правило, в натуральную величину. В 
зависимости от ее размеров и сложности может быть выбран масштаб увеличе-
ния или уменьшения. Для выносных элементов следует использовать только 
масштаб увеличения.  

Рабочий чертеж детали должен содержать ряд требований, выполнение ко-
торых обеспечивает осуществление изготовленной деталью предназначенных 
ей функций, надёжность, длительность ее работоспособности. Требования из-
лагаются в виде изображений, условных знаков и текстовых записей на поле 
чертежа. 

Если отдельные элементы изделия необходимо до сборки обработать со-
вместно с другим изделием (например, половины корпуса подшипника, редук-
тора и т.п.), для чего их следует соединить и скрепить, то на оба изделия 
должны быть самостоятельные чертежи, выполненные по общим требовани-
ям. В отдельных, более сложных случаях допускается помещать полное или 
частично упрощенное изображение другого изделия, выполненное сплошны-
ми тонкими линиями. Специальные чертежи на совместную обработку не до-
пускаются. 

Если отверстия под винты, штифты и другие аналогичные детали обраба-
тываются в процессе сборки, на чертежах такие отверстия не изображают  
и сведений о них в технических требованиях не дают. Необходимые данные для 
их обработки приводят на сборочном чертеже. 
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На чертежах деталей не допускается помещать технологические указания. 
В виде исключения можно указать совместную обработку, гибку, развальцовку 
и т.д. Эти данные приводят на полке линии-выноски или в ТТ. 

Правила оформления чертежей типовых деталей – зубчатых и червячных 
колес, червяков, звездочек, шкивов, валов – приведены в соответствующих 
ГОСТах, СТП и т.д. Не допускается в курсовых и дипломном проектах приво-
дить чертежи нормализованных деталей (крепеж, стойки, втулки, некоторые 
другие элементы и т.д.). Эти изделия включаются в соответствующие разделы 
спецификации со ссылкой на действующую нормативно-техническую докумен-
тацию (см. раздел 9.1).  

Изделия простой конфигурации, изготавливаемые из полуфабриката, вно-
сятся в спецификацию без чертежа (БЧ) с присвоением обозначения по класси-
фикатору. Например: 

 

Фор-
мат Зона Поз. Обозначение Наименование Кол. Приме-чание 

БЧ  17 БГУИ.741235.013 
Прокладка. Лакоткань элек-
троизоляционная ЛШМ 0,5 
ГОСТ 2214-78 20х60 мм 

4  

 
9.4.1 Нанесение размеров на чертежах деталей 
Основанием для определения величины изображённого изделия и его эле-

ментов служат размерные числа, нанесенные на чертеже. Размеры, как правило, 
проставляют от баз. Общее количество размеров на чертеже должно быть мини-
мальным, но достаточным для изготовления и контроля изделия. Размеры, не 
подлежащие выполнению по данному чертежу, называются справочными.  

Нанесение размеров является одним из главных этапов составления черте-
жей и должно отвечать правилам, установленным ГОСТ 2.307-68 ЕСКД:  

1 Нанесению размеров на чертеже предшествует выбор баз изделия. 
2 В зависимости от назначения различают следующие виды баз: техноло-

гическую, используемую для определения положения заготовки или изделия в 
процессе изготовления или ремонта; конструкторскую, используемую для оп-
ределения положения детали или сборочной единицы в изделии; измеритель-
ную, определяющую относительное положение заготовки или изделия и 
средств измерения. 

3 Конструкторские базы подразделяют на основные, принадлежащие дан-
ной детали или сборочной единице и определяющие их положение в изделии, и 
вспомогательные, также принадлежащие данной детали или сборочной единице 
и используемые для определения положения присоединяемого к ним изделия. 

Установлены две категории размеров: сопряженные – размеры соедине-
ний, посадочных поверхностей, а также входящие в размерные цепи; свободные 
– не входящие в размерные цепи. Сопряженные размеры наносят от кондуктор-
ских баз, свободные – от технологических. 

Если детали получены литьем, ковкой, штамповкой или прокаткой, то раз-
меры необрабатываемых по чертежу элементов деталей проставляют от техно-
логических баз. 
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Если деталь имеет обработанные и необработанные поверхности, то раз-
меры обработанных поверхностей наносят от конструкторской базы, а необра-
ботанных – от технологической. Обе базовые поверхности в каждом коорди-
натном направлении должны быть связаны одним размером. 

Установлены два способа нанесения размеров от баз: 
координатный – размеры наносятся от одной, основной базы  или от не-

скольких баз лесенкой. При этом способе погрешности в размерах не накапли-
ваются и не влияют на общий результат; 

цепной – размеры наносят цепочкой (один за другим), исключая один из 
размеров той части детали, которая не подвергается обработке и имеет самый 
большой допуск на размер.  

Нанесение размеров в виде замкнутой цепи допускается только в том слу-
чае, когда один из размеров указывается как справочный.  

Справочный размер отмечают на чертежах знаком «*», а в технических 
требованиях записывают: 

* Размер для справок.  
Необходимые для изготовления размеры, за исключением справочных, на-

носят с предельными отклонениями. Допуски и расположение поверхностей 
приводятся в соответствии с рекомендациями ГОСТ 2.307-68, ГОСТ 2.308-79, 
ГОСТ 21495-76, ГОСТ 25346-82, ГОСТ 7713-62, ГОСТ 25347-82. Выбирать но-
минальные значения размеров необходимо из ряда предпочтительности. 

Размеры и допуски формы, как правило, указываются от технологических 
баз. Размеры между центрами симметричных отверстий должны иметь симмет-
ричный допуск, например ± 0,1 мм. Допуски формы и расположения поверхно-
стей указывают либо условными обозначениями, согласно ГОСТ 2.309-79, либо 
текстом в технических требованиях (рисунок 9.6, таблица 9.4).  

 

 

 
Рисунок 9.6 – Варианты обозначения базы и допусков формы на чертеже 

 

Предельные отклонения линейных размеров на чертеже указывают одним 
из трёх способов (рисунок 9.7): 

а) условными обозначениями полей допусков; 
б) числовыми значениями предельных отклонений; 
в) условными обозначениями полей допусков с указанием справа в скобках 

числовых значений предельных отклонений. 
Многократно повторяющиеся на чертежах предельные отклонения разме-

ров относительно низкой точности (от 12-го квалитета и грубее) записываются 
в технических требованиях: «Неуказанные предельные отклонения размеров: 
отверстий – по Н12, валов – по h12, остальных – ±IT14/2». Рекомендуется для 
размеров от 3 до 6 мм выбирать предельные отклонения ±0,15 мм (IT11),  
6–10 мм – ±0,18 мм (IT12), больше 10 мм – ±0,215 мм (IT13). 
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Таблица 9.4 – Обозначения допусков формы и расположения поверхностей 

Вид допуска Знак Вид допуска Знак 
Допуски формы 

 
Прямолинейности 

 
  Цилиндричности 

 

 

Плоскостности 
 

 

Круглости 
 

 

 

Профиля  
продольного  
сечения 

 

 

Допуски расположения поверхностей 

Параллельности 

 

 

Пересечения осей 
 

 

Перпендикулярности 

 

 
 

Симметричности 

 

 

Позиционный 
 

 
Соосности 

 

 Наклона 
 

 
Суммарный допуск формы и расположения 

Торцевого и радиаль-
ного биения в заданном 

направлении 

 
 

 

Формы заданного про-
филя 

 
 

Полного торцевого и 
радиального биения 

 

 

Заданной  
поверхности 

 
 

 
Детали для изделий ЭЛА выполняются с определенной точностью. Шкалы 

точности образуют 20 разрядов допусков, называемых квалитетами. Допуски на 
размеры деталей ЭЛА с точки зрения экономической целесообразности соот-
ветствуют 8–15 квалитетам. 

Числовые значения полей допусков приведены в ГОСТ 25317-82. 
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 а б в 

Рисунок 9.7 – Варианты нанесения предельных отклонений на детали 
 

9.4.2 Нанесение шероховатости поверхности на чертежах деталей 
Проектируя детали, необходимо задавать не только точность, с которой 

должны быть выдержаны размеры элемента детали, но и допустимую шерохо-
ватость ее поверхности. При этом необходимо учитывать экономические фак-
торы (чем выше требования к качеству, тем дороже изготовление), взаимосвязь 
между способом обработки элемента поверхности и величиной шероховатости, 
между квалитетом и числовым значением параметра шероховатости и рекомен-
дации по выбору шероховатости в зависимости от применения детали (среда, 
климат) (таблица 9.5). Обозначения шероховатости поверхностей наносят в со-
ответствии с ГОСТ 2.309-73 с изменением №3 включительно, принятым Меж-
государственным советом по стандартизации, метрологии и сертификации 
(протокол №21 от 28.05.2002 г.) (рисунок 9.8, таблица 9.6). 
Таблица 9.5 – Рекомендации по выбору шероховатости поверхности 

Шероховатость Условия эксплуатации, применения 

Ra 6,3; Rz 40 
Поверхности деталей, не соприкасающиеся с другими поверхно-
стями и не используемые в качестве технологических баз 

Ra 3,2; Rz 20 
Поверхности деталей, прилегающие к поверхностям других дета-
лей, не подвергающиеся износу 

Ra 2,5 
Базовые поверхности деталей с допусками в пределах квалитетов 
Н8, h8, Н9, h9 включительно под гальванические покрытия 

Ra 1,25 
Трущиеся поверхности и базовые поверхности с допусками в пре-
делах квалитетов h8, h7 и точнее 

Ra 0,63 
Соприкасающиеся поверхности, хорошо противостоящие износу,  
с повышенными требованиями к коррозионной стойкости 

Ra 0,32 Декоративные поверхности особо высокого качества 
Ra 0,18 Поверхности качения особо ответственных деталей 
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Рисунок 9.8 – Условное обозначение знака шероховатости 

 

Таблица 9.6 – Примеры обозначения шероховатости поверхностей 

Обозначение Обработка поверхности 
 

 По данному чертежу не обрабатываются 
 

 Не устанавливаемая конструктором 
 

 
Определено конкретно, например точение или 

фрезерование 
 

 
Указанный вид является единственным,  

например полировка 
 
Допускается при недостатке места располагать обозначение шероховато-

сти на размерных линиях или на их продолжениях, на рамке допуска формы, а 
также разрывать выносную линию. 

 
9.4.3 Выбор материалов для изделий электронной аппаратуры 
Материалы для изделий ЭЛА определяются исходя из функционального 

назначения, серийности производства, технического уровня заготовительного 
производства и экономической целесообразности применения определенного 
способа изготовления заготовок. Материалы деталей выбирают с учетом специ-
альных требований, предъявляемых к работе не только каждой детали изделия, 
но и отдельных элементов детали. Это дает возможность уменьшить массу де-
тали, сборочных единиц и изделия ЭЛА в целом. 

Для современных требований, предъявляемых к изготовлению деталей из-
делий ЭЛА, характерны следующие технологические тенденции: максимальное 
приближение заготовок по формам и размерам к деталям, требующимся по чер-
тежу; экономия материала, применение прогрессивных способов получения за-
готовок деталей. 

Назначая материалы, необходимо учитывать стоимость, надежность, каче-
ство, длительность работоспособности детали и условия, в которых будет рабо-
тать изделие. 

Сведения о материалах для деталей приводятся в основной надписи. Жела-
тельно, чтобы деталь изготавливалась из сортового материала определённых 
профиля, размеров и качественной характеристики. Запись о материалах детали 
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должна содержать сведения о сортаменте (в числителе) и материале (в знамена-
теле), например: 

15 ГОСТ5949-75Пруток
12X18Н9Т ГОСТ5632-72

, 

где 15 – диаметр прутка; ГОСТ 5949-75 – стандарт на сортамент прутка; 
ГОСТ 5632-72 – стандарт на химический состав высоколегиро-
ванной коррозионностойкой, жаростойкой и жаропрочной де-
формируемой стали и сплавов, 12Х18Н9Т – химический состав 
сплава (0,12 % углерода, 18 % хрома, 9 % никеля, 1 % титана). 

Правильно выбрать марку материала и его сортамент можно с помощью 
соответствующих справочников. Ряд материалов для изделий ЭЛА приведен  
в приложении Н, материалы, используемые для изделий с электромонтажом, –  
в приложении П. Рекомендуется для курсовых проектов выполнять поиск необ-
ходимых материалов и сортамента с помощью поисковых систем в сети Internet. 

 

9.4.4 Особенности оформления чертежей деталей, получаемых литьем 
Ряд деталей может быть получен литьём. Отливки из цветных сплавов, из-

готовленные методом литья в песчаные формы, кокиль, оболочковые формы, 
по выплавляемым моделям и под давлением, выполняются согласно норматив-
но-технической документации. Они подразделяются на две группы отливок: I –
 общего назначения; II – ответственного назначения, имеющие повышенную 
прочность. В зависимости от метода литья установлены следующие классы 
точности для отливок: 

− литье под давлением – ЛТ1-ЛТ3; 
− литье в кокиль, оболочковые формы – ЛТ5, ЛТ6; 
− литье в песчаные формы – ЛТ6, ЛТ7. 
При получении деталей литьем в технических требованиях указывают тре-

бования к размерам, группам и предельным отклонениям, например: 
«Литейные радиусы 0,5 мм max.»;  
«Литейные уклоны до 10»; 
«Отливка 1 гр.»; 
«Неуказанные предельные отклонения размеров – по ЛТ5». 
Пример чертежа литой детали показан на рисунке 9.9. 
 
9.4.5 Обозначение покрытий деталей электронной аппаратуры 
Для повышения коррозийной стойкости поверхности изделия, улучшения 

механических свойств материала, а также для придания изделию декоративного 
вида обычно поверхности деталей покрывают покрытиями. Обозначения по-
крытий устанавливают ГОСТ 9.306-85. Покрытия металлические и неметалли-
ческие неорганические и ГОСТ 9.032-74. Покрытия лакокрасочные. 

Покрытию могут подвергаться все поверхности деталей или избиратель-
ные участки. В нормальных условиях эксплуатации толщина гальванических 
покрытий 6–9 мкм, в атмосферных и морских – 12–15 мкм.  
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Ra 3,2 

 
1 Отливка II группы по ГОСТ 977-75. 
2 Изготовление отливки по II кл. точности по ГОСТ 2009-75. 
3 Литейные радиусы 4 мм. 
4 Покрытие: эмаль МЛ, чёрная IV У4. Fпокр = 53,4 см2. 
5 Неуказанные предельные отклонения размеров: H14, h14, ±0,5IТ14. 

Рисунок 9.9 – Пример оформления чертежа литой детали 
 
Ряд покрытий требует предварительного нанесения подслоя. Никелевое 

покрытие, наносимое на сталь, требует, например, медного подслоя, а серебря-
ное, наносимое на латунь или бронзу, – медного подслоя. Для применения по-
крытия из драгоценных металлов, например серебряного, необходимо обосно-
вание. О применении покрытий на чертежах деталей соответствующим образом 
делаются записи (таблица 9.7). 

В обозначениях лакокрасочных покрытий, согласно ГОСТ 9.032-74, в пер-
вую группу знаков входят обозначение покрытия по ГОСТ 9.825-73 и, при не-
обходимости, предварительное наименование и группа шпатлёвки с указанием 
числа слоёв; во вторую группу – обозначение классов покрытий (I–VII); в тре-
тью – обозначение условий эксплуатации в части действия климатических фак-
торов (по ГОСТ 9.104-79) и особых сред (по ГОСТ 9.032-74), например: 

«Покрытие эмаль ЭП-140 серая, III.VI» 
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Таблица 9.7 – Примеры обозначения покрытий на деталях 

Обозначение в  
технических требованиях Расшифровка и назначение покрытия 

Покрытие Ц9. хр.,  
кроме отверстий 

Материал покрытия – цинк, толщина – 9 мкм, после-
дующее хроматирование. 
Наносится на стальные детали, работающие в нор-

мальных условиях внутри корпуса изделия 

Покрытие хим.окс.прм. 

Покрытие выполнено методом химического оксиди-
рования с промасливанием. 
Наносится на стальные детали, работающие в нор-

мальных условиях внутри корпуса изделия 

Покрытие Кд15.хр. 

Материал покрытия – кадмий, толщина – 15 мкм, 
последующее хроматирование. 
Наносится на стальные детали, работающие в усло-

виях атмосферных осадков и в морском климате 

Покрытие М6.Н12 

Двухслойное покрытие: I слой – медь толщиной  
9 мкм; II слой  – никель толщиной 12 мкм. 
Наносится на латунные или бронзовые детали, рабо-

тающие в нормальных условиях снаружи корпуса изде-
лия, т.к. обладает хорошими декоративными свойствами 

Покрытие М3.Ср6 

Двухслойное покрытие: I слой – медь толщиной  
3 мкм; II слой  – серебро толщиной 6 мкм. 
Наносится на латунные или бронзовые детали, рабо-

тающие в качестве контактирующих элементов, т.к. 
обладает малым сопротивлением 

Покрытие ан.окс.черн. 

Покрытие выполнено методом электрохимического 
(анодного) оксидирования с чернением. 
Наносится на детали из алюминиевых сплавов, рабо-

тающие в качестве теплоизлучающих элементов конст-
рукции внутри корпуса изделия 

Покрытие хим.окс.э 

Покрытие выполнено методом химического оксиди-
рования, электропроводное. 
Наносится на детали из алюминиевых сплавов, рабо-

тающие в нормальных условиях внутри корпуса изделия 

9.4.6 Технические требования и техническая характеристика 
Технические требования и техническую характеристику (ТХ) помещают на 

свободном поле чертежа над основной надписью в виде текстовой части. При 
недостатке места их продолжают слева от основной надписи. Текст записывают 
сверху вниз.  

Пункты ТТ и ТХ должны иметь самостоятельную нумерацию. Каждый 
пункт записывают с новой строки, причем строки должны быть не длиннее 185 
мм. При выполнении чертежа на двух листах и более ТТ и ТХ помещают толь-
ко на первых листах. 

ТТ на чертеже детали следует приводить в соответствии с ГОСТ 2.316-68. 
Заголовок «Технические требования» не пишут, если на чертеже помещены 
только технические требования.  
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ТТ рекомендуется излагать в следующем порядке: 
1) требования к материалу, заготовке, термической обработке и к свойст-

вам материала готовой детали (например твердость); указание материалов-
заменителей; 

2) размеры (формовочные и штамповые уклоны, радиусы и пр.); предель-
ные отклонения размеров, формы и расположения поверхностей; дисбаланс; 

3) требования к качеству поверхностей (отделке, покрытию); 
4) зазоры, расположение отдельных элементов конструкции; 
5) требования, предъявляемые к настройке и регулированию изделия; 
6) другие требования к качеству, например, бесшумность, виброустойчи-

вость; 
7) условия и методы испытаний; 
8) указания о маркировании и клеймении; 
9) правила транспортирования и хранения; 
10) особые условия эксплуатации; 
11) ссылки на другие документы, содержащие ТТ, распространяющиеся на 

данное изделие, но не приведенные на чертеже. 
В последнем пункте технических требований в обоснованных случаях не-

обходимо привести следующее требование: Остальные технические требова-
ния по СТБ 1014-95. СТБ 1014-95 распространяется на детали, изготавливаемые 
механической обработкой, из металлов, резины, стекла, слоистых диэлектри-
ков, карбонильного железа, кожи, войлока, древесины и применяемые в изде-
лиях приборостроения. Стандарт устанавливает общие технические требования, 
правила приёмки, методы испытаний, маркировку, упаковку, транспортировку 
и хранение. В общих технических требованиях содержатся сведения о неука-
занных предельных отклонениях размеров, радиусах гибки, вытяжки, закругле-
ний, размерах фасок, глубине зенковки и т.д., например: 

− неуказанные предельные отклонения размеров до 1 мм должны быть для 
отверстий – Н13, валов – h13, остальных – ± IT13/2, а размеров свыше 1 мм – 
для отверстий – Н14, валов – h14, остальных – ± IT14/2;  

− неуказанные предельные отклонения угловых размеров должны быть по 
16-й степени точности; 

− острые кромки должны быть притуплены радиусом 0,3–0,5 мм или фас-
кой под углом 45o; 

− резьба должна быть предохранена от попадания краски; 
− неуказанные отклонения формы и расположения поверхностей должны 

быть выполнены в соответствии с ГОСТ 25.069-81. 
На чертежах пружин основные ТТ рекомендуется приводить в последова-

тельности, указанной в ГОСТ 2.401-68, а на чертежах изделий, содержащих 
надписи, – ГОСТ 9.032-74. Указания о маркировании и клеймении изделий на-
носят на чертеже по ГОСТ 2.314-68. 

В ТХ содержатся требования о напряжении питания, потребляемой мощ-
ности устройства, рабочем давлении газа или жидкости и т.п. 
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ТХ следует помещать отдельно от ТТ под заголовком «Техническая характе-
ристика», который располагается над ТТ. Оба заголовка не подчеркивают. 

 
9.4.7 Особенности оформления чертежей плат печатных 
Одними из основных чертежей в курсовом проекте являются чертежи пе-

чатных плат. Термины, относящиеся к печатным платам (ПП) и узлам, приве-
дены в ГОСТ 20406-75. Методы конструирования и расчёта содержит 
ГОСТ 23751-86, общие технические условия приведены в ГОСТ 23752-86. Со-
гласно требованиям, приведенным в ГОСТ 10317-79, размеры каждой стороны 
должны быть кратными: 2,5 – при длине до 100 мм; 5,0 – при длине до 350 мм; 
10,0 – при длине более 350 мм. Максимальный размер любой из сторон должен 
быть не более 470 мм. Соотношение линейных размеров сторон – не более 3:1. 
ГОСТ 2.417-78 устанавливает основные правила выполнения чертежей ПП. 
Чертежи ПП содержат координатную сетку, которую наносят с шагом 1,25 или 
2,5 мм. Размеры отверстий, их количество, размеры зенковки и другие сведения 
помещают в таблице, расположенной на поле чертежа. Печатные элементы 
(проводники, экраны, монтажные площадки) положено штриховать. При шири-
не проводника на чертеже менее двух миллиметров их изображают сплошной 
жирной линией.  

Чертежи односторонних и двухсторонних печатных плат именуют Пла-
та печатная. Они относятся к 75 классу, 8 подклассу по классификатору 
ЕСКД. Например, БГУИ. 758716.003 Плата печатная. 

Чертеж многослойной ПП называют Плата печатная многослойная. Он 
относится к 68 классу, 7 подклассу по классификатору ЕСКД. Например, 
БГУИ. 687263.007 Плата печатная многослойная. В состав комплекта черте-
жей на многослойную ПП входят спецификация и сборочный чертеж. В специ-
фикации в разделе «Документация» содержатся сведения о конструкторских  
и технологических документах на многослойную ПП (Сборочный чертеж (СБ), 
Таблица координат отверстий (ТБ), Ведомость документов на носителях дан-
ных (ВН) и т.п.), в разделе «Детали» – сведения о слоях ПП (они оформляются, 
как правило, в виде чертежей БЧ с указанием материала и размера), в разделе 
«Материалы» – сведения о прокладках между слоями ПП. На сборочном чер-
теже на первом листе указываются технические требования, требования к от-
верстиям, внешний вид ПП с габаритными и присоединительными размерами,  
а также разрез многослойной ПП с указанием порядка следования и количества 
слоев и межслойных диэлектрических прокладок, на последующих листах – ри-
сунки отдельных проводящих слоев.  

Возможно выполнение отдельных слоев многослойной ПП в виде отдель-
ных чертежей аналогично односторонним ПП. 

На чертеже ПП наносят координатную сетку линиями толщиной 
0,2…0,5 мм в соответствии с выбранным шагом и масштабом. Линии коорди-
натной сетки относительно нулевой нумеруются через один или несколько ша-
гов (но не более пяти) цифрами. Допускается простановка номеров линий по 
четырем сторонам чертежа печатной платы. 
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На чертеже ПП допускается приводить дополнительные виды с частичным 
изображением рисунка. 

Чертежи печатных плат выполняют, как правило, в масштабах 1:1, 2:1, 4:1, 
5:1, 10:1. 

Размеры на ПП наносятся одним из следующих способов: 
1) в соответствии с ГОСТ 2.417-91; 
2) нанесением координатной сетки в прямоугольной системе координат 

(линии сетки нумеруются); 
3) нанесением координатной сетки в полярной системе координат; 
4) комбинированным способом с помощью размерных и выносных линий 

и координатной сетки в прямоугольной или полярной системе координат. 
Шаг координатной сетки в прямоугольной системе координат равен (по 

ГОСТ 10317-79) 2,5 мм, дополнительный – 1,25 или 0,5 мм.  
За ноль в прямоугольной системе координат на главном виде печатной 

платы следует принимать: 
− центр крайнего левого нижнего отверстия, находящегося на поле платы, 

в том числе технологического; 
− левый нижний угол печатной платы; 
− левую нижнюю точку, образованную линиями построения. 
При необходимости нужно указать границы участков платы, которые не 

допускается занимать проводниками, при этом на чертеже следует применить 
штрихпунктирную линию. 

Проводники на чертеже должны изображаться одной линией, являющейся 
осью симметрии проводника. Проводники шириной более 2,5 мм могут изо-
бражаться двумя линиями, при этом если они совпадают с линиями координат-
ной сетки, то численное значение ширины не указывается. 

Круглые отверстия, имеющие зенковку, и круглые контактные площадки 
с круглыми отверстиями следует изображать одной окружностью. Их форму  
и размеры оговаривают на поле чертежа в ТТ. 

Круглые контактные площадки и контактные площадки произвольной фор-
мы, не обозначенные размерами, выполняются на чертеже тоже окружностью. 

Для простановки размеров контактной площадки под многовыводные и по-
верхностно-монтируемые элементы контактную группу в увеличенном масштабе 
выносят на поле чертежа. 

Размер отверстия на чертеже печатной платы обозначают условно. Размер 
отверстия в миллиметрах, наличие металлизации, его условное обозначение  
и количество представляют в виде таблицы на поле чертежа. Проводники, 
имеющие заданную ширину, показывают на чертеже. Если такой проводник 
имеет по длине переменную ширину, то ее указывают на каждом участке. 

При наличии на чертеже печатной платы двух и более проводников, 
имеющих заданную ширину, допускается их изображение выполнять штрихов-
кой, зачернением. 

При необходимости форму и размеры вырезов на широких проводниках  
и экранах показывают на чертеже. 
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Маркировку печатной платы располагают на чертеже с одной или двух 
сторон. Размер шрифта и способ маркировки указывают в технических требо-
ваниях чертежа. 

На чертежи обязательно наносится следующая маркировка: обозначение 
ПП или её условный шифр; дата изготовления; буквенно-цифровое обозначение 
слоёв многослойных ПП; порядковый номер изменения чертежа.  

Комплектность КД на ПП и требования по их выполнению при автомати-
зированном проектировании устанавливает ГОСТ 2.123-83. 

При изготовлении чертежей сложных насыщенных печатных плат ре-
комендуется размещать на отдельных листах трассировку печатных проводни-
ков, маркировку, конфигурацию защитных масок и т.п. Чертежи слоев много-
слойных печатных плат также помещают на отдельных листах.  

Параметры элементов рисунка рекомендуется группировать в виде табли-
цы и размещать ее на свободном поле чертежа. В таблице можно указывать ми-
нимально допустимые значения элементов проводящего рисунка (ширины пе-
чатного проводника, диаметра контактной площадки и др.). Расположение от-
верстий допускается обозначать координатным способом. 

Рекомендуемый состав и последовательность записи технических требова-
ний чертежа: 

− размеры для справок; 
− печатную плату изготовить... (метод изготовления указывается только в 

случае невозможности изготовления другим методом); 
− печатная плата должна соответствовать ГОСТ 23752-79, группа жестко-

сти... ; шаг координатной сетки... мм; 
− сведения об элементах рисунка печатной платы, не указанные в чертеже. 

Параметры элементов рисунка рекомендуется группировать в виде таблицы и 
размещать ее на свободном поле чертежа. В таблице можно указывать мини-
мально допустимые значения элементов проводящего рисунка (ширины печат-
ного проводника, диаметра контактной площадки и др.). Расположение отвер-
стий допускается обозначать координатным способом; 

− покрытие... (указывают только конструктивное покрытие. Обозначение 
покрытия записывается по ГОСТ 9.306-85. Покрытия металлические и неметал-
лические неорганические. Обозначения); 

− масса покрытия (массу покрытия указывают только для драгоценных 
металлов); 

− маркировать… .шрифт…  по...; 
− дополнительные указания. 
Для печатных плат, имеющих одинаковые технические требования, допуска-

ется технические требования чертежа выполнять отдельным документом. 
 
9.4.8 Типовые технические требования на чертежах печатных плат 
Двухсторонняя ПП должна содержать следующие технические требования: 
1 * Размеры для справок. 
2 ПП изготовить комбинированным позитивным методом. 
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3 Шаг координатной сетки 1,25 мм, ГОСТ 2.417-78. 
4 ПП должна соответствовать ГОСТ 23752-86, группа жёсткости 2. 
5 Класс точности 3 по ГОСТ 23751-86. 
6 Форма контактных площадок произвольная.  
7 Допускаемые отклонения очертаний проводников, контактных площа-

док от заданных чертежом ±0,1 мм. 
8 Покрытие: Хим.М.М 24 О-С (66) 10-12 опл. Покрытие концевых печат-

ных контактов Н3 Зл на размер В с двух сторон платы. 
9 Маркировать краской маркировочной МКЭЧ черной по 

ОСТ 4Г0.054.205.VI дату изготовления. Шрифт 3-Пр3 по СТБ 992-95. 
10 Маркировать травлением, шрифт 2,5-Пр3 по СТБ 992-95, в узких мес-

тах – шрифт 2,0-Пр3: 
а) позиционные обозначения; 
б) знаки вспомогательной маркировки. Толщина линий 0,3 мм. 

11  Допускается смещение маркировки в места, удобные для чтения. 
12  Предельные отклонения расстояний между осями двух любых конце-

вых печатных контактов ±0,1 мм. 
13  Неуказанные предельные отклонения размеров ±IТ 14/2. 
14  Остальные технические требования по СТБ 1014-95. 
Чертеж печатной платы дан в приложении Р. 
При проектировании печатных плат под технологию поверхностного 

монтажа рекомендации по заполнению ТТ несколько отличаются, например 
для односторонней платы: 

1 *Размер для справок. 
2 Плату изготовить фотохимическим методом. 
3 Плата должна соответствовать ГОСТ 23752-86, группа жёсткости 2. 
4 Предельные отклонения на размеры и расположение элементов конст-

рукции по 3 классу точности ГОСТ23751-86 обеспечиваются инструментом. 
5 Неуказанные предельные отклонения размеров: Н14, h14, ±IT12/2. 
6 Следы перфорации по контуру платы не допускаются. 
7 Размеры и количество контактных площадок – см. таблицу 1, отвер-

стий – см. таблицу 2 лист 2. 
8 Печатный монтаж, прямая и обратная маркировки и маска должны со-

ответствовать утвержденным фотошаблонам (см. листы 3, 4, 5, 6). 
9 Сопротивление изоляции проверять между точками Л и М (см. лист 3). 
10 Плата предназначена для автоматизированной установки ЭРЭ. 
11 Допускается разрыв подрезанных контактных площадок в 10 местах. 
12 Нанести паяльную маску зеленую Fotochem FSR 8000-8G фирма UNION 

SOLTEK GROUP (Тайвань). 
13 Маркировать маской белой фотопроявляемой Fotochem FSR 8000-11W 

фирма UNION SOLTEK GROUP (Тайвань), шрифт 2,5-Пр3 по СТБ 992-95, в узких 
местах – шрифт 2,0-Пр3: 

а) позиционные обозначения; 
б) знаки вспомогательной маркировки. Толщина линий 0,3 мм. 
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14 Допускается смещение маркировки в места, удобные для чтения. 
15 Максимальный прогиб платы относительно диагонали не более 3 мм. 
16 В зоне К допускаются следы технологических отверстий.  
17 Остальные технические требования по СТБ1014-95. 

 
 

9.5 Оформление сборочных чертежей 
При выполнении курсовых проектов по дисциплине ЭЛА исследователь-

ского типа либо по информационным технологиям допускается вместо сбороч-
ных чертежей аппаратов приводить их упрощенные варианты. 

 
9.5.1 Чертеж общего вида 
Чертеж общего вида (по ГОСТ 2.119-73) должен давать сведения о конст-

рукции, взаимодействии составных частей, эксплуатационно-технической ха-
рактеристике проектируемого изделия и пояснять принцип его работы. 

На чертеже общего вида должны быть: 
а) изображены виды, разрезы и сечения изделия, нанесены надписи и тек-

стовая часть, необходимые для понимания конструктивного устройства изде-
лия, взаимодействия его составных частей и принципа работы изделия; 

б) указаны наименования (если возможно, то и обозначения) составных час-
тей изделия, для которых объясняется принцип работы, приводятся технические 
характеристики, указываются материал, количество, и тех составных частей изде-
лия (например органов управления), с помощью которых описывается принцип 
работы изделия, поясняются изображения общего вида и состав изделия; 

в) приведены необходимые размеры и, если требуется, схема (например кине-
матическая) изделия, техническая характеристика и технические требования. 

Чертеж выполняется с максимальными упрощениями, предусмотренными 
ГОСТ 2.109-73 и другими стандартами. Составные части изделия (в том числе 
заимствованные и покупные) рекомендуется изображать упрощенно (отдель-
ные – лишь контурными очертаниями), если при этом понятны конструкция, 
взаимодействие составных частей и принципы работы изделия. Составные час-
ти могут изображаться на одном листе с общим видом или на отдельных после-
дующих листах этого чертежа. Наименования и обозначения составных частей 
изделия должны быть указаны одним из следующих способов: 

− на полках линий-выносок, проведенных от деталей, на чертеже общего 
вида; 

− в таблице, размещаемой на чертеже общего вида; 
− в таблице, выполненной отдельно в виде последующих листов этого чер-

тежа. 
Таблица должна состоять из граф «Поз.», «Обозначение», «Кол.», «Дополни-

тельные указания», а если необходимо, – граф «Материал», «Наименование» и др. 
При наличии таблицы номера позиций составных частей изделия должны 

быть указаны на полках линий-выносок в соответствии с этой таблицей. Реко- 
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мендуется такая последовательность записи составных частей изделия в таб-
лицу: 

− заимствованные изделия;  
− покупные изделия;  
− вновь разрабатываемые изделия.  
Чертеж общего вида следует оформлять в соответствии с правилами, уста-

новленными для разработки рабочих чертежей (в отношении расположения но-
меров позиций, подписей, текста технических требований). 

 
9.5.2 Габаритный чертеж 
Габаритный чертеж следует выполнять с максимальными упрощениями, 

но так, чтобы были видны крайние положения перемещающихся, выдвигаемых 
или откладываемых частей, рычагов, кареток, крышек на петлях и т.п. 

Число видов должно быть минимальным, но достаточным, чтобы дать 
представление о внешних очертаниях изделия и его выступающих элементах. 
Изображения изделия следует выполнять сплошными основными линиями,  
а очертания частей, перемещающихся в крайние положения, – тонкими штрих-
пунктирными линиями с двумя точками. 

На габаритном чертеже допускается изображать тонкими линиями «обста-
новку» – детали и сборочные единицы, не входящие в состав изделия. 

На габаритном чертеже должны быть нанесены габаритные, установочные 
и присоединительные размеры, определяющие положение выступающих час-
тей, без указания того, что все эти размеры справочные. Установочные и при-
соединительные размеры, необходимые для увязки с другими изделиями, 
должны быть с предельными отклонениями. Допускается указывать координа-
ты центра тяжести. На габаритном чертеже можно указывать условия примене-
ния, хранения, транспортирования и эксплуатации изделия. 

 
9.5.3 Сборочный чертеж 
Одним из важнейших видов конструкторской документации являются 

сборочные чертежи. Согласно ГОСТ 2.109-73 (издание – март 2001 г. с изме-
нениями №1…10), сборочный чертеж содержит: изображение сборочной еди-
ницы с минимальным, но достаточным количеством видов, разрезов и сечений, 
дающее представление о расположении и взаимной связи составных частей, со-
единяемых по данному чертежу, и обеспечивающее возможность осуществле-
ния ее сборки (изготовления), контроля и т.п. Для полного удовлетворения этих 
требований, согласно ГОСТ 2.102-68, необходимо выполнять кроме сборочного 
габаритный, монтажный и другие чертежи. Однако в курсовых  проектах с це-
лью уменьшения объема графических работ рекомендуется совмещать их на 
одном сборочном чертеже. 

Независимо от типа производства (единичное, серийное, массовое) конст-
рукция изделия должна состоять из отдельных четко разграниченных сбороч-
ных единиц, обеспечивать параллельность и независимость сборки, а также 
простоту связей. 
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Число деталей собираемого изделия (сборочной единицы) должно быть 
минимальным, этого можно достичь правильным конструированием. Сложные 
изделия, состоящие из большого числа деталей, рекомендуется конструировать 
по блочному (агрегатному) принципу. 

При проектировании следует стремиться к уменьшению числа крепежных 
деталей. Вместо резьбового крепежа целесообразно применять сварку, расклеп-
ку, развальцовку, резку, следует также избегать применения соединений, кото-
рые трудно выполнить, например, шпоночные, с пружинами и другие крупно-
габаритные и тяжелые детали должны иметь специальные элементы для уста-
новки (отверстия, приливы и т.д.) и фиксации. 

Детали, входящие в сборочные единицы, должны иметь простую форму. В 
противном случае необходимо, чтобы они имели явно выраженные базовые по-
верхности. 

Шероховатость сопрягаемых поверхностей деталей должна быть обосно-
вана. Детали, сопрягаемые в осевом направлении по кромкам поверхностей, 
должны иметь конструктивные элементы, облегчающие самоустановку и само-
центрирование поверхностей. Допуски на размеры деталей должны обеспечи-
вать возможность осуществления сборки методом полной или частичной взаи-
мозаменяемости. Необходимо также предусматривать средства, предотвра-
щающие поворачивание болтов при затяжке. 

Следует избегать или сводить до минимума совместную механическую об-
работку деталей (в сборе), включая сверление и выполнение резьбы, так как это 
снижает производительность и нарушает основной принцип поточной сборки – 
взаимозаменяемость сборочных единиц и деталей. 

При проектировании сборок необходимо учитывать класс исполнения по 
условиям эксплуатации. 

Соединения деталей в сборочных единицах могут выполняться различны-
ми способами: сваркой, пайкой, склеиванием, заклепками, резьбовыми соеди-
нениями и т.д.  

Резьбовые детали, с помощью которых выполняют соединения, называют 
крепежными. К ним относят болты, винты, шпильки и гайки. Под гайки при со-
единении деталей необходимо подкладывать шайбы, а для исключения самоот-
винчивания крепежных деталей при ударах и вибрациях – пружинные шайбы. 
Если соединяются неметаллические детали, то со стороны и головки крепежно-
го изделия, и гайки необходимо устанавливать шайбы. 

Сборочный чертеж изделия должен содержать: 
1) изображение сборочной единицы, позволяющее осуществить ее сборку 

и контроль; 
2) размеры с указанием предельных отклонений (и другие параметры и 

требования), которые проверяются при сборке; 
3) сопряженные размеры с обозначением посадок (в местах установки на 

валы и в корпус зубчатых и червячных колес, подшипников, втулок и т.д.); 
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4) основные размеры, характеризующие изделие и его основные состав-
ные части (например, для редуктора: межосевое расстояние с допускаемыми 
отклонениями; направление линии, угла наклона и число зубьев); 

5) номера позиций составных частей, входящих в изделие; 
6) основные технические характеристики изделия; 
7) габаритные, установочные и присоединительные размеры, а также не-

обходимые справочные размеры; 
8) технические требования к готовому изделию. 
Габаритными называются размеры, определяющие предельные внешние 

или внутренние очертания изделия. Установочными и присоединительными 
называются размеры, определяющие величины элементов, по которым данное 
изделие устанавливают на месте монтажа или присоединяют к другому изде-
лию. К справочным, согласно ГОСТ 2.307-68, относят следующие размеры:  

1) один из размеров замкнутой цепи;  
2) размеры, перенесенные с чертежей заготовок изделий;  
3) размеры на сборочном чертеже, по которым определяют предельные по-

ложения отдельных элементов конструкции, например ход поршня;  
4) габаритные размеры на сборочном чертеже, перенесенные с чертежей 

деталей или являющиеся суммой размеров нескольких деталей;  
5) размеры деталей (элементов) из сортового, фасонного, листового и дру-

гого проката, если они полностью определяются обозначением материала, при-
веденным в графе основной надписи;  

6) размеры на сборочном чертеже, перенесенные с чертежей деталей и ис-
пользуемые в качестве установочных и присоединительных (с предельными от-
клонениями элементов, служащих для соединения с сопрягаемыми изделиями). 

Сборочный чертеж изделия рекомендуется выполнять в масштабе 1:1 на 
одном или нескольких листах формата А1 (в зависимости от размеров и слож-
ности изделия могут быть использованы другие масштабы и форматы листов). 

На сборочном чертеже необходимо указывать в соответствии со специфи-
кацией номера позиций всех составных частей сборочной единицы. Эти номера 
указывают на основных видах и разрезах и помещают на полках линий-
выносок, проводимых от видимых изображений составных частей и заканчивае-
мых точкой, причем выноски и полки проводят тонкими линиями. У зачерненных 
или узких площадей точку заменяют стрелкой. Номера позиций следует распола-
гать параллельно основной надписи чертежа вне контура изображения и группи-
ровать их в колонку или строчку по возможности на одной линии. 

Номера позиций наносят на чертеж один раз. Шрифт номеров позиций 
должен быть на один–два размера больше, чем шрифт размерных чисел данно-
го чертежа.  

Общая линия-выноска с вертикальным расположением позиций допускается: 
− для группы крепежных деталей, расположенных в одном месте; 
− для группы деталей с отчетливо выраженной взаимосвязью; 
− при невозможности подвести выноску к каждой составной части. 
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Линию-выноску в этих случаях отводят от изображения составной части, 
номер позиции которой указан первым. 

Изображение на чертеже может быть упрощенным в соответствии с 
ГОСТ 2.109-73. В частности, допускается: 

− не показывать выступы, рифления, насечки, оплетки и другие мелкие 
элементы, маркировочные и технологические данные; 

− сварной узел изображать как монолитное тело; 
− шестигранные и квадратные головки гаек и винтов изображать упро-

щенно; 
− крепежные детали (винты, болты, шпильки, гайки, шайбы, закладки и т.п.), 

шпонки, сплошные валы, зубья и спицы колес и маховиков условно показывать не-
рассеченными, если секущая плоскость направлена вдоль оси такой детали; 

− если вал имеет углубления, шпоночные пазы, центровые отверстия, то 
для изображения этих элементов следует применять местные разрезы; 

− шарики подшипников качения показывать нерассеченными; 
− ребра жесткости и тонкие стенки показывать рассеченными, но без 

штриховки; 
− пластины, а также элементы деталей (отверстия, фаски, пазы, углубле-

ния и т.п.) размером 2 мм и менее изображать с отступлением от масштаба, 
принятого для всего изображения, в сторону увеличения. 

Перемещающиеся части изделия изображают в крайнем или промежуточ-
ном положении только штрихпунктирными линиями с двумя точками с разме-
рами, характеризующими эти положения. Перемещающиеся части допускается 
изображать на дополнительных видах с соответствующими надписями, напри-
мер «Крайнее положение шатуна поз. 5». 

На сборочном чертеже устройства допускается помещать изображение по-
граничных (соседних) изделий (обстановку) и размеры, определяющие их вза-
имное расположение. Предметы «обстановки», как правило, выполняются уп-
рощенно и приводятся для определения места изделия. Составные части изде-
лия, расположенные за «обстановкой», изображают как видимые. 

В технических требованиях на сборочных чертежах, в обоснованных слу-
чаях, следует указать: «Остальные технические требования по СТБ 1022-96». 
Данный стандарт содержит общие требования, требования к подвижным и не-
подвижным соединениям, методы испытаний и правила приемки. В документе 
указывается, что неподвижные соединения не должны иметь качки, проворачи-
вания; резьбовые соединения затянуты, а резьба должна быть без краски; шли-
цы, грани не сорваны и не смяты; подвижные части должны перемещаться без 
рывков, заеданий, плавно, шум должен быть однотонным, стопорные устрой-
ства должны фиксировать требуемое положение; испытания изделий необхо-
димо проводить в нормальных условиях. Требования, отличные от требований 
стандарта, в том числе и требования о маркировке, упаковке, транспортировке 
и хранении, надо оговаривать в сборочных чертежах специальными пунктами 
в технических требованиях.  
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9.5.4 Оформление сборочного чертежа печатного узла 
Сборочный чертеж печатного узла должен давать полное представление о 

характере расположения навесных элементов и способе их установки на пла-
ты. Способы установки в соответствии с нормативно-технической документа-
цией приводятся в технических требованиях, а для элементов, отсутствующих 
в ней, – отдельными видами на поле чертежа.  

Например, ГОСТ 29137-91 содержит общие требования и нормы конст-
руирования по формовке выводов и установке изделий электронной техники на 
печатные платы. В данном ГОСТе для обозначения варианта формовки выво-
дов и установки ИЭТ на печатные платы устанавливают следующую структуру 
условных обозначений: 

 
 Обозначение варианта  
формовки и установки  

 ХХХ. ХХ. ХХХХ. ХХ. ХХ 

 Номер чертежа 
 Шифр позиции ИЭТ 

 Глубина формовки Н 
 Наличие дополнительной формовки  

 

Данные для условного обозначения формовки ИЭТ приведены в таблице 9.8. 
Пример условного обозначения варианта формовки выводов и установки 

резистора, соответствующего исполнению 14 с длиной корпуса 10,8 мм при ис-
пользовании зиг-замка:  

140.02.0203.00.02. 
Таблица 9.8 – Варианты типовых конструктивных исполнений формовки ИЭТ 

Типовое 
конструктивное 
исполнение 

Обозначение 
варианта  
формовки и 
установки 

Номер 
чертежа 

Шифр  
позиции 
ИЭТ 

Характеристика 
ИЭТ 

1 2 3 4 5 
 

010 
 

 
 

011 

2 

 
0201–0221 

 
 

0301–0341 

Резисторы, конденсато-
ры, диоды, дроссели в 
цилиндрических и пря-
моугольных корпусах с 
двумя осевыми выводами 

 1+0
,5

 
140 2 0201–0221 

0301–0341 

Резисторы, конденсато-
ры, диоды, дроссели в 
цилиндрических и пря-
моугольных корпусах с 
двумя осевыми выводами 

 

190 – – 

Транзисторы в прямо-
угольных и цилиндриче-
ских корпусах с тремя  
однонаправленными вы-
водами 
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Продолжение таблицы 9.8 
1 2 3 4 5 

 

220 3 0401–0407 

Резисторы, конденсаторы, дио-
ды, дроссели в цилиндрических 
и прямоугольных корпусах с 
двумя осевыми выводами 

 
320 - - 

Микросхемы и другие ИЭТ в 
корпусах типа 1 по ГОСТ 17467 

 
330 - - 

Микросхемы и другие ИЭТ в 
корпусах типа 2 по ГОСТ 17467 

360 

 
361 18 1101–1113 

Микросхемы и другие ИЭТ в 
корпусах типа 4 по ГОСТ 17467 

 
Пример записи вариантов формовки выводов и установки ИЭТ, имеющих 

согласно спецификации поз. 3, 7, 9: 
Установку производить по ГОСТ 29137-91: 

поз. 3 – вариант 140.02.0203.00.02, 
поз. 7 – вариант 071.04.0602.12.00, 
поз. 9 – вариант 301.14.0000.00.00. 

При формовке выводов ИЭТ размером от корпуса ИЭТ до места изгиба 
вывода Lo считают размер от корпуса ИЭТ до центра окружности изгиба выво-
да. При установке ИЭТ на печатные платы размером от корпуса до места пайки 
вывода считают размер от корпуса ИЭТ вдоль оси вывода до места приложения 
паяльника или зеркала припоя, в том числе при пайке вывода в металлизиро-
ванное отверстие. 

Минимальный размер от корпуса ИЭТ до места изгиба при формовке вы-
водов L0, мм: 
для резисторов, конденсаторов ..........................................................0,5 
для микросхем и других ИЭТ в корпусах типа 4  
по ГОСТ 17467-88...............................................................................1,0 
для полупроводниковых приборов ....................................................2,0 
для дросселей ......................................................................................3,5 

Минимальный внутренний радиус изгиба выводов R, мм: 
для выводов диаметром или толщиной до 0,5  
включительно ......................................................................................0,5 
для выводов диаметром или толщиной свыше 0,5 до  
1,0 мм включительно ..........................................................................1,0 
для выводов диаметром или толщиной  
свыше 1,0 мм .......................................................................................1,5 

В технически обоснованных случаях допускается уменьшать внутренний 
радиус изгиба выводов до 0,3 мм. 
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Минимальный размер от корпуса ИЭТ до места пайки – 2,5 мм. Допуска-
ется уменьшение указанного размера при условии обеспечения теплоотвода  
в процессе пайки. 

Предельные отклонения размеров между осями двух любых выводов ИЭТ, 
устанавливаемых в монтажные отверстия, – ±0,2 мм, а на контактные пло-
щадки – ±0,1 мм. Остальные размеры формовки выводов ИЭТ не контроли-
руются и должны быть обеспечены инструментом. 

Установочные размеры для ИЭТ, устанавливаемых в отверстия печатных 
плат, следует выбирать кратными шагу координатной сетки 2,5 мм или 1,25 мм 
в соответствии с ГОСТ 10317. 

В местах крепления установочных деталей (стоек, втулок, скоб) делают 
местные разрезы. На чертеже приводят также маркировку позиционных обо-
значений ИЭТ, условные обозначения выводов трансформаторов и реле, нуме-
рацию выходных контактов, полярности элементов согласно принципиальной 
электрической схеме, а также оговаривается характер стопорения резьбовых 
соединений, например, по ГОСТ 30133-95, вид 27, красный; размеры – выпол-
няемые по чертежу (посадки, высота радиоэлементов над печатными платами), 
габаритные, установочные, присоединительные и другие справочные размеры, 
например обозначения резьб и т.д.  

Типовые технические требования к сборочным чертежам изделий 
СМЭ, содержащим печатный и объемный монтаж (блоки ЭЛА, аппараты, 
приборы и т.п.): 

1 *Размеры для справок. 
2 Трущиеся поверхности смазать смазкой ЦИАТИМ-201 ГОСТ 6267-74. 
3 Электромонтаж выполнить проводом поз. 16 по схеме электрической 

принципиальной КПКП. 941132.001 ЭЗ. 
4 Паять ПОС-61 ГОСТ 21931-76. 
5 Провода, идущие в одном направлении, вязать в жгуты нитками поз. 25, 

крепить скобками поз. 15. 
6 Поверхность контакта транзистора поз. 19 с радиатором поз. 10 покрыть 

пастой КПТ-8 ГОСТ1978-81.  
7 Клей ВК-9 ОСТ 92-0948. 
8 ЭРЭ маркировать по ГОСТ 23594-79 в местах, удобных для чтения, крас-

кой ТНПФ-53 черной на светлой поверхности и краской ТНПФ-851 белой на 
темной поверхности. Шрифт 3-Пр41 по СТБ 992-95. 

9 Места для клеймения заполнить мастикой №2 ГОСТ 18680-73. 
10 Технические требования к конструкциям разделки и соединения экра-

нов проводов по ГОСТ 23586-79.  
11 Технические требования на жгут по ГОСТ 23586-79. 
12 Технические требования к разделке монтажных проводов и крепления 

жил по ГОСТ 23587-79. 
13 Технические требования к электромонтажу приборных частей соедини-

телей по ГОСТ 23591-79. 
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14 Технические требования к монтажу ЭРЭ по ГОСТ 23592-96. 
15 Остальные технические требования по СТБ 1022-96. 
Типовые технические требования для сборочных чертежей печатных 

узлов: 
1 *Размеры для справок. 
2 **Размеры для формовки выводов элементов обеспечиваются инстру-

ментом. 
3 ***Подбирается при регулировании. 
4 Установку элементов производить по ГОСТ 29137-91. 
5 Шаг координатной сетки 1,25 мм. Элементы ... установить по варианту ...; 

установку отдельных элементов см. поле чертежа. 
6 Позиционные обозначения элементов показаны условно. 
7 Технические требования к монтажу ЭРЭ по ГОСТ 23592-96. 
8 Технические требования к конструкциям разделки проводов и крепления 

их жил – ГОСТ 23587-79. 
9 ПОС 61 ГОСТ 21931-76. 
10 ПОСК 50-18 ГОСТ 21931-76 для... 
11 ПСр. 2,5 ГОСТ 19746-74 для... 
12 Пайку транзисторов производить при закороченных выводах паяльни-

ком с напряжением 6–12 В, мощностью не более 60 Вт в течение не более 3 с. 
13 Поверхности соприкосновения транзисторов поз. ... смазать полиметил- 

оксановой жидкостью ПМС-1000 ГОСТ 13032-77. 
14 На выводы транзисторов поз. ... надеть трубки поз. … 
15 При пайке, промывке и лакировке недопустимо попадание флюса, при-

поя, спирта и лака на корпуса элементов. 
16 Клей ЭЛ-19 ОСТ 4Г0.029.204. 
17 Клей ТК-200 ТУ 6-01-1241-80 для ... 
18 Клей К-400 ОСТ 4Г0.029.204 для ... 
19 Клей ГИПК-231 ТУ 6-05-251-96-79. 
20 Стопорить по ГОСТ 30133-95 поз. ... вид ... 
21 Стопорение сердечников катушек после регулировки церезином синте-

тическим M 100 ГОСТ 7658-74 для ... 
22 Покрытие – жидкость гидрофобизирующая 136-41 ГОСТ 10834-76, 

кроме поверхностей ... 
23 Маркировать и клеймить краской ТНПФ-1851 белой. Шрифт 2,5-Пр3 по 

СТБ 992-95. 
24 Остальные технические требования – по СТБ 1022-96. 
Пример оформления технических требований для печатного узла, из-

готовленного с применением технологии поверхностного монтажа: 
1 *Размеры для справок 
2 Позиционные обозначения элементов показаны условно. 
3 Центры симметрии поверхностно-монтируемых элементов установлены 

в узлах координатной сетки. Предельные отклонения размеров между центрами 
элементов при установке не более 0,3 мм. 
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4 Координаты установки поверхностно-монтируемых элементов см. таб-
лицу 1. 

5 Поверхностно-монтируемые элементы устанавливать на клей SMD-
ADHESIVE «Heraeus» PD 860002 S с последующей пайкой волной припоя. 

6 Элементы, обозначенные знаком «**», устанавливать по вариантам ис-
полнений. 

7 ПОС-63 ГОСТ 21931-76. 
8 Паяльная паста G4(A)-SM 833 NION SOLTEK GROUP (Тайвань). 
9 Маркировать дату изготовления и номер платы краской МКЭЧ. Шрифт 

3-Пр41 по СТБ 992-95. 
10 Остальные ТТ по СТБ 1022-96. 
Сборочный чертеж печатной платы приведен в приложении С. 
 
 

9.6 Оформление текстовых документов 
Весьма важным видом технической документации являются текстовые до-

кументы. К ним относятся различные инструкции, технические условия и опи-
сания, документы ремонтные и эксплуатационные, пояснительные записки и 
т.п. Общие правила оформления текстовых документов регламентированы 
ГОСТ 2.105-95. Особенности требований к оформлению технологической до-
кументации содержатся в ГОСТ 3.1104-81. Правила выполнения текстовых до-
кументов устанавливает ГОСТ 2.106-96. В соответствии с требованиями стан-
дартов их выполняют по формам 5 и 5а. Основную надпись и дополнительные 
графы к ней выполняют по ГОСТ 2.104-68.  

В курсовых проектах допускается пояснительную записку выполнять на 
обычных листах формата А4 с соблюдением требований ГОСТ 2.105-95. Еди-
ная система конструкторской документации. Общие требования к текстовым 
документам, ГОСТ 7.32-2001. Отчет о научно-исследовательской работе. 
Структура и правила оформления. 

ПЗ выполняется с применением печатающих и графических устройств вы-
вода ЭВМ (ГОСТ 2.004-88 ЕСКД). Текст ПЗ печатается с количеством знаков в 
строке 60–75 и межстрочным интервалом, позволяющим разместить 40±3 строк 
на странице. При компьютерном наборе печать производится шрифтом 13–14 
пунктов. Высота строчных букв, не имеющих выступающих элементов, должна 
быть не менее 2 мм. Разрешается использовать компьютерные возможности ак-
центирования внимания на определениях, важных особенностях, применяя 
шрифты разной гарнитуры, выделение с помощью рамок, разрядки, курсива, 
подчеркивания и пр. 

Текст ПЗ следует размещать на листе, соблюдая следующие размеры полей: 
левое – не менее 30 мм, правое – не менее 10 мм, верхнее – не менее 15 мм, 
нижнее – не менее 20 мм. 

Текст ПЗ можно излагать на русском или белорусском языке. Сокращение 
русских и белорусских слов и словосочетаний в записке – по СТБ 7.12-2001. 
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В тексте ПЗ применять не допускается: 
- математический знак минус (–) перед отрицательными значениями вели-

чин (следует писать слово «минус»); 
- знак «∅» без числового значения для обозначения диаметра (следует пи-

сать слово «диаметр»); 
- без числовых значений математические знаки, например, > (больше),  

< (меньше), = (равно), ≥ (больше или равно), ≤ (меньше или равно), ≠ (не рав-
но), а также знаки № (номер), % (процент). Исключение составляют формулы, 
таблицы, рисунки. 

В ПЗ следует применять стандартизованные единицы физических величин, 
их наименования и обозначения в соответствии с ГОСТ 8.417-81. 

Наряду с единицами СИ при необходимости в скобках указывают единицы 
других систем, разрешенных к применению. Применение в ПЗ разных систем 
обозначения физических величин не допускается. 

В тексте числа от одного до девяти без единиц измерений следует писать 
словами. 

Дробные числа необходимо приводить в виде десятичных дробей, за ис-
ключением размеров в дюймах, которые следует записывать в строку, напри-
мер 1/2". 

При невозможности выразить числовое значение в виде десятичной дроби 
допускается записывать его в виде простой дроби в одну строчку через косую 
черту, например 35А – 8С / (20В + 10), при этом действия знаменателя берутся 
в скобки. 

Иллюстрации, таблицы и распечатки ЭВМ, включенные в ПЗ (по тексту 
или в приложении), должны соответствовать формату А4. Допускается пред-
ставлять иллюстрации, таблицы и распечатки с ЭВМ на листах формата А3. 

Абзацы в тексте начинаются отступом, равным 10–13 мм. 
Текст ПЗ делится на разделы, подразделы и пункты. Пункты при необхо-

димости могут делиться на подпункты. 
Разделы должны иметь заголовки. Подразделы могут иметь заголовки при 

необходимости. Пункты, как правило, заголовков не имеют. 
Заголовки следует писать с абзацного отступа с прописной буквы без точ-

ки в конце, не подчеркивая. Перенос слов в заголовках не допускается. 
Расстояние между заголовком (за исключением заголовка пункта) и тек-

стом должно составлять 2–3 строки. Если между двумя заголовками (например 
раздела и подраздела) текст отсутствует, то расстояние между ними устанавли-
вается в 1,5–2,0 строки. Расстояние между предшествующим текстом и новым 
заголовком рекомендуется делать несколько больше, чем между заголовком  
и последующим текстом. 

Каждый раздел текстового документа рекомендуется начинать с нового 
листа (страницы). 

Разделы должны иметь порядковые номера в пределах всей записки, обо-
значенные арабскими цифрами без точки и записанные с абзацного отступа. 
Подразделы должны иметь нумерацию в пределах каждого раздела, пункты  
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в пределах подраздела и т.д. Номер подраздела состоит из номеров раздела  
и подраздела, разделенных точкой. В конце номера точку не ставят. Если раз-
дел имеет только один подраздел или подраздел – один пункт, то нумеровать 
его не следует. 

Пункты при необходимости могут быть разбиты на подпункты, которые 
должны иметь порядковую нумерацию в пределах каждого пункта.  

Перечисления внутри пунктов или подпунктов оформляются следующим 
образом. 

Перед каждой позицией перечисления следует ставить дефис или при не-
обходимости ссылки в тексте документа на одно из перечислений – строчную 
букву со скобкой. Для дальнейшей детализации перечислений необходимо ис-
пользовать арабские цифры со скобкой, а запись производится с абзацного от-
ступа, как показано в примере. 

Пример 
а)… : 
      1)________________ ; 
      2)________________ ; 
б)__________________ . 
Страницы нумеруются арабскими цифрами без точки в правом верхнем 

углу (ГОСТ 2.105-95) либо в центре нижнего поля (ГОСТ 7.32-2001), учитывая 
титульный лист, соблюдая сквозную нумерацию по всему тексту. Номер стра-
ницы на титульном листе, аннотации и задании не ставится. 

Иллюстрации и таблицы, расположенные на отдельных листах, и распе-
чатки с ЭВМ включают в общую нумерацию страниц записки. Лист формата 
А3 учитывают как одну страницу. 

Количество иллюстраций должно быть достаточным для пояснения изла-
гаемого текста. Иллюстрации могут быть расположены как по тексту ПЗ (воз-
можно ближе к ссылкам на них в тексте), так и в приложении. Иллюстрации 
должны быть выполнены в соответствии с требованиями стандартов ЕСКД. 
Иллюстрации, за исключением приложений, следует нумеровать арабскими 
цифрами сквозной нумерацией. Если рисунок один, то он также нумеруется: 
«Рисунок 1». 

Допускается нумеровать иллюстрации в пределах раздела. В этом случае 
номер иллюстрации состоит из номера раздела и порядкового номера иллюст-
рации, разделенных точкой.  

При ссылках на иллюстрации слово «рисунок» пишут полностью. Напри-
мер: « ... в соответствии с рисунком 1.2». 

Иллюстрации каждого приложения обозначают отдельной нумерацией 
арабскими цифрами с добавлением перед цифрой обозначения приложения. 
Например: Рисунок В.3. 

При необходимости иллюстрации могут иметь наименование и поясни-
тельные данные (подрисуночный текст). Слово «Рисунок» и наименование по-
мещают после пояснительных данных по центру строки и располагают сле-
дующим образом (рисунок 9.10):  

Би
бл
ио
те
ка

 БГ
УИ
Р



 171 

  

ЭЛА 

 

1 
 

2 
 

1 – низкочастотные, 2 – высокочастотные терапевтические аппараты 
Рисунок 9.10 – Классификация ЭЛА 

 

Иллюстрация, как правило, выполняется на одной странице. Если рисунок 
не умещается на одной странице, допускается переносить его на другие стра-
ницы. При этом тематическое наименование помещают на первой странице, 
поясняющие данные – на каждой странице и под ними пишут, например «Рису-
нок 1, лист 2». 

Иллюстрация должна быть расположена так, чтобы ее было удобно рас-
сматривать без поворота записки или с поворотом на 90 % по часовой стрелке. 
На все иллюстрации должны быть даны ссылки в записке. 

Фотоснимки размером меньше формата А4 должны быть наклеены на 
стандартные листы белой бумаги. 

Оформление таблиц в ПЗ делают по ГОСТ 2.105-95.  
Таблицы применяют для наглядности и удобства сравнения показателей. 

Цифровой материал, как правило, оформляют в виде таблиц в соответствии  
с рисунком 9.11. 

 

Таблица 1.1  –  Пример оформления таблицы 
номер                                          название таблицы 

 

  Заголовки граф Головка  
    подзаголовки граф 

      строки 
      (горизонтальные 
      строки) 
       
 Боковик (графа 

для заголовков) 
графы (колонки)  

 

Рисунок 9.11 – Оформление таблицы 
 
Название таблицы (если оно предусмотрено) должно отражать содержа-

ние, быть точным, кратким. При переносе части таблицы на другие страницы 
название помещают только над первой частью, над остальными – «Продолже-
ние таблицы» с указанием номера. 

Таблицы, за исключением таблиц приложений, следует нумеровать араб-
скими цифрами сквозной нумерацией. Допускается нумеровать таблицы в пре-
делах раздела. 

Таблицы каждого приложения обозначают арабскими цифрами с добавле-
нием перед цифрой обозначение приложения. Например: Таблица А.2. 

На все таблицы должны быть даны ссылки в тексте ПЗ, при ссылке слово 
«таблица» не сокращается. 
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Заголовки граф и строк таблицы следует писать с прописной буквы, а под-
заголовки граф – со строчной буквы, если они составляют одно предложение  
с заголовком, или с прописной буквы, если они имеют самостоятельное значе-
ние. В конце заголовков и подзаголовков таблиц точки не ставят. Заголовки и 
подзаголовки граф указывают в единственном числе. 

Таблицы слева, справа и снизу, как правило, ограничивают линиями. 
Разделять заголовки и подзаголовки боковика и граф диагональными ли-

ниями не допускается. 
Заголовки граф, как правило, записывают горизонтально. При необходи-

мости допускается вертикальное расположение заголовков граф. Головка таб-
лицы должна быть отделена линией от остальной части таблицы. 

Таблицу помещают после первой ссылки на нее в тексте, если целесообраз-
но, то на следующей странице, а при необходимости – в приложении к записке. 

При необходимости помещенные на отдельной странице таблицы могут 
быть расположены с поворотом страницы на 90°. Номер страницы в этом слу-
чае проставляют как на других страницах, без поворота. 

Заменять кавычками повторяющиеся в таблице цифры, математические 
знаки, знаки процента и номера, обозначения марок материалов и типоразмеров 
изделий, обозначения нормативных документов не допускается. 

В формулах в качестве символов следует применять обозначения, уста-
новленные соответствующими государственными стандартами. Пояснения 
символов и числовых коэффициентов, входящих в формулу, если они не пояс-
нены ранее в тексте, должны быть приведены ниже, после слова «где». Поясне-
ния каждого символа следует давать с новой строки в той последовательности, 
в которой символы приведены в формуле. 

Формулы, следующие одна за другой, разделяют запятой. Переносить 
формулы на следующую строку допускается только на знаках выполняемых 
операций, причем знак в начале следующей строки повторяют. При переносе 
формулы на знаке умножения применяют знак «×». 

Применение машинописных и рукописных символов в одной формуле не 
допускается. 

Формулы, за исключением формул, помещаемых в приложении, должны 
нумероваться сквозной нумерацией арабскими цифрами, которые записывают 
на уровне формулы справа в круглых скобках. Одну формулу также нумеруют. 
Допускается нумеровать формулы в пределах раздела. 

Формулы, помещаемые в приложениях, должны нумероваться отдельной 
нумерацией арабскими цифрами в пределах каждого приложения с добавлени-
ем перед цифрой обозначения приложения, например формула (В.1). 

Порядок изложения в ПЗ математических уравнений и неравенств такой 
же, как и формул. 

Материал, дополняющий текст ПЗ, допускается помещать в приложениях. 
Приложениями могут быть, например, графический материал, таблицы боль-
шого формата, расчеты, описания аппаратуры и приборов, алгоритмов и про-
грамм задач, решаемых на ЭВМ, и т.д. 
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Приложения выполняют на листах формата А4. Допускается оформлять 
приложения на листах форматов А3, А4×3, А4×4, А2 и А1 по ГОСТ 2.301-68. 

Приложения обозначают заглавными буквами русского алфавита, за ис-
ключением букв Ё, З, Й, О, Ч, Ь, Ы, Ъ.  

Допускается обозначение приложений буквами латинского алфавита, за 
исключением букв I и О. 

В случае полного использования букв русского и латинского алфавитов 
допускается обозначать приложения арабскими цифрами. 

Каждое приложение следует начинать с новой страницы с указанием 
вверху посредине страницы слова «Приложение» и его обозначения, а под ним  
в скобках для обязательного приложения пишут слово «обязательное», а для 
информационного – «рекомендуемое» или «справочное». 

Приложение должно иметь заголовок, который записывают симметрично 
относительно текста с прописной буквы отдельной строкой. 

Если в ПЗ одно приложение, оно обозначается «Приложение А». 
Все приложения должны быть перечислены в содержании ПЗ с указанием 

их номеров и заголовков. 
Ссылки на литературные источники указываются порядковым номером 

(по списку источников), выделенным косыми чертами или квадратными скоб-
ками. Например: /3/, [3]. 

При ссылках слова «таблица», «рисунок», «приложение» следует писать пол-
ностью. 

В повторных ссылках на иллюстрации и таблицы указывается сокращенно 
слово «смотри». Пример: см. таблицу 1.3. 

Список использованных источников должен содержать перечень источ-
ников, использованных при выполнении курсового или дипломного проекта. 
Источники располагаются в порядке появления ссылок в тексте. Сведения об 
источниках следует давать в соответствии с требованиями ГОСТ 7.1-2003, 
ГОСТ 7.4-95, СТБ 7.12-2001, ГОСТ 7.82-2001, ГОСТ 7.83-2001. 

Пример оформления списка использованных источников 
Книги 
1–3 автора: 
1 Разевиг, В. Д. Проектирование печатных плат в P-CAD 2001 / В. Д. Разе-

виг. – М. : СОЛОН-Р, 2001. – 580 с. 
2 Романычева, Э. Т. AutoCAD. Практическое руководство / Э. Т. Романы-

чева, Т. М. Сидорова, С. Ю. Сидоров. – М. : Радио и связь, 1997. – 385 с. 
4 и более авторов: 
3 Медицинская электроника. Дипломное проектирование / В. М. Бондарик 

[и др.] ; под ред. А. П. Достанко. – Минск : БГУИР, 2002. – 158 с. 
Статьи  
1–3 автора: 
1 Котов, Д. А. Система электродов для многоканальной электронейрости-

муляции / Д. А. Котов, А. Н. Осипов, В. М. Бондарик // Известия Белорусской 
инженерной академии. – 2001. – №1(11) / 3. – С. 149–152. 
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2 Larsen, R. P. Computer-Aided Preliminary Layout Design of Customized MOS 
Array / R. P. Larsen // IEEE Trans. of Computers. – 1971. – Vol. EC-20, №5. –  
P. 512–523. 

4 и более авторов: 
3 Влияние параметров ультразвуковых колебаний на процессы перемеши-

вания препаратов крови / В. М. Бондарик [и др.] // Вестник Полоцкого государ-
ственного университета. Серия С. Фундаментальные науки. – №11. – 2004. –  
С. 70–74. 

Авторские свидетельства и патенты 
1 А. с. 436350 СССР. Двоичный сумматор / Ю. Н. Корнеев, С. В. Пискунов, 

С. И. Сергеев. – Опубл. в БИ, 1974, №26. 
2 Пат. 7300 Беларусь, МКИ А 61N 1 / 44, A 61L 9 / 22. Аэроионизатор / 

А. Н. Осипов [и др.] (Беларусь). – № а 20000277 ; Заявлено  27.03.2000 ; Опубл. 
30.09.2001 ; Пат. 05.05.2005. – 4 с. 

3 Пьезоэлектрический датчик : А. с. 477751 СССР, МКИ В 06 В 1 / 06. 
4 Пат. 4893742 США от 16.01.1990. Ultrasonic laser soldering / Bullock P., 

Hugers Aircraft Co. 
Нормативно-технические документы 
1 ГОСТ 7.82-2001. Библиографическая запись. Библиографическое описа-

ние электронных ресурсов. Общие требования и правила составления. – Минск : 
Госстандарт Респ. Беларусь, 2001. – 35 с. 

2 Формовка выводов и установка изделий электронной техники на печат-
ные платы. Общие требования и нормы конструирования : ГОСТ 29137-91. 

Электронные издания 
на физическом носителе (CD-ROM, DVD-ROM и т.д.): 
1 Большие и малые библиотеки России : справочник [Электронный ре-

сурс] / Рос. библ. ассоц. – Электрон. текстовые дан. (5570560 байт). – М. : Ли-
берея, 2001. – 1 CD-ROM. 

в Интернете: 
2 Мельгуй, О. И. Ультразвуковое перемешивание препаратов крови [Элек-

тронный ресурс] / О. И. Мельгуй, В. М. Бондарик. – 11 февраля 2007. – Режим 
доступа: http://bmeg.by.ru/ru/body.shtm.ssi/snir#moi. 

3 Библиотека электронных ресурсов Исторического факультета МГУ  
им. М. В. Ломоносова [Электронный ресурс] / ред. В. Румянцев. – 2001. – Ре-
жим доступа: http://hronos.km.ru/proekty/mgu. 

 

В ссылке допускается опускать отдельные элементы записи при условии, 
что оставшийся набор элементов обеспечит поиск объекта ссылки в библиотеке 
или других фондах. Так, в ссылке на книгу допускается не указывать ее объем 
(количество страниц). В ссылке на составную часть документа (например ста-
тью) может быть не указано ее название, но при этом обязательно указаны 
страницы, на которых она опубликована. Если приведено название статьи, то 
страницы могут не указываться. 
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В ссылке допускается сокращать названия журналов, издательств, мест из-
даний в соответствии с правилами, приведенными в ГОСТ 7.12-93; 7.11-78. 

В ПЗ после аннотации помещают содержание, включающее номера и на-
именования разделов и подразделов с указанием номеров страниц. 

Слово «Содержание» записывают в виде заголовка (симметрично тексту) 
прописными буквами. Наименования, включенные в содержание, записывают 
строчными буквами, начиная с прописной буквы. 
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ПРИЛОЖЕНИЕ А 
Пример исходных данных, содержания пояснительной записки  

и перечня графического материала курсовых проектов 
 

ПРОЕКТ ПО ПРОЕКТИРОВАНИЮ ЭЛЕКТРОННОЙ ЛЕЧЕБНОЙ АППАРАТУРЫ 
 

Тема курсового проекта: Аппарат для местной дарсонвализации 
 

ИСХОДНЫЕ ДАННЫЕ: 
1 Масса аппарата: не более 350 г. 
2 Габаритные размеры аппарата без электродов: не более 260х46х75 мм. 
3 Амплитуда импульсов на основном электроде должна регулироваться в диапазоне 

min = 3,0(±2.0) кВ, max = 14,0(+8,0 –5,0) кВ. 
4 Частота следования импульсов низкочастотных колебаний: 20±8 Гц. 
5 Частота импульсов заполнения: 100±20 кГц. 
6 Ток потребления: не более 300 мА. 
7 Питание: от источника питания напряжением (3.0±0.3) В 
8 Условия эксплуатации:  

- диапазон рабочих температур +10 ...+35 0С; 
- относительная влажность до 95 % при температуре +30 0С; 
- атмосферное давление 710 ± 90 Торр; 
- механические воздействия отсутствуют. 

9 Остальные требования уточняются в процессе проектирования. 
СОДЕРЖАНИЕ ПОЯСНИТЕЛЬНОЙ ЗАПИСКИ 

Введение. 
1 Анализ современных способов и устройств для лечебного воздействия импульсным 

ВЧ-током (включая патентный обзор). 
2 Анализ задания на курсовое проектирование. 
3 Разработка электрической схемы. 

3.1 Обоснование электрической структурной схемы. 
3.2 Разработка электрической принципиальной схемы. 
3.3 Электрический расчет блоков устройства. 

3.3.1 Задающий генератор. 
3.3.2 Блок коммутатора 
3.3.3 Выходной каскад. 

4 Моделирование работы схемы в среде Electronics Workbench. 
4.1 Исследование переходных процессов и частотных характеристик аппарата. 
4.2 Моделирование работы схемы аппарата 

5 Разработка конструкции устройства. 
5.1 Выбор и обоснование комплектующих элементов и материалов конструкции уст-

ройства. 
5.1.1 Обоснование выбора активных и пассивных элементов. 
5.1.2 Обоснование конструкторского исполнения устройства, выбор вида элек-

трического монтажа. 
5.1.3 Обоснование выбора материалов. 

5.2 Расчет основных компоновочных характеристик устройства. 
5.3 Расчет показателей надежности устройства с учетом электрического режима и 

условий работы элементов. 
5.4 Расчет электромагнитной совместимости. 
5.5 Расчет и разработка печатной платы (с использованием САПР). 
5.6 Разработка конструкции аппарата. 
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Продолжение приложения А 
Заключение.  
Список использованных источников. 
Приложение А – Результат расчетов, полученных с помощью ЭВМ. 
Приложение Б – Спецификация сборочных единиц, перечень элементов электрической 

принципиальной схемы. 
 

ПЕРЕЧЕНЬ ГРАФИЧЕСКОГО МАТЕРИАЛА 
1 Электрическая структурная схема устройства – 0,5–1 лист формата А1. 
2 Электрическая принципиальная схема устройства – 0,5–1 лист формата А1. 
3 Сборочный чертеж устройства – 0,5–1 лист формата А1. 
4 Сборочный чертеж электронного блока – 0,5–1 лист формата А1. 
5 Чертеж печатной платы – 1 лист формата А1. 
 
 
 
 

ПРОЕКТ ИССЛЕДОВАТЕЛЬСКОГО ВИДА 
 

Тема курсового проекта: Исследование характеристик прибора интенсивной магнитной 
терапии 

 
ИСХОДНЫЕ ДАННЫЕ: 

1 Схемы электрические: структурная и принципиальная прибора. 
2 Питание: от сети переменного тока 220 В 50 Гц. 
3 Габаритные размеры, мм, не более: прибора 350х220х150; 

 индуктора 150х30х15. 
4 Масса прибора: не более 1,5 кг. 
5 Потребляемая мощность: не более 20 ВА. 
6 Условия эксплуатации: класс II, группа NF по ГОСТ Р 50267.0-92. 
7 Электрические характеристики на выходе прибора: 

амплитудное значение магнитной индукции 40 мТл; 
частота следования импульсов 10 Гц; 
длительность импульса 12 мс. 

8 Погрешность контроля магнитного поля,  не более ±10 %. 
9 Остальные требования уточняются в процессе проектирования. 
 

СОДЕРЖАНИЕ ПОЯСНИТЕЛЬНОЙ ЗАПИСКИ 
Введение. 
1 Анализ современных способов, устройств и методик исследования их характеристик 

по данному направлению проектирования, включая патентные исследования. 
2 Анализ задания на курсовое проектирование. 
3 Разработка методики исследования. 

3.1 Разработка схемы (структурной, функциональной) исследований. 
3.2 Выбор технических средств для проведения исследований. 
3.3 Выбор основных расчетных соотношений и уравнений. 

4 Разработка схемы электрической и конструкции оснащения для проведения исследо-
ваний. 

4.1 Разработка и расчет электрической принципиальной схемы. 
4.2 Выбор конструкции приспособлений. 

 

Би
бл
ио
те
ка

 БГ
УИ
Р



 183 

Продолжение приложения А 
5 Экспериментальные исследования устройства. 

5.1 Исследование влияния параметров активирующих воздействий на выходные ха-
рактеристики прибора. 

5.2 Физические модели воздействия активирующих факторов. 
6 Моделирование и оптимизация исследуемого процесса в среде MatLab. 

6.1 Разработка методики моделирования и выбор алгоритма. 
6.2 Моделирование процесса. 
6.3 Оптимизация параметров исследуемого процесса на модели. 

7 Рекомендации по использованию результатов исследований. 
Заключение. 
Список используемых источников. 
Приложение А – Распечатки программ и результатов расчета, полученных на ПЭВМ. 
Приложение Б – Спецификации сборочных единиц, перечень элементов электрической 

принципиальной схемы. 
 

ПЕРЕЧЕНЬ ГРАФИЧЕСКОГО МАТЕРИАЛА 
1 Схема исследования – 0,5–1 лист формата А1. 
2 Графики исследований – 0,5–2 листа формата А1. 
3 Математические модели и факторные пространства – 0,5–1 лист формата А1. 
4 Электрическая принципиальная схема исследовательского оснащения – 0,5–1 лист 

формата А1. 
5 Сборочный чертеж исследовательского оснащения – 0,5–1 лист формата А1. 
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ПРИЛОЖЕНИЕ Б 
Пример титульного листа курсового проекта 

 
МИНИСТЕРСТВО ОБРАЗОВАНИЯ РЕСПУБЛИКИ БЕЛАРУСЬ 

 
Учреждение образования 

БЕЛОРУССКИЙ ГОСУДАРСТВЕННЫЙ УНИВЕРСИТЕТ  
ИНФОРМАТИКИ И РАДИОЭЛЕКТРОНИКИ 

 
Факультет: компьютерного проектирования 
 
Кафедра: электронной техники и технологии 
 
 
 
 К защите допустить 
 ___________А. В. Петров  
 “___”__________ 200 __г. 
 
 

 
ПОЯСНИТЕЛЬНАЯ ЗАПИСКА 
К КУРСОВОМУ ПРОЕКТУ 

 
НА ТЕМУ: 

АППАРАТ АКУСТОЭЛЕКТРОННОЙ ТЕРАПИИ 
 
 
 
 
 
 
 

 Разработал: ст. гр. 311801 
 __________И. П. Иванов  
 Принял: 
 ___________А. В. Петров 
 
 

МИНСК 2008 
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ПРИЛОЖЕНИЕ В 
Максимальные значения интенсивностей отказов элементов  

электронной аппаратуры (для учебных целей) [10] 
Наименование элемента (группа, вид, тип) Интенсивность  

отказов х 10-6 1/ч 
 

1 2 
Полупроводниковые (ПП) цифровые интегральные схемы (ИС) 1-й 
степени интеграции 0,40 

ПП цифровые ИС 2-й степени интеграции 0,45 
ПП цифровые ИС 3-й степени интеграции 0,50 
ПП цифровые ИС 4-й степени интеграции 0,60 
ПП аналоговые ИС 1-й степени интеграции 0,45 
ПП аналоговые ИС 2-й степени интеграции 0,55 
ПП аналоговые ИС 3-й степени интеграции 0,65 
Транзисторы полевые малой мощности 0,30 
Транзисторы полевые средней мощности 0,35 
Транзисторы полевые большой мощности 0,45 
Транзисторы кремниевые малой мощности 0,40 
Транзисторы кремниевые средней мощности 0,45 
Транзисторы кремневые большой мощности 0,50 
Транзисторы германиевые малой мощности 0,45 
Транзисторы германиевые средней мощности 0,55 
Транзисторы германиевые большой мощности 0,65 
Транзисторы маломощные в ключевом режиме 0,40 
Транзисторы большой и средней мощности в ключевом режиме 0,60 
Диоды высокочастотные кремниевые 0,20 
Диоды высокочастотные германиевые 0,30 
Диоды импульсные в ключевом режиме 0,15 
Диоды выпрямительные маломощные, Iср. выпр. < 300 мА 0,20 
Диоды выпрямительные средней мощности, Iср. выпр. = 0,3...10 А 0,50 
Диоды-столбы высоковольтные выпрямительные 0,80 
Блоки (мосты) выпрямительные кремниевые, Iср. выпр. < 400 мА 0,40 
Блоки (мосты) выпрямительные германиевые, Iср. выпр. > 400 мА 1,10 
Стабилитроны маломощные, Рmax < 1 Вт 0,90 
Стабилитроны средней мощности Рmах < 5 Вт 1,25 
Варикапы 0,20 
Светодиоды 0,70 
Диоды туннельные и обращенные 0,27 
Диоды инфракрасного излучения 0,80 
Фотодиоды 0,70 
Диоды сверхвысокочастотные 6,00 
Оптроны 0,75 
Тиристоры маломощные, Iср < 2 А 2,20 
Тиристоры маломощные, Iср < 2../10 А 4,40 
Резисторы постоянные непроволочные, Рном < 0,5 Вт, ток постоянный 0,05 
Резисторы постоянные непроволочные, Рном < 0,5 Вт, ток переменный 0,10 
Резисторы постоянные непроволочные, Рном = 1...2 Вт, ток постоянный 0,08 
Резисторы постоянные непроволочные, Рном = 1...2 Вт, ток переменный 0,15 
Резисторы постоянные проволочные, Рпом < 10 Вт 0,40 
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Продолжение приложения В 
1 2 

Резисторы постоянные проволочные, Рном < 50 Вт 0,80 
Резисторы переменные непроволочные 0,50 
Резисторы переменные непроволочные с выключателем 1,30 
Резисторы переменные проволочные 1,20 
Резисторы переменные проволочные ползункового типа 1,10 
Терморезисторы 0,20 
Варисторы 0,40 
Фотореэисторы 0,50 
Конденсаторы слюдяные 0,03 
Конденсаторы танталовые 0,02 
Конденсаторы керамические 0,05 
Конденсаторы бумажные 0,07 
Конденсаторы металлобумажные 0,06 
Конденсаторы пластиковые 0,07 
Конденсаторы нейлоновые 0,01 
Конденсаторы электролитические алюминиевые 0,55 
Конденсаторы электролитические танталовые 0,25 
Индикаторы стрелочные 4,00 
Индикаторы цифровые на жидких кристаллах 3,25 
Индикаторы цифровые наполненные (серии ИН) 3,50 
Индикаторы цифровые вакуумные накальные (серии ИВ) 0,80 
Индикаторы цифровые вакуумные люминесцентные (серии ИВ) 2,00 
Индикаторы цифробуквенные на основе светодиодов одноразрядные 1,00 
Индикаторы цифробуквенные на основе светодиодов многоразрядные 3,00 
Индикаторы люминесцентные сигнальные 3,30 
Лампочки сигнальные, накаливания 8,00 
Лампочки сигнальные, неоновые 10,00 
Кинескопы черно-белого изображения 7,50 
Кинескопы цветного изображения 9,50 
Трубки осциллографические (ЭЛТ) 10,00 
Катушки индуктивности, dпров < 0,1 мм 0,30 
Катушки индуктивности, dnpoв > 0,1 мм 0,20 
Дроссели, dnpов < 0,1 мм 0,30 
Дроссели, dnpов > 0,1 мм 0,20 
Обмотки сетевых трансформаторов, dпров. < 0,1 мм 0,75 
Обмотки сетевых трансформаторов, dnpoв > 0,1 мм 0,50 
Трансформаторы входные и выходные 0,90 
Трансформаторы импульсные 0,13 
Трансформаторы высоковольтные 2,50 
Реле электромагнитные общего применения 2,50** 
Реле электромагнитные миниатюрные 0,60** 
Герконы 0,30* 
Соединители (разъемы) штепсельные 0,20*** 
Гнезда, клеммы 0,70* 
Вилки двухполюсные 0,50 
Зажимы 0,01* 
Тумблеры, кнопки 0,40** 
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Продолжение приложения В 
1 2 

Переключатели галетные 0,40** 
Переключатели малогабаритные 0,30** 
Переключатели малогабаритные модульные (П2К) с независимой 
фиксацией 0,30** 

Переключатели малогабаритные модульные (П2К) с зависимой фик-
сацией 0,37** 

Микропереключатели типа МП 0,30* 
Штеккеры (гнезда) телевизионные 2,12 
Лепесток контактный 0,20 
Плата (колодка) контактная межблочного монтажа 0,40* 
Провод монтажный 0,30**** 
Кабели (шнуры) 0,60**** 
Кабели (шнуры) питания 2,00**** 
Держатели предохранителей 0,20 
Предохранители 5,00 
Изоляторы 0,50 
Шайбы, прокладки изолирующие 0,75 
Соединения пайкой, ток постоянный 0,04 
Соединения пайкой, ток пульсирующий 0,40 
Соединения накруткой 0,02 
Платы печатного монтажа 0,20 
Линии задержки 0,75 
Фильтры пьезокерамические 0,25 
Резонаторы кварцевые 0,37 
Магнитопроводы ленточные 0,10 
Ферритовые элементы 0,01 
Головки магнитные малогабаритные 7,50 
Электродвигатели асинхронные, сельсины 12,30 
Электродвигатели синхронные 0,51 
Электродвигатели постоянного тока 13,40 
Батареи однозарядные 43,00 
Батареи заряжаемые 2,00 
Аккумуляторы 10,30 
Датчики электромеханические пассивные 15,00 
Конструкции несущие легкосъемных субблоков 0,10 
Конструкции несущие РЭА 3,00 
Пружины 2,20 
Соединения механической пайкой 0,06 
Соединения винтами 3...5 мм 0,001 

Примечания  
1 Значения интенсивностей отказов элементов, помеченные символом, приведены со-

ответственно: 
*  – на один контакт при номинальном токе;  
** – на одну контактную группу при номинальном токе;  
*** – на один штырек при номинальном токе;  
**** – на каждый метр длины при номинальной плотности тока в проводе (неполный 

метр длины должен считаться как один метр). 
2 При использовании безвыводных компонентов и технологии поверхностного монтажа  

значения интенсивностей отказов компонентов можно уменьшать примерно на 50 % 
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ПРИЛОЖЕНИЕ Г 
Данные к расчету поправочного коэффициента α1,2  

 
 

а

 
а – для контактных элементов (разъемы, реле, переключатели и т.п.); 

б – для соединений пайкой; 
в – для резисторов типов С2-23 и ОМЛТ; 
г – для переменных проволочных резисторов 

Рисунок Г.1 – Обобщенные зависимости поправочного коэффициента α1,2  
от температуры и коэффициента нагрузки 
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Продолжение приложения Г 
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а – для резисторов; б – для неполярных конденсаторов; 

в – для изделий, имеющих обмотки; г – для электролитических конденсаторов 

Рисунок Г.2 – Обобщенные зависимости поправочного коэффициента α1,2  
от температуры и коэффициента нагрузки 
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Продолжение приложения Г 

 

   0.2  0.4  0.6  0.8  1.0

0.8

1.6

2.4

a1.2

KH

40

30

20

t=60 C

а б

в г

20        40         60         80  t, Co

1

2

3

4

5

a1.2

K =1.2H 1.0

0.6

0.2

6

7

0   0.2  0.4  0.6  0.8  1.0

o

0.6

1.4

2.2

3.0

a1.2

KH

120

100

80
60

40

20          60       100      140  t, Co

0.8

1.6

2.4

0.2

0.6

0.8

0.4

K =1H

a1.2
o

o

o

o

o
50

t=20 C

o

o

o

o

o

 
а – для германиевых диодов; б – для кремниевых диодов; 

в – для германиевых транзисторов; г – для кремниевых транзисторов 

Рисунок Г.3 – Обобщенные зависимости поправочного коэффициента α1,2  
от температуры и коэффициента нагрузки 
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Продолжение приложения Г 
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а – для кремниевых высокочастотных транзисторов; 
б – для германиевых высокочастотных транзисторов; 

в – для полупроводниковых цифровых интегральных микросхем; 
г – для полупроводниковых линейно-импульсных интегральных микросхем 

Рисунок Г.4 – Обобщенные зависимости поправочного коэффициента α1,2  
от температуры и коэффициента нагрузки 
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ПРИЛОЖЕНИЕ Д 
 

Значения поправочных коэффициентов  
(составлено для учебных целей) 

 
Значения поправочных коэффициентов α3,  

учитывающих влияние механических воздействий [10] 
Условия эксплуатации Значение α3 

Лабораторные 1,00 
Стационарные 1,07 
Полевые 1,07 
Корабельные 1,37 
Автомобильные 1,46 
Железнодорожные 1,57 
Самолетные 1,65 

 
Значения поправочных коэффициентов α 4 , 

учитывающих влияние относительной влажности [10] 
Относительная влажность Значение α4 

60...70 % при t = 20...40 °С 1,0 
90...98 % при t = 20...25 °С 2,0 
90...98 % при t = 30...40 °С 2,5 

 
Значения поправочных коэффициентов α 5,  

учитывающих атмосферное давление (высоту над уровнем моря) [10] 
Высота, км Значение α5 Высота, км Значение α5 

0...1 1,00 5...6 1,16 
1...2 1,05 6...8 1,20 
2...3 1,10 8...10 1,25 
3...5 1,14 10...15 1,30 
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ПРИЛОЖЕНИЕ Е 
Средние значения случайного времени восстановления τj элементов  

и функциональных частей электронной аппаратуры (для учебных целей) [10] 
 

Элемент, функциональная часть РЭУ τj, ч 
Цифровые интегральные микросхемы малой и средней степени ин-
теграции 1,5 

Цифровые интегральные микросхемы большой и сверхбольшой 
степени интеграции 0,5 

Аналоговые интегральные микросхемы малой и средней степени 
интеграции 1,2 

Транзисторы большой мощности 0,7 
Транзисторы средней и малой мощности 0,8 
Резисторы постоянные 0,5 
Резисторы переменные 1,2 
Конденсаторы неполярные 1,1 
Конденсаторы электролитические 0,55 
Диоды (кроме выпрямительных) 0,6 
Диоды выпрямительные 0,4 
Блоки (мосты) выпрямительные 0,3 
Стабилитроны 0,5 
Переключатели 0,7 
Соединители (разъёмы) 2,0 
Катушки индуктивности 1,3 
Трансформаторы 2,2 
Дроссели 1,4 
Предохранители 0,1 
Платы печатного монтажа 3,0 
Монтажные провода 0,5 
ТЭЗы устройств цифровой обработки информации 0,5 
Индикаторные устройства 1,5 
Сигнальные и индикаторные лампочки 0,2 
Реле 2,6 
Тумблеры, кнопки 0,6 
Зажимы,   гнёзда, клеммы 0,8 
Шнуры питания 0,3 
Пайки 0,5 
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ПРИЛОЖЕНИЕ Ж 
Пример расчета надежности электронного блока  

с помощью программы АСРН 
 

Расчет надежности модуля: Блок 1 
 
I Основные исходные данные 
1 Расчет в режиме: эксплуатации 
2 Группа аппаратуры: 3.3, 3.4 
3 Температура окружающей среды °С: 25 
II Методический документ: 
Справочник «Надежность электрорадиоизделий» 
III Расчет суммарной интенсивности отказов входящих модулей и ЭРИ: 
   
Модуль: Плата1 

Тип ЭРИ Количество Схемная позиция б (бсг)  э, 1/ч  э*n, 1/ч  
Интегральные микросхемы 
Микроконтролер 1 DD1 - 0.91·10-6 0.91·10-6 
Полупроводниковые приборы 
2Д522Б 1 VD1 0.55·10-7 0.41·10-7 0.41·10-7 
2Т825А - В 1 VT1 0.6·10-7 0.99·10-7 0.99·10-7 
Приборы пьезоэлектрические и фильтры электромеханические 
РК259 1 ZQ1 2.3·10-8 0.81·10-7 0.81·10-7 
Резисторы 
Р1-8 1 R1 0.4·10-7 0.48·10-7 0.48·10-7 
Р1-12 5 R2-R6 0.65·10-7 0.79·10-7 0.39·10-6 
Конденсаторы 
К10-17а 2 С1-С2 3·10-8 0.61·10-8 1.21·10-8 
Коммутационные изделия 
КЭМ-6 1 K1 1.1·10-9 2·10-6 2·10-6 
Итого для модуля: 0.36·10-5 
ЭРИ, находящиеся непосредственно в модуле: Блок 1 

Тип ЭРИ Количество Схемная позиция б (бсг)  э, 1/ч  э*n, 1/ч  
Коммутационные изделия 
кнопка 5 SA1-SA5 1.6·10-7 0.77·10-8 0.39·10-7 
Соединители низкочастотные и радиочастотные 
РБН1 1 XP1 0.8·10-9 2.77·10-10 2.77·10-10 
Итого для модуля: 0.39·10-7 
IV Итого для модуля: Блок 1 

Шифр модуля Децимальный номер Количество Схемная позиция э, 1/ч  э*n, 1/ч  
Плата1 БГУИ.943011.001 1 A1 0.36·10-5 0.36·10-5 

ЭРИ, находящиеся непосредственно в модуле: 0.39·10-7 
Итого для модуля: 0.36·10-5 
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ПРИЛОЖЕНИЕ И 
Примеры некоторых классов классификатора ЕСКД 

 

Подклассы № 
класса 

Наименование 
класса 1 2 3 4 5 6 7 8 9 

1 2 3 4 5 6 7 8 9 10 11 
30 Сборочные 

единицы  
общемашино-
строительные 

Устройства 
базовые 

Трубопроводы 
и их элементы 

Устройства, 
передающие 
движение 

Устройства 
направляю-
щие, огра-
ничительные 
и передаю-
щие движе-
ние 

Устройства 
защитные, за-
крывающие, 
уплотнитель-
ные, поясни-
тельные  

Устройства 
гидравличес-
кие, пневма-
тические, 
смазочные 

   

40 Средства измере-
ний линейных и 
угловых размеров, 
параметров движе-
ния, времени, си-
лы, массы, темпе-
ратуры, давления, 
расхода количества

Средства изме-
рений линей-
ных и угловых 
размеров 

Средства изме-
рений парамет-
ров движения 
(приборы) 

Средства из-
мерений вре-
мени 

Средства 
измерений 
силы и мас-
сы 

Средства из-
мерений тем-
пературы 

Средства 
измерений 
давления, 
уровня, рас-
хода 

Средства изме-
рений давления, 
уровня, расхода 

(кроме мано-
метрических) 

Состав-
ные 
части 
средств 
измере-
ний 

 

41 Средства изме-
рений электри-
ческих и маг-
нитных величин, 
ионизирующих 
излучений 

Средства изме-
рений электри-
ческих и маг-
нитных вели-
чин 

Средства изме-
рений ионизи-
рующих излу-
чений 

Средства оп-
ределения 
состава и 
свойств газов 

Средства 
определения 
состава и 
свойств 
жидкостей 

Средства оп-
ределения 
состава и 
свойств сы-
пучих ве-
ществ. Сред-
ства универ-
сальные 

 Составные 
части средств 
измерений 

  

67 Трансформаторы. 
Конденсаторы. 

Аппараты электри-
ческие. Электро-
магниты. 

Трансформаторы, 
дроссели 

(мощностью до 
5 кВА) 

Трансформаторы, 
дроссели 

(мощностью 
свыше 5 кВА) 

Конденсаторы Аппараты 
электриче-
ские 

Источники 
света 

Приборы и 
комплексы 
световые 

Электромаг-
ниты 

  

195 
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Продолжение приложения И 
1 2 3 4 5 6 7 8 9 10 11 

1 2 3 4 5 6 7 8 9  
68 

 
Электрообору-
дование. Мон-
таж механиче-

ский 

    Устройства 
токопрово-
дящие 

Устройства 
электроизо-
лирующие 

Устройства 
электромон-
тажные. 
Монтаж ме-
ханический 

  

71 С L/D до 0,5 включительно С L/D св. 0,5 до 2,0 включи-
тельно 

С L/D свыше 2,0    

 

Детали – тела 
вращения типа 
колец, дисков, 
втулок, стерж-
ней, стаканов, 
валов, осей и т.п. 

С нар. поверхн. 
цилиндр. 

С нар. поверхн. 
конич., комби-
нир. 

С нар. по-
верхн. ци-
линдр. 

С нар. по-
верхн. конич., 
комбинир. 

С нар. по-
верхн. ци-
линдр. 

С нар. по-
верхн. конич., 
комбинир. 

   

73 Корпусные Опорные     
 

Детали – не тела 
вращения: кор-
пусные, опорные 

без плоскости 
разъема 

с плоскостью 
разъема 

рамы, осно-
вания 

кронштейны, 
стойки 

Емкостные 
(крышки, ко-
робки, футляры 

и т.п.) 

    

75 Оптические  
 

Детали –  тела 
вращения и (или) 
не тела вращения: 
оптические, элек-
трорадиоэлектрон-
ные, крепежные 

Ползуны, 
вилки 

Арматуры, с 
перфорир. отв. 

и др. 

С элементами 
тел вращения 
и не тел вра-
щения, пру-
жины, ручки 

Уплотни-
тельные, 
маркировоч-
ные, платы 
печатные 

с рабочими 
поверхностями 
плоскими, лазе-
ров, волоконной 

оптики 

с рабочими 
поверхностя-
ми, кроме 
плоских 

Электро-
радио-

электронные 

Крепеж-
ные  

94 Медицинская  
техника 

Комплексы 
медицинской 
техники. При-
боры медицин-
ские. Аппараты 
медицинские 

Инструменты 
медицинские. 
Средства заме-
щения функций 
органов и сис-
тем организма. 
Оборудование 
медицинское 

Составные 
части меди-
цинской тех-
ники 

      

Примечание – L, D – соответственно, длина и диаметр детали – тела вращения 

95 
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ПРИЛОЖЕНИЕ К 
Буквенный код наиболее распространённых видов элементов 

Первая бук-
ва кода 

(обязатель-
ная) 

Группа видов элементов Примеры видов элементов 
Двух-
буквен-
ный код 

1 2 3 4 
A Устройство (общее обозначение)   
B Громкоговоритель BA 

 Магнитострикционный 
элемент BB 

 Детектор ионизирующих 
излучений BD 

 Сельсин-приёмник BE 
 Телефон (капсюль) BF 
 Сельсин-датчик BC 
 Тепловой датчик BK 
 Фотоэлемент BL 
 Микрофон BM 
 Датчик давления BP 
 Пьезоэлемент BQ 

 Датчик частоты вращения 
(тахогенератор) BR 

 Звукосниматель BS 
 

Преобразователи неэлектриче-
ских величин в электрические 
(кроме генераторов и источни-
ков питания) или наоборот; ана-
логовые или многоразрядные 
преобразователи или датчики 
для указания или измерения 

Датчик скорости BV 
C Конденсаторы   

D Схема интегральная анало-
говая DA 

 Схема интегральная циф-
ровая, логический элемент DD 

 Устройство хранения ин-
формации DS 

 

Схемы интегральные, микро-
сборки 

Устройство задержки DT 
E Нагревательный элемент EK 
 Лампа осветительная EL 
 

Элементы разные 

Пиропатрон ET 

F 
Дискретный элемент защи-
ты по току мгновенного 
действия 

FA 

 То же инерционного дейст-
вия FP 

 Предохранитель плавкий FU 

 

Разрядники, предохранители, 
устройства защитные 

Дискретный элемент защи-
ты по напряжению, раз-
рядник 

FV 

G Генераторы, источники питания Батарея GB 
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Продолжение приложения К 
1 2 3 4 

H Прибор звуковой сигнали-
зации HA 

 Индикатор символьный HG 
 

Устройства индикационные и 
сигнальные 

Прибор сигнализации HL 
K Реле токовое KA 
 Реле указательное KH 
 Реле электротепловое KK 

 Контактор, магнитный 
пускатель KM 

 Реле времени KT 
 

Реле, контакторы, пускатели 

Реле напряжения KV 

L Катушки индуктивности, дрос-
сели 

Дроссель люминесцентно-
го освещения  LL 

M Двигатели  PA 
Р Амперметр PA 
 Счётчик импульсов PC 

 Частотомер (Примечание. 
Сочетание PE не допускается) PF 

 Счётчик активной энергии PI 
 Счётчик реактивной энергии PK 
 Омметр PR 
 

Приборы, измерительное обо-
рудование 

Регистрирующий прибор PS 

 Часы, измеритель времени 
действия PT 

 Вольтметр PV 
 

 

Ваттметр PW 

Q Выключатель автоматиче-
ский QF 

 Короткозамыкатель QK 
 

Выключатели и разъединители в 
силовых цепях (энергоснабжение, 
питание, оборудование и т.д.) 

Разъединитель QS 
R Резисторы Терморезистор RK 
  Потенциометр RP 
  Шунт измерительный RS 
  Варистор RU 

S Выключатель или пере-
ключатель SA 

 Выключатель кнопочный SB 

 

Выключатель автоматиче-
ский (для аппаратов, не 
имеющих контактов сило-
вых цепей) 

SF 

 

Устройства коммутационные в 
цепях управления, сигнализации 
и измерительных 

Выключатели, срабаты-
вающие от различных воз-
действий: 
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Продолжение приложения К 
1 2 3 4 
 от уровня SL 
 от давления SP 
 от положения (путевой) SQ 
 от частоты вращения SR 
 

 

от температуры SK 
T Трансформатор тока TA 

 Электромагнитный стаби-
лизатор TS 

 

Трансформаторы, автотранс-
форматоры 

Трансформатор напряже-
ния TV 

U Модулятор UB 
 Демодулятор UR 
 Дискриминатор UI 

 

Устройства связи 
Преобразователи электрических 
величин в электрические 

Преобразователь частот-
ный, инвертор, генератор 
частоты, выпрямитель 

UZ 

V Диод, стабилитрон VD 
 Прибор электровакуумный VL 
 Транзистор VT 
 

Приборы электровакуумные и 
полупроводниковые 

Тиристор VS 
W Ответвитель WE 
 Короткозамыкатель WK 
 Вентиль WS 

 Трансформатор, неодно-
родность, фазовращатель WT 

 Аттенюатор WU 
 

Линии и элементы СВЧ, антен-
ны 

Антенна WA 

X Токосъёмник, контакт 
скользящий XA 

 Штырь XP 
 Гнездо XS 
 Соединение разборное XT 

 

Соединители контактные 

Соединитель высокочас-
тотный XW 

Y Электромагнит YA 

 Тормоз с электромагнит-
ным приводом YB 

 Муфта с электромагнит-
ным приводом YC 

 

Устройства механические с 
электромагнитным приводом 

Электромагнитный патрон 
или плита YH 

Z Ограничитель ZL 
 

Устройства оконечные, фильт-
ры, ограничители Фильтр кварцевый ZQ 
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ПРИЛОЖЕНИЕ Л 
Пример выполнения перечня элементов 
к схеме электрической принципиальной  
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Продолжение приложения Л 
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ПРИЛОЖЕНИЕ М 
Пример выполнения спецификации  
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Продолжение приложения М 
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ПРИЛОЖЕНИЕ Н 
Материалы, наиболее часто применяемые при разработке ЭЛА 

Обозначение Наименование Область  
применения 

1 2 3 
Черные металлы и сплавы 

7016523  ГОСТ  КП  0.8
573681  ГОСТ 20010001  Х/КЛист

−
−××

 

Сталь углеродистая ка-
чественная холоднока-
таная тонколистовая 
нормальной точности 
прокатки 

Изготовление кор-
пусов, панелей, 
уголков, кронштей-
нов и т.п. 

731051  ГОСТ  40
678560  ГОСТ 22(h11)икШестигранн

−
−

 
Сталь углеродистая каче-
ственная 0,40 % углерода, 
в виде шестигранника 
размером 22 мм 

Изготовление стоек, 
втулок, кронштей-
нов и т.п. 

731051  ГОСТ  20
811415  ГОСТ 15(h11)Круг

−
−

 

Сталь углеродистая ка-
чественная 0,20 % угле-
рода, в виде круга с 
диаметром 20 мм 

Изготовление стоек, 
втулок, осей и т.п. 

Лента 65-Г-С-ПН-0,5х80  
ГОСТ 2283-79 

Лента стальная на пру-
жинной стали 65 Г, хо-
лоднокатаная нормаль-
ной точности изготов-
ления, толщина 0,5 мм; 
ширина 80 мм; С – 
светлая; ПН – полуна-
гартованная 

Изготовление пру-
жин, держателей, 
ручек и т.п. 

Лента 0,05x150-2-79 HM  
ГОСТ 10160-79 

Лента из железоникеле-
вого сплава с высокой 
магнитной проницае-
мостью, 0,05 – толщи-
на, мм; 150 – ширина, 
мм; 2 – класс; 79 НМ – 
марка 

Изготовление сер-
дечников транс-
форматоров 

Проволока 1-2,0 ГОСТ 9389-7 Проволока стальная уг-
леродистая пружинная  
холоднокатаная нор-
мальной точности изго-
товления (I,  II класса), 
диаметр 2 мм 

Изготовление пру-
жин, держателей, 
ручек и т.п. 

Проволока 0,3-3а-Х20Н80  
ГОСТ 12766.1-77 

Проволока из прецизи-
онных сплавов с высо-
ким электрическим со-
противлением 

Изготовление рези-
сторов, реостатов, 
нагревательных 
элементов 

751435  ГОСТУ8А  
7714955  ГОСТ Н-В-3-5Круг

−
−

 
Сталь круглая инстру-
ментальная углероди-
стая со специальной 
отделкой поверхности 

Изготовление изде-
лий с особыми тре-
бованиями к твер-
дости поверхности 
(пуансоны в штам-
пах, штифты и т.п.) 
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Продолжение приложения Н 
1 2 3 

Цветные металлы и сплавы 

Лист АМц М 3 ГОСТ 1613-76 
Лист из алюминиевого 
сплава АМц, толщиной 
3 мм, М – отожженный 

Изготовление кор-
пусов, панелей, 
уголков и т.п. 

Пруток Д16Т-10.0 ГОСТ4783-68 Пруток из дюралюми-
ния  диаметром 10 мм 

Изготовление стоек, 
втулок и накладок 

Лента ЛС 59-1-0.5×175 
ГОСТ 2208-71 

Лента латунная, тол-
щиной 0,5 мм, шириной 
175 мм 

Изготовление экра-
нов, лепестков, 
корпусов и т.п. 

Лента Бр Б2 - М - 0,3х50 - Н  
ГОСТ 1789-70 

Лента из бериллиевой 
бронзы, толщиной 0,3 мм, 
шириной 50 мм 

Изготовление кон-
тактов, пружин, ле-
пестков и т.п. 

Проволока БрБ2-ЗМ-0,5  
ГОСТ 15834-70 

Проволока из берил-
лиевой бронзы, ЗМ – 
мягкая (закаленная), 
толщиной 0,5 мм 

Изготовление кон-
тактов, пружин, ле-
пестков и т.п. 

Литейные сплавы 

Сплав АЛ2   ГОСТ 2685 - 75 
Сплав алюминиевый 
литейный 

Изготовление кор-
пусов, кронштей-
нов, радиаторов и 
т.п. методом литья 

Бронза Бр ОСЦ 5-5-5 ГОСТ 493 - 54 
Бронза оловянная ли-
тейная 

Изготовление корпу-
сов и других деталей 
РЭС методом литья 

Неметаллические материалы 

Текстолит А – 10,0  ГОСТ 2910 – 74 
Текстолит электротех-
нический листовой, 
толщина 10 мм 

Изготовление ди-
электрических дета-
лей методами штам-
повки и резания 

СтеклотекстолитСТК-1,0  
ГОСТ 12652-74 

Стеклотекстолит элек-
тротехнический листо-
вой, толщиной 1 мм 

Изготовление ди-
электрических де-
талей РЭС метода-
ми штамповки 

Пластина Ф - 4 8х245х245 ,  
высший сорт ТУ 6 - 05 - 810 -76 

Пластина из фторопла-
ста, размер листа: 
8х245х245 мм 

Изготовление ди-
электрических дета-
лей методами штам-
повки и резания  

Лист фольгированный GFN 1,5 35 А 2 С 
PND 39-683-93 

Лист диэлектрический 
фольгированный, двух-
сторонний, толщиной 
1,5 мм с толщиной 
фольги 35 мкм 

Изготовление двух-
сторонних печат-
ных плат 

Лист фольгированный FR-4 1,0 Cu 18/18 
UV фирма Kingboard Laminates LTD 

Лист диэлектрический 
толщиной 1,0 мм, лами-
нированный с двух сто-
рон медной фольгой 
толщиной 18 мкм, с за-
щитой от ультрафиоле-
тового излучения 

Изготовление двух-
сторонних печат-
ных плат 
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Продолжение приложения Н 
1 2 3 

Лист фольгированный FR-4DS7405U-50/0-
2,0 фирма «Doosan Corporation» 

Лист диэлектрический 
фольгированный, одно-
сторонний, толщиной 
2,0 мм с толщиной 
фольги 50 мкм 

Изготовление одно-
сторонних печат-
ных плат 

Трубка 3.31 ТВ-40, 4, черная, высший 
сорт, ГОСТ 19034-82 

Трубка из поливинил-
хлоридного пластиката, 
внутренний диаметр   
4 мм  

Изготовление изо-
лирующих деталей  

ТОСП, I сорт, красное прозрачное 
 ГОСТ 17622-72 

Стекло органическое 
техническое листовое. 
Размер листа: не более 
1150х1250 мм; толщи-
на, мм: 3,0 ; 4,0 ; 5,0 

Изготовление пане-
лей, стекол и т.п. 

Полистирол ударопрочный  
УПЛ-612Л-06 рец. 151,  

1 с. ГОСТ 28250-89 

Полистирол ударо-
прочный литьевой, цвет 
согласно рецептуре 
№151 (серый), 1 сорта  

Изготовление ди-
электрических де-
талей РЭС методом 
литья (крышки, ос-
нования, корпуса и 
т.п. 
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ПРИЛОЖЕНИЕ П 
Материалы, используемые для изделий с электромонтажом 

Материал 
Нормативно-
технический  
документ 

Бумага кабельная марок К-080; К-120; КПМ-120 ГОСТ 23436-83 
Бумага конденсаторная марки КОН ГОСТ 1908-82 
Жидкость гидрофобизирующая 136-41 ГОСТ 10834-76 
Жидкость полиметилоксановая ПМС-1000  ГОСТ 13032-77 
Картон электроизоляционный марки ЭВ ГОСТ 2824-86 
Картон прокладочный ГОСТ 9347-74 
Клей БФ-2 и БФ-4 ГОСТ 12172-74 
Клей 88НП ТУ 38-105.540-73 
Клей ВК-9  ОСТ 92-0948 
Компаунд «Виксинт ПК-68» ТУ 38-103.508-81 
Краски маркировочные специальные БМ, КМ, СМ, ЧМ, ЗМ, ЖМ ТУ 29-02-859-78 
Краска ФКС3-5, зеленая ТУ 107-91 

БИТС.066629.003ТУ 
Лак МЛ-92 ГОСТ 15865-70 
Лак НЦ-134 ТУ 6-10-1291-77 
Лак НЦ-132 ГОСТ 6631-74 
Лакоткань электроизоляционная марки ЛШМ ГОСТ 2214-78 
Ленты асбестовые  электро- и теплоизоляционные ГОСТ 14256-78 
Лента липкая маркировочная ТУ 6-05-1240-76 
Лента поливинилхлоридная электроизоляционная ПВХ ГОСТ 16214-86 
Мастика У-9м ОСТ 92-0948-74 
Мастика пломбировочная №2 ГОСТ 18680-73 
Нитки швейные хлопчатобумажные ГОСТ 6309-80 
Паста припойная ПП 250 АУЭО.033.023 ТУ 
Припой ПСр. 2,5 ГОСТ 19746-74 
Припой ПОС-61 ГОСТ 21931-76 
Припой ПОСК 50-18 ГОСТ 21931-76 
Провода монтажные с изоляцией из спекаемой плёнки ТУ 16-505.083-78 
Провода монтажные теплостойкие с изоляцией из фторопласта ТУ 16-505.185-71 
Провода монтажные с плёночной или волокнистой изоляцией 
(МГШВ, МГШВЭ) 

ТУ 16-505 – 437-82 

Проволока медная ММ ГОСТ 2112-79 
Смазка ЦИАТИМ-201 ГОСТ 6297-74 
Смазка ВНИИ НП-248 ТУ 38 101643-76 
Стеклоткань электроизоляционная ГОСТ 10156-78 
Стеклотекстолит ГОСТ 12652-74 
Трубки из поливинилхлоридного пластиката ГОСТ 19034-82 
Церезин синтетический M 100  ГОСТ 7658-74 
Эмаль МЛ-12 ГОСТ 9754-76 
Эмаль МЛ-165, МЛ-165ПМ, МС-160 ГОСТ 12034-77 
Эмаль НЦ-25 ГОСТ 5406-85 
Эмаль ЭП-51 ГОСТ 9640-85 
Эмаль ЭП-572 ТУ 6-10-1539-76 
Эмаль ПФ-19, ПФ-19М ТУ-10-1294-78 
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ПРИЛОЖЕНИЕ Р 
Пример оформления чертежа печатной платы 
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Продолжение приложения Р 
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ПРИЛОЖЕНИЕ С 
Пример оформления сборочного чертежа печатного узла 
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